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PREFACE

Microsoft Excel learning is perceived as more attractive from time to time and it is
probably the most widely software-learning topic written into books, websites, courses,
tutorial videos, groups, etc. Favored by many people because Excel is relatively easy to
operate and giving "completely” results by showing spreadsheet form (rows and columns),
images, text, tables, charts, and so on. Talking about Excel for applied engineering
calculation cannot be separated from the discussion on Visual Basic for Application (VBA)
macro, which is the programming language of Microsoft Visual Basic for the automation of
certain tasks. This is due to macro like any other programming language capable of doing
iterative calculation or repeating the calculation process with ease. There is a unique
combination between worksheet as user-interface and VBA, which turned out to be a lot
makes it easy for users to create a program.

This book also discussed the depiction in AutoCAD software. Why? Because the drawing
creation process can be done through Excel formulas or macros, and this will enhance a
series of producing program. The advantage of an AutoCAD drawing creation is no doubt
that relies on high image accuracy with a myriad of features it will certainly be a challenge
to create drawings. With the ease of working with Excel, coupled with a lot of given
examples in this book, it is expected to increase the interest of the reader to create new
original application programs. Thus, each model or even a specific model of calculation will
be an exciting challenge for a programming job is already enjoyable.

Happy Excel programming!

Jakarta, November, 2015

Gunthar Pangaribuan
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CHAPTER 1

BASICS OF EXCEL

The work performed by Excel is basically the job of entering data which is then processed
to obtain the desired results. It is, in principle, the same as entering data into an electronic
calculator. However, the data entered here consists of various types and coupled with
existing Excel facilities makes it possible to present the appearance of numbers, text,
associated tables, graphs and a database. This makes Excel becomes well integrated to
create a reporting text and the problem analysis as well.

Each version of Excel to be developed to always make changes and additions of new
facilities, while is still maintaining compatibility with previous versions. But the changes do
not alter the basic features of this software as a worksheet for computing applications. In
this book, we will be working with Microsoft Excel 2007.

1.1 WORKSHEET AND WORKBOOK

When opening Excel, by default Book1 is the name of the first workbook. This workbook
consists of 3 worksheets named Sheetl, Sheet2 and Sheet3. Excel worksheet is also
referred to as a spreadsheet that is the sheet for processing text and numbers.

Figure 1.1 shows the elements of a workbook. At the top of the page there is a title bar
displays the workbook name. Underneath, there is a Ribbon, new interface intoduced in
Excel 2007, which is a navigation tool replaces the menu and tool bars in earlier Excel
version as a tool of access to Excel commands. All commands are grouped and placed into
tabs for particular purposes, thus a tab contains groups of commands.

Worksheet is divided into rows and columns. In Excel 2007, the number of columns and
rows have been improved from previous versions. Columns are from A to Z, then AA, AB to
XFD (16,384 columns), while the rows start from 1 to 1,048,576. The intersection point of
column and row forms a cell as a place to fill data. Each cell has an address referred to by a
column and a row, for example cell B4 is a cell in column B and 4t row. The address of
selected cell can be seen in the Name Box below the Ribbon.
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A collection of cells is called a cell range, forming an array extending horizontally or
vertically. For example range A1l: A5 is a collection of cells from A1 to A5, forming an array
of 5x 1 or the range Al: C5 form a 5 x 3 array, and so on.

The name of the worksheet can be replaced by other names, by clicking twice on the sheet
tab, press Delete to clear the name, then write the new name; or by right-clicking on the
tab and then on the shortcut menu click Rename to change its name.

1.2 DATA TYPE

The input data in the spreadsheet can be divided into some types that are:
a. Text: alphabet characters and text: A, B, -Z, AB, A2, Computers ...
b. Numbers: numerical data: 1,2,3,0, -1, -2,4,5.85...

c. Date: the date data typically refers to the setting of a computer calendar or
formulated in the calculation.

d. Hours: Data of hours generally are referred to computer time setting or formulated
in the calculation.

e. Formula: mathematical expressions that calculate two or more values produce a new
value.

f. Function: a function that is used for various applications such as calculations, finance,
mathematics and trigonometry, statistics, database, logic and others.

An Introduction to Excel for Civil Engineers 2
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Figure 1.1: Excel 2007 Worksheet

Table 1.1: Excel Basic Commands

Name Shortcut Description
or Icon
Office Button % Icon to basic commands below:
Save a file with the name of the workbook
Save = o
that is being done
Store the file with another name into a folder
and directory, or to a disc. By default file
extension of .xlsx is given (free macros). If
Save As Alt+FA the file contains macro (VBA) and needs to
activate each time it is opened, an extension
of .xIsm extension must be given.
New (1 Open a new workbook
Open =2 Open an existing workbook
Print = Print a worksheet through the printer device
Close Close the workbook (Close Window icon)
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Exit Close the program and exit Excel (icon Close)
Quick Access
Toolbar:
Undo El Cancel the last job
Redo o Repeat the last job
Tab HOME
Copy the data of a cell or range of cells to
- another location. To select the data to be
Copy . .
copied or cut, then click on the cell or range
of cells where the data is then press Ctrl+C
Move the data to another location.
Commands such as Cut, Copy and Paste can
Cut 3 be found in the pop-up menu by clicking the
right mouse button on the highlighted cells
or by pressing Ctrl+X
Put the data into a new cell or range of cells.
Paste command is done after preceding Cut
Paste iz or Copy. To place the data, click the new
location, then press Enter or by pressing
Ctrl+V
Display Insert dialog box. Used to insert a
Insert > Cells Alt+IE new cell, row or column at the pointer
position (highlighted cell)
Insert > Sheet Rows Alt+IR Insert a new row at the pointer position
[nsert g Sheet Alt+IC Insert a new column at the pointer position
Columns
Format .> Row ?I}It;rlr—llg . Format row, consists of the row height
Height setting, to hide and to unhide row
Format)
Alt+HO Format column, consists of the column width
Format .> Column setting, automatic width (autofit selection),
: (Home > | .
Width Format) hide and show columns, and showing
information of the standard column width
Alt+HO Format cell such as numbers, text, font used,
Format > Cell (Home > .
borders, colors and worksheet protection
Format)
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Table 1.2 Operators and mathematical relationships

Operator Description

+ Summation

- Subtraction

* Multiplication

/ Division

% Percent

A Exponentiation
Relationships

= Equal to

> Greater than

< Less than

<> Not equal to

>= Greater then or equal to
<= Less than or equal to

1.3 FOrRMULA

By definition, a formula is a mathematical expression to calculate the results of two or more
values. Formula can consist of numbers, mathematical operators, functions, reference cell
or range of cells. Cells and cell range are often given a name, for example "A" to B2, or "B"
for a range of D2: D6. Naming cells will be discussed later in this section. All formulas begin
with an equal sign (=). For example, in cell B4 is written the following formula:

A B c D

=B2+B3

r | e | L [ —
(&g

=B2+B3 summing the data in cell B2 to cell B3
=B4*B5 multiplying the data in cell B4 to cell B5

=SUM(D2:D4) summing the number of cells D2, D3 and D4

An Introduction to Excel for Civil Engineers 5




When a formula to be copied, it needs to be considered what is the type of cell in the
formula. Relative cell is the cell that will adjust to its new place when copied. Cell C1 that
contain formula =A1+B1 will be =C2+D2 in Cell E2. The result is as shown in Figure 1.2.

Absolute cell is a cell that does not change the address if copied to another place. The
notation is to add $ before the name of a column or row number, for example: $A$4. Adding
$ in the name of any column or row number will only change one address. Column A in $A4
will remain when copied, but the row number will adjust to its new location. And vice versa
with cell A$4. Such cells are called semi-absolute cell.

A B C D E F

1 20 30 =A1+B1

\
2 =C2+D2
3 =$A$1+B1
4 =$A$1+D2
5 =$A1+B1
6 =$A2+D2
7 =A$1+B7

=

8 =C$1+D8
9
10

Figure 1.2: Copied formula and the results in spreadsheet

Formula stating cell relationships or range of cells, for example, =B4+C30 or =SUM (A4:
C20) are more difficult to read than the mathematical relationship with the more practical
variable name, for example, =x+n or SUM(B). Name of cell or cell range is created by
clicking Formula > Define Name. This name applies to all sheets in a workbook. If it only
represents the specific sheet, for example, Sheet1, the writing is Sheetl!x, i.e. to the variable
x in Sheetl. The use of variables is highly recommended because it will simplify a formula.
The names used and the locations can be seen in Name Manager and you can also create,
edit and delete a name.

An Introduction to Excel for Civil Engineers 6
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Excel has many built-in functions to build complex formulas, some of them are shown in
Table 1.3. Functions such as mathematic and trigonometry or statistic, for example, are the
most common functions used in engineering practices e.g. to produce calculation data sheet
in laboratory soil testing. Before using a function, it is advised to know well the function
and its arguments. The reference could be found the Help menu or press F1.

Table 1.3 Excel Built-in Functions

A. Math and Trigonometry

ABS(num)
ACOS(num)
ACOSH(num)

ATAN(num)
EXP(num)

FACT(num)
INT(num)

LOG(num, base)

LOG10(num)
MDETERM (array)
MINVERS(array)
MMULT (array1l,array2)
PI0)

RAND()

SIGN(num)

SIN(num)

Returns the absolute value of a number
Returns the arccosine of a number

Returns the inverse hyperbolic cosine of a
number

Returns the arctangent of a number

Returns e raised to the power of a given
number

Returns the factorial of a number

Rounds a number down to the nearest
integer

Returns the logarithm of a number to a
specified base

Returns the base-10 logarithm of a number
Returns the matrix determinant of an array
Returns the matrix inverse of an array
multiplying of 2 arrays

Value of pi =3.141592654

Random value between antara 0 dan 1

Sign of number. Sign 1 or 0 or -1 if the
number is positive, zero or negative,
respectively.

Returns the sine of the given angle
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SINH(num)

SQRT(num)

SUM (num1,numz2,...)
SUMPRODUCT (arrayl,array2)

TAN(num)
TANH(num)

Returns the hyperbolic sine of a number
Returns square root of a number
Add the numbers

Multiplies corresponding components in the
given arrays

Returns the tangent of a number
Returns the hyperbolic tangent of a number

B. IS Function

ISBLANK(value)
ISLOGICAL(value)

ISNUMBER((value)
ISTEXT(value)

TRUE if value is empty

TRUE if value is logical value (TRUE or
FALSE)

TRUE if value is a number
TRUE if value is a text

C. Statistic

AVERAGE(num1,numz2,...)
COUNT(valuel,value2,...)

COUNTA(valuel,value2,...)
LINEST(y’s,x’s,const,stats)
MAX(num1,numz2,...)

MIN(num1,numz2,...)
SLOPE(y’s,x’s)

INTERCEPT(y’s,x’s)

TREND(y’s,x’s, new x’s,const)

Average value of the numbers

Counts the number of cells that contain
numbers within the list of arguments

Counts the number of cells that are not
empty within the list of arguments

Returns the parameters of a linear trend.
Const and stats are logical values (see in
Excel Help)

Maximum value in a list of arguments
Minimum value in a list of arguments
Returns the slope of linear regression line

Returns the linear

regression line

intercept of the

Returns values along a linear trend. Const is
a logical value specifying whether to set the
constantb = 0 in y = mx + b relationship

D. Lookup and Reference

COLUMNS(reference)

INDEX(array,row_num,column_num)
ROWS(reference)

Returns the column number of the given
reference

To choose a value from a reference or array

Returns the row number of the given
reference
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TRANSPOSE((array)
HLOOKUP(value,table,row_in)

VLOOKUP(value,table,col_in)

Returns the transpose of an array

Search for a value based on the row index in
the table data arranged horizontally

Search for a value based on the column
index in the table data arranged vertically

E. Logical

AND(logical1,logical2,..)

IF(log_value,value_if_true,value_if false)

Returns TRUE if all of its arguments are
TRUE

Specifies a logical test to perform

NOT(logical) Reverses the logic of its argument:
NOT(TRUE) = FALSE

OR(logical1,logical2) TRUE if one of its argument is TRUE

F. Text

CHAR(num) Returns the character specified by the code
number

EXACT (text1,text2) Checks between two text strings and

FIND(text1,text2,start_num)
LEFT (text, num_character)
LEN((text)

RIGHT (text, num_character)

TRIM (text)

UPPER(text)

returns TRUE if they are exactly the same,
otherwise returns FALSE

Finds one text value within another with
start number

Returns the first character based on the
specified number of characters

Returns the number of characters in a text
string

Returns the last character or characters in a
text string, based on the specified number of
characters

Removes spaces from text except for single
spaces between words

Converts text to uppercase

1.5 ARRAY FORMULA

By Excel definition, array formula is a formula that can perform multiple calculations and
then return either a single result or multiple results. Array formulas act on two or more
sets of values known as array arguments. Each array argument must have the same
number of rows and columns. For an example, the built-in LINEST returns two results

An Introduction to Excel for Civil Engineers 9




which are Slope and Y-Intercept. This function gives linear regression lines that fit with the
known x and y-values, as shown in Figure 1.3.

A B
1 X y
2 -1.0 -5.0
3 -0.5 0.0
4 1.0 5.0
5 2.0 4.0
6 3.0 0.5
7 4.0 -5.0
8 5.0 -12.0
9 | Slope |. Y- 9 Slope Y-intercept
intercept
10 | -1.204 | 0537 10 | ={LINEST(B2:B8,A2:A8)} | {=LINEST(B2:B8A2:A8)}

Figure 1.3: Array formula for linear regression and the results

Array formula is entered by pressing Ctrl+Shift+Enter and Excel will automatically insert
the formula in brackets ({}). To display values returned by LINEST function, make LINEST
formula in cell A10 as shown in Figure 1.3, and then select the range A10: B10 > press F2 >
Ctrl+Shift+ Enter.

Here are some other examples of array formula:
{=SUM(A2: B2*A3:B3)} is a single result
{=TREND(A2:A6,B2:B6)} is a separately 5 results

Alternatively, the INDEX function can be used to return the values, as shown below. LINEST
has two results indexed sequentially that are Slope and Y-intercept.

Y-
9 Slope | intercept 9 Slope Y-intercept
10 | -1.204 0.537 10 | =INDEX(LINEST(B2:B8,A2:A8),1) | =INDEX(LINEST(B2:B8,A2:A8),2)

An Introduction to Excel for Civil Engineers 10




1.6 DATA FORMATTING

Data and cells formatting can be done through the Home tab > Format > Cells. In the
Format Cells dialog box, there are several sheet tabs which are Number, Alignment, Font,
Border, Fill and Protection. Number formatting in Number tab is divided into several
categories such as general, number, date and so on. For example, for custom category or
user preference is shown in Table 1.4. Alignment is the setting for layout of text in a cell
such as vertical and horizontal alignment, control and orientation of text in a cell. Fonts are
the settings that relate to the character, such as the font face used (Arial, Times New
Roman, Tahoma, ...), style (italic, bold ...), size, color and so on. Border is to make the
margins, line types (straight, dotted, thin, thick), and color. Fill to create a displayed cell
with shading (horizontal, diagonal, dot, ..), shading color and the color of the cell
background. Protection is used to select the condition (locked or not) of data and formulas
(hidden or not) in a cell when worksheet protection is enabled. To protect a worksheet
click Review tab > in Changes group click Protect Sheet.

Table 1.4: Custom format for numbers

Format Displayed
0.00 2343.00
0.00E+00 2.34E+03
##0.0+0 2.3E+3
#,##0.00 2,343.00
#,##0.00% 234,300.00%
0.0 "m” 2343.0 m

Column width and row height can be adjusted by: first way, by dragging the mouse (hold
the left mouse button while moving) when the pointer position at the boundaries of the
column and row headings (there is a sign "=" or ""), or second way is by right-clicking the
mouse on the column or row heading and from the shortcut menu click Row Height or
Colomn Width, then enter desired value in the textbox. The other way is through Home >
Format.

1.7 ERROR MESSAGE

Error message will be appeared if a formula is not working as it should be, for examples,
arguments in a formula are not complete, the data type does not match, or wrong in
developing the logic. Another case, for example is division by 0 (zero) or the width of the
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column is not wide enough to display a result. The message started with the # sign
followed by the type of error. Table 1.5 shows some error messages that may appear.

Table 1.5 Error Messages

Messages Remarks

Cell contains number, date or time that is wider than the cell

i width or minus result in the date and time format
(Not Available) when a value is not available to a function or
#N/A
formula.
#DIV/0! Error due to division by zero (0).
#NAME? Excel does not recognize text in a formula
#REF! When a reference cell is not valid

The types of arguments used in the function are wrong. The
#VALUE! argument can be a numerical value, text, name, label, reference
cell, cell range and function.

1.8 PRINTING

Before printing the worksheet to paper, you can set the area by blocking the area that will
be printed (press Shift + ">" or "l" or drag the mouse). Afterward, click the Page Layout

"
tab > Print Area > Set Print Area. The print area can be seen in ** Office Button > Print

> Print Preview or to press the shortcut key Ctrl+F2. Printing then performed through &
> Print > OK or pressing Ctrl+P.

The limits of printing page can also be specified through the View tab > Page Break
Preview instead current Normal view. This will show all the data in worksheet to be
printed with a page number. You can also adjust the boundaries of the printing page by
dragging the mouse on the blue boundary line.

Page configuration is then set through the Page Layout tab. Click the Print Titles in the
Page Setup group, and a Page Setup dialog box will appear with several sheets tabs which
are Page, Margins, Header/ Footer, and Sheet. Page is to select the orientation and size of
paper, and the scale of worksheet on paper; Margins is to set the boundaries of the text in
the paper; Header/Footer is to make custom header and footer; and Sheet is to set print
area, showing grids, row and column headings, and the print order.
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1.9 MAKING CHARTS

A set of data can be well delivered and communicated through a chart image shown the
correlation between the data. In Excel there are many types of chart depictions such as Bar,
Column, Line, Pie, Area and so on, plus a 3-dimensional view. Chart is created through the
Insert tab > Chart, and there will be Charts group as shown in Figure 1.4. For this example,
we will use the data from Figure 1.3. Select Scatter > Scatter with Smooth Lines and
Markers because smooth line between points to be made. Click Select Data on the Ribbon
interface to display the Select Data Source dialog box as shown below.

Select Data Source E] E] |

Chart data range: | =Sheetl!$a44:46410 E
- I ESﬂitch Row/Column I
Legend Entries {Series) Harizontal (Category) Axis Labels
’ 3 Add ” o Edit ” X Remove ] || @ %
Seriesl -1 <
-0.5
1
2
3 W
Hidden and Empty Cells Ok ] [ Cancel

Enter x and y-values data in the Chart Data Range by clicking a button at the right side of
the input box and then point the pointer to cell A2 and drag the mouse from cell A2 to cell
B8. Click OK and a chart will be created as shown in Figure 1.5. In the chart, the regression
line is also shown with the associated equation. Regression line is created by clicking
mouse on the data in the chart (at point or a line), then right click > Add Tendline > Linear
> checked the Display Equation on Chart. Furthermore, if you want to work with the chart
thoroughly, click the graph area to display Chart Tools tab where commands are grouped
in accordance with their task name, which are Type, Data, Chart Layouts, Chart Styles
and Move Chart.
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Figure 1.4: Charts group displays chart type options
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Figure 1.5: Example of Scatter with smooth lines chart type

Note:

As designed for office applications, Excel offers various types of charts. However, we will
not discuss many different types of charts, and but only focused on Scatter chart type
with straight lines that frequently used in this book.
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1.10 ENGINEERING DRAWING

Chart type of XY Scatter is suitable for use in Civil engineering practices in giving a
drawing presentation that forms lines or elements of structure. The reason is that every

line can stand alone, so that easily modified and formulated for the intended drawing.

A straight line of XY Scatter chart type is determined by the given coordinates of both ends
required for its input data. If both ends of the line called joint, then a line segment is formed
by the coordinates of two joints. Thus, there will be a series of joint data put into a
worksheet table to create straight lines.

To make it easier to understand the intent and purpose of this discussion, below is given

examples and the followed steps.

Example 1

DDRCreate 3 continuous lines drawing through 4 points (1 to 4), as shown in figure below.

7.0

3.0 1

2.0

1.0 1

1

0.o
0.

The joint coordinates are:

I AP R S—
18 SRR SRR Y 5 S

4.0 4-----ee- oo d-efeeee onnneee]

a 1.0 20 3.0 4.0

Joint 1 0 0
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Joint 2

Joint 3

Joint 4

To create continuous lines as the figure above, it takes the following steps:

1. First step: click on the Insert tab > Scatter > Scatter with Straight Lines and

Markers.
S T ~ _ - _ - . =
(O (= B B R W Lines.xls [Compatibility Made] - Microsoft Excel
el
—/‘I Home Insert Page Layout Faormulas Data Review View
= =T T - = = = = T .
U] EH || [l @ik L‘__‘J'J b ﬁi W & = “ l' YO g..g [AZ] = 4 ) 2
PivotTable Table Picture Clip Shapes Smartart | Column Line Pie Bar Area |Scatter| Other Hyperlink Text Header WordArt Signature Object Symbol
> Art 5 i e o i i & Charts ~ Box & Footer x Line~
Tables Nustrations Charts Scatter Text
| N1 - 5| o ol [|a,—¢
E ., ™y
| A B c 1D E E G H |-‘.. d "ol L ] il o]
46 |
47
I 4
48| W)
43| =
a0 Scatter with Straight Lines and Markers
51 { j'"\.‘ Compare pairs of values.
52 —
53 Use it when there are a few data
71 1 iih All Chart Ty points in x-axis order and the data
| - - represents separate values,
85 |
56 |
57

2. Chart Area displays nothing because no data on it as shown below. Click Select
Data on the Ribbon interface to display the Select Data Source dialog box.

(O=)
i

L

Chart T

al W, F

Chang

FEEE

Home Insert

& SaveAs s
ype Template | Ro
Type

Data

Page Layout

=]
]
1 Select
mn Data

Formulas

Linesxls [Compatibility Mode] - Microsoft Excel

Data

Chart Taals

Review  View  Design = layout  Format

Chart Layouts

Chart 19 -

3

A B c

D E
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3. A Select Data Source dialog box is displayed as shown in the figure below (left
side). Click Add to display the Edit Series dialog box (right side). Each series that
added (clicking Add) represents a line that requires a pair of x and y values as
inputs. Thus, a line series shall consist of the coordinates of the both ends, the one to
be (x1, y1) and the other is (x2, y2).

Select Data Source @@
Chartdatar 2 £ = =
hart gata range: || Edit Series @@
Click Series pame:
Add I
series Senes ¥ values:
L lpeg!rT&Tn"i‘Es.LS_enes:

Horizontal {Categary) Axis Labals
P A y b . »
\[ =40 1 £ | et ) o E> Seres f values:

[ gt}

l | Cancel

tdden and Empty Cells o« | [ concel

4. Following Step 3 is to enter the line coordinate values i.e. series x and series y-
values. When needed, give a name for the series in the Series name input box.
5. Click OK to end.

The intended joint coordinate and lines for chart depiction can be summarized as below:

Coordinate
Line Joint x1 yl x2 y2
1 1 2 0.0 0.0 1.0 1.0
2 2 3 1.0 1.0 2.0 3.0
3 3 4 2.0 3.0 3.0 6.0

Thus it can be stated that the first line (no.1) is a line created by given joint 1 and 2
coordinates (refers to the figure).

In step 4, what we do is to enter x1 and x2 range of values (colored yellow) into the Series
X values input box, while the Series Y values is filled by column y1 and y2 range of values
(colored green). To enter x-coordinates, press Ctrl+left mouse button click at x1 column
and repeat left mouse button click at x2 column to get the range of cells. Do the same way
to enter y-coordinates.

Repeat step 3 to 5 to make 2nd and 3rd line. The result will be shown as below:
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Joint 4

5.0 .
/
4.0

Jaint 3

3.0

2.0

Joint 2
1

Joint 1
0.0 X

0.0 1.0 2.0 3.0 4.0

Example 2
Draw a simple picture of one floor building as below:
12 1

10 1

As in Example 1, to simplyfy the portrayal of the drawing it needs to produce joints and
lines coordinate tables. The buiding is composed of 6 joints and 6 straight lines that can be
built up with the following numbering system:
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12 7

. 3
10 4 Joint 3¢ $ Joint 4
8 -
2 4
7 3
Joint 24 4 laoint 5
4 -
5
5 1
i Joint &
o 4Joint 1y : : : ' .
0 1 2 3 4 5 6
Based on the picture above, the following tables can be formed:
! ﬁ_____ﬁ“\“
3 Coordinats Coardinate
5 1 1.0 0.0 1 1 2 1 0 1 5
7 3 1.0 10.0 3 3 4 1 10 5 10
8 3 50 10.0 4 4 5 5 10 5 5
a s 50 50 & g g 5 & 5 0
10 © 5.0 0.0 o 2 5 1 5 5 5

The joint coordinates for assigning lines on the right table is obviously the repetition of
inputting task of the previous joint coordinates on the left table. To avoid repeated data
entry manually, VLOOKUP function can be used by adopting the x, y joint coordinates data
of the left table as a reference table to obtain x1, y1 and x2, y2 coordinates of the right
table. The formulas in the worksheet are shown as follows:

Gogbnms e
il nd e

L OTIFUPT § GASY Sk H 7] =L CHLIPE G B be BLE10 3 =L ORI G8 G SCa10 Tt

3

e ol Xavalue
T Joit Y aalue
x

i Jolnf relefence (no.)

H
:
:
-
i
}

=L LM ML
£

ALS BL

-1

A= EE

L 20 C25 50 ) (5 1

= EE

To get the drawing, do the sequence steps as in Example 1.
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Example 3

Draw the following truss structure that consists of 21 lines and 12 joints. The joint
coordinates are tabulated as below:

250
200 A Joint G
15.0 1
10.0 1
5.0 Joint 3 Joint 9
Joint 2 - Joint 10
Joint 12
0.0 loint / : . \.Joint il
0.0 2.0 4.0 6.0 8.0
Joint X y
1 1.0 0.0
2 1.5 2.5
3 2.0 5.0
4 2.5 10.0
5 3.0 15.0
6 3.5 20.0
7 4.0 15.0
8 4.5 10.0
9 5.0 5.0
10 5.5 2.5
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11 6.0 0.0
12 3.5 2.5

Before creating the drawing of truss, it is convenient to form lines coordinates as required
for Series X and Series Y input data. The coordinates of truss lines are tabulated as the
following:

Line Joint x1 yl x2 y2
1 1 2 1.0 | 0.0 | 1.5 | 25
2 2 3 1.5 | 25 | 2.0 | 50
3 3 4 20 | 5.0 | 25 |10.0
4 4 5 25 [ 100 | 3.0 | 15.0
5 5 6 3.0 | 150 | 3.5 | 20.0
6 6 7 3.5 [ 200 | 4.0 | 15.0
7 7 8 4.0 | 150 | 45 | 10.0
8 8 9 45 {100 | 50 | 5.0
9 9 10 | 5.0 | 5.0 | 55 | 25
10 10 11 | 55 | 25 | 6.0 | 0.0
11 2 12 | 1.5 | 25 | 35 | 25
12 12 10 | 35 | 25 | 55 | 25
13 3 12 | 20 | 50 | 35 | 25
14 12 9 35 | 25 | 50 | 50
15 3 8 20 | 50 | 45 |10.0
16 3 9 20 | 50 | 5.0 | 5.0
17 4 9 25 [ 100 | 5.0 | 5.0
18 4 8 2.5 100 | 45 | 10.0
19 4 7 2.5 | 10.0 | 4.0 | 15.0
20 5 8 3.0 | 150 | 45 | 10.0
21 5 7 3.0 | 15.0 | 4.0 | 15.0
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As the previous examples, the line coordinates data entry used VLOOKUP function. The
formulas writing is also to follow the same manner as the previous example. To obtain the
truss drawing, do the sequence steps as in Example 1.

Next example is to draw truss structure subjected to horizontal load so that each joint will
be shifted as far as n unit. Suppose that the displacement at the joints will be from 0 at
supports to maximum +0.5 unit at joint 6 (at the top), so it will be in a range of 0 < n < 0.5 to
the right direction. The table of joints coordinates is then modified and labeled for two
conditions, before and after loading, where n is used in the calculation. It will show as
follow:

A B C D E
4
5 Coord Before Coord After
6 |Joint X y X y
7 1 1.0 0.0 1.0 0.0
8 2 15 2.5(=B8+0.1 2.5
9 3 2.0 5.0|=B9+0.2 50
10 4 25| 10.0/=B10+0.3 10.0
11 5 3.0 15.0/=B11+0.4 15.0
12 5] 3.5 20.0/=B12+0.5 20.0
13 7 4.0 15.0/=B13+0.4 15.0
14 8 45 10.0=B14+0.3 10.0
15 "] 5.0 5.0(=B15+0.2 5.0
16| 10 55 2.5|=B16+0.1 25
w11 8.0 0.0 8.0 0.0
18 | 12 3.5 2.5(=B18+0.2 2.5
19

It is noticed that only the x-values will be changed by adding the horizontal displacement
value of n, from 0 at Joint 1 to a maximum of 0.5 units at the Joint 6. Joint 1 and 11 are fixed
supports so their positions remain in place before and after loading.

After forming the joints coordinates table, next is to create lines coordinates table of Series
X and Y. There are now 42 Series X and Y to be created for the condition of before and
after loading. Table below shows lines coordinates before and after loading:
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4
5 Coord Before Coord After

6 Line Joint i1 y1 X2 y2 %1 y1 X2 y2

T 1 1 2 1.0 0.0 15 25 1.0 0.0 16 25
8 i i 3 15 25 2.0 50 16 2.5 2.2 50
g9 3 3 4 2.0 50 251 100 2.2 50 28| 100
10 4 4 5 250 100 301 150 281 100 34| 150
11 5 5 6 301 150 351 200 34 150 401 200
12 § § 7 35| 200 401 150 401 200 44 150
13 7 7 8 401 150 451 100 441 150 48| 100
14 8 8 9 45 100 50 50 481 100 52 50
15 9 9 10 50 50 55 25 b2 50 56 25
16 10 10 11 55 25 6.0 0.0 56 25 6.0 0.0
17 11 2 12 15 25 35 25 16 25 37 25
18 12 12 10 35 25 55 25 3.7 2.5 56 25
19 13 3 12 20 50 35 25 2.2 50 3.7 2.5
20 14 12 9 35 25 50 50 37 25 52 50
21 15 3 8 20 50 451 100 2.2 50 481 100
22 16 3 9 20 5.0 5.0 50 2.2 5.0 52 50
23 17 4 9 250 100 50 50 281 100 52 50
24 18 4 8 25 100 451 100 281 100 48| 100
25 19 4 7 25 100 401 150 281 100 44| 150
26 20 5 8 301 150 451 100 34 150 48| 100
27 21 5 7 301 150 401 150 34! 150 441 150
28

The reference range of data table in VLOOKUP function is now range A7 to E18. Thus, the
coordinates of the lines before and after loading are respectively referred to column BC and
DE or column index of 2.3, and 4.5.

The drawing of truss lines before and after the horizontal loading are shown in chart
below, which are in blue and red, respectively.
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1.11 VISUAL BASIC FOR APPLICATION

One of the strong points of Excel is its macro capability of using macro programming
language to shorten and simplify the repetitive works (automation task). It can not be
separated, however, from the presence of Microsoft Visual Basic application which is by
default embedded in as an Excel command menu. The Visual Basic application for the
repetitive works or macros in an application program (e.g. Excel or Word) is called Visual
Basic for Applications (VBA). In addition to Microsoft Office, many of non-Microsoft
software also use VBA, such as AutoCAD, CorelDraw, Visio and Norton.

VBA can also serve as a programming language to solve many problems in science and
technology field, for instance to solve a complex iterations and the analysis of civil
structures that are not easily or can not be done rely on the built-in functions and
spreadsheet standard commands. In this respect, the analogy of using macro is therefore a
repetitive calculation in an effort to get new output when new input is entered.
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Microsoft Visual Basic as well as Excel VBA is an Object Oriented Programming, which
reads and analyzes objects exposed by Excel through object library. The reference to these
objects is stored in Microsoft Excel Object Library (EXCEL12.0LB). In a programming
structure for a calculation application, Excel exposes the property of an object which is the
value of input data that to be processed by VBA and then returns the result to a worksheet.
So, in writing inputs what we have actually done is storing object value into a variable, or
the value of the variable = value of cell property of the worksheet (= Range object, that will
be mentioned next).

1.11.1 CREATING MACRO

To create macros, activate the Developers tab through “* > Excel Options > Popular >
Show Developer tab in the Ribbon, so it looks like this:

(1
[ .!J e |
o
3 Homé Ingert Page Layowd Farmuilas Data Rewig-w e Developer #=—Develps Tab
2, = ] Record Macro | L7 [N Properties = _'Ell—mzll oy
| B S B == 0 Caininain
r EL":-! Relative Referendes g View Code & Expansion Paciy - i ks
Visual Macros Insert Design Sourge Document | Deyeloper Tab
Basic 4 Maers Seeurity - Mode  Pun Dialag Pang o ’
Code ML Muaadify
o1 il j =

To go to the window where the VBA programming language is created, click Visual Basic
to open Visual Basic Editor (VBE) window > click the Insert menu > Module to show the
following window:

_
-‘E'! Fie Edi iwew nseri Formesi Delbun Hun  foois  Adddre @ndow  Heip

Iﬂlg'.d M =N [ .dl.{ o - B Ll Coid
Al + u = 53 10 S il i h e 2ie & =7 . S I =

frajoct - waropat [ p—— x| [iDwchesions)

—

i i i

- 5 YORProiect (Book3) €— Write here

3 MEresalt Eansl Obents

) Shesst] (Seet])

] Shesst2 (Tt}
Sheesst D | Fhast T}

B Therworkdeck

1 Miodules

w4 Mode

VBA programming language is written in a module that has been added before by Insert >
Module. Below is an example of VBA programming language (program code) in a
procedure in a module:
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VBA reads, analyzes and manipulates Excel's objects through their properties and methods.
A VBA code for an object is orderly composed of the object name, a period, followed by the
property or method. The property is an attribute of an object and is always accompanied by
an equal sign (=), while the method is the action carried out with the object.

In the code created above, Select and ClearContents are called method, whereas Selection
in the second row is an object refers to Range object in the first row. Value on the third row
is a property of the Range object with the value of 10. The code above is intended to
remove the existing value in the range A1 on Sheet1 and replace it with a new value of 10.
The Worksheets ("Sheet1") code refers to active sheet name, in this case is Sheet1.

To see the available objects in Excel, you can access through the Object Browser by
clicking the icon | on VBE toolbar or press F2. Select the Excel libraries in the pull down
menu as shown below:

B

% File Edit Miew Insert Format Debug Run  Jools Add-ns  Window Help Type a question for help = o & X
pou oo R @

Ale b i IHT E - B 5 -]

(1B

ject (Book1)
soft Excel Objects
heetl (Sheet1) Class Memher
heetz (Sheetz)
hest3 (Sheet3)
4] ThistWorkboak
=] 5 Modules
& Modulsl
Classes Members of =globals='
® [glohelsz e[S ActiveCel ~
21 Abovefwerage |8 ActiveChart =
21 Action 5 ActivePrinter
2 Actions ES' ActiveSheet
21 Addin ES' Activewindow
2 Addins B ActiveWorkbook
2 Adjustments B Addins
2 AlowEditRange E& Application
& AllowEditRanges EE Assistant
2 Application =& Calculate
2 Areas & Cells
2 AutoCorrect B Charts
22 AutoFilter EE Columns
21 AutoRecover ES' CommandBars
2] Axes ES' Creator
2 s e8! DDEAppRetunCode
2 AvisTitle =& DDEExecute
) Border & DDEnitiate
) Barders & DDEPoke
) CalculatedFields =% DDEReqguest
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LibraryExcel ~
C:¥Program Files'Microsoft OfficeiOffice 2EXCEL EXE
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An Introduction to Excel for Civil Engineers 26




Objects are classified into Classes (on Class window) and their Members (on Members
window) that could be a property, a function or a constant. Names, Cells, FormulaArray
for instance, are members of the Range class. Excel’s objects are arranged in a hierarchy;
objects contain other objects from top level to down level. Code below shows an example of
an object hierarchy from the Application object to the Range object:

Application.Workbooks(*'Bookl.xIs'™) _Worksheets(*'Sheetl') .Range(*'Al'")

In the code, Range is the property of the Worksheet object that returns a Range object. It
uses Range(arg) syntax where arg is name of the range (A1) to return a Range object
represents cell A1l. Moreover, Worksheet is the property of the Workbook object that
returns a Worksheet object, Workbook is the property of the Application object that
returns a Workbook object, and the top level of this hierarchy is the Application object that
is Excel.

1.11.2 RECORDING MACRO

The best way to figure out how VBA communicates with Excel’s objects is to record a
macro. This tool gives a quick introduction of all Excel's object as well as how to write code
in VBA. For instance, we would like to record a macro to delete data on a range of cells, say,
in a range of A1 to E10. We need to create an automation steps to clean the existing data as
the program produces a new one. The steps for recording macro are as follows:

1. Click the Developer tab > Record Macro to display the Record Macro dialog box
with the default name of Macrol for macro name as shown below:

Record Macro @

Macro name:
Shartcut key:
Ctrl+ |
Skare macro in;
.This w;rkbmk v

Descripkion:

Ok, ] ’ Cancel

2. Change macro name to ClearOutput
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3. Move the pointer to cell A1 and drag the mouse to the cell E10 to assign the range
data that will be removed.

4. Press Delete to delete the contents of range Al to E10 and then place the pointer in
cell Al.

5. End the process by clicking Stop Recording.

il
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- Home [nsert Page Layout Formulas Data Review
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Code Controls
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The recorded macro is stored in the workbook, and to see the code you have to open the
Visual Basic Editor window through Developer tab > Visual Basic. The code is created as
the following:.

Sub ClearOutput

"Macro ClearOutput

Range(*'A1:E10") .Select

Selection.ClearContents
End Sub

In the recorded macro above there are VBA statements such as Range (), Select, Selection
and ClearContents. You may a bit familiar with these statements that have been briefly
explained in the previous section.

The recording macro tool is very useful for writing complex code or you may indeed never
imagined before, like how to manipulate a chart object such as to copy, to create a title, to
change the colors, making marker, automation for creating lines, and so on. This can all be
done without the need to understand more about the Excel’s object hierarchy that such
“long” and may be a bit confused.
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1.11.3 PROCEDURE

VBA Macro is a programming language written in a procedure, for instance, ClearOuput
macro that is written in a Sub procedure. Procedure in VBA is divided into three types as
follows:

e Sub procedure, procedure that begins with Sub, its name and ended with End Sub

e Function procedure, begins with Function, its name and ended with End Function

e Event procedure, works when there is a certain event, for example, open a
workbook, click the button, activate the worksheet, and so on.

The syntaxes of above types of procedure are as follows:
1. Sub Procedure
Syntax:
[Private | Public | Friend] [Static] Sub name [(arguments)]
[statements]
[Exit Sub]
[statements]

End Sub

Remarks

Public Optional. Indicates that the Sub procedure is accessible to all other
procedures in all modules. If not defined, the procedure by default is Public

Private  Optional. Indicates that the Sub procedure is accessible only to other
procedures in the module where it is declared

Friend Optional. Used only in a class or object module. Can be accessed from other
procedure in all modules in a workbook

Static Optional. Indicates that the Sub procedure's local variables are preserved
between calls.

name Required. Name of the Sub; follows standard variable naming conventions.
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arglist Optional. List of variables representing arguments that are passed to
the Sub procedure when it is called. Multiple variables are separated
by commas.

statements Optional. Any group of statements to be executed within the Sub
procedure.

2. Function Procedure

Syntax:

[Private | Public | [Static] Function name [(arguments)][As type]
[statements]

End Function

3. EventProcedure

Syntax:

Sub expression.eventname (parameters)

Remarks:

expression variabel that refers to object
eventname name of event

parameters argumens used in Event procedure

The most frequently used of Event procedure is clicking a button (command button) on
the worksheet. Here is the example code:

Private Sub CommandButtonl Click()
"call other procedure
Call Pro_Subl

End Sub

The steps and examples of the above procedures will be shown in next chapters.
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1.11.4 RUNNING MACRO

Macros can be executed in the two following ways:

1. Through the Developer tab > Macros > select the macro name > Run. Function
procedure, Private Sub procedure and Sub procedure written with argument, can
not be run by this way.

2. Clicking Button (Form Control) or the Command Button (Active X control) on the
worksheet.

The second way is commonly used because it is done by only one step. However, it can be
done in two ways, which are as follows:

0 Create a button through the Developer tab > Insert > Form Controls > Button >
there is a sign "+" on worksheet, and place it on worksheet by dragging the mouse,
the same way to determine its size as well. The Assign Macro dialog box will be
displayed as below. Enter the name of a macro that to be executed and then click

OK.

Macro name:

| =

Macros in; E.ﬁ.ll Cpen Workbooks w

Descripkion

| ok || canca |

0 DMacro is executed by clicking a command button on the worksheet which is
associated with an event procedure. To create command button click the Developer
tab> Insert > Active X Controls > Command Button > there is sign "+" at the
pointer, and place it on the worksheet by dragging the mouse, the same way to
determine its size as well. The results is as shown below:
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5

Double-click the command button to write code in the following procedure:

Private Sub CommandButtonl Click()

End Sub

When a command button is created, the code program is inactive or when the Design Mode
is enabled. Before run macro, click the Design Mode to disable (until it looks unselected).

1.11.5 VBA DICTIONARY

Statements or words that are used in Excel-VBA are too many because the capability VBA
to support Excel for diverse goals. Some statements are similar to those used by Excel, for
examples, operator and mathematical relationships, some strings functions and math
functions. In this book, all statements related to this book will not be placed in a special
section, but it will be discussed respectively, on each topic in its section.
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CHAPTER 2

EXCEL FUNCTIONS

Almost identical to a function definition in mathematics, a function in Excel works based on
the given arguments and written as follows:

Result Name Argument/s

v ¥ ¥
y = f (ab,c,...)

Arguments are written after the function name, between parentheses, which are the values
used to perform the operation. The argument can be a numerical value, text, references or
range of cell, name, label or a function.

Excel functions are listed by category such as, math and trigonometry, statistics, finance,
logic, and so on. In addition, Excel also provides macrosheet and Visual Basic for
Applications (VBA) to create a function that is defined by the user (user-defined function).

2.1 MATH AND TRIGONOMETRY FUNCTIONS
ABS

Returns the absolute value of a number.

Syntax:

ABS(number)

Example:

ABS(4) = 4

ABS(-4) = 4

SQRT(ABS(-81)) = 9

An Introduction to Excel for Civil Engineers 33




INT

Rounds a number down to the nearest integer
Syntax:

INT(number)

Example:

INT(8.9) =8

INT(-8.9) = -9

TRUNC

Makes a number to an integer by removing the fractional part of the number. To specify the

precision of the truncation, enter a specified number of digits after the number.

Syntax:

TRUNC (number,number_digits)
Example:

TRUNC(8.9) =8

TRUNC(-8.9) = -8

TRUNC(PI()) =3

TRUNC(PI (), 3) = 3,141

ROUND

Rounds a number to a specified number of digits.

Syntax:
ROUND(number,num_digits)
Example:

ROUND(3.25,1) = 3.3
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ROUND(3.247,1) = 3.2
ROUND(3.247,0) = 3
ROUND(32.47,-1) = 30

ROUNDOWN

Rounds a number down to a specified number of digits.

Syntax:

ROUNDDOWN (number,number_digits)
Example:

ROUNDDOWN(3.3,0) =3
ROUNDDOWN(66.8,0) = 66
ROUNDDOWN(3.14159,3) = 3,141
ROUNDDOWN(-5.24621,2) =-5.24

ROUNDDOWN(1550.24621,-2) = 1500

ROUNDUP

Rounds a number up to the desired number of digits.
Syntax:

ROUNDUP (number, num_digits)

Example:

ROUNDUP (3.3,0) =4

ROUNDUP (66.8, 0) = 67

ROUNDUP (3.14159, 3) = 3,142

ROUNDUP (-5.24621, 2) =-5.25

ROUNDUP (1550.24621,-2) = 1600
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SUMPRODUCT

The number resulted by multiplying corresponding components of arrays
Syntax:

SUMPRODUCT(arrayl,array2,...)

Example

SUMPRODUCT(1,2,3)=1x2x3=6

SUMPRODUCT({1,2,3},{4,5,6}) =1x4+2x5+3x6=36

SUMPRODUCT({1,2,3, hello”},{4,5,6,5}) = 36

2.2 LOGICAL FUNCTIONS

IF

This function has two values of results, which are TRUE and FALSE, with logical test, if met
will do the TRUE value. If the result returns a text, then the text must be between quotes
("text").

Syntax:
[F(logical_test,value_ if true,value_if_false)
Example 1:

In a class, students which have exam scores below or equal to (<=) 55 will FAIL the exam,
and above the value will PASS the exam.

=3 B = o E F
1
2 Name Score Femark
3 V. Magda 51 FAIL 4—=IF{B3==55"FAIL","PASS"]
4 Y. Artist 93 PASS
> L. Money 90 PASS Resultof copying cel
5 M. House 70 DASS from (3 to C4:C7
7 H. Aunt 7 EAIL
]
5

Example 2: Nested IFs with two logical tests
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Students who FAIL with exam score > 45 have chance to take a supplementary exam to
increase their scores. Use the function to find out the name of student:

A B C D E F G H
1
2 MNamea Score Remark
3 V. Magda 51 RE-EXAM #=IF(B3<=45 "FAIL" IF(B3<=55,"RE-EXAM", "PASS"))
4 Y. Artist 93 PASS
5 L Money 30 PASS Result of copying cell
6 M. House 70 DASS froms woec?
7 H. Aunt 37 FAIL
8
9

AND

Returns TRUE if all of its arguments are TRUE, and returns FALSE if one its argument is
FALSE. Generally nested with IF function.

Syntax:

AND(logical_1, logical_2, ...)

Example 1:

AND(2*2=4,2+2=4) Returns TRUE
AND(2<100,4<100,102<100) Returns FALSE
Example 2:

Now, with the same class and the same students in Example 1, but with different exam
subjects: a course score can help the student that receives exam score > 40 and <= 55. The
given formula is:

(2 x Exam score + 1 x Course score) / 3.

A B C D E F G H I

1

Fimal

Mame Caxam Course

Score
2
3 V. Magda 60 56 60 «=IF|AND(B3>40,83<=55), ROUND|(2"B3+C3)/3,0),83)
4 Y. Arfist 55 72 61 —_ - -

- esult of copying ozl fram
3 L. Monesy 60 60
! = to C4:C7

6 M. House 40 60 4[
i H. Aunt 46 G4 5d
B
9
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COUNTIF

Counting the number of cells in a range of cells according to given criteria.
Syntax:

COUNTIF(range,criteria)

Example 1

Looking for the number of students with specified value for Example 2 above:
COUNTIF(D2: D6,60) =2

COUNTIF(D2: D6,> 60) = 1

OR
The result is TRUE if one of its arguments is TRUE. Generally nested the IF function.
Syntax:

OR(logicall,logical2, ...)

Example:
OR(2*2 = 4,2+2=4) Returns TRUE
OR(2<100,4<100,102<100) Returns TRUE

2.3 LOOKUP FUNCTIONS

VLOOKUP

Search for a value based on the column index in the table data arranged vertically
Syntax:

VLOOKUP(value,table,col_index,range_lookup)

Example

The experimental result of laboratory test is affected by the size and weight of the used
tools. This example shows how to use VLOOKUP function to read the size and weight of the
ring based on the Ring Calibration table. Suppose it is intended to search the diameter and
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weight of ring no. 3 and 7. The table data refers to range A4 to F11, ignoring the column
heading.

A B C D E F
RING
1 CALIBRATION
2
Ring | Height | Diameter | Weight | Area | Volume
3 | No. (cm) (cm) (gram) | (cm?) (cm3)
4 1.950 5.000 | 32.850 | 19.635 | 38.288
5 2 2.000 5.000 | 32.000 | 19.635 | 39.270
6 3 2.000 5.000 | 33.440 | 19.635 | 39.270
7 4 2.000 5.000 | 34.980 | 19.635 | 39.270
8 5 1.950 5.000 | 33.700 | 19.635 | 38.288
9 6 1.925 4.985 32.000 | 19.517 | 37.571
10 | 7 2.000 5.000 | 33.000 | 19.635 | 39.270
11| 8 1.975 5.125 | 34.000 | 20.629 | 39.711
VLOOKUP result:
A B C D E F

Ring | Diameter | Weight
14 | No. (cm) (gram)

15 3 5.000 33.440
16 7 5.000 33.000

Formula in cell B15 to C16:

A B C
Ring . .
14 | No. Diameter (cm) Weight (gram)

15 | 3 |=VLOOKUP(A15,$A$4:$F$11,3) | =VLOOKUP(A15,$A$4:$F$11,4)
16 | 7 |=VLOOKUP(A16,$A$4:$F$11,3) | =VLOOKUP(A16,$A$4:$F$11,4)
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Range_lookup is a logical value that specifies whether VLOOKUP finds an exact match or an
approximate match. If TRUE (or omitted), the values in the first column of table_array must
be in ascending sort order (-2, -1,0,1,2, ..) because VLOOKUP may return incorrect. If
FALSE, the table_array values do not need to be sorted. For TRUE condition, if the
lookup_value does not match with table_array, VLOOKUP returns the next largest value that
is less than lookup_value. Otherwise, if FALSE, VLOOKUP will find an exact match, if it is not
found, VLOOKUP returns #N/A (error).

HLOOKUP

Search for a value based on the row index in the table data arranged horizontally. The
application of HLOOKUP are almost identical to VLOOKUP, in exception that row index is
needed to lookup the value.

Syntax:
HLOOKUP(value,table,row_index,range_lookup)
Example

Transpose (Copy > Paste Special > Transpose) the Ring Calibration table to arrange table
data as shown below. After that, use HLOOKUP the same way as VLOOKUP example above
to search the diameter and weight of ring no. 3 and 7.

Ring No. 1 2 3 4 5 6 7 8

Height (cm) 1.95 2.00 2.00 2.00 1.95 1.93 2.00 1.98

Diameter (cm) 5.00 5.00 5.00 5.00 5.00 4,99 5.00 5.13

Weight (gram) 3285 | 32.00 | 33.44 | 3498 | 33.70 | 32.00 | 33.00 | 34.00

Area (cm?) 19.64 | 19.64 | 19.64 | 19.64 | 19.64 | 1952 | 19.64 | 20.63

Volume (cm3) 38.29 | 39.27 | 39.27 | 39.27 | 3829 | 37.57 | 39.27 | 39.71

2.4 TEXT FUNCTIONS

LEFT, RIGHT, MID

Returns characters in a text string based on the specified number of characters
=LEFT (text,num_chars)

Returns the first character
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=RIGHT (text,num_chars)
Returns the last character
=MID(text,start_num,num_chars)

Returns characters starting at specified position

Example
A B
1 | ENGINEERING ENG =LEFT(A1,3)
2 745.56 RING =RIGHT(A1,4)
3 ENGINEER | =MID(A1,1,8)
4 745.5 =LEFT(A2,5)
CONCATENATE

Combines two or more strings from different cells into one string

Example
A B C D
1
Civil
2 Civil | Engineer Engineer
3
4 Point Coordinate
5 X y Z
6 2.0 4.0 0.0 2,4,0
7 2.0 4.0 -1.5 2,4,-1.5
8 2.0 4.0 -1.5 (2,4,-1.5)
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D
1
Civil | _CONCATENATE(A2," " B2)
2 Engineer
3
4 | Coordinate
5
=CONCATENATE(AS6,",",B6,",",C6)
6 2,4,0
=CONCATENATE(A7,",",B7,",",C7)
7 2,4,-1.5
=CONCATENATE("(",A8,",",B8,",",C8,")")
8 (2,4,-1.5)

Another way is to use the way of writing as the following:

numeric & "text" & numeric

Example

A B C D
1

Civil

2 Civil | Engineer Engineer
3
4 Point Coordinate
5 X y vA
6 2.0 4.0 0.0 2,4,0
7 2.0 4.0 -1.5 2,4,-1.5
8 2.0 4.0 -1.5 (2,4,-1.5)

D
1
2 En(;ii‘rlli(leer =AZ&TT&B2
3
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4 Coordinate

=A6&","&B6&","&(C6

6 2,4,0
=A7&" "&B7&","&C7
7 | 24-15
="("&AS&"’"&B8&"'"&C8&") n
8 | (24-15)

2.5 DATA ANALYSIS FUNCTIONS

Excel has many built-in functions that are used to analyze data obtained from experimental
result. The objective of the analysis is to obtain theoretical parameters that give the best
relationship between theory and experimental result. Three methods will be discussed
here which are: linear regression, polynomial regression and interpolation.

2.5.1 LINEAR REGRESSION

Linear regression is to determine a straight line that fits or the most closely fits to a
number of points data, providing a linear relationship between two variables. The method
used to obtain the line is called the least squares method. Thus, linear regression consists of
a series of points that fit to a number (n) of points data (x;, yi) written into a straight line
equation:

y=Ax+B (2.1)
where:

A = slope of the line,

B = the intersection of the straight line to the Y-axis

The accuracy of the straight line over a number of points data is evaluated by a total
deviation E, which is the sum of squares of the distance e between the points data and the
fitted points:

E=>e' = (Ax +B-y,)’ (2.2)
i=1 i=1
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AXI+B
¥i

By making E to minimum, A and B values therefore can be determined to obtain the
equation 2.1. Beside E, R2 value is also used for the accuracy measurement by a relationship
below:

) >l - 00
S i[5

R? =1

(2.3)

R2 value varies from 0 to 1. R2 = 1 is when the regression line coincides with the data. In
polynomial regression, the higher-order of polynomial, the closer R2 value to = 1.

Regression in Excel can be obtained using the TREND function, SLOPE, INTERCEPT and
LINEST or with Trendline, a regression line from data relations in an XY coordinate
system. Trendline is created by the following steps: right-clicking the mouse when the
pointer is on one of the points data in the graph to display a box menu > click Add
Trendline to display the Format Trendline dialog box > select Linear for linear
regression.

Example 1: Linear Regression

The soil shear strength determination from a laboratory test obtains the result as shown in
Figure 2.1. In general, the depiction of data generated from the test is rarely a straight line
to show failure envelope, therefore, it needs a fitted straight line to represent the data.
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Regression is used to obtain shear strength parameters, which are cohesion (c) and shear
angle in (¢) of the soil mass.

In direct shear test, the failure envelope is a straight line that is expressed into equation:

T=C+ optan ¢

Where, T shear strength
c cohesion intercept
On normal stress
@ shear angle or slope of failure envelope
Direct Shear Test
=g il | |
(&)
Y y=0.437x + 0.364
= |
§ 20 Failure dnvelope
&
g 1.0 —
I
% /./
0.0
0.0 1.0 2.0 3.0 4.0 50
Mormal Stress (kg/cm?)
Triaxial Tegt
2.0
w15 — _
I gut Modified faillre enveldne
S R
= 05 — e
0.0

0.0 1.0 20 3.0 4.0 5.0

Yol 5, G,

Figure 2.1: Regression on Excel Chart
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Shear strength in this model is a linear function over the normal stress, where c and tan ¢
respectively expresses Y-axis intercept and the slope of the line.

In Chart, a regression can be done with Trendline by the following steps: right clicking
mouse when the pointer is on one of the points data on Chart to display a box menu. From
the box menu select Add Trendline to display Format Trendline dialog box > Linear >
Backward to intercept Y-axis > click Display Equation on Chart. The result is as shown in

Figure 2.1.

Format Trendline

|"'Frend|ine UDﬁDﬂS‘|
Line Color
Line 5tyle

Shadaow

Trendline Options

Trend/Regression Type

| O Exponental

® Linear
J ) Logarithmic
_‘ 3 Polynomial e __|
J ) Power
2 Moving Average F= |

Trendline Name

® Automatic ; Linear {Series1)

3 Custom: i

Forecast

Forward: :IE_I:I | periods

Backward: E-IZI.EI . periods

|:| Set Intercept = | |
[] pisplay Equation on chart

I:| Display R-squared value on chart

Close

The values of A and B that are shown in line equation, y = Ax + B in direct shear test are
equal to those calculated with the following functions:

A = slope of the line = tan ¢ = SLOPE(Y,X)

B = Y-intercept = INTERCEPT(Y,X)

Shear angle ¢ therefore can be calculated with ATAN function (in degree):

=ATAN(SLOPE(Y,X))*180/PI()
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LINEST and TREND function used and written as follows:
=INDEX(LINEST(Y,X),1) to obtain Slope,
=INDEX(LINEST(Y,X),2) to obtain Y-intercept

In practices, TREND function is entered in a series of worksheet formulas to obtain fitted
points represents a series of data (array Y, array X). The formula can be written as follows:

A B C D
1 |Direct Shear Test

2 Normal Shear Fitted

3 Strecg Strecg Shear

4 0.50 0.50 0.583 +- =TREND{5CS54:5C57,5B54:5B57,B4)
5 0.90 1.00 0.802

6 1.25 2.00 1.239 Result of copying cell

7 1.65 300 | 1.676 ron DX to DS

B Y-Intercept = 0.00 0.364

=]

Shear strength can also be expressed in major o1 and minor o3 principal stresses in the
triaxial test by plotting %2(o1 - o03) against %2(o1+ o03). The stress condition that fit to a
number of points data is referred to as modified failure envelope, which expressed into
equation:

Y(o1-o3)=a+ Y2(o1+ o3) tan

where a and « are the modified shear strength parameters. The parameters c and ¢ are
then given through relations below:

¢ =sin-1(tan a)

a
CcC=
cos ¢

Example 2: Logarithmic Regression

[t is often found that the data relationship from a test is presented where the X-axis is made
in log scale as shown figure 2.2. The equation 2.1 now becomes:

y=Aln(x)+B (2.4)

where A and B are constants
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The example data here is adopted from laboratory liquid limit (LL) test, i.e. to determine
soil moisture content at 25 blows. Below are the related informations:

e Moisture content (Wn) = [(weight of wet soil - weight of dry soil) / (weight of dry
soil)] x 100%.

e Water content' (Wn') = fitted Wn in the semi-log relationship.
e N =blows number

Liquid Limit Sheet

85.00
& 80.00
= y=-10.887In(x) + 105.972
8 75.00 MY
[
8 70,00 70.93 \
B B
g N
6500 & Data
60.00 —— Log. Trendline
25
10 100
No. of Blows (N)

Figure 2.2: Regression on Semi-log Liquid Limit Test

Figure 2.2 shows the LL test result and a regression line created through Add Trendline
command. The fitted Wn value (Wn') that represents a number laboratory Wn for each N
value can be obtained through the equation below:

y =-10.887In(x) + 105.972
Using the above equation, at N = 25 blows, the related fitted Wn = 70.93%.

The calculation sheet of LL test in the worksheet can be made as follows:
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A B C D E F G

1 LIQUID LIMIT TEST
2
3 No. |Weightof| Can + Can + Water Fitted
4 | get | Can(gr) |Soil (gr) |Dry Soil (gr)| Blows |Content (%) Wn (%)
5 Wc Ws wd N Wn Wn'’
6 1 8.3 52.46 33.29 14 76.71 77.24
7 2 2.8 55.61 32.96 19 75.10 73.92
8 3 2.8 57.14 35.12 29 68.13 69.31
9 4 7.8 52.72 34.62 36 67.49 66.96

Liquid Limit (%) = 70.93
3 Water Fitted
4 Content (%) Whn (%)
5 Wn Wn'’
6 | =100*(C6-D6)/(D6-B6) | =TREND(Wn,LOG10(N),LOG10(E6))
7 | =100*(C7-D7)/(D7-B7) | =TREND(Wn,LOG10(N),LOG10(E7))

Liquid Limit (%) =TREND(Wn,LOG10(N),LOG10(25))

The relationship of Wn 'and N in sheet above is a regression line as pictured in Figure 2.2.

Example 3: Log-log Regression

In the third example, we will examine on the data that is formed in log-log scale in the XY
coordinate system. The given data is the standard sieve size (US) for the particle size

distribution of the granular material as shown in Figure 2.3.
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A B C D
1 Sieve Sieve Fitted
2 No. Size Sieve Size
3 (US) (mm) (mm)
4 N S Formula :
5 4 4.750 5.142 =10"TREND(LOG10(S),LOG10(N),LOG10(A5))
6 5 4.000 4.031 =10"TREND(LOG10(S),LOG10(N),LOG10(A6))
7 6 3.350 3.305 =10"TREND(LOG10(S),LOG10(N),LOG10(A7))
8 7 2.800 2.794 Copy the formula down...
9 8 2.360 2.415
10 10 2.000 1.894
11 12 1.700 1.552
12 14 1.400 1.312
13 16 1.180 1.134
14 18 1.000 0.998
15 20 0.850 0.889
16 25 0.710 0.697
17 30 0.600 0.572
18 35 0.500 0.483
19 40 0.425 0.418
20 45 0.355 0.367
21 50 0.300 0.328
22 60 0.250 0.268
23 70 0.212 0.227
24 80 0.180 0.196
25 100 0.150 0.154
26 120 0.125 0.126
27 140 0.106 0.107
28 170 0.090 0.086
29 200 0.075 0.072
30 230 0.063 0.062
31 270 0.053 0.052
32 325 0.045 0.043
33 400 0.038 0.034
34 500 0.025 0.027

Figure 2.3: Formula for Log-log data relationship
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Regression in log-log data relationship can be obtained using formulas as shown in Figure
2.3, or by adding Trendline by the following steps: click the Add Trendline > Power >
Display equation on chart and the R-squared value on the graph, the results will be
shown as in Figure 2.4. The general equation of Power Trendline is:

y = 10X, c and a = constant (2.5)

Slope and Y-intercept are respectively the constants a and c in equation 2.5, where the
formulas for this series are, respectively:

=SLOPE(LOG (S),LOG (N)) = -1.09022

=INTERCEPT(LOG (S),LOG (N)) = 1.36749

10
¢ Data
Power(Data)
p— 1 '
£
E
5]
e
"s]
@
=
2
=L 0.1 |
R*=0.998
0.01
1 10 100 1000

Sieve Mo. (US)

Figure 2.4: Chart from Figure 2.2 data series where TREND is used to obtained the
fitted points
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2.5.2 POLYNOMIAL REGRESSION

Polynomial regression is used to obtain fitted points of a number of points data which
having non-linear (curve) trend in XY coordinate system. Thus, polynomial regression
consists of fitted points of a number (n) of points data (x;, yi) to be a polynomial equation
form:

f(X) = amx™ + amax™1 + ... + a1x + ao (2.6)

In Equation 2.6, m = a positive integer and the equation is called a polynomial function of
order m. Linear regression is a special form of polynomial regression with m = 1, A = ai and
B = ao.

A B

Temp Unit Mass
1] (0 (gr/cm?)
2 X Y
3 4 1.00000
4 16 0.99897
5 17 0.99880
6 18 0.99862
7 19 0.99844
8 20 0.99823
9 21 0.99802
10 22 0.99780
11 23 0.99757
12 24 0.99733
13 25 0.99708
14 26 0.99682
15 27 0.99655
16 28 0.99627
17 29 0.99598
18 30 0.99568

Figure 2.5: Example of two data series for polynomial regression

Example

Figure 2.5 shows two data series from the relationship between water density and
temperature, where X-coordinate is the temperature (°C) and the Y-coordinate is the water
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density (g/cm3). By plotting Y-values against X-values, it is apparently visible that the
result has a curve trend.

Figure 2.6 shows chart of the plotted data from Figure 2.5 and regression lines created
using Trendline that consist of Linear and Polynomial of order 2 and 3. It is apparently
seen that the polynomial regression is much better than linear regression for this data
series. The fitted points produced from order 2 and 3 regression seemed like really
coincides with the data and are only distinguished by the value of R?, where order 3 (red
curve) the value of R2 = 1. Excel 2007 provides the type of polynomial regression up to
order 6.

1.0000 &
# Data
----- Linear (Data)
0.99590 - )
Paly. (Data)
_ Paoly. (Data)
5 09980 4
-
P
g (a)y =-0.0002x + 1.0015
= 059970 4 R*=0.9207
=
(b)y = -BE-06x% + 2E-05x+ 1
R*=0.85920
0.9960 -
{c)y =4E-08x% - BE-06x% + SE-05x + 0.999
Bt
0.9950 . T T
a 10 20 30 40

Temperature (deg.C)
Figure 2.6: Regression analysis using Trendline for data series in Figure 2.5

2.5.3 INTERPOLATION

In an engineering calculation, sometimes it only needs a data interpolation without resolve
it into regression analysis. Here is to find y-value that correspond to known x-value a line
segment, based on a number data (x; yi) tabulation, where xi may continuously be
increased or decreased. Linear interpolation of y-value corresponds to x-value is:

y=Yi +—§l(i+l : z(li (X=X) 2.7)
i+1 i

where (X—=X)(X—=X;,;) <0 and X; # X;,,
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If y and x-axis has linear-log scale, respectively (semi-log), equation 2.7 becomes:

In(y;,,) —In(y;)
—X

i+1 i

In(y) =In(y;) + (X=X) (2.8)

where (X—=X)(X—X;,;) <0 and X; # X,

Equation 2.8 can also be written:

X — X; :
In yliz o y;l 29)
Or,
Vo, (X=X ) (Xi1 = X;)
Y=Y (T] (2.10)

In Excel, the interpolation value can be obtained by TREND function. Data series for this
function is a line segment formed by x;, yi and X+ 1, Vi + 1.

Example 1: Linear Interpolation

Given below is two data series of X and Y-array for interpolation:

Table 2.1: Two Data Series for Linear Interpolation

Data X DataY
0 -1

1

2 4

3

4 -1

5 -2

6 0

7 3

Plotted in chart:
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—l—Data

Worksheets below show formulas to obtain the interpolation of the data in Table 2.1, using
TREND function and Equation 2.7, respectively.

Using TREND function:

A B

G

Linear Interpolation

D

Data X Data ¥

New X

Y Value =

0 4,

0

-1

O|pa e |0 |&|D

||| w |-
Teo| o
wlo|f|i|wv|s|o

e O =m0 T O S R I

|
T R =R T B = R P R R S

< e W 1 e B Wl W e O et
(el e TN - S O O (6 R LR

MNew Y

X VWalue =

0

Ly T B I = IR S

wlow|s|wve o
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=TREND(B3:B4,A3:A4,C3)

Result of copying cell from D3
to D4:D3

=TREND{A3:A4,B3:B4,C13)

Result of copying cell from D13
to D14:D19
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Using Equation 2.7:

A B C D E F
18] Linear Interpolation
2 | DataX Data Y New X ¥ Value =
3 0 o 0 1 =B3+((B4-B3)*(C3-A3)/(A4-A3)) {Eq. 2.7)
4 1 o] 1 0
5 2 4 2 a4
6 3 5 3 5
7 4 1 4 1 Result of copying cell from D3 to
g 5 2 5 2 D4:D10
9 6 0 = 0
10 7 3 7 3
11
12 New Y XValue =
13 1 0| =A3+{{A4-A3)%(C13-B3)/(B4-B3))
14 o b
15 4 2
16 5 3
17 1 1 Result of copying cell from D13 to
18 B 5 D14:D20
19 0 g
20 3 7

M
g

The interpolation values are in column D, which correspond to new values entered in
column C. The y-value that correspond to a x-value that lies between 0 - 1 in cell C3 is
shown in cell D3; the y-value that correspond to a x-value that lies between 1 - 2 in cell C4
is shown in cell D4, and so forth.

TREND function and Equation 2.7 can also be used to interpolate x-values from known y-
values, by replacing the variable x with y and vice versa in Equation 2.7, or by switching x
and y-argument in TREND function. The formulas are shown in the worksheet above at row
12, columns C and D.

Example 2: Logarithmic Interpolation

A sands soil sample of 1,000 grams weight is taken and placed in the sieving machine for a
sieve analysis test. The results are presented in Table 2.2, showing sieve size used and
percent finer. The percent finer (or percent passing) is calculated based on cumulative
weight of soil retained on each sieve. Chart of log grain sizes versus percent finer of soil is
presented in Figure 2.7.
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Table 2.2: Sieve Analysis Results

A B
1 Sieve Size Finer
2 (mm) %
3 9.50 100.00
4 4.75 97.80
5 2.36 95.48
6 1.18 88.50
7 0.60 70.60
8 0.30 24.10
9 0.15 2.40
10 0.00

The next step is to obtain grain size distribution in percentage of the weight of the sample,
for an example to obtain grain size value corresponds to 60 percent finer or D60. The
corresponding value can be obtained using Equation 2.10. Formulas for semilog
interpolation are shown in worksheet as follows:

A g [ ) £
] X y
3 Gigin Size Finai
- {mim}) (%)
o 9.50 100 00 100.00 950
b 475 57 B0 97 .80 475
7 236 95 .48 85 48 236
2 1.18 88.50 B8 .50 1.18
9 060 70 60 T0 B0 0&0
10 0.30 2410 24 10 0.30
11 0.15 240 240 -
12
13 D10 = 10 0.1
14 D30 = 30 0328
15 Db = 60 0512
16

Plotted in chart:
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100 /.,_P.

——Data

—&— Interpolation

% Finer

1.00 10.00

Grain Size (mm)

Figure 2.7: Semilog interpolation for the data of Table 2.2

Notes:

e There is however more-more flexible way to obtain data interpolation which to
resolve them with a macro (custom function), using Equation 2.7 or 2.10. When
entered into macro, formulas can be shortened and does not depend on a line
segment where a known value is placed. Discussion on the custom function macro
will be in the following chapter in the topic of user defined function.

e The interpretation on sieve analysis result includes to determine how well the
gradation of sands soil. Gradation of sands or grained particles (silt to gravel) can be
measured by the coefficient of uniformity (Cy) and the curvature coefficient (Cc) as
defined below.

_Dy

CU_ Ce =

DlO ’ D60 DIO
The greater the value of Cy, the greater grain distribution range, where well-graded
particles usually has C¢ value between 1 and 3.
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2.5.4 STATISTICAL DATA

Histogram and Cumulative Distribution

In a statistical data presentation, it is convenient to make the data from observation into
histogram to see the data distribution. In histogram, the observed data plotted against its
frequency distribution and thus, we can get a visual summary and give quick impression on
the observed data.

Example

The following is concrete compressive strength data selected randomly from 40 samples
obtained from the test of characteristics compressive strength of concrete:

Concrete compressive strength test result
(kg/cm?)
376.28 399.30 375.41 370.41
394.43 409.47 393.53 371.43
387.19 374.34 386.30 372.44
390.35 392.29 389.46 390.30
401.27 386.78 390.37 384.82
379.95 361.23 379.08 362.28
380.97 402.90 380.10 400.86
389.33 368.22 388.44 366.35
384.64 399.20 383.76 407.46
396.34 365.36 398.83 363.51

To simplify data distribution, the result data divided into several classes within interval
(taken) = 5 kg/cm?, and then tabulated in Table 2.3. The scores from each class of data is
called class frequency, which is represented by height of the bar. To ease data distribution
process into classes can be done by using a function macro or custom function. The
discussion on custom function will be in the next chapter in the topic of user defined
function.
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Table 2.3: Data distribution to create a histogram

Class
Interval Mid Point Frequency Percent Cumulative
kg/cm? kg/cm?2 N (%) (%)
360-365 362.5 3 7.5 7.5
365-370 367.5 3 7.5 15.0
370-375 372.5 4 10.0 25.0
375-380 377.5 4 10.0 35.0
380-385 382.5 5 12.5 47.5
385-390 387.5 6 15.0 62.5
390-395 392.5 6 15.0 77.5
395-400 397.5 4 10.0 87.5
400-405 402.5 3 7.5 95.0
405-410 407.5 2 5.0 100.0
40 100.0

Histogram chart of Figure 2.8 is made based on Table 2.3 data. To create a histogram take
the following steps: click Insert tab > Column > Column clusterd > Select Data > Add >
Series Values: select range "Percentage" > OK. Click Edit for Horizontal Axis Labels >
insert range "Mid Point".

To create cumulative frequency chart as Figure 2.9, select the type of XY scatter chart
with smoothlines and markers > Select Data > Add > Series X values: select range "Mid
Point" > Y-values: select range "Cumulative".

16

14

12

Frequency (%)
ca

362.5 367.5 372.5 377.5 3815 387.5 3925 357.5 4025 407.5

Compressive Strength (kg/cm?)

Figure 2.8: Histogram of concrete compressive strength
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Figure 2.9: Cumulative frequency of concrete compressive strength Range, Mean dan
Standard Deviation

The classification or data distribution is generally defined into three statistical parameters,
which are, range, mean and standard deviation. Range is the difference between the lowest
and the highest values of data. From the concrete compressive strength test result, there is
a range of 48.24, from the lowest 361.23 to the highest 409.47 in kg/cm? units. The mean
or average is the sum of the data values divided by the total number of data (n). From the
test, the mean is obtained = 384.87 kg/cm?. If a set of data values are divided into M classes,
the mean formula is written as follows:

Mz

x=t (2.11)

Where,
m; = frequency of class interval i
x; = mid point of class interval i

Mean is a value that commonly used to represent values of a set of data. In consistent with
this, several measurements are made to state deviation, and one of them is the formulation
of mean square deviation (MSD). The MSD is also called the variance, and the formula is:
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i m; (X; - x)’

n

(2.12)

Another measurement to be used is the standard deviation (S), which is the square root of
MSD:

i m; (X; _;)2
S — i=1

- (2.13)

Through Equation 2:13, the standard deviation from the test result as in Table 2.3 is
calculated = 12:49 kg/cm?, and with divisor of (n - 1), calculated from the sample, MSD and
S is respectively calculated 394.74 and 16.12 kg/cm?2. The standard deviation is a measure
of dispersion of a set of data values from its mean; where a big or small of the value
indicates the quality of job execution.

Normal Distribution

From the histogram and measurement of statistical parameters above, it can now be drawn
a normal distribution curve. The normal distribution function is,

f(x,S,X)= ! e_;[xsx] (2.14)

s\2rx

For log-normal distribution, it can be obtained by replacing x with In(x) in Equation 2.14.

Figure 2.10 and 2:11 show normal distribution curve that fits with the percent frequency
data in Table 2.3. Figure 2.12 shows the formulas used in the presentation of the test result.
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Frequency (%)

Figure 2.10: Normal distribution curve that fits to the data of Table 2.3

Cumulative frequency (%)

Figure 2.11: Cumulative normal distribution curve that fits to data of Table 2.3

=
1=}
A - .
/ - .
14 il ™,
14
1 7 N
4 Y
4 [ ] N
12 7 y
4 A
! A"
P = - —_ — ot
10 = B o B Data
J hS
S S
o il Y larmal
= mWOorma
~ || S Ay | T
- =/ =
4 Y
o 7 Y
s N, -
S A |
a i A,
Fal
£ by
-
)
] T T T T
Ey=Tet T e l=Te! FeTals A A4
S0 e RRv SO Sl LI 41U

100
90
80
70
60
50
40
30
20
10

0

360

Concrete compressive strength (kafem?]

n/
n/

™

370 380 390 400

Concrete compressive strength (kg/cm?)

An Introduction to Excel for Civil Engineers

410

B Data

——— Normal

63




A B C D E F G
Class

1 Interval Mid Point Frequency Percent Cumulative | Normal | Normal
2 kg/cm? Kg/cm? (%) (%) Cum.
3 k N f
4 |360-365 362.5 3 7.5 7.5 3.2 3.7
5 [365-370 367.5 3 7.5 15.0 6.1 8.2
6 |370-375 3725 4 10.0 25.0 9.8 16.1
7 |375-380 377.5 4 10.0 35.0 13.4 27.8
8 |380-385 3825 5 12.5 47.5 15.7 42.5
9 |385-390 387.5 6 15.0 62.5 15.6 58.3
10 |390-395 392.5 6 15.0 77.5 13.2 72.9
11 |395-400 397.5 4 10.0 87.5 9.6 84.4
12 |400-405 402.5 3 7.5 95.0 59 92.1
13 |405-410 407.5 2 5.0 100.0 3.1 96.5
14 40 100.0

15

16 Mean = 384.87 kg/cm?

17 = 12.49 kg/cm?

F G

1 Normal Normal

2 Cumulative

3

4 | =500/($E$17*SQRT(2*PI()))*EXP(-0.5%((k-$E$16)/$E$17)72) | =NORMDIST(k$E$16,$E$17, TRUE)*100
5 | =500/($E$17*SQRT(2*PI()))*EXP(-0.5*((k-$E$16)/$E$17)"2) | =NORMDIST(k$E$16,$E$17,TRUE)*100

D E F

15

16 Mean = =SUMPRODUCT (k,n)/SUM(n) kg/cm?

17 S= =SQRT(SUMPRODUCT(n,(k-E16)*2)/SUM(n)) kg/cm?

Figure 2.12: Data presentation from the test result to obtain normal distribution and
the formula used in spreadsheet

Formulas used as follows:

Mean : =SUMPRODUCT (k,n)/SUM(n)
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S: =SQRT(SUMPRODUCT (n,(k-Mean)"2)/SUM(n))

Normal : =500/(S*SQRT(2*PI()))*EXP(-0.5*((k-Mean)/S)"2)

Normal Cumulative : =NORMDIST (k,Mean,S,TRUE)*100

Mean and standard deviation are respectively, calculated using Equation 2:11 and 2:13.
The actual scale for normal function (Equation 2.14) is determined from the interval used,
in this case were taken 5 kg/cm2. Multiply then by 100 to get the depiction in percent (%).

Excel has also the other ways to make distributions, such as Exponential, Weibull, Gamma

and Poisson.

2.5.5 CIRCULAR REFERENCE

When formulas are connected with their own cell, either directly or indirectly, then this
condition is called a circular reference. Excel by default can not process a formula that
contains a circular reference until we select Enable Iterative calculation by the following
steps: Office Button > Excel Options > Formulas. Iteration is the repetition of numerical
calculation until a condition is met. The process is executed based on iterations number
entered in the textbox Maximum iterations and Maximum Change for the maximum
change resulting from the last two iterations. Excel will stop counting when one of the

conditions is met, or whichever comes first.

Excel Options B]
Popular ) .
Wfi Change options related to formula calculation, performance, and error handling.
[-Fomutas ]
Proofing Calculation options
c - — — Select to allow
St Workieak Caltulatioly [#] Enable iterative calculation N 3
et Sl LA e L : iterative calcul
dvanced = Maximum Iterations: (100 | §
i o) ) Automatic except for data tables ) ~
' Maximum Change: 2,001
Customize O Manual
Add-Ins
Trust Canter Working with formulas
Resources [] B1CL reference style

Formula AutoComplete
Use table names in formulas
Use GetBivotData fundtions for PivotTable references

Error Checking

Enable background error checking

X Reset Ignaored Errars
Indicate grrors using this color: |58 =

Error checking rules

[#] Formulas inconsistent with ather formulas in the region

E Cells containing formulas that result in an error Formulas which amit cells in a region
Incongistent calculated column formula in tables E] Unlocked cells containing formulas
Cells containing years represented as 2 digits [[] Formylas retarring to empty cells
Numbers formatted as text or preceded by an apostrophe E] Data entered in a table is invalid

ation
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Cell with a circular reference in a spreadsheet as shown below:

Example 1
A B Result: 1 x iteration A B
1 4 1 4
2| =B2 |=(A1+A2)/3 2 0 1.33333
5 x iterations A B
1 4

2 (1.97531(1.99177

100 x iterations A B
1 4
2 2 2

In short, it can be explained herein about the iteration method - to describe the
way of Excel executes Example 1. Formulas in cell A2 and B2 are interrelated and
have the form: x = f(x) and calculated by the following equation:

Xn+1 = f(Xn),
where: X, = predicted value of x at iteration nth

Xn+1 = predicted new value of x at iteration nth + 1

n = number of iterations
Formula in cell sel A2 and B2 can be written: x,:1 = (4 + x1)/3.
At first iteration (n =1), x1is taken =0 - x> = (4 + 0)/3 = 1.33333
Atn=2,xyistaken = 1.33333 —> x3=1.77778
Atn=5,x5=197531 > x6=1.99177

And so on.
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Excel will do this process based on the number of iterations (n) and the maximum change
|Xn+1 - Xn| that you specify, and will stop if one is met. This analogy is found in the process

of Newton Raphson Method function in Chapter 3, but of course, the method is different.

Application of Excel iteration can also be applied to solve system of linear equations, to
obtain unknown variables of equations. For an example, to obtain values of x, y which
satisfy the equations below:

2x+3y=7

3x-2y=4

The solution is firstly to re-write each of equation to form x and y:
2x+3y=7 =2>x=(7-3y)/2; y=(7-2x)/3

3x-2y=4 S>x=(4+2y)/3; y=(4-3x)/2

Next, convert the formed x and y into formulas and placed them in cell B2 until C3 as
shown in the worksheet below. In order to perform iteration, the cell must be linked which
is in this operation the formula in cell B3 and C2 are to be interrelated.

A | B | ¢ | D |
1 Eqg.1 Eg.2
2 W= =[7-3* B2 =(44+2*B3)3
3 y = S[72CAE =430
4

10 x iterations

Eq.1 Eq.2
X = 1.999 2.000
= 1.000 1.001

(LB —
|

11 x iterations

Eq.1 Eqg.2
X = 2.000 2.000
= 1.000 1.000

| LI B[ —
|
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Values of x and y that satisfy both equations are obtained at iteration 11, which are: x = 2

andy =1.
Example 2
A B C 1 x iteration A B C
1 0 10 10 1 0 10 10
2 | 10 | =(B1+B3+A2+C2)/4 | =B2 2 10 5 5
3 | 10 | =(B2+B4+A3+(C3)/4 | =B3 3 10 | 3.75 | 3.75
4 0 0 0 4 0 0 0

5 x iterations
A B C

1 0 10 10

2 | 10 |8.641288.64128

3 | 10 [6.18032|6.18032

4 0 0 0
100 x iterations
A B C
1 10 10

2 | 10 8.75 8.75

3 | 10 6.25 6.25

In the cell B2 formula, the initial value for B3 and C2 are taken = 0. The value of B2 will be
used as the initial value in the cell B3 formula, where C3 = 0. The values obtained are then
used as a predicted new value in the next iteration.

In its application, for examples, the Excel iterative calculation or circular reference can be
used in the solution of linear simultaneous equations, slope stability analysis using Bishop
method (where the safety factor is on both sides of the equation), and the solution for
seepage below dam using finite difference method.
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CHAPTER 3

CREATING MACRO

3.1 FUNCTION PROCEDURE

In addition to the functions that already exist in Excel, it is often to create a function to
perform calculations which is determined by the user. Such function is called user-defined
(UD) function. This function will be added by Excel into a collection of functions and can be
used as well as a built-in function.

Some UD functions are made by combining formulas and built-in functions. UD function is
made in macrosheet or using VBA. Macrosheet is a sheet where macro is created by XLM
language, the original Excel macro language that is still maintained, at least until the Excel
2007. Figure 3.1 shows the UD functions to obtain cosine of an angle in macrosheet and
VBA.

A

Function Cosd(x)

1 | COSD
Cons Pi = 3.141592655

2 | =RESULT(1)

3 ~ARGUMENT("X",1) Cosd = Cos(Pi * x/180)
End Function

4 | =RETURN(COS(PI()*X/180))

Figure 3.1: Function in Macrosheet (left) and VBA (right)

Creating Function in Macrosheet

To insert a macrosheet in worksheet, right-click on the sheet tab to display a command
menu, click Insert > MS. Excel 4.0 Macro > OK, to insert a macrosheet named Macro1 as
shown below:
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This sheet is seemingly similar to a worksheet, but there are columns that are wide enough
to write a function. The first row is to write the name of function, for example, COSD in
macro example in Figure 3.1. The second row is to define the type of output refers to Table
3.1, for example, number, text or an array, using RESULT statement and followed by the
data type. Next, is to define variables or input data using ARGUMENT statement, followed
by the name and data type.

User has to determine formulas used in the operation of function of the input variables,
which is defined by ARGUMENT. A variable can refer a name or cell reference of worksheet,
such as "x" of COSD for a cell in the worksheet. A formula can be given a name to simplify
writing the next formulas. The process in writing a function is ended by RETURN
statement, which returns the function value. Below is an example of macrosheet macro to

calculate volume of a cube:

I
m
(]

MVOL
=RESULT(1
3 =ARGUMENT("a",1)
- =ARGUMENT("b",1)
5 =ARGUMENT|"h",1)
6 |Arsa I:;-;_-, . FEII n':amed
Area
7 =RETURM({Area*h)
3

MVOL function is used in the worksheet as follows:
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Table 3.1: Data Types in Macrosheet

Value Data Type
1 Number
2 Text
4 Logical
8 Reference
16 Error
64 Array

Creating Function in Visual Basic for Application (VBA)

UD function is made in a module that inserted through Insert tab > Module in Visual Basic
Editor which has been shown previously in Chapter 1. Function procedure is begin with
word function, followed by its name and ends with the word End Function. The type of a
function can be Single, Double or all data types of Variant, depending on what it would be
produced, a number or an array. Data types in VBA are presented in Table 3.2.

The selection on these data types in addition to define a function and arguments, or
variables, it is also related to the allocation of computer memory which depends on the
range of the data type (the greater the value, the greater memory allocation). If an
argument is not defined, it will be classified as a Variant and consumes memory more than
any other data type. Defining data type in a programming is highly recommended because
it saves computer memory consumption and accelerates the process of VBA in recognizing
the data type as well, or in the other word to accelerate VBA to execute a macro.

Table 3.1: Data Types in VBA

Data Type Range
Integer -32,768to 32,767
Long (long integer) -2,147,483,648 to 2,147,483,647
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Single (single precision) -3.402823E38 to -1.401298E-45 ( - values)
1.401298E-45 to 3.402823E38 (+ values)

Double (double precision) | -1.79769313486231E308 to -4.94065645841247E-324 (-)
4.94065645841247E-324 to 1.79769313486232E308 (+)

Currency -922,337,203,685,477.5808 t0 922,337,203,685,477.5807
String (variable length) 0 to approx.2 billion characters

String (fixed length) 1 to approx. 65,400 characters

Byte 0 to 255

Boolean (logika) TRUE or FALSE

Date 1 Januari 100 to 31 Desember 9999

Object Any object reference

Variant (with numbers) Any numeric value up to the range of Double

Variant (with characters) | 0 to approx.2 billion characters

Such as Excel, VBA also has many built-in functions that have names similar to Excel built in
functions, say, Cos function in Figure 3.1 or Abs to find the absolute value of a number.
Some Excel built-in functions can also be used in VBA by using the prefix Application.
Figure 3.2 is an example where Excel built-in functions are used in UD functions MLIN to
obtain linear regression parameters. MLIN returns an array result (multiple result) which
is the slope of the line and the intersection with Y-axis (Y-intercept).

Function MLIN(Y, X) As Variant
Slope = Application.Slope(Y, X)
Intercept = Application. Intercept(Y, X)
MLIN = Array(Slope, Intercept)
End Function

Figure 3.1: Excel built-in functions in VBA

Notes:

e Module with Option Explicit requires all variables are to be declared. If not, VBA will
show an error message "Variable not defined". To declare a variable use Dim,
ReDim, Private, Public and Static statement.

Example

An Introduction to Excel for Civil Engineers 72




Option Explicit
Sub OptEx1()
Dim myVar as Integer

Mylnt = 5 "error: variable not defined
myVar = 10
End Sub

e Dim is to declare a size of variable that already set at the beginning of the program,
while ReDim is to change the size of variable that could be changed during the
execution of program. Variables declared by Dim or Redim at procedure level
(between Sub - End Sub statements) are available only to the procedure where the
variables are declared.

Example

Sub OptEx2()

Dim myVar as Integer

Dim myString(l to 3) as String
Dim n As Integer

n =3 "an input

ReDim MyInt(n) As Integer
My Int(l)
MyInt(2)
My Int(3)
myVar = 10
myString(3) = "Hello"

End Sub

e Use Type..End Type with the example below to define a user-defined data type.

Type FamilyTree
Name As String
Address As String
Phone As Long
Numsiblings As Byte
End Type

Sub GetRecord()

Dim TheFirst As FamilyTree

TheFirst.Name = "Johan"
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TheFirst.Address = "'Street 123"
TheFirst.Phone = 1234
TheFirst.Numsiblings = 3

End Sub

3.2 SUB PROCEDURE

Macro that previously used to create a function can also be used to make an engineering
calculation program to solve more complex problem, such as structural analysis. In VBA,
such program is created in the Sub procedure, that is procedure with syntax as briefly
discussed in Chapter 1. In general, the process of input - output data from a Sub procedure
is:

1. Read input data from the worksheet
2. To execute data input by VBA
3. Print the results to the worksheet

In Excel-VBA programming, the value of input data is taken from the value of the cell or
range of cells on worksheet or a Range object with value as shown by its Value property. So
typing in the value in the cell in the worksheet with numbers, text, and so on actually is to
set the value on Value property of these cells. Cells property is commonly used to express
the Range object with the syntax Cells (row_index, column_index), i.e. cell (1,1) to return a
Range object of cell Al.

Here is an example to set a number to a cell in VBA languange, which sets the value of cell
A1=10:

Worksheets(’Sheetl) .Cells(1,1).vValue = 10

Value is the default property of the Range object, therefore negligible or means no need to
be written again. If no object qualifier or an objects before period (Worksheets () above),
then a range of cells are on the active sheet, in this case from which the macro runs, for
example via a command button on the worksheet. Use an object qualifier before the range
of cells if the data is not located on the active sheet with the writing of Worksheet ("sheet
name").

To complete this topic of discussion, the following is a simple example of Sub procedure
named Pro_Sub1:

Sub Pro_Subl1()
Dim Length As Double
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Dim Width As Double
Dim Area As Double
Length = Cells(2, 1)
Width = Cells(3, 1)
"Determine Area
Area = Length * Width
Cells(4, 1) = Area
End Sub

The above procedure is to calculate the area of a rectangle which is the multiplication of the
length and width of its sides. The variables are declared using the Dim statement and the
data type is a number with double precision (Double). Cells property is created without an
object qualifier, therefore, the range of cells is on the active sheet, which the active sheet
(opened) when the code program is executed.

Sign apostrophe (') is a sign where program ignores the comments in it. This sign is used to
insert an explanation. The default color of the text is green.

The process of input-output of Pro_Sub1 procedure can be explained as below:

A B C D E
1 gub Pro_Subl()
2
3 Dim Lfngth As Double
. Dim Width As Doubleée
i Dim Area As Double
5
= Length = Cells (2, 1}}
0 Width = Cells(3, 1) ReadInput
Area = Length * Width :Perform Caculation
10 Cell=z(4, 1) = Arsa ‘Print Output

End Sub

If the procedure in the above figure is executed, value of cell A4 or Cells (4,1) = 30. To run
the macro, perform a sequence of steps as described in Chapter 1.11.

In creating large scale application program, normally, the program is divided into several
sub-programs or procedures Sub and/or with some functions that each handles a specific
task then they called with Call statement or the name of function. The advantages of this
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division are to make a programming become more focused, more readable and if an error
occurred it can be quickly addressed. Chapters 6 to 10 show the examples of such
computer programming.

3.3 CONTROL STRUCTURES

A program is created to be able to handle any changes either from the data input or to that
occurred during program execution. Therefore, there are necessary control structures in
order to make program remains on its specified steps. Such controls are looping and
branching or a combination of both.

3.3.1 LOOPING
Do While...Loop or Do...Loop While

Repeats a set of statements while a condition is TRUE. If condition becomes FALSE, the
program will exit the looping and move to the next code.

Syntax:

Do While condition
[statements]
[Exit Do]
[statements]

Loop

Example

Sub exLoopl()
i=1
Do While 1 <=5
Cells(1 + i, 1) =1
i=i+1
Loop
End Sub
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Do Until...Loop or Do...Loop Until

Repeats a set of statements until a condition becomes TRUE. If a condition becomes FALSE,
the looping will be discontinued.

Syntax:

Do Until condition
[Statements]
[Exit Do]
[Statements]

Loop

Example

Sub exLoop2()
i=1
Do Until 1 >=5
Cells(1 + i, 1) =i

1=1+1
Loop
End Sub

For...Next
Repeats a set of statements a given number of times
Syntax:
For counter = start To end [Step step]
[statements]
[Exit For]
[statements]
Next [counter

Example
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Sub exLoop3()
j=1
For 1 =1 To 5
Cells(1 + i1, 1) =]
j=3+1
Next i
End Sub

For Each...Next

Repeats a set of statements a number of elements in an array. It helps if the number is
unknown. For example, to be used in a function below:

Syntax:

For Each element In array
[statements]
[Exit For]
[statements]

Next [element]

Example

Function exLoop4(Yarray, Xarray) As Variant

Dim n As Integer, x As Single, y As Single

n=2~0

X =0

y =0

For Each c In Xarray
n=n+1
X = X + Xarray(n)
y =y + Yarray(n)

Next

a=x%*x

b=y *x

exLoop4 = Array(a, b)

End Function
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3.3.2 BRANCHING

Select Case

Executes several set of statements depends on the value of an expression
Syntax:

Select Case testexpression

[Case expressionlist-n

[statements-n]]

[Case Else

[elsestatements]]

End Select

Example

Sub exLoop5Q)

Dim Number

Number = Cells(l, 1) "a number

Select Case Number

Case 1 To 5
Cells(2, 1)

Case 6, 7, 8
Cells(2, 1)

Case Else
Cells(2, 1) = "Greater than 8"

End Select

"Between 1 and 5"

""Between 6 and 8"

If...Then...Else

Executes a set of statements because of certain condition, when it is not appropriate then
move to another state of condition.

Syntax:
If condition (1) Then

statement(1)
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Elself condition(2) Then
statement(2)
Else

statement(3)

End If

Branching is usually nested in a looping. If the condition is met, the program will exit the
looping with Exit command. If...Then...Else branching can also be combined with And, Or, or
Not statement to state the expression or the relationship between two expressions.

Syntax:
For...or Do Until...
statement(1)
If statement(1) And or Or expression(2) Then
statement(2)
Exit For or Exit Do or Exit Function or Exit Sub
End If

Next...or Loop

Goto...Gosub...Return

This branching is used in a procedure consisting of one or several blocks of statements
(subroutines) that is made for particular task or calculation. The block is then called upon
to do the job with GOSUB statements and returned with RETURN statement. GoTo
statement will branch to a code line, subroutines, or line label, and then continue to the
next code.

Example

Sub exBranch()
Dim myNum As Double
myNum = Cells(2, 1)
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IT myNum >= O Then
GoSub MyRoutine

GoTo 10
Else "means myNum < O
GoTo 20
End If
MyRoutine:
myNum = Sqgr(myNum) “determine square root of number >=0
Return
10 Cells(3, 1) = myNum
Exit Sub
20 Cells(3, 1) = "#NUMI" "error message
End Sub
Call...Sub

Calls a procedure from another procedure
Syntax

[Call] name [argument]

Example 1: Calling Sub procedure from function procedure

Sub Area(x, y, L)
L=x%*y
End Sub

Function Volume(a, b, t) As Single
Call Area(a, b, L)
Volume = L * t

End Function

Example 2: Calling Sub procedure from another Sub procedure.

Sub Area(x, y, L)
L=x%*y
End Sub
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Sub Pro_Vol(Q)
Dim a As Single, b As Single, t As Single

Dim volume As Single

Cells(2, 2)
Cells(3, 2)
Cells(4, 2)

-
1

Call Area(a, b, L)
volume = (L * t)
Cells(5, 2) = volume

End Sub

In addition to looping and branching defined above, there is also useful control structure
thatis With statement.

With

Execute a series of statements on the same object
Syntax:

With object

[statements]

End With

Example:

With MyObject
-HorizontalAlignment = xlICenter
-VerticalAlignment = xlICenter
-Position = xlLabelPositionRight
-Orientation = xlHorizontal
With _Font
-Name = "Arial”
-FontStyle = "Regular™
.Size = 8
End With
End With
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3.4 USER DEFINED FUNCTION PROBLEMS

Problem 1

Create a macro to determine rectangular area where area = length x width.
Solution

If a and b express length and width respectively, area in macro can be expressed as a
function of (a, b) = a x b. If the name of the function is Area, the expression is:

Area (a,b) =axb.

To solve this problem, we will use macrosheet languange. Insert a macrosheet by right-
clicking on the worksheet Sheet tab > Insert > MS. Excel 4.0 Macro > OK. Type the macro
as follows:

AREA

=RESULT(1}
=ARGUMENT("a", 1]
=ARGUMENT{"b",1]
=RETURM{a*b)

Afterward, we have to define the function name so that it can be recognized by Excel and
incorporated it into Excel functions. The steps are as follows:

1. Click cell A1 where the name of the function (Area) is placed.

2. Click the Formula tab > Define Name to show the New Name dialog box as below.
Enter a macro name in the name text box. Macro name will automatically be
referred to cell A1 with step 1 above.
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T

Mame: | |
acope: | Workbook v |
Caommenk: ‘
Referstol | macrozigagl B
Macro Cafegory!
(%) Function User Defined i|
) Command I:l
O Mone
[ Ok ] [ Cancel ]
s

3. Select Function in the option button, so the function (by default) is categorized as
User Defined or you can choose a category for your function.

4. Click OK.

Now back to the worksheet. Area function is written as follows:

A B C D E
1 la(length) b(width) Area
2 3 2 b4—=Area(ab)
3
4

Cells A2 and B2 are respectively named a and b which carried out by follow step No. 1 and
2 above through active sheet. In this step, there is no option (option button) for Macro
category in New Name dialog box.

Problem 2

Find the area between a straight line y = mx + c and the X-axis, betweenx =aandx=b (c 2
0). This will be solved using integral with formula:

Area =

j(mx+ c)dx

In macro, area can be expressed as:

function(m,c,a,b) = (Y2.mb? + cb) - (Yama? + ca)
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Now, based on the area formulation above, find the area between y = x + 2, X-axis, between

a=-1,b = 3. The name of function is INAREA.

Solution

The macro in macrosheet looks like below:

A
INAREA
=RESULT(1)
=ARGUMENT{"m",1)
=ARGUMENT{"c_"1)

=ARGUMENT("b",1)
=-c_/m

=IF(m=0,IF{OR{a=A7,b=A7), RETURN(#VALUE!}])
=IF{m=0,1F{OR{a<A7,b<AT), RETURN{&#VALUE!}])

1
2
3
4
5 =ARGUMENT("a",1]
i
7
3
9

10 =1/2*m*a2+({c_*a)
11 |=1/2*m*b"2+(c_*hb)
12 |=RETURN({A11-A10)

Problem 2 in chart:

Chart

(a3

un

/3,5

iy

/‘,I'=K+2

[45]

M2

0.2

2 g/

[REY

4 &l

4 -2

Before applying the function, perform step no.1 to 4 as in Problem 1. The use of function in

worksheet as follows:
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1 (m c a b Area
2 1 -1 3 12 + =INAREA[AZ2,B2,C2,D2)
3 1 -3 3 HVALUE! =INAREA(AZ,B3,C3,D3)
4 0.5 1 5 HVALUE! &= =INAREA[A4. B4 C4,D4)
5

Problem 3

Create a VBA macro to assign letter grade for a course with score range 0 - 100 as follows,
A: representing scores from 80 - 100, B: 65 - 79, C: 51 - 64, D: 40 - 50 and F: for scores
below 40. Macro will return literal grade with sign + and - at given numerical value.

Solution

Function VBGrade(g, a, b, c, d) As String
Select Case ¢

Case Is >= 2 * (100 - a) / 3 + a
VBGrade = "A+"

Case Is >= (100 - a) / 3 + a
VBGrade = ""A"

Case Is >= a
VBGrade = "A-"

Case Is>=2* (a-b) /73 +0b
VBGrade = "B+"
Case Is >= (a-b) /7 3
VBGrade = "'B"

Case Is >= b
VBGrade = "'B-"
Case Is>=2* (b-c¢c)/ 3 +c
VBGrade = "'C+"
Case Is >= (b -c¢) /7 3
VBGrade = "'C"
Case Is >= ¢
VBGrade = ""C-""
Case Is>=2* (c-d) /3 +d
VBGrade = "'D+"
Case Is >= (c -d) /7 3
VBGrade = "'D"

+
(op

+
(@]

+
o
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Case Is >=d

VBGrade = "D-'
Case Else
VBGrade = "F"
End Select

End Function

Functions that created in VBA will automatically be entered into Excel functions collection.
The use of the function in worksheet is as follows:

A B - D
1 Name Score Letter
2 V. Magda G54 C+ 4 =\VBGrade(B2,80,65,51,40)
3 |Y. Artist 90 A
4 L Monay 79 - - Re sult of copying ce
5 M. House 66 B- fromC2 to C3:C6
& H. Aunt 39 F

|

If the teacher wants to apply a different standard for course scoring, it is simply done by
changing value of the function arguments.

Problem 4

Create a VBA macro to find vertical stress distribution below a foundation with elastic
equation from Boussinesq - Newmark (1935). The equation to get the vertical stress (o)
below a corner of a rectangular area b x 1 at depth y as shown in Figure 3.3 is:

1 [2MNW V +1 [ 2MNWV
O,=0,—— +tan | —

) . a
Y Ar| V +V, \Y V-V,
where,
M=b/y
N=1/y

V=M2+N2+1
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V1= (MN)?2
b dan 1 is length of rectangular sides

[f V1>V, then the arctan in the equation needs to be added with .

b o (stress) /

{

d

Yo,

Figure 3.3: Vertical stress below a corner of a rectangular area

Solution

Function Bous(q, b, I, y) As Double
Const pi = 3.141593
Dim m, n, v, vs, rad, at

m=b/y

n=1/y

v=m~*2+n"r2+1

vs = (m*n) N2

rad = (2 *m*n * Sqr(v)) /7 (v - vs)

If vs > v Then

at = Atn(rad) + pi
Else

at = Atn(rad)
End If

Bous =g/ (4 *pi) * ((2*m=*n*Sgr(v) 7 (v +vs)) * ((v +1) 7 vVv))

+ at)
End Function
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The advantage to convert an equation or formula into a function is that it greatly simplifies
the calculation. The above equation with a condition V1 > V certainly would be very lengthy
and requires a lot attention if b built into worksheet formula. It is more easily solved by
typing it into VBA code.

Now, given a foundation with a size of 3 x 3 m is subjected to uniform pressure of 10
ton/m2. The vertical stress distribution of each interval depth of 0.5 meters below the
center of the foundation is shown in the worksheet as below:

=
=

o

Fit

1 Unmiform Pressure on Rectangular Area

2 g= 10 tondm*2

1 b= 158'm

4 |l= 15m

6 Vertical Stress Distribution

T vim) py (tim*2)

(= ] N &M N L =i . a O COED COC A AD
@ [ER LY U U= == DUUSI9DgL D00, 303k M0
] 0 &0 976

L 1.00 8.63

14 1.50 r.oi

12 2.00 549

Ay i 4 ¥

I £ .U =+ £0

4 ER1H i3k . Resu tof coovingee
15 350 268 from B8 to B3:B20
G 404 217

17 450 1.79

A o0y L i 4 A

1o R ELY) =3

A £ Cin 4 "NC

13 o v 1 £

20 6.00 108

24

e Boussinesq - Newmark equation is intended to find vertical stress below a corner of
a rectangular area, therefore, below a center a foundation of 3 x 3 m is obtained 4
area with the same size, with 1.5 x 1.5 m dimension. Furthermore, for the
contribution of four corners it shall be calculated = 4 oy.

e Division by 0 is not allowed in the calculation, therefore the value entered in cell A8
shall be an approach = 0 (take, for example, y = 0.0001).

Chart of stress versus depth is shown as below:

An Introduction to Excel for Civil Engineers 89




Stress Vs. Depth

Stress

0.00 5.00 10.00 15.00
0.00 +
1.00
2.00 o

Depth

3.00

4.00 /
5.00 f
5.00 j

Chart is created through Insert tab> Scatters with smoothlines and markers > Select
Data > Add and then select x and y-data. To modify the chart click once on chart area then
click Chart Tools tab > Chart Layout > Layout 1, and then add chart titles by clicking once
on the title, select Edit Text to type. The depth orientation is made to increase downward
by right clicking the Y-axis > Format Axis > Axis Option > Values in reverse order.

Problem 5
Find root x in equation: ax* + bx3 + cx2 + dx+c=0
Solution

This problem will be solved numerically by Newton-Raphson method. The process of
calculation is done in an iterative technique, which root x is gradually approached.
Function of equation depicted in chart in Figure 3.4 and exemplified intercepts the X-axis at
the point p and f (x) = 0 or (p, 0). In the first step, it is taken x;-value to get tangent line at y
= f(x) which intercepts the X-axis at the point (x2,0), where x; is new approach value to p.
The next approaching process is done using xz-value to get x3-value and so on until x, — p.
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y =f(x)
y = f(xn) = F(Xn)(X —Xn)

i fxn))y” 7

% (ne2.0) X

Thus, by induction it obtains tangent line: y - f(xn) = f'(xn) (x - xn) Which intercepts X-axis at
point (Xn+1,0), where:

(X))
Xn+1=Xn-— fv(xn)

Macro

Function NRM(a, b, c, d, e) As Double
Dim funct, deriv, X, Xn

Dim n As Integer, 1 As Integer

n = 1000

i=1

x = 100
Do

funct = (@ *x"™"4) + (b*x"~3) + (c*x"N2) _
+ (d*x) +e
deriv=(@*a*x"3)+ @B *b*x"2)+ _
@*c*x) +d
xn = x - (funct / deriv)
IT funct = 0 Or Abs(xn - x) < 0.00001 Then

NRM = xn
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Exit Function

End If
i=i+1
X = Xn

Loop Until i = n
NRM = *"Divergen!™

End Function

Function NRM (stands for Newton-Raphson Method) is now used to find the value of x in
the equation below:

-2.79x3 - 2:11 x2 + 24.51x + 36.68 = 0.

This equation form can be found in the geotechnical engineering to find the embedment
depth of retaining wall with Free-Earth Support Method. The use of the function in
worksheet is as below:

[t C I = = {3 H !

Roaot of Equation

o
0 2.79 -12.11 24 51 36.66 X = 2 2325«+—="|RMiA4 B4 C4 D4 E4)

Problem 6

Table X is a number of random numeric data from 0 - 100. Create macro to calculate the
amount of data in Table X with a range of values from Y to Z.

A B C D E F G
Tabel X
77.58|73.27|22.21|70.40 | 81.40 | 52.57 | 98.34
68.58 | 21.86 | 62.37 | 37.61 | 51.24 | 12.41 | 18.55
60.92 | 22.26 | 35.01 | 23.76 | 63.34 | 32.81 | 83.16
98.27 | 63.85|30.97 | 34.98 | 64.44 | 70.49 | 17.96
71.23|79.63 | 74.21 {100.00| 37.95 | 3.94 | 95.27
10.62 | 20.69 | 5.82 | 74.81|95.09 | 37.48 | 0.74

N | OO W N
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Solution

Macro

Function DNUM(Xarray, Y, Z) As Integer
Dim n As Integer, Num As Integer
Dim c
n=2~0
For Each c In Xarray
n=n+1
IT Xarray(n) >= Y And Xarray(n) <= Z Then Num = Num + 1
Next
DNUM = Num
End Function

The use of the function in worksheet is as below:

[ J K  |Formula at Column K
2 | 0.0 | 50.0 19 |=DNUM(X,12,]2)
3 | 50.0 {100.0| 23 |=DNUM(X,3,]3)
4 | 0.0 |100.0| 42 [|=DNUM(X]4,]4)

Argument X is an array argument, in this example is the name that has been defined for the
table data in a range A2 to G7. Argument array can be also written in the following manner,
range(A2:G7) or a certain range, for example range(B2:C7), range(A7:G7) and so on. One
of the simplicities of using function in Excel because it is well supported by the spreadsheet
to create variable names, writing function and put the result at once.

Problem 7
Create a macro for linear interpolation example in Chapter 2.5.3. Use Equation 2.7 to solve.
Solution

Macro

Function Linter(Xrange, Yrange, nval) As Double

Dim 1 As Integer

Dim c, X
X = Xrange(l)
i=1

For Each c In Xrange
IT nval = ¢ Then

Linter = Yrange(i)
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Exit Function
*find a new value satisfying the given condition
Elself (nval - ¢) * (nval - xX) <= 0 And ¢ <> x Then
"Eq. 2.7:
Linter = Yrange(i - 1) + (Yrange(i) - Yrange(i - 1)) _
* (nval - x) /7 (c - X)
Exit Function

End If

X =cC
i=i+1
Next

End Function

The use of the function in worksheet is as below:

s 8 [ ¥ E
1 Linear Interpolation
2 Data X Data Y M ¥ Y Value =
3 G -1 3.54 1.76 s =inieriA3ALDB3:810.03)
4 1 1]
5 F 4
£ 4 c
o > =
7 4 -1
8 > =2
a = "
] w L)
o 7 3

|
H

Interpolation in Chart:

' Enter New Value at this range

Yvalue

—l—Data
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Problem 8

Create a macro for semilog interpolation example in Chapter 2.5.3. Use Equation 2.10 to
solve.

Solution

Macro

Function Loginter(Xrange, Yrange, nval) As Double
Dim 1 As Integer
Dim ¢, X
X = Xrange(l)
i=1

For Each c In Xrange
IT nval = ¢ Then
Loginter = Yrange(i)
Exit Function
"find a new value satisfying the given condition
Elself (nval - ¢) * (nval - X) <= 0 And ¢ <> x Then
"Eq 2.10:
Loginter = Yrange(i - 1) * (Yrange(i) 7/ Yrange(i -1)) _
N ((nval - x) /7 (c - X))
Exit Function

End IFf

X = cC
=1 +1
Next

End Function

The use of the function in worksheet is as below:
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100.00
97.80
9548
88.50
70.60
2410

240

D10= 10
D30 = 30
D60 = 60

9.50
475
238
1.18
0.60
0.30
015

0191
0.328
0.512

+— =loginter(B5:811 A5:A11,D5)

Result of copying cell from
E5to EGE11

+— =loginter(5B35:58511 SA$5:3A811,D13)
+— =loginter($855:38511 SAS5.5A511.D14)
<+ =loginter(SBS5:5BS11,8A85:8A511, D15)

A B
1 Grain Size Distribution
2 X's y's
3 Grain Size Finer
4 (mm) (%)
5 9.50 100.00
6 475 97.80
7 236 95 48
8 1.18 8850
9 0.80 70.80
10 0.30 2410
11 0.15 2 40
12
13
14
15
Interpolation in Chart:
------------ 100

Enter New Value at this range
% Finer

Notes:

—

—l— Data

—8— Interpolation

1.00

Grain Size (mm)

10.00

e Character "¢" and "r" can not be used for variable names in macrosheet, because C
and R stand for column and row, respectively. However, you can define a variable

names such as "c_"or "r_

nmn
)

cx" or "rx" and so on.
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3.5 STRUCTURE OF PROGRAM

Data processing in Excel-VBA is a sequence of step; read - execution - print, as described
previously in Section 3.2, which is (rewritten for your you convenience):

1. Read input data from the worksheet
2. To execute data input by VBA
3. Print the results to the worksheet

In large data processing either from the input data or from program execution, a computer
programming (coding) must be planned and managed properly. It is intended in order to
make the program flow becomes simple (not complex), saving coding, and it is easy to solve
if an error is occurred. In this section, the three of the above steps will be discussed that is
how to create Input Form, Output Form and writing code in VBA module. In this topic, we
are going to create a civil structural analysis program.

3.5.1 INPUT OUTPUT FORM

In Excel-VBA programming structure, input-output form is worksheet itself and can be
made in the same sheet, e.g. on Sheet 1. For large input data, for an example for structural
analysis program as shown in Figure 3.4, it would be better if the input data extends to the
right, for an example, the data entered here is consist of number of joint, coordinates and
properties of structure elements. By creating form widens on the right side, the location
(read: rows) of data output is therefore can be specified in the program.

T — G0 to e rght

]
|

lote "Perpinditular o Mmember o (el FL* 0

Joit Loms - Dapacerant | armoer Ena Forces |
gt | P | Py | mr | x| Gy | Rz |hediengin] t-Sxel | g-Shear | hem | 4Sfuiel | SShesr | E-Mem |
- — — T - — — — s =

14
@ uTPUT = defined row for GUTPUT

0.000 b Go080 & i30aq 001483 120 0.00 i3 [
40 i - oo 0.000 o aoeen SEETY 001003 220 0o L.2a7 A EH naan [FR

Figure 3.4: Input-Output Example Form
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Figure 3.4 shows that how much the input data entered in the form does not change the
row numbers for data output. It thus obtains a fixed input-output form and does not
depend on the size of the input data, so that code of read - print steps can be specified in
the program.

Contrary to the input data, it is possible to extend the output data downward because end
of the row is not a boundary that has to be identified for program input. Therefore, the data
presented here following the common way in presenting the results of the structure
analysis extending downward to improve readability.

3.5.2 WORK WITH MODULES

A large data processing such as for an application program generally consists of several
smaller sub-programs united into one unit for a goal that is well managed. What is meant
by sub-program is VBA Sub procedure or function procedure given the scope of their
respective task and then placed into a module.

For the convenience, Author distinguishes each procedure into three modules according to
their tasks as follows:

Module 1: Main Module

Module 1 consists of data provision from input-output form (see Figure 3.3), which is
mainly from: geometry data, materials data, determination of node support or fixities and
load data. Module 1 is the main module, which controls the process of read - execution -
print.

Module 2: Calculation Process (Analysis)

Procedures in module 2 are associated with the theory of the structure and the analytical
methods used, e.g. building stiffness matrix, generate load matrix and compute nodal
displacement. Module 2 works based on data provided by Module 1.

Module 3: Creating Charts

Procedures in module 3 are associated with the presentation of data in graphical form, e.g.
for 1). Input data: geometry of the structure and loads, and 2). Data output: displacement,
moment and shear distribution. Module 3 works based on data provided by Module 1 and
Module 2.

Figure 3.5 shows in general how Excel-VBA programming structure is depicted in a chart.
Figure 3.6 shows a chart of programming structure in real world; consist of main
procedures (abbreviated to facilitate in writing) that exist in TRUSS2D, program for truss
analysis as presented in Chapter 7.
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EXCEL

VBA

w
Module 1 Module 2

(Main Madula)

Read — Execution - Print Froblem Analyshs

It

Module 3

Froduce Charts

Figure 3.5: Excel-VBA programming structure

PROGRAM FOR TRUSS ANALYSIS

T

|

/ Module 1 (Main Module) \ VBA

Read: Excellnput

EXCEL

Execution: -Call_stiff (
-Call_InverseStiff
-Call_Load
-Call_Disp Stiff (Develop Stiffness Matrix)
~Compute Axial Forces Inverse Stiff
-Compute SupportReactions Load (Generate Load)

Disp {(ComputeDisplacemenis)

Print: -Displacements
-AxialForces ‘\
-SupportReactions

-Call_PlotGeometry
-Call_PlotDisplacement
~Call_PlotAxial

4

Module 2

Module 3

PlotGeometry
PlotDisplacement
PlotAxial

Function Max_Displacement
Function Max_Axial Force

Figure 3.6: Excel-VBA programming structure for truss analysis (TRUSS2D)
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3.5.3 Tips

In designing macros, the movement between worksheet and Visual Basic Editor (VBE)
window is often done because both windows are interconnected. To open VBE, click on
Visual Basic icon Developer tab and from VBE click Microsoft Excel icon to go back to
worksheet, or by pressing shortcut Alt+F11 on both windows. Actually, to accelerate the
process of displaying window is to place together in the monitor screen as shown in Figure
3.7. Thus, if a VBA program code is executed, its interaction to the worksheet can be viewed
simultaneously.

Here are the steps to put a worksheet and VBE in one screen and simple techniques to
execute line by line:

1. In the worksheet window click Restore Down icon in the top right corner, then
drag the sheet to the left, place it approximately half size of the monitor screen. Drag
the mouse pointer on the worksheet window ends to adjust its size.

o
Restore Down

iyt

2. Next, go to the VBE window, in the same way place it on the right side of the monitor
screen. There are now already both these windows simultaneously.

3. Now, go to the VBE by clicking its window. Click Close VBA Project icon to close
VBA Project window on the left so only VBA module is now visible (to display back,
click icon Project Explorer or press Ctrl+R). To start from the first line press F8
and press F8 again to continue to the next line. If you want to jump to the desired
line press Ctrl+F8 at the cursor. Each line to be executed is marked in yellow.

4. Press F9 to select program line at which execution will stop (breakpoint) when you
run macro by clicking Run Macro (F5). The other way is to click the left bar at
program line that you want to set a breakpoint until red dot appears. Click on the
red dot to remove.

5. The variable value computed during program execution can be seen its value by
attaching a pointer on a variable, as shown in Figure 3.8. This variable reads the
value of the cell of the worksheet. Hold on a second the pointer until the value is
displayed, which is the cell value of the worksheet on the left.
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Through step 1 and 2, the movement between worksheet - VBE is simply done by clicking
one window without losing another window. This kind of method is very helpful if you
want to run the program and see the results at once (through step 3 and 4).

The above steps are very helpful in developing flow of program and solve errors as well.
Running step 3 and 4 is actually the process of tracing errors (debugging) by using
commands in the Debug menu and it is also similar to the process of program verification
(testing) by running code line by line. Testing and debugging is a routine activity to build a
program that requires a number of control structures (branching and looping). A condition
where a program is paused for the purpose of developing the code is called break mode.

Ol ® X 7 & Wicrwnaft Vil Bavic - Rac ) Sares i - |Maduis) [Cass]]

Figure 3.7: VBA - Worksheet window is placed in one screen

One of error type that may occur is when element of an array smaller or larger than the size
that has been assigned to, so when program is running it will show an error message box
"subscript out of range". For example in a looping where the number of process exceeds the
subscript of an element. To get to the location where an error occurs clicks Debug, and
Reset to stop the program.
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Subk Pro_Bubl()

Dim length As Doublse
Dim width A= Doubls
Oim Area As Double

length = Cells (2, 1)
orgth= 3= Calls (3, 1)

L unt area
Area = lesngth * width
Cells(d, 1) = Araa

End EBub

Figure 3.8: To see a variable value by attaching pointer

3.6 CHART MACRO

Excel chart is an object that can be manipulated by VBA through its methods and
properties, for example, in an aim of adding lines (Add series), changing the line color,
border color, creating line styles and setting the thickness (Weight). By creating macros,
the job becomes very easy, fast, and advances to the most difficult level, which would not
be done manually.

In Chapter 1 we have discussed how to make lines in the worksheet with formulas and
tables. In this section, it will be created using macro instead of what has done manually. For
a case, Example 3 of Chapter 1.10 will be used here - which is to create truss structure
drawing with joint and coordinate tables as shown below:

Table of joints
Joint X y
1 1.0 0.0
2 1.5 2.5
3 2.0 5.0
4 2.5 10.0
5 3.0 15.0
6 3.5 20.0
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7 4.0 15.0
8 4.5 10.0
9 5.0 5.0
10 55 2.5
11 6.0 0.0
12 3.5 2.5

Table of Coordinates

Line Joint x1 ‘ yl ‘ X2 | y2

1 1 2
2 2 3
3 3 4
4 4 5
5 5 6
6 6 7
7 7 8
8 8 9
9 9 10 Data is programmed

—_
(@]
—_
(@]
—_
—_

[UnN
[EnN
N
—_
N

—_
[\]
—_
[\]
[N
o

—_
w
w
[N
[\]

14 12 9
15 3 8
16 3 9
17 4 9
18 4 8
19 4 7
20 5 8
21 5 7

By creating macro, the data of x1, y1, x2, y2 of above table do not need to be formulated
because it will automatically be created by the program. The Macro is shown as follows:

Sub MChartl1()

Dim npt, nin, 1

npt = 12 "no. of joint
nin = 21 "no. of line
ReDim x(npt), y(npt)
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ReDim x1(nIn), yi1(nIn), x2(nIn), y2(nin)
"Read joint coord

For 1 = 1 To npt

x(i) = Cells(4 + i, 2)
y(i) = Cells(4 + i, 3)
Next i

"Read line coordinates
For i = 1 To nln
x1(i) = x(Cells(4 + i, 6))
y1(i) = y(Cells(4 + i, 6))
x2(1) = x(Cells(4 + i, 7))
y2(i) = y(Cells(4 + i, 7))
Next i
ActiveSheet.ChartObjects(*"Chart 1')_Activate
ActiveChart.ChartArea.Select
Selection.ClearContents
"creating lines
For i =1 To nln
With ActiveChart
-SeriesCollection.NewSeries
.SeriesCollection(i).XValues = Array(x1(i), x2(i))
.SeriesCollection(i).Values = Array(y1(i1), y2(i))
-SeriesCollection(i).Name = ™=""m
End With
ActiveChart.SeriesCollection(i).Select
Next i
End Sub

Now, we focus on three blocks of statements enclosed by a red line, as below. The blocks

description are given thereafter.
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Description:

e Block 1 is the same to that done using VLOOKUP formula in Chapter 1. This is the
emptied line coordinates in the sheet table above because it is now processed by
VBA. Figure out this, formulas as many as 21 rows x 4 columns (84 formulas) for
creating 21 lines be is simply replaced with only 6 VBA statements without limit to
any a number of lines that will be created, 100 or 200, 1000, etc.!

e Block 2 is code to activate a Chart that to be manipulated, in this case is Chart1. Note
that, we will never (ever) create a new Chart (Charts.Add) because it will make
code longer. Instead, we will proceed manually (through Insert > Charts >
Scatters) and format the chart as desired. To identify a chart name right-click on the
Chart Area > Assign Macro, and then see the name in the Macro Name text box.

e Block 3 is steps that we do with Add Series in the Select Data Source dialog box for
data entry (see Chapter 1). This VBA looping replaces job for line coordinates data
entry which takes a long time when done manually.

Excel input form for the chart macro above as below:
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A B c D E F G H J K L M ] o

1 |Macro Chart

2

3 |Joint Coordnates No. of Line 25
4 |Joint X y Line Joint

5 1 10 0.0 1 1 2

6 2 1.5 2.5 2 2 3

7 3 210 5.0 3 3 4

8 4 250 100 4 4 5 20
9 5 30[ 150 3 5 6

10 G 35 200 G 5 7

11 7 400 150 [ 7 8

12 i 45 100 il i 9

13 9 5.0 5.0 9 9 10 15
14 10 5.5 2.5 10 10 "

15, N 5.0 0.0 11 2 12

16 12 35 2.5 12 12 10

17 13 3 12 i
18 14 12 9 :
19 15 3 8

20 | 16 3 9

21 17 4 9

22 18 4 B 5
23 19 4 7

24 20 5 8

25 | 21 5 7

26

27 0
28 | 0 2 4 8 8
28

30

If you want to go further in creating chart it can be continued by setting its properties, such
as line color, marker style and color, or line style (continuous, dashed). The following is
code to set the Chart properties (code enclosed by red lines)

Sub MChartl1()

Dim npt, nin, 1

npt = 12 "no. of joint

nln = 21 "no. of line

ReDim x(npt), y(npt)

ReDim x1(nIn), yi1(nIn), x2(nIn), y2(nin)

"Read joint coordinates
For i = 1 To npt
x(i) = Cells(4 + i, 2)
y(i) = Cells(4 + i, 3)
Next i
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"Read line coordinates

1 To nln

x(Cells(4
y(Cells(4
x(Cells(4
y(Cells(4

+

i, 6))
i, 6))
i, 7))
i, 7))

1
+

+

+

ActiveSheet.ChartObjects("Chart 1')._Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

"creating lines

For 1 =

1 To nIn

With ActiveChart

End

-SeriesCollection._NewSeries
.SeriesCollection(i).XValues
.SeriesCollection(i).Values
-SeriesCollection(i)-Name =
With

= Array(x1(i), x2(i))
Array(yl(i), y2(i))

ActiveChart.SeriesCollection(i).-Select
With Selection

End

-MarkerBackgroundColorIndex
-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

With

With Selection.Border

End

-ColorIndex = 3 "red
-Weight = xIMedium
-LineStyle = xlIContinuous

With

xINone

xINone

Next 1

End Sub
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The above examples is about setting the type and color of lines, which is respectively,
continuous (xlcontinuous) and red (color index = 3). This code uses Border property of the
Selection object to return Border object with its properties that are ColorIndex, Weight and
LineStyle. Selection represents SeriesCollection(index) object of ActiveChart object that is
an active chart named Chart 1.

3.7 MANIPULATION ON PROGRAM STEPS

An application program (for specific application) built through a sequence of steps that
took quite long process, start from defining problems, to find solutions, build algorithms, to
write and debug the code. An algorithm is defined as a sequence of logical steps in problem
solving.

Algorithm is closely related to the use of the control structures in program that are
branching and looping that have been discussed earlier. In array data basis such as
structural analysis, it is necessary to have little bit of knowledge how to manipulate of
program steps or flow of array data using control structures. For examples, is to read and
print data, changing the composition of elements of an array and create integer variables
for storing data.

Example 1

Given a simple example; look at an array data in the worksheet as shown below. Build
elements of array on the left side to be as on the right side, where only the main diagonal
value will still remain while the other = 0.

A B C D E F G H 1 K L Wyl

1

2 |INPUT QUTPUT

3 1 7 13 19 25 ] 1 0 0 0 0 0
4 2 8 14 20 26 32 0 8 0 0 0 0
5 3 9 15 21 27 33 0 0 15 0 0 0
6 4 10 16 22 28 34 0 0 0 22 0 0
7 5 11 17 23 29 35 0 0 0 0 29 0
8 5 12 18 24 30 36 0 0 0 0 0 36
3

ot
=]

Here is a code to solve Example 1, starts from reading the data, manipulating the data (code
in red line) and print the results:
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Sub EXSTEP1(Q)
Dim i, j, n
ReDim myArray(6, 6) As Integer

"Read input data
For i =1 To 6
For j =1 To 6
myArray(i, j) = Cells(2 + i, j)
Next j

Next i

"Manipulate data

For i =1 To 6

n = myArray(i, i)
For j =1 To 6

myArray(i, jJj) = 0

Next j

myArray(i, 1) = n

Next i

"Print ouput data
For i =1 To 6
For j =1 To 6
Cells(2 + i, 7 + J) = myArray(i, j)
Next j
Next i
End Sub

The code (outlined in red line) is the Author’s version. Every programmer must has own
steps to proceed, based on his/her interpretation in the same problem. Similarly, if you are
a programmer or whose accustomed to use Excel-VBA.

Example 2

Create an elements of an array in Example 1 in sequence from bottom to top or from the
largest subscript (myArray (6,6)) to the smallest (myArray (1,1)).
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The code (The Author’s version):

Sub EXSTEP2()

Dim i, j, m, n

ReDim myArray(6, 6) As Integer
ReDim rvArray(6, 6) As Integer

"Read input data
For i =1 To 6
For j =1 To 6
myArray(i, j) = Cells(2 + i, })
Next j

Next 1

"Manipulate data

m=20
n=2~0
For i = 6 To 1 Step -1
n=n+1
For j = 6 To 1 Step -1
m=m+1
rvArray(J, 1) = myArray(m, n)
Next j
m=20
Next i

"Print data
For i =1 To 6
For j =1 To 6
Cells(2 + i, 7 + J) = rvArray(i, j)
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Next j
Next i
End Sub

Example 3

Assemble the upper triangular array on the left side into the arrangement shown on the
right side, as below.

A B c D E F G H ] K L M N

INPUT OUTBUT
7 13 19 25 31 1 7 13 19 25 31
3 14 20 26 32 2 14 20 26 32
9 15 21 27 33 15 21 27 33

10 16 22 28 34 22 28 34

11 17 23 29 35 29 35

12 13 24 a0 36 36

| | g [ o [

5 RN RS = AT R RS RS

=
(=

This example is made as an exercise for readers to make their own code. As previous
examples, the data manipulation in this example is done and completed within two looping.
Use always the Debug menu to verify the program steps. Good luck and hopefully these
examples are helpful to develop your Excel-VBA skill.

Note:

An algorithm or in the (Author’s) other words is a manipulation on program steps (flow)
is basic procedure to tell computer how the program will be executed step by step.
Although it may formally a guideline to be followed but everything is gained from
experiences and also exercises. So, the coding more depends on instinct or
interpretation of an author on the problems faced. However, it was still agreed that the
fewer steps needed to solve a problem, the better the program built, meaning the faster
execution time by the computer. Thus, it is not because of the fewer program lines
created.

A Note for Beginners:

If you are a beginner in program algorithm, it is fine because your lesson has just started
here. Run the program code of Example 1 and 2 step by step using the Debug menu (for
example by pressing F8) and be focused on the code in the red lines. In break mode, see
how the algorithm for both examples and try to understand the idea behind those code
writing. After you have understood, try to solve Example 3 or any problem you define by
yourself, for example that are developed from Example 1 and 2.
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CHAPTER 4

MATRIX PROGRAM

The calculation using matrix operation is very suitable and easy to be performed by a
computer. Thus, in line with rapidly growth of computer usage, matrix method is becoming
very popular and widely used instead of the analysis with manual method. It is widely used
in mathematical siences or in civil engineering field.

4.1 MATRIX DEFINITION

A matrix is a rectangular array which involves a series of numbers of constituent
components or elements.

Example:
all a‘12 aln
a'21
a
A — 31
_aml amz amn i

The notation for a matrix is usually used [] and () or {} for row or column matrix. A matrix
can be written [A] = [a;], where ajj is element of the matrix, i =1,2,.. mand j =12, .. n.
Subscript m indicates the number of rows and n for the number of column, or called has
order (m x n). If m = n, then called a square matrix.

4.1.1 TYPES OF MATRIX

1. Row matrix or row vector, where m = 1.
Example: {1 2 3 4}

2. Column matrix or column vector, where n = 1.
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Example:

AW o o~

3. Square Matrix
Diagonal matrix

All elements = 0, except in the main diagonal.

1 0 00
0 2 00
0 0 30
0 0 0 4

Upper Triangular Matrix

All elements under the main diagonal = 0.

a‘l 1 a‘12 a‘l 3 a‘14 a‘l n
0 a‘22 a23 a'24 a2n
O 0 a33 a‘34 aSn
0 0 0 a, a,
0 0 0 0 a,

Lower Triangular Matrix

All elements above the main diagonal = 0.

a, O 0 0 0
a, a, 0 0 0
a; a; a; 0 0
ay 8y 8y Ay 0
- - - - 0

[ @mi my 8z 8py Amn
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Scalar matrix

Scalar matrix is a diagonal matrix where the diagonal elements are the same number.

R
S © ~ O
S b~ O O
~ O O O

Unit matrix

Unit matrix is a scalar matrix in which the value of elements = 1. This matrix is also
called identity matrix and generally denoted by [I]. Multiplying by [I] will return the
origin matrix.

1 0 00
01 00
0 010
0 0 01

Band Matrix

Band matrix is a square matrix (n x n) where the non-zero elements are grouped and
form a diagonal elements band.

a, a, 0 0 0 0
a, a, 0 0 0 0
0 0 a, a, 0 0
0 0 a, a, .. O 0
0 0 0 0 .. &, &,
(0 0 0 0 . a,, a,

Symmetric matrix
A matrix [A] is announced symmetric if,
[A]"= [A] or ajj = aji

Example:
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4.1.2 MATRIX OPERATION

Matrix Addition and Subtraction

If [A] and [B] are two matrices that have equal dimension, then they can be added.
If [A] = [a;5] and [B] = [bjj] returns [C] = [Cjj], it is written:

[C] = [A] + [B]

cij = a; + bjj for each i dan j.

Example

2 4 3 0 -3 2

A=l s 4pBI=l4 2 -3
240 4-3 3+2] [2 1 5
A= 14 542 4-3] |5 7 1

Subtract [B] from [A] is equal to add [A] with [-B] or written: [A] - [B] = [A] + [-B].
Matrix Multiplication

Multiplication of two matrices, [A] (m x n) by [B] (n x p) will return [C] of order (m x p).
When do the matrix multiplication the number of columns [A] must be equal to the number
of rows [B].

If [A] = [ay], [B] = [by] and [C] = [Cy] then,
Cij = anbyj + Qizbzj + ... + Aimbm

or written as,

m
Cj = Zaikbkj
k=1
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Example 1

a, ap b, by,
[A] = a, ay ,[B]:L)21 b }

a‘31 a32

11 12 b11 b12
[C] = [A] X [B] = a21 a22 b21 b22

allbll + a12b2l allblZ + a12b22
= aZlbll + a22b21 a2lb12 +a22b22
_a3lb11 + a‘32b21 a3lblZ + a32b22

Example 2

[A] =

N BN

3
| [B]_{s 3}
4l -1 5

2 3 3 3
(=[xl = (41 L 5}
7 4

[23+3.-1 23+3.5
_|43+1.-1 43+15
_7.3+4.—1 73+4.5

321
_ 1117
117 41

Matrix Inverse

Division is not defined in a matrix operation, for it used the inverse of a matrix. Matrix
inversion is only done on square matrix and written with the notation [ ] -1 . Multiplication
by matrix inverse is a division by the matrix. For example: [A] x [B] = [C] where [A] is a
square matrix, the equation can be written into a division operation: [B] = [A] -1 [C]. [A] -1 is
called the inverse of [A].
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Matrix Transpose

If [A] is a matrix of order (m x n), then the transpose of [A] is a matrix of order (n x m) or
written as [A]T. Rows and columns of [A] become the columns and rows of [A]T.

[B] = [A]"
bij = aji

Example

Some properties associated with matrix transpose:
([A]D)T = [A]
([Al+[BD" = [A]" + [B]"

(AI[B])" = [B]" [A]*

System of Linear Equations

Many problems in civil engineering are represented by systems of "n" linear equations with

unknown number "n" and this can be solved using matrix methods. It is often, the number
of equations equal to number of unknowns.

Example: two systems of equations
3x+2y=9
5x-y=2

When expressed in matrix form it becomes:
32 0x] |9
5 -1yl |2
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In general form, "n" linear equations with "n" unknown number can be expressed as:

all a'12 a13 aln Xl bl

a21 a‘22 a‘23 o aZn X2 bZ

a‘31 a'32 a‘33 o a‘3n X3 = b? (4.1)
_anl anz a’n3 ann__Xn_ _bn_
and simplified into:
[A]{X} = {B} (4.2)

where,
[A]  square matrix represents coefficients of Equation 4.2
{X}  unknowns column vector

{B}  constants column vector

Simply to say that the solution of systems of "n" linear equations in matrix form as
expressed in Equations 4.2 is finding {X}, where [A] and [B] are known values. There are
many methods used out there to solve Equation 4.2, some will briefly be discussed in
examples below.

1. Elimination - Back Substitution
Example

2x+3y=7 ..(1)

3x-2y=4 ..(2)

This is an example of two linear equations with 2 unknowns, x and y.
Elimination

Eliminate x from both equations by subtracting Equation 2 from Equation 1 that has
been given a multiplying factor (Eq. B1):
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21
2x+3y=7 .. (1)xi > 3x + 2}/: — ..(B1)
2 2 2
3x-2y=4 (2)
[ENNER
> y
y=1
Back Substitution

Substituting y value back into Equation 1, then we have x = 2.

X 2
Thus, solution for the unknowns {X}: { } = { }

2. Directly get the inverse of [A] or [A] -1
From Equation 4.2:
[ANX} = {B}
Multiply both matrices by [A]-1:
[A][A{X} = [A]1{B}, it is known [A]-1[A] = [I]
[I{X}=[A]"{B}
{X}=[A]"{B} (4.3)
Thus, if [A] -1 is known, Equation 4.3 can be solved.
Example
Given two a system of two linear equations:

2x+3y=7
3x-2y=4

In this example the matrix inverse will be found using by Gauss-Jordan method. The
solution is to put the unit matrix [I] next to coefficient matrix [A] such that when the
process is finished [A] become [I] and the previous [I] become matrix inverse [A] -1
The overall process can be just expressed as:

(A T1]>[1:[AT']
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The process is done through elementary row operation on [A] and [I] as well to
reduce [A] to [I]. Thus, it is a sequence of row operation to turn elements of [A] = 1
on the main diagonal and zero elsewhere. For detail see the following example:

Derive matrix coefficient:

N ERE
(A=,

Put [I] next to [A]:

By

Step 1: From above matrix, divide row 1 by 2

)

Step 2: Add row 2 to row 1 times -3

oN |~
=

T

2 |2 9
0 -130 31

2 2

. 2

Step 3: Multiply row 2 by — )

3 1 0
I = 2 b

21 e —=

l|— 13

26

Step 4: Add row 1 to row 2 times —%

&8 6

1 0% 9
0 1]6 2
26 13
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Thus,

8 6
52 26
A=l 2
26 13

Enter [A]-! into Equation 4.3

{X} = [A].{B}

8 6
X[ _|52 26 |)7
y] |6 _2]4

26 13

104
X _J 52
y] |26

26

So, the solution to this system,

x| 2
y 1
3. Iterative Method

This method is actually an approach and done by taking initial value of the unknown
then corrected or refined to enter the next value. We have examined the iterative
method on the example above in the previous discussion in Chapter 3. Here is now
an example from a system of three linear equations:

S5x+4y+3z=12 (4.4)
4x+ 7y +4z=15 (4.5)
3x+4y+4z=11 (4.6)

The iterative process is quite long, so in this example we will be working with help
of a computer through Excel iteration.

Re-write Equation 4.4, 4.5 and 4.6 into forms below:
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Equation 4.4: x=12/5-4y/5-3z/5 =(12-4y-32)/5
Equation 4.5: y=15/7-4x/7 -4z/7 = (15 - 4x-4z)/7
Equation 4.6: z=11/4-3x/4-4y/4=(11-3x-4y)/4

Next, convert the equations into worksheet formulas and enter in cell B2, C3 and D4.
However, until this stage no iteration to be done because the formulas are still
standing on their own equations.

A | B | ¢ | b | E | F |
1 Eq.1 Eq.2 Eq.3
2 =[12-4"B3- 3B/
3 =(15-4"C2-A*C47
4 z =(11-3"02-4"D3)44
5
b

The iterative process will be carried out after these connections:

The value of y, z of Equation 4.4 = value y, z of Equation 4.5

The value of x, z of Equation 4.5 = value x of Equation 4.4 and z of Equation 4.6
The value of x, y of Equation 4.6 = value X, y of Equation 4.5

In the worksheet, the equations are done as follows:

A E | C | D | E |
1 Eq.1 Eq.2 Eq.3
2 =(12-4"B3-3"B4)5  |=B2 =CZ
3 =C3 =(15-47C2-4"CAT  |=C3
4 z =C4 =D4 =(11-3"D2-4"D33/4
5
B

The iteration steps shown in the worksheet below:

1 x iteration:

A B | C | D | E |
1 Eq.1 Eq.2 Eq.3
2 2.40000 2.40000 2.40000
3 0.00000 0.77143 0.77143
4 z 0.00000 0.00000 0.17857
5
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5 x iterations:

A B | C | D | E |
1 Eq.1 Eq.2 Eq.3
2 X 1.28520 1.29890 1.29890
3 ¥ 1.07655 1. 16637 116637
4 z 0.40995 0.56703 0.60945
]

10 x iterations:

A B | C | D | E |
1 Eq.1 Eq.2 Eq.3
2 X 1.01554 1.01854 1.01854
3 ¥ 1.03905 1.02231 1.02231
4 z 0.84242 0.95088 095379
5

20 x iterations:

A B | C | D | E |
1 Eq.1 Eq.2 Eq.3
2 bt 1.00597 1.00557 1.00587
3 ¥ 1.015294 1.00260 1.00960
4 z 097723 0.93348 098552
5

50 x iterations:

A B | C | D | E |
1 Eq.1 Eq.2 Eq.3
2 1.00046 1.00046 1.00046
3 1.00172 1.00097 1.00097
4 z 0.997584 0.99343 0.99365
]

The iteration process of finding {X} of Equation 4.4 is actually to make ¥, y, z to the same
value on the worksheet columns B, C and D in satisfying the given equations. It appears that
they are very close at 50th iteration and by rounding obtained:

1
=41
|

N < X
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4.2 PROGRAM FOR MATRIX OPERATIONS

Multiplication and inversion of matrix are two main operations in matrix equation found in
most of engineering calculations using matrix method. In this discussion, it will
demonstrate how to create program code for multiplication and inversion of matrix.

Matrix Multiplication

In the following example is given a program to calculate the multiplication of two matrices.
The program is named MMULT1, input data and the results will be done on Sheet1.

Example

Find the multiplication of two matrices in the following equation:

[C] = [A] [B]

where,

2 3 3 3
[A]l=]4 1 ,[B]{ }
7 4 -5

We know that the multiplication of a matrix is the multiplication of element row in one
matrix by element column of other matrix. If done manually as in the example of Section
4.1.2, code to get [C] is:

Sub MMULT1Q)

Dim MA(3, 2) As Double

Dim MB(2, 2) As Double

Dim MC(1 To 3, 1 To 2) As Double

"Read Input Data

"[A] or MA

MA(1, 1) = Cells(6, 2)
MA(2, 1) = Cells(7, 2)
MA(3, 1) = Cells(8, 2)

MA(L, 2) = Cells(6, 3)
MA(2, 2) = Cells(7, 3)
MA(3, 2) = Cells(8, 3)
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"[B] or MB

MB(1, 1) = Cells(6, 5)
MB(2, 1) = Cells(7, 5)
MB(1, 2) = Cells(6, 6)
MB(2, 2) = Cells(7, 6)
"Multiplying

"[C]1 = [Al-[B]

MC(1l, 1) = MA(L, 1) * MB(1, 1) + MA(l, 2) * MB(2, 1)
MC(2, 1) = MA(2, 1) * MB(1, 1) + MA(2, 2) * MB(2, 1)
MC(3, 1) = MA(3, 1) * MB(1, 1) + MA(3, 2) * MB(2, 1)

MC(1, 2) = MA(L, 1) * MB(1, 2) + MA(Ll, 2) * MB(2, 2)
MC(2, 2) = MA(2, 1) * MB(1, 2) + MA(2, 2) * MB(2, 2)
MC(3, 2) = MA(3, 1) * MB(1, 2) + MA(3, 2) * MB(2, 2)

+

Range(Cells(12, 2), Cells(14, 3)).-FormulaArray = MC
End Sub

Worksheet form that fits to the above program code is as below:

! A INEECE F D] , "*ee Enput Dats

|1 |MULTIPLY TWO MATRICES 1

L2 IAfF3e2 MULTIPLY Al oF HA

3 ||Bs 2ud _ MA(L, 1) ells (6, 2)
& |[A][B]= 32 "____________._.—u—-—‘_'_‘_*:u.::.. 1) = calls(7, 2
5| MAL3, 1} = Cellwm(B, 2}
E | fal= 2 3 1 3 MA(L, 2) = Cells (8, 3)
7] 4 1| i 5 MA{2, 2) = Celle(7, 2)
(8| 3 | — = MA{3, 2} = cella(d, 3)
CH \

10 [C] ={AllE] TR

F” __ MB(1, 1) = Cells(6, 5)

1.;. &= MB(2, 1) = Cells(7, &)

ol MB(l, 2] = Cells(6, &

] ——} MB(2, 2] = calls(7, &)

In this example, [A] has order 3 x 2 and [B] has order 2 x 2 to return [C] of order 3 x 2. Input
data of elemen [A] is made on a range of cells (6,2) to cell (8,3), while element [B] on a cell
range (6.5) to cell (7.6). To run the program, click the command button that has been made
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in the worksheet. The results are printed on a range of cells (12, 2) to cell (14, 3), using
statement FormulaArray = [C], that shown below:

TN N - I A0 [ (20 -

1 |MULTIPLY TWO MATRICES 1

2 ||Al=3u2 ULTPLY |

3 [[B]F 22 Jrses, L_n

4 |[AliE)E 322

=

& | A= 2 3 [Bl= 3 3

7 | 1 ' B 5

8 | i L

2

10 |[E] =AlE]

11

- - — = MA . HA{L, 2) = MBi2, 1)

12 [C]= 3 21 = MAL . : MA(Z:, 2} * MBL2, 1)

13 11 17 = MAL . 1} + MAL3, 23 ® MB(2, 1)

14 | 17 T = MA(L b o+ MALL, 2} * MB(2, 2)

151 = MA (2 4 t MAL2, 2} * Ma(2, 2)
= MA(3, * + HA[3, 2} * ME{2, 2)

For a large-sized matrix, the given MMULT1 example is inefficient in term of wasting time
and coding to write code for all matrix (row) operations one by one. Instead, use For-Next
looping for reading input data, to process and print the results. This way saves a lot of code
writing.

The code program of above matrix multiplication can be modified by giving the row and
column indices (i, j and k) to [A], [B] and [C], which is done in three looping below:

Row Col Row Col
8 [A] IB] [A] IB]
! it | .'I".I." JIJIII
' L4
Mol 1) =[MA{1l, 1)]|*[mMB(l, 1)]+[MA(l, 2)]|*|MB(2, 1)
HC (2 1) =IMA(2, 1)]*|HB(1, 1) |+ |HA(2, 2)|*|MB(2: 1)
BT(3, 1) =|MAL(3, 1)]|*|mBi(1, 1)]|+[HA(Z, 2)|*|MB(2. 1)
Mci1l, 21 =|MA(l, 1)|*|mB(1, 2)|+[ma(l, 2}]|*|MB(2. 2)
HC (2, 2) =|MA{2, 1)|*|MB(1, 2)|+|HA(2, 2)|*|MB(2; 2]
Mo, 2) =|Ma3, 1] v|meia, 230+ imacE, 23| |MB (2, 2)
' =
For 2 = 1 To m
For j = 1 To p
Hofi, 3) =0
For k.= 1 Te n
HCti, 30 = meiis 3 +[mAati, k) = MEk. 3]

In a looping above, m and n represents number of rows and columns of [A], respectively,
while n and p represents number of rows and columns of [B]. In the following example, we
will use the modified program code to multiply a 6x6 matrix by a 6x3 matrix. The program
is named MMULT?2.
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Sub MMULT2Q)

Dim m, n, p As Integer

m = Cells(2, 5)
n = Cells(3, 5)
p = Cells(4, 5)

ReDim MA(1 To m,
ReDim MB(1 To n,
ReDim MC(1 To m,

=

To n) As Double
To p) As Double
To p) As Double

o

"Input data [A]
For i =1 Tom
For j =1 Ton
MACE, J)
Next j

Cells(5 + i, 1 + j)

Next 1

"Input data [B]
For i =1 To n

For j =1 To p

MB(i, J) = Cells(5 + i, 9 + j)
Next j
Next i
"Multiplying
"[Al(mxn) x [Bl1(nxp) returns
"[C1(mxp)

For i =1 Tom
For j =1 To p
MC(i, J) =0
For k =1 To n

MC(i, §) = MC(i, j) + MACE, k) * MB(k, )

Next k
Next j

Next i

"Print result
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For i =1 Tom

For j =1 To p
Cells(15 + i, 1 + j) = MC(i, j)

Next j
Next i
End Sub
A B C D|E| F |G | J K| L

1
2 [A] = mxn m=| 6
3 [B] = nxp n=| 6
4 [C] = mxp p=1| 3
5
6 [A] = 20 | 5 0O (0| 0] O [B]={025]|0 |0
7 512000 (0|0} O 025|110
8 0 0 [ 3010 0 | O -0.50[ 1|0
9 0 0 |10 (30| 0 | O -050] 0 | 1
10 0 0 0 (0|12 6 0250 |1
11 0 0 0O [0 6 |12 0251010
12
13
14 | [C] =[A].[B]
15
16 [C] = 6.25| 5 0
17 6.25] 20 | O
18 -20 | 30 | 10
19 -20 | 10 | 30
20 45| 0 | 12
21 45| 0 6
22
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In this program, the printing of the results that used Array Formula has been replaced by
two orders of For-Next looping. The first and second looping is respectively for printing
rows and columns of [C]. This way is much better in term of automation, because we do not
need to calculate the range of the array that will be generated as it has been known = m x p.

Matrix multiplication can also be done in a worksheet using Excel built-in function MMULT
(arrayl, array2). For MMULT?2 procedure example, a formula can be written as follows:

= MMULT(B6:G11,]6:L11).

To print the result use INDEX function or you can enter the formula above as an array
formula. See about array formula in Chapter 1.5.

Matrix Inversion

In finding an inverse of matrix, Gauss-Jordan method is among the most popular method to
be used and programmed, with a process that has been described in the previous section.
The steps are an effort to turn a matrix to be searched its inverse (e.g. [A]) becomes an
identity matrix [I] and at the same time, [I] to [A] -1. That is done by elementary row
operation as ever shown in the previous example.

In the program, this can be done by taking one matrix e.g. [C], such that at the end of the
process [C] turns into [A] -1. In the beginning is to divide the first row by element a1l of
[A], in an effort to turnall = 1 so that c11 =1 / all and this is analogous to that performed
in [I]. If [A] is n x n matrix, then in the first step the first column of [C] is analogous of that
performed in [I], while the second column to column n is analogous of that performed in
[A]. At the end of step 1, the value of [C] of order 3x3 can be written as follows:

1 a, a3
a, a, a,
a,, a, a;
[C] = a,, + a c—a8y Ayt -y
11 11 11
as, a,;, 13
as, + -~ a5 as; + as,
a, 11 11

In the second step, the first and second column of [C] is analogous of that performed in [I],
while the third column to column n is analogous of that performed in [A], etc.

Program for finding inverse is created in VBA and provided here. It notes that matrix
inversion requires square size (say, m x m) matrix and the determinant of matrix must not
be zero. For the purpose to create worksheet form, the maximum element of matrix is
limited to m = 6, but it can certainly be made more than 6.
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Example 1
Find the inverse of [A] = [5].

Solution for Example 1:

(A B c 7 E f ! i | | K L M N ] F
1 INVERSE MATRIX
z & Wanix sizemzm = 1x1 Iverse
3 im @ *:
4
z L 5[a=lnput data INVERSE -> L0 20000
;
(]
1
11
Example 2
Find the invers of,
2 3
[Al=
3 -2
Solution for Example 2:
A B £ o E F G H i ] K L 1] N o P
1 INVERSE MATRIX :
2 z hverse
= Mty sizemxm =2x 2
3 m=
I ® \
] i ] {0 15385] 623077
G ] 3 IR | T R P
]
9
10
11
Example 3

Find the invers of,

1
[A]=|1
1

W A W
nowWoWw

Solution for Example 3:
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r B r L E E ™ i [T L 7] [T Q [
! INVERSE MATRIX

@f-"‘ Matrix sizemuxm = 3x 3 Imverse

Y m=

| J "7 0o000] -3.08000] -3 60000
: ) 3 INVERSE > (750000] 1 oveon]_ ocoa] )

3 y 1.00000] 0 66056 1506600

To find inverse of matrix in worksheet can also be used the built-in function MINVERSE.
The way to use it is the same as MMULT.

VBA code:

Sub Inverse()

On Error Resume Next

m = Cells(3, 2)

ReDim MA(1 To m, 1 To m) As Double
Range("'k5:p10'™) .ClearContents

"Read input data
For i =1 Tom
For j =1 Tom
MACi, J) = Cells(4 + i, })
Next j

Next 1

"Find inverse []
For i =1 Tom
For j =1 Tom
IT jJ <> i1 Then MA(i, j)
Next j

MAGE, §) /7 MAGE, i)

For n =1 Tom
If n =1 Then GoTo 10
For j =1 Tom
IT j <> i1 Then MA(nh, j)
Next j
10 Next n

MA(n, §) - MACi, j) * MA(n, i)

For n =1 Tom
IT n <>1 Then MA(n, 1)

Next n

-MA(n, i) /7 MACi, i)
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MACi, 1) =1 /7 MAGI, 1)
For i1t =1 Tom
For ij =1 Tom
Cells(4 + ii, 10 + ij) = MA(ii, ij)
Next ij
Next ii

Next 1

"Print output data
For i =1 Tom
For j =1 Tom
Cells(4 + i, 10 + j) = MA(, J)
Next j
Next i

End Sub

4.3 MATRIX METHOD FOR STRUCTURAL ANALYSIS

Structure can be analyzed as a series of structural elements which are connected to each
other at endpoint called node. Solution of this system of arrangement of elements can be
expressed by simultaneous linear equations that are made in a matrix form. In matrix form,
then the calculation of the structure becomes easier to be solved with the help of a
computer.

4.3.1 UPPER STRUCTURE

The method that will be used for structural analysis is direct stiffness method. A brief
introduction to the basics of this method will be given here; readers are encouraged to read
other references to supplement the discussion on this topic. In short, the aim using of this
method of analysis is to obtain force - displacement relationship expressed as:

{P} = [KI{X} (4.7)
where, {P} vector of external force acting on node

[K] structure stiffness matrix

{X} vector of nodal displacements
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By deriving [K], thus it can be obtained force - displacement relationship as expressed by
Equation 4.7. One of the processes here is to derive stiffness matrix of an element, then
applied for other elements and put together to form stiffness matrix of the whole structure.
To meet deformation continuity and compatibility between the elements is by superposing
corresponding force - displacement components.

Furthermore, to simplify the calculation we can partition element of the stiffness matrix at
the nodes that are free to displace (free nodes) and fixed (zero displacement at the
supports). If X, represents displacements vector at the support, Xr represents
displacements vector at free nodes, Pr and P, are the external forces vector which
correspond to their displacements, Equation 4.7 can be written as follows:

Pf _ Kff i be Xf
R [Ke 1 KX *8)

If node displacements vector {X,} = 0, then Equation 4.8 can be written:

{Pe} = [Kerl{ X} (4.9)
And
{Po} = [Koe]{Xe} (4.10)

The displacements vector at free nodes is then obtained using Equation 4.9 that becomes
{X¢} = [Ke] {Ps}. If {X¢} is known then the internal forces of the element can be obtained. In
this relation, the internal force of element i is expressed in local coordinate and obtained by
the following equation:

{P}i = {Po} + [K]i{X}H (4.11)
where,

{P,} fixed-end forces: reactions at end of element i due to external load directly
acting on element i

[K]i stiffness matrix of element i in local coordinate system
{X}i deformations matrix = [T]i{Xs}

[T]i transformation matrix of element i

To find the support reactions, it can be directly obtained in the global coordinate of the
structure using Equation 4.10 becomes:
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{Ro} + {Pp} = [Ko]{Xt}
or,

{Rv}= [Kue]{Xt} - {Pv} (4.12)

4.3.2 SUB STRUCTURE

The structure analysis in this subject is to obtain a force - displacement relationship of soil -
structure interaction which is modeled by the means of beam on elastic foundation.
Generally it is solved with the finite element method where the system is built by a series of
finite elements connected at endpoint called node.

Some equations are made in order to find force - displacement relationship at the nodes,
and begins by writing the relationship between external forces at the nodes {P} and
internal forces of element {F} in principle of equilibrium.

The relationship between {P} and {F} is expressed as:
{P} = [AKF} (4.13)
The relationship between node displacements {X} and deformations of element {d}:

{d} = [B]{X}, and from reciprocal theorem it can be shown

{d} = [A]"{X} (4.14)
From elastic behavior of element, the relation between {F} and {d}:

{F} = [S{d} (4.15)
Subsituting Equation 4.14 into 4.15 to get,

{F} = [Si{d} = [S][A]™{X} (4.16)
Subsituting Equation 4.16 ke 4.13 to get.

{P} = [A{F} = [A][S][A]{X} (417)
{X} is unknown displacements to be determined, thus

{X} =([AI[SI[A]" ) {P} (4.18)

Subsituting {X} back to Equation 4.16 to find internal forces {F}.

Equations 4.16, 4.17 and 4.18 are the fundamental equations in the analysis using finite
element method (]J.E. Bowles, 1982).
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CHAPTER S5

NUMERICAL METHOD

Many problems in science and technology involve the use of integral and differential
equations. If the mathematical equation model is quite simple, then it can be solved by
means of analytical method. However, many of those equations are difficult or may be
impossible to be solved analytically. Instead, it must be solved numerically or using
numerical methods.

The result of the numerical method is an approach to its exact value by means of
analytically. Thus, it is just an approximate calculation with estimated accuracy. Numerical
methods will provide many benefits if done by a computer.

5.1 NUMERICAL INTEGRATION

The integral of a function f(x) from a to b is written:

y= Lbf (x)dx

has a broad sense as the area bounded by the curve y = f(x) and the X-axis, the between x =
aandx =b.

Analytical solution to integral or exact solution is:
b b
y=[ F00dx=[F(x)]=F(a)-Fb) (5.1)

where, F(x) is an anti-derivative of f(x) such that F'(x) = f(x).

Numerical integration to calculate area under the curve uses the concept of approach
whereby the area is divided into smaller pieces of area in such that, if combined the total
area of the pieces approaching the exact result. In this example we will use trapezoidal
method where the area under the curve is divided into small pieces of area with sides f(xn)
and f(xn-1) that resembles a trapezoid as shown in Figure 5.1.
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Figure 5.1: Trapezoidal method for approximating area

Trapezoids are having the same width for Ax, if there are n intervals (or n trapezoids) from
a to b, then the Ax = (b - a) / n as shown Figure 5.1. Figure 5.2 shows the comparison
between the area obtained from the total area of the trapezoids and the exact results
obtained using Equation 5.1. The formula to find total area (L) is given by:

L =%((f(xo)+ FOO)+ (PO + T + o+ (F (X)) + T(X) (5.2)
=%(f(xon2f(x])+2f(x2)+2f(x3))+...+2f(xn4)+ f(x,)) (5.3)

¥ i

fiw) fixd

/“”"’Fﬁ“\ "

Figure 5.2: The comparison of area resulted from trapezoids (left) and the exact one
(right)
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Figure 5.1 and 5.2 show, the calculation by means of trapezoidal method is getting closer to
the exact result when taking more trapezoids into account, or by making smaller Ax.

Furthermore, to complement this discussion we will examine the given example below via
VBA.

Example

Find the area bounded by the parabola y = 4x - x2, the X-axis, from x = a and x = b. Find also
the exact value.

Solution

VBA code

Function Trapez(a, b, n)

a = Cells(3, 2)
b = Cells(4, 2)
n = Cells(5, 2)

Dx = (b -a) /n

X = a
For i =2 Ton -1
X = X + Dx
Sum = Sum + 2 * f(X)
Next i

Sum = Sum + (@) + f(b)
Trapez = Sum * Dx / 2
End Function

Function f(X)
f=4*x-xn2

End Function
Function integf(x)

integF =2*x722-1/3*x"3

End Function
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In this experiment, we take a = 0 and b = 4 respectively, for n = 10 and 100. The values of a,
b and n are then used as function arguments of Integf and Trapez in the above program.
The use of function in the worksheet and the results are shown below:

USING FUNCTION:

A | B [ c [ b [ E |
_1 |Trapezoidal Method
2
3 |a= 1]
| 4 |b= 4
| 5 |n= 10
B | Type this formula in cell BT
| 7 |Anum=|=trapez{B3,B4,B5) ‘/“/'Type this formula in cell B8
| 5 |A exact = =integf(B4)-inte gf{B3)
=R
RESULT:
A | B [ ¢ [ D | A | B8 [ ¢ [ D |
1 |Trapezoidal Method 1 |Trapezeidal Method
2 2
| 3 |a= a | 3 |a= 1]
4 b= 4 4 |b= 4
[5 |n= [ 5 |n=
6 | v 6 | ¥
7 [Anum= 9934 7 |Anum= | 10.B500E
| 8 A exact = | 10.66667 | G |Aexact= 10.66667
g z

In the worksheet, the area calculated using trapezoidal method and its exact value is
respectively expressed as A_num and A_exact. This experiment shows that the smaller
width of trapezoids taken with n = 100, the closer A_num to A_exact, compared with n = 10.
However, the more thorough results requires a longer calculation process and it is certainly
suitable done with the help of computer.

The other methods for approaching area, for examples are by the Simpson method and
Gauss quadrature.

5.2 NUMERICAL DIFFERENTIATION

Differential equation is any equation that contains derivatives of function.

Examples:

dv d?x
F=ma=m—=m >
dt

(5.4)
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d’v. M

=— 55
dx* El (5:9)
ou o’u
—=c 5.6
ot v oz’ (5-:6)
Description:

e Equation 5.4 is Newton's second law of motion that states force (F) acting on an
object = mass (m) of the object multiplied by its acceleration (a) where, acceleration
(a) is the first derivative of velocity (v) with respect to time (t) and the second
derivative of position (x).

e Equation 5.5 shows the relationships between bending moment (M) at any point on
the X-axis and transverse deflection (v) of the beam. EI is flexural rigidity of the
beam.

e Equation 5.6 is the partial differential equation of one-dimensional consolidation,
where u, t, z are respectively, excess pore-water pressure, time and the depth of clay
layer. Cv is a coefficient of consolidation where the value is assumed to be constant.

Numerical differentiation solution is an approach to continuous differential form into
discrete or finite model. In this discussion we adopt Taylor approach for it is among the
most popular and widely used in introducing numerical approximation. Taylor theorem for
approaching a function is graphically shown in Figure 5.3.

y4

fx)

Taylor theorem:

gt

& 0‘_ X

A o a\g'(‘
e

order( -
constant

i i+1
- X

Figure 5.3: Taylor theorem for approximating a function
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The value of the function at point xi+1 located at a distance Ax from point Xi can be
approximated by Taylor series below:

2 3 n
) = OO+ 100 T 0 700 S £7(x) S+ R (5.7)

where,
- All derivatives of function through the point (x;, f(xi)).
- Rn: truncation error when the series counted up to n-order.

Taylor series will give an estimation of the function correctly if all derivatives in the series
are taken into account, where n = infinite number. However, in practice, the use of Taylor
series is done by simply taking the first few terms of the series.

Equation 5.7 of the Taylor series can be derived into the discrete form (finite) as shown in
Figure 5.4. The estimation of first derivative of a function f'(x) is approached through
several slope of the line through the value f(x) at x = xi.1 (point A), x = x; (point B) and x =
xi+1 (point C) as in Figure 5.4. From Equation 5.7, with respect to first derivative:

f(x.,)="Ff(x)+f (x)Ax+Rn

or,
of o o f(x.)-f(x)
po f'(x,)= o Rn (5.8)

Equation 5.8 is called forward difference formula.
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f(x)
, forward difference
- central ifference

r(x)
Aackward difference

-

=y

Figure 5.4: Estimation of first derivative of a function

Moreover, backward difference formula is given by:

of f(x)— f(x.) + RN

_— f ! L) =
s 0 = (5.9)
Central difference formula:
of f(x,)— f(x_)
— f' ) = i+1 i—-1 R
oX (x;) 2AX £ (5.10)

If the function contains two independent variables such as f(x, y), then the derivatives in
the Taylor series will have the following form:
of Ax of Ay 0°f AX O°f Ay’ o"f Ay"

f(X,,¥y.,)=fX,y)+——+——+ + +... ,
KoY = T Y S Sy 1 T a2 Ty 2 Ty (511)

Equation 5.11 can be written into the following:
Forward difference formula of first derivative:

i~ fi+1,j B fi,j
OX AX
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ﬂ~ fi,j+1 - fi,j
oy Ay

Central difference formula of first derivative:

iN fi+1,j B fi—l,j
OX 2AX
iz fi,j+l - fi,j—l
oy 2Ay

Central difference formula of second derivative:

o f fH)j—2fivj+ f
ox’ AX®

i+1,]

Q

o f  f,-2f +f
oy’ Ay*

i,j+l

Q

Subscript i, j on the function f(i, j) is a simplification of f(xi, yj) form. A grid points of
function values in the xy coordinate system is shown in Figure 5.5, it is used to estimate
derivative of partial differential with respect to x and y.

Vi
(i, jF1)
alr o
ay
1. f (i, f {i+1. f)
JI | | ‘If- J'l ’J J’I -“J _ﬂ
(i, F1)
F1 t
Ax
- -

Figure 5.5: Two dimensional grid points of a function
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Taylor’s discretization method whereby derivative of a function is approached as the
difference value of a function between the given independent variable (e.g. x1) and a small
increment (e.g. x1+Ax), is called the Finite Difference Method (Gilberto E.U, 2004). An
approach using finite difference method implies that the smaller Ax is used the better the
result closer to the exact value as shown from an approach of slope of the line in Figure 5.4.

In Chapter 10, we will build a program using finite difference method for the one-
dimensional consolidation based on Equation 5.6. In the process, it is necessary to put a
multiplier into input data to divide interval of the independent variables (e.g. Ax) to be
smaller so that the solution is expected close to exact result. Program is created in VBA and
of course, with the advantages of making chart automation to present the result.
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CHAPTER 6

PROGRAM FOR 2D FRAME STRUCTURE
ANALYSIS

The matrix program as described in Chapter 4 is now implemented for analysis of structure
in this chapter and the next few chapters. It is expected that these series of references for
Excel-VBA programming will be complementary, as basic knowledge for readers to make
an application program.

Please differentiate between the purpose of programming in Excel and the aim to build an
executable program (using Visual Basic or C++ programming language). Using Excel means
the program as a whole to be convenient and practical for it is created case by case. Each
case is packed in such a way to utilize the facilities on the spreadsheet and then presented
as in creating a technical report. This is consistent with the nature of working with Excel.

6.1 CASE EXAMPLE

Structure of plane frame is composed of 3 members with 4 m long each. The stiffness of
member BC is 2 times of the stiffness of members AB or CD. Point B, and C are the free
nodes, each has 3 displacement components.

1 ton

q =0.6 ton/m’'
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All members of the frame are made of the same linear elastic material with modulus of
elasticity, E = 2.1 x 10¢ ton/m?2. Dimension of member AB = BC = CD =30 cm.

The given load as the following:

e Known external load:
Hatnode B=0.5 ton
Vatnode C=1 ton
Uniform load, q at member BC = 0.6 tom/m’

e Uniform load, q is converted to equivalent nodal loads at B and C
(see sign convention in Fig 6.1)
Pgcm) = - Pcwy = 1/12.q.L2 = -0.8 ton.m.

Pevy = Pcvy = - %.q.L = -1.2 ton.

Sign convention represents the direction of the forces - displacements with reference to
either the global coordinate or the local coordinate. It is set as follows: axial and shear
forces follow the right-hand rule and the moments follow the right-hand screw rule, or in
the easy way it is evident from Figure 6.1, i.e. positive when in the direction of the positive
axis.

[ 5 [ 8 Positive direction

B 4 C for forces and
— - displacements

3 12

Figure 6.1: Force and displacement components at nodes in global coordinate system
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Figure 6.3: Members force and displacement components that conform to global
coordinate system

The process of frame analysis consists of the following steps:

1. Stiffness matrix for plane frame member is derived as the following:
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[K]i=| -=—

0

12El
L3

6El
L2
0

_12El

L3
6El
L2

0 =
6El
LZ
4El
L
0 =
6El
L2
2El
L

0
6El

2El

6El
-0
4El

(6.1)

2. Transformation matrix to convert vector components from local coordinate to global
coordinate is as the following:

For 6 force - displacement vector components of each member,

[T]i=

cos o

—sina

0

0
0
0

aBC=0

i o AB = 90°

sina 0 0
cosa O 0
0 1 0

cosa

0 0
0 0 —-sina cosa
0 0

0
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0
0
0

sin &

0

aCDh= 270°
C

- o O O o O

(6.2)
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3. Member stiffness matrix in the global coordinate system:
[K]s = [T]iT[K]i[T]i (6.3)

Member stiffness matrix is then superposed with other member, which altogether
form global stiffness matrix or called [K] structure. This process is written:

Superpose [K]s = [K] structure (6.4)
4. Displacements at the free nodes to be determined by Equation 4.9 that becomes:
{Xe} = [Ks] 1{Pg} (6.5)

5. Internal forces on each member can be found by firstly transforming displacements
from global coordinate back to local coordinate,

(X3 = [T]i{Xi}

After the displacements of member {X}i are obtained, then internal forces on each
member can be found using Equation 4:11:

{P}i = {Po} + [K]i{X}I (6.6)
6. Support reactions are determined using Equation 4.12:

{Rv} = [Kot[{Xt} - {Pv} (6.7)

From above sequence of process then we can create a simple program for frame structure
analysis named FRAME2D.

Programming:

In designing matrix program, it is convenient to mastering design-build in matrix-based
data. In this relation, is how to make matrix variables of Equation 6.3 to 6.7. There are a few
things in coding that actually require a little imagination of a programmer.

For instance is how to assembly [K] structure. For that purpose, it requires to manipulate
program steps, so that [K] members can be placed on their position in [K] structure. The
idea is simply creating an integer variable, namely dindex, to equalize subscripts of [K]
member. Dindex reads index (numbering) of members joint displacements in the global
coordinate system and uses the subscripts to store [K] members in [K] structure and do the
superposition at once.

The program code is as follows:
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"Member end-displacements index:
For i = 1 To NM
With Member (i)

dindex(1, i) = 3 * .J1 -
dindex(2, 1) =3 * .J1 -
dindex(3, i) =3 * .J1
dindex(4, i) =3 * .J2 - 2
dindex(5, i) =3 * .J2 - 1
dindex(6, i) = 3 * .J2
End With
Next i

"Storing members and superposition
For i = 1 to NM "NM= no. of member
For j =1 To 6
For n =1 To 6

s(idm@, i), Idm(n, 1)) = S(dm(g,

Next n
Next j

Next i

Notes:

1), ldn(n, 1)) + M@, n, )

e Idm variable is the same displacement index as stated by dindex variable, but
declared at a different level. Idm is at public-level, while dindex is at procedure-
level. For more clearly understand how these variables are proceeded you can see in

FRAME2D code provided in the Attachment.

e The above code is for completion of the description (6.4).

The other thing is to partition (separation) of the structure stiffness matrix to form [Kg]
and [Kbyf] as written in Equation 4.8. To do this, it uses two integer variables namely Ifr to

form [K¢] and Ifx to form [Kbye].

The sequence of steps to partition the structure stiffness matrix is as follows:

1. Creating displacement index at free nodes and supports

"Joint free displacement index,

n=1
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j=1
For 1 = 1 To NP

IT Rs(i) = 0 Then IFr(n) = i: n=n+1
Next i

n=1

For 1 = 1 To NS

n = Cells(22, 1 + i)
IFX(B@* i -2)=3*n-2
IFX(3* i -1)=3*n-1
IFX(3 * 1) =3 *n

Next i

2. Sub-matrix [Kg] is obtained as follows:

"submatrix Stiffness, KFF
For i = 1 To DOF
For J = 1 To DOF
SD(i, J) = GS(Idj(i), 1di())
Next j
Next i

3 Sub-matrix [Ky] is obtained as follows:

"submatrix Stiffness, KBF
For i = 1 To DOF
For j =1 To 3 * NS

SR, 1) = GSUri@), 1dj(i))
Next j
Next i

Notes:

e Rsrepresents joint displacement condition at supports, 1 = fixed, 0 = free.

e NS =no. of supports

e Variable Idj = Ifr, Irj = Ifx, but they are declared at different level which is at public and
procedure level, respectively. See FRAME2D code provided in the Attachment.
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The input and output data in form of FRAME2D program are presented in Figure 6.4. Below
are the results of each step of the analysis.

Member AB

[K] (member stiffness matrix)

47250.00| 0.00 0.00 |-47250.00| 0.00 0.00
0.00 265.78 | 531.56 0.00 -265.78 | 531.56
0.00 531.56 |1417.50 0.00 -531.56 | 708.75

-47250.00] 0.00 0.00 | 47250.00 0.00 0.00
0.00 -265.78 | -531.56 0.00 265.78 | -531.56
0.00 531.56 | 708.75 0.00 -531.56 |1417.50

[T] (member transformation matrix from local to global coordinate system)

0.00 1.00 0.00 0.00 0.00 0.00
-1.00 0.00 0.00 0.00 0.00 0.00
0.00 0.00 1.00 0.00 0.00 0.00
0.00 0.00 0.00 0.00 1.00 0.00
0.00 0.00 0.00 -1.00 0.00 0.00
0.00 0.00 0.00 0.00 0.00 1.00

[K]s = [T]iT[K]i[T]i (member stiffness matrix in global coordinate)

265.78 0.00 -531.56 | -265.78 0.00 -531.56
0.00 |47250.00| 0.00 0.00 [-47250.00, 0.00
-531.56 0.00 1417.50 | 531.56 0.00 708.75
-265.78 0.00 531.56 | 265.78 0.00 531.56
0.00 [-47250.00, 0.00 0.00 [47250.00| 0.00
-531.56 0.00 708.75 | 531.56 0.00 |1417.50
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Member BC

[K]

59850.00f 0.00 0.00 |-59850.00| 0.00 0.00
0.00 540.15 | 1080.29 0.00 -540.15 {1080.29
0.00 1080.29 | 2880.78 0.00 -1080.29 | 1440.39

-59850.00, 0.00 0.00 59850.00 0.00 0.00
0.00 -540.15 |-1080.29 0.00 540.15 |-1080.29
0.00 1080.29 | 1440.39 0.00 -1080.29 | 2880.78

[T]

1.00 0.00 0.00 0.00 0.00 0.00
0.00 1.00 0.00 0.00 0.00 0.00
0.00 0.00 1.00 0.00 0.00 0.00
0.00 0.00 0.00 1.00 0.00 0.00
0.00 0.00 0.00 0.00 1.00 0.00
0.00 0.00 0.00 0.00 0.00 1.00

[K]s

59850.00| 0.00 0.00 -59850.00 0.00 0.00
0.00 540.15 | 1080.29 0.00 -540.15 |1080.29
0.00 1080.29 | 2880.78 0.00 -1080.29 | 1440.39

-59850.00{ 0.00 0.00 59850.00 0.00 0.00
0.00 -540.15 |-1080.29 0.00 540.15 |-1080.29
0.00 1080.29 | 1440.39 0.00 -1080.29 | 2880.78
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Member CD

[K]

47250.00| 0.00 0.00 |-47250.00| 0.00 0.00
0.00 265.78 | 531.56 0.00 -265.78 | 531.56
0.00 531.56 |1417.50 0.00 -531.56 | 708.75

-47250.00, 0.00 0.00 | 47250.00 0.00 0.00
0.00 -265.78 | -531.56 0.00 265.78 | -531.56
0.00 531.56 | 708.75 0.00 -531.56 |1417.50

[T]

0.00 -1.00 0.00 0.00 0.00 0.00
1.00 0.00 0.00 0.00 0.00 0.00
0.00 0.00 1.00 0.00 0.00 0.00
0.00 0.00 0.00 0.00 -1.00 0.00
0.00 0.00 0.00 1.00 0.00 0.00
0.00 0.00 0.00 0.00 0.00 1.00

265.78 0.00 531.56 | -265.78 0.00 531.56
0.00 |47250.00| 0.00 0.00 |-47250.00 | 0.00
531.56 0.00 1417.50 | -531.56 0.00 708.75
-265.78 0.00 -531.56 | 265.78 0.00 -531.56
0.00 |-47250.00[ 0.00 0.00 47250.00 | 0.00
531.56 0.00 708.75 | -531.56 0.00 1417.50
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Partition at free nodes = [Kg]

4 5 6 7 8 9
60115.78 0.00 531.56 |-59850.00f 0.00 0.00
0.00 |47790.15|1080.29| 0.00 -540.15 |1080.29
531.56 | 1080.29 |4298.28| 0.00 -1080.29 |1440.39
-59850.00f 0.00 0.00 |60115.78| 0.00 531.56
0.00 -540.15 |-1080.29| 0.00 |47790.15|-1080.29
0.00 1080.29 |1440.39| 531.56 |-1080.29 |4298.28

O ([0 |3 |0 |01 | »

Partition at support nodes = [Ku]

4 5 6 7 8 9

1 |-265.78 0.00 -531.56| 0.00 0.00 0.00
2 0.00 |-47250.00| 0.00 0.00 0.00 0.00
3 | 531.56 0.00 708.75 | 0.00 0.00 0.00
10 | 0.00 0.00 0.00 |-265.78 0.00 -531.56
11 | 0.00 0.00 0.00 0.00 |-47250.00| 0.00
12 | 0.00 0.00 0.00 | 531.56 0.00 708.75

0.00000
0.00000
0.00000
0.00117
—-0.00002
—-0.00039
0.00117
—0.00005
0.00017
0.00000
0.00000
0.00000

Joint displacements at free nodes : {Xg} =

After getting {Xf} then member deformations are calculated by using relationship:
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{XH = [T]i{Xt}

Member internal forces are calculated by using Equation 6.6:
{P}i = {Po} + [K]i{X}i

Support reactions are calculated by using Equation 6.7:

{Ro} = [Koel{Xt} - {Pv}

The result of the analysis is presented in FRAME2D input-output form as shown in Figure
6.4 and 6.5 below:

R [ = Pl [ i N [ [ [ H J K L M

1 |[FRAMEZD v.1.0 (Pregram for plane frame analysis)
=4
|3 |Title Framel
L4 M= 4 Soale 01 or 0y
| 5 {hM = 3 1: true scale - Beam Ex. Plot Geometri RUN Program
| B | O:auto scale - Frame Ex.
7 |IHPUT
8 |Joint Coordinstes:
9 |Jaint Ma. 1 2 3 4
10 [X_coord oo 0o 4.0 4.0
11| _coord on 4.0 4.0 0o
12 |Element Information: ;
13 [N, i 2 EIl S [FRAMEZD Ex.xis]Sheet1 Chart 1
14 [ 1=t 1 2 3
15 | 2nd 2 3 4
16 |Density 0.00 0.00 0.00 Geometry
17 |A Sec 0.0a0 0114 0.030
15 |E 210E+06 ] 2A0E+06 | 2 10E+06 45
19 [Inettia £ 0.00067S  0.001372 0000675 4 & e J3
20 35 4
21 [Support Condition: 3]
22 Mo, 1 4
2R x 1 1 25
24 Ry 1 1 2w M [ B
25 R z 1 1 154
26 [Joint Load: 1
27 |Joint 2 3 05 4
28 [Px 0.50 000 i . "
29 [Py .00 -1.00
= v oo .00 i 05 1 15 2 25 3 15 4 45
31_|Uniform Load: M= & MM = 3
32 [Memno. | 2
33 [Load* | oo
34 {Mote: *Perpendicular to member axis (unit FL*-1)
3s

Y I (T ] ) E | F | 6 | H T T € [ [ o N [ o [ P [ @ | R ]
34 |Note: *Perpendicular to member axis {unit FLA1)
gg"ouwm
ar Joint Load - Displacement T Member End Forces | Support Reaclion |
38 Joint [ Px ] Py Wz Dk | Dy | Rz |NofLength] 1-Axdal | 2-Shear | 3-Mom [ 4-Adal | 5-Shear | 6-Mom |  Joinl | Rx Ry Rz |
El 1 0000 0.000 0.000 000000  0.00000  0.00000 1/4.0 0.970 0102 0343 -0970,  -0.102 0.064 T -0102 0970 0343
40 7] 0500  -1.200  -0.800  0.00117 -0.00002 -0.00039 2J4.0 0.398 0970 -0.064  -0.398 1430 -0.855 4 0398 2430 0737
| 3 0000 -2.200 0.800 000117 -0.00005  0.00017 34.0 2.430 0.398 0856  -2430  -0.398 0.737
ig | 4 0.000 0.000 0.000 000000  0.00000  0.00000

Figure 6.4: FRAME2D input-output form
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u [ [w T ow [y ]z | s [ A [ ac [ ap [ A | A [ Aas [ AH [ oA | A

4.5 4

Displacement Shear

4.5

35 4

2.5

1.5

0.5

354

25 H

1.5H

054
o

0s 1 15 2 25 3 35 4 45 5 -0s o 0s 1 15 2 25 3 35 4 4.5

Max Displacement, J2=000117 hax Shear, J.3=-1.430

Moment Axial

5 45

4 354

254

1 151

5 0.5

1} 1 2 3 4 5 a s 1 15 2 25 3 35 4 45

Max Moment, J.3 = -0.855 i Axial, J.3=-2.430

Figure 6.5: Charts of displacement, diagrams of bending moment, shear force and

axial force

Notes for FRAME2D input and output form:

Data input is blue text.

Scale for presenting output data is divided into 2 cases: true scale for beam members
(continuous beam) and auto scale for frame structure.

NM: number of structural members

NJ: number of joints or nodes

FRAME2D distinguishes 3 types of loading: selftweights by inputting material
density (row 16), nodal loads (row 27 to 30), and uniform loads (row 32 to. 33).
When Plot Geometry button is clicked it shows Chart Window of the geometry of
structure to give geometry verification to that inputted before the program is
executed by clicking RUN Program button. It is expected to minimize kind of errors
that caused by numbering system of the members and joints.

Chart Window command used in Plot Geometry is only compatible with Excel 2003
and earlier, which is a version where FRAME2D was created (also the next few
programs). When running it in Excel 2007 version, Chart Window (as shown in
Figure 6.4) will not be displayed. However, readers can see it placed before
displacement chart in the input-output form.
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Figure 6.5 shows chart of displacement as well as diagrams of moment, shear and
axial forces that are drawn automatically within the program. It is also included
maximum values occurred on nodes. Sign convention used for presenting diagrams
of the moments and internal forces is described in Chapter 6.2.

The above calculation does not show the optimum result as the displacement of the
second member looks like a straight line, contrary to the fact that the member is
subjected to uniform load of 0.6 t/m'. Therefore, it is necessary to expose the result
thoroughly by dividing all members into smaller members.

With the intention of the above point, the frame members is now re-inputted into
smaller members, so that it becomes NM = 12, and NJ = 13. The results are then
shown in Figure 6.6 and 6.7.

The displayed geometry in chart window (only available in Excel 2003) from re-inputted

data is shown below:

S [FRAMEZD Ex.xls]Titel2 Chart 1

B w 8
Geometry
4.5
4 ._ME .-. { =g . AL .-. {rd . AT .-. (<] . {1 [=] Jg
35 14 (k]
34 Ji
25 W M2 RO
Moo J =
15 W M2 R
1 &z Jiz
0.5 M i
u} H T T T T T T H |
o 05 1 15 2 25 3 35 4 45
M=13 M =12
m n |
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a [ e | ¢ [ D E [ F T e T w [ 17 T 4 T k& L [ wm [ nm ]
1 |FRAME2D v.1.0 {Program for plane frame analysis)
2
3 |Title = Framez2
4 M= 13 Soale 0 arm
5 |Mk = 12 1: true scale - Beam Ex. Flot Geomaetri RUM Frogram
[} 0:auto scale - Frame Ex.
| 7 |IHPUT
& |Joint Coordinates:
9 |Jaint Ma. 1 2 3 4 ) [} g 9 10 11 12 13
10 [¥_coard oo oo a0 (1] 0.0 1.0 20 30 4.0 4.0 4.0 4.0 40
11 ¥ _coord oo 10 20 3.0 4.0 4.0 40 40 4.0 3.0 20 1.0 oo
12 |Element Information:
13 Mo, 1 2 3 4 ) 5] g 9 10 11 12
14 [J1st 1 2 3 4 ) 5] g 9 10 11 12
15 [J 2mdd 2 3 4 ) 5] 7 9 10 11 12 13
16 |Density 0.00 0.00 0.00 0.0a 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
17 A Sec 0.090 0.090 0.090 0.090 0114 0114 0114 0114 0.090 0.090 0.090 0.090
18 [E 210E+06  210E+06 210E+06  210E+06  210E+06 210E+06 210E+06  210E+06  210E+06  210E+06  210E+06) 210E+06
19 [Inertia £ 0000675 0000675 0000675 0000675 00M372 000372 0001372 0001372 0000675 0000675 0000675 0000675
20
2 | Support Condition:
22 [Mo. 1 13
23 [R_x 1 1
24 R v 1 1
25 R = 1 1
26 | Joint Losd:
27 [Joirt 3 3
25 [Px 0.50 0.00
29 [Py 0.00 -1.00
30 Mz 0.00 0.00
31 |Uniform Load:
32 [Memno. | 5 3 7 8
33 [Load* | ogo =] i) 0.60
34 |Mote: *Perpendicular to member axis
35
36 | OUTPUT
Joint Load - Displacement | Member End Forces | Support Reaction |
Joint [ Px | Py Mz Dx | Dy | Rz |NofLength] 1-Axial | 2-Shear | 3-Mom [ 4-Axal | 5-Shear | &Mom |  Joint | Rx Ry Rz |
1 4.000 0.000 0000 0.00000, 0.00000  0.00000 110 09 0102 0.343 -0.970 -0.102 -0.242 1 <0102 0970 0.343
2 0.000 0.000 0000 000011 -0.00001 -0.00021 2410 0.970 0.102 0.242 -0.970 -0.102 -0.140 13 -0.388 2430 0.737
3 0.000 0.000 0000 0.00033 -0.00001 -0.00034/3/1.0 0.870 0.102 0.140 -0.970 -0.102 -0.038
4 0.000 0.000 0000 000077 -0.00002 -0.00040 4/1.0 0.870 0102 0.038 -0.970 -0.102 0.064
5 0500 -0.300 -0.050 000117 -0.00002 -0.00038511.0 0.398 0970 -0.064 -0.398 -0370 0.734
[ 0.000 -0.600 0000 000117 -0.00036 -0.00024 610 0.398 0.370 -0.734 -0.388 0.230 0.804
7 0.000 -0.600 0000 000117 -0.00046  0.00005 7.41.0 0.398 -0.230 -0.304 -0.398 0830 0.274
3 0.000 -0.600 0000 000117 -0.00029  0.00025811.0 0.398 -0.330 -0.274 -0.388 1.430 -0.855
L] 0.000 -1.300 0050  0.00117  -0.00005  0.00017 8410 2430 0.398 0.855 -2.430 -0.398 -0.457
10 0.000 0.000 0000 000108 -0.00004 -0.00030 10410 2430 0.398 0.457 -2430 -0.398 -0.058
11 0.000 0.000 0000 000067 -0.00003 -0.00048 11010 2.430 0.398 0.059 -2430 -0.398 0.339
12 0.000 0.000 0000 0.00021 -0.00001 -0.00038 12/1.0 2.430 0.388 -0.339 -2.430 -0.398 0.737
13 0.000 0.000 0000 000000 0.00000 0.00000

Figure 6.6: FRAME2D input-output form - Re-inputted
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Displacement

45 4

35

25

15 4

05

Shear

i} 05 1 15 2 258 ki 25
Max Displacement, J.5=000117

4 45 [} 05

1} 0§ 1 15 2 25 2 35 4

Max Shear, J9=-1.430

45

Moment

45 4

35 4

25

-1 o 1 2 3
Max Moment, J.9 = -0.855

4 8

4.5 4

354
a
254
2 4
15 4

14

0.5 4

Axial

08 1 15 2 2.5 3
Mai Axial, J.9 = -2.430

45

Figure 6.7: Charts of displacement, diagrams of bending moment,
shear force and axial force - Re-inputted

The results shown in Figure 6.7 and 6.8 are much better than in Figure 6.5 and 6.6. Thus, it
is convenient to divide into smaller members and for this example at least 4 smaller
members with the same length for each member. Avoid odd divisors (e.g. 5, 7, 9 etc.) so that
the results in the middle of span can be exposed.

6.2 SIGN CONVENTION FOR DIAGRAM

To depict diagrams of moment, shear force and axial force in members, program refers to

the sign convention as follows:

Positive direction is as shown in the above picture and ruled as follows:
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- Bending moment (M) is given a positive sign if causing the upper fibers of members
is compressed or to curve upward, and is given a negative sign if to curve
downward.

- Shear force (V) is given a positive sign if rotates the member clockwise and is given
a negative sign if rotates the member counter-clockwise.

- Axial force (N) is given a positive sign if pulls the member apart, and is given a
negative sign if pushes the member.

This convention is adopted in order to have same interpretation on the chart depiction of
the application programs in the next few chapters, thus it is more easily interpreted and
also design-oriented. The program automatically differentiates the moments and forces
that occur in members section, which is blue line inside the curve for the positive
direction and red for the negative direction. The example below shows the coloring for
bending moment result:

Moment
Red = negative moment
5 - Blue = positive moment
65 ] l
) _ / — — :
N I e /-
3 1 d
2.5 H
1.5
IL —
a5 4
1 0 1 2 3 4 5

Max Moment, J.2=-0.855
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6.3 APPLICATION

FRAMEZ2D is now applied to the following beam problem:

S ton q = 2ton/m’

s R RRERE

The beam can be seen to have three main members that are, roll-load segment, load-roll
segment, roll-fixed node, have lengths 3, 3 and 5 meters, respectively. In practice however
it needs to divide the beam into smaller members for exposing the result more accurately.

FRAME?2D is then inputted from which each of main members is divided into 4 equal parts.
So, there are 12 members and 13 joints. When the program has run, the charts will be
shown as below.

Digplacement Shear

0.00z2 4 a0 4

B0 4
-0z 4 404

0004 | 204 \

0006 ] | | T | T T T ]

0002 4 20 ] 2 4 g \]m\l 12
-0.01 4 ELE

-nmz 4 &0
Max Displacement, J.5=-0.01124 Max Shear, J.9 = 5.869

Moment Axial

804 20 4

g0 4 7.0
4.0 6.0
20 5.0 -
410

0.0 r r ! ~ ] 20
20 z 4 [ 3 0 12 1
i 20 4
40 10

-5.0 4 on

-804 Ao 4
i Moment, J.5 = 7.07S e Axial, J6 =7.071

2 4 [ g n 12
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CHAPTER 7

PROGRAMFOR 2D TRUSS STRUCTURE
ANALYSIS

Member of plane truss is analyzed with consideration that carries only axial force, thus,
there are two associated displacement components at both ends with respect to axial force.
Truss member is generally made of steel or aluminum connected one to another as pin
connection.

Stiffness matrix for plane truss member is derived as the following:

AE y _AE
L L
o o0 o0 0
[Kli= | _AE , AE
L L
o o0 o0 0

Transformation matrix to convert vector components from local coordinate to global
coordinate is as the following:

cosa sina 0 0

—sina cosa 0 0
[T]i = 0 0 cosa sina
0 0 —sinax cosa

The equation of member stiffness matrix in global coordinate system:
[K]si=[T]iT[K]i[T]i (7.1)

[K]s of the member is then superposed on the appropriate force-deflection components to
get global stiffness matrix or called [K] structure. The internal forces and support reactions
can be determined by firstly partitioning [K] structure at free nodes and at supports
according to Equation 4.8.
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7.1 CASE EXAMPLE

The following example includes a sequence of steps in the analysis for plane trusses based
on matrix method as described in Chapter 4. It also gives some notes for writing code in
Excel-VBA. This section is complement explanation for previous FRAME2D example.

Given a truss structure is shown in Figure 7.1, includes numbering system in Figure 7.2 to
7.4. Each of member are made of the same linear elastic material, with E = 2,100,000 kg
/cm? and cross-sectional area A = 68.4 cm?2.

Truss as a whole has only two degrees of freedom (DOF) which is at vector components 3
and 4, while both supports are pinned-pinned thus will have no any translation.

20 ton

10 ton

4.0m

A 2\ c Lx
4

3.0m———=fe«——3.0m

Figure 7.1: Geometry and loading condition on plane truss

4

Figure 7.2: Force and displacement components at nodes in global coordinate system
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f o '}

Vo

Figure 7.4: Members force and displacement components that conform to global
coordinate system

The first step is to build member stiffness matrix with reference to either local or global
coordinates. In the program, it is done within one looping through the member number,
and made in a separate procedure in Module 2.

Program code:

Sub Stiff _Mtx(MK() As Double, S() As Double)
Dim sms As Double
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ReDim M(4, 4, NM) As Double

"Building global stiffness matrix
For i = 1 To NM
With Member (i)
sms = .Ax * _.E / _Lh
"Member stiffness
MK(1, 1, i) = sms: MK(1, 3

, 1) = -sms
MK(3, 1, 1) = -sms: MK(3, 3, i

) = sms

"Member global stiffness

M(1, 1, i) = sms * .Cx * .Cx: M(Ll, 2, i) = sms * .Cx * .Cy: M(l, 3, i) =
-M(L, 1, i): M(L, 4, i) = -M(1, 2, i)

M(2, 1, i) = M(L, 2, i): M(2, 2, i) = sms * .Cy * .Cy: M(2, 3, i) = M(Q,
4, i): M2, 4, i) = -M2, 2, i)

M(3, 1, i) = ML, 3, i): M@, 2, i)
i): M3, 4, i) = ML, 2, i)

M(4, 1, i) = M(L, 4, i): M(4, 2, i)
i): M(4, 4, i) = M2, 2, i)

"Storing members and superposition
For j =1 To 4
For n =1 To 4
S(ldm(@, i), Idm(n, i)) = S(dm(@, i), Idm(n, i)) + M{, n, i)

Next n

M(2, 3, i): M3, 3, i) = M, 1,

M(2, 4, i): M(4, 3, i)

1
=
~
w
N

Next j
End With

Next 1

End Sub

Notes:

e The above code is about to build the members global stiffness matrix as shown in
Equation 7.1, and then store them to form [K] structure and do the superposition at
once.

e Each member matrix (variable M) has three indexes in it; the first and second states
rows and columns subscripts of the matrix, respectively, while the third index states
matrix of member i.
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¢ Index Idm is an integer variable that reads displacement indexes of ends members,
the same as used in FRAMEZ2D.

The program for truss analysis is modified from FRAME2D and named TRUSS2D. Below are
the results of each step of the analysis.

Member Stiffness Matrix

[K]AB

28728.00| 0.00 |-28728.00] 0.00
0.00 0.00 0.00 0.00
-28728.00 0.00 [28728.00| 0.00
0.00 0.00 0.00 0.00

[K]AC

23940.00| 0.00 |-23940.00; 0.00
0.00 0.00 0.00 0.00
-23940.00f 0.00 [23940.00] 0.00

0.00 0.00 0.00 0.00
[K]BC

28728.00| 0.00 |-28728.00] 0.00
0.00 0.00 0.00 0.00
-28728.00 0.00 [28728.00| 0.00
0.00 0.00 0.00 0.00

Transformation Matrix

[T]AB
0.60 0.80 0.00 0.00
-0.80 0.60 0.00 0.00
0.00 0.00 0.60 0.80
0.00 0.00 -0.80 0.60
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1.00 0.00 0.00 0.00
0.00 1.00 0.00 0.00
0.00 0.00 1.00 0.00
0.00 0.00 0.00 1.00

[T]BC
0.60 -0.80 0.00 0.00
0.80 0.60 0.00 0.00
0.00 0.00 0.60 -0.80
0.00 0.00 0.80 0.60

Member Stiffness Matrix in Global Coordinate System

[K]s = [TIi"[K]i[T]i

[K]s AB
10342.08 | 13789.44 |-10342.08|-13789.44
13789.44 | 18385.92 |-13789.44|-18385.92
-10342.08 | -13789.44 | 10342.08 | 13789.44
-13789.44 | -18385.92 | 13789.44 | 18385.92
[K]s AC
23940.00 0.00 -23940.00 0.00
0.00 0.00 0.00 0.00
-23940.00 0.00 23940.00 0.00
0.00 0.00 0.00 0.00
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[K]s BC

10342.08

-13789.44

-10342.08

13789.44

-13789.44

18385.92

13789.44

-18385.92

-10342.08

13789.44

10342.08

-13789.44

13789.44

-18385.92

-13789.44

18385.92

Structure Stiffness Matrix

1 2 3 4 5 6
1 34282.08 | 13789.44 |-10342.08|-13789.44|-23940.00| 0.00
2 13789.44 | 18385.92 |-13789.44(-18385.92| 0.00 0.00
3 | -10342.08 | -13789.44 | 20684.16 0.00 |-10342.08|13789.44
4 1-13789.44 | -18385.92 0.00 36771.84|13789.44 |-18385.92
5 | -23940.00 0.00 -10342.08|13789.44 | 34282.08 |-13789.44
6 0.00 0.00 13789.44 |-18385.92|-13789.44| 18385.92

The next step is to partition [K] structure at free nodes and supports. Manipulation on

program steps to establish [K¢] has been discussed earlier in FRAME2D example.

3
4
1
[K] struktur = 2
5
&
20684.16
[Kee] = [ 0.00

241

0.00
36771.84

From Equation 4.9,

{Ps} = [Kee]{Xr}

2 5 6
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{Xe} = [Ke] 1{P}
0.00048
3 =1_0.00054

After displacements of free nodes are known, the internal forces of each member can be
determined using equation:

{P}i= {Po} + [K]i([T]i{X})
[T]i{Xs} is displacements vector transformed from local to global coordinate system.

In this example, no external load directly acting on each member thus {P,} = 0. The
equation to determine the internal forces of member becomes:

{P}i = [KJi([T]i{X})

The values of internal forces of each member are shown below:

{P}AB : {P}AC : {P}BC
4167 0.00 20.833
0.00 0.00 0.00
-4.167 0.00 -20.833
0.00 0.00 0.00

The magnitude of support reactions can be found using Equation 4.12:
{Ro} = [Koe|{Xr} - {Pv}

There is no external load directly acting on supports thus {P,} = 0. The equation to
determine the support reaction becomes:

{Rv} = [Koe{Xr}

In this stage, we have to establish [Kys] first. It uses the same way as to establish [K¢], which
to partition using integer variables. The completed code is similar to that in FRAME2D:

"Indexing for matrix subscript
Sub Mindex(index() As Integer, IFr() As Integer, IFx() As Integer)

"Member end-displacements index:
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For i = 1 To NM
With Member (i)

dindex(1, i) =2 * J1 - 1
dindex(2, i) =2 * _J1
dindex(3, i) =2 * .J2 - 1
dindex(4, i) =2 * .J2
End With

Next i

*Joint free displacement index, IFr and
"restraint (support) index, IFx
n=1
j=1
For i = 1 To NP
IT Rs(i) = 0 Then IFr(n) = i: n=n+1

Next i
n=1
For 1 = 1 To NS
n = Cells(22, 1 + i)

IFX(2 *i-1)=2*n-1
IFX(2 * 1) =2 *n

Next i

End Sub

Sub MInvers(SR() As Double, SD() As Double)

"submatrix Stiffness, KBF
For i = 1 To DOF
For J =1 To 3 * NS
SR, 1) = GSrjd). 1dj(i))
Next j
Next i

End Sub
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We have known that variable Idj = Ifr, Irj = Ifx, but they are declared at different level which
is at public and procedure level, respectively. With the above code, the subscript i,j of [Kue]i;
associated with this example are:

1,3 14
23 24
[Kedl =53 54
6,3 6,4

And the values of its elements are:

—-10342.08 —13789.44
—13789.44 —18385.92
[Kofl = | ~10342.08 13789.44
13789.44 —18385.92

The magnitudes of support reactions are determined:

2.500
3.333

{Ro} =] _12.500( ton
16.667

The results of the internal forces of members and supports reactions are then plotted on

the truss chart as shown in Figure 7.5. Negative sign is used to indicate compression state
along the member, and positive sign for tension state.
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20 ton

-20.833 ton

2.50 ton 12.50 ton

3.333 ton 17.667 ton

Figure 7.5: Depiction of result from 2D truss analysis

Check balance of forces at point B:
>Fu=10+4.167x3/5-20.833x3/5=0
Y>Fy=20-4.167x4/5-20.833x4/5=0 ..0K!
Check balance of forces of a whole structure:
YFy=10+2.50-1250=0
>Fy=20-3.333-17.667 =0 ...0K!

The input and output form of TRUSS2D for given truss example is as follows:
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Figure 7.6: Input-output form of TRUSS2D

An Introduction to Excel for Civil Engineers

A_| B | © ] DO T o e o o o« P s | [ ¥ L H_ |

1 |TRUSZD v.1.0 (Program for 20 TRUSS Analysis)

i

1 |Tie = Trusal

g e 3 Pia| Gaarmeti RUN Progran
EXT 3
[ER

T INeUT

A |Jaint Cooedinabes -

9 [Joinibo_| 1 Fl ] B [ TRUSS 20, sis|Sheeil Charl 1

10 [¥_coord 0.0 [29] 10

11 |¥_eoond [ I1] (1]

13 Grametry
| 13 [Elamani miormation i

14 [N I Fl ] }——
KLITAra . ] o | P

16 |J 2n a i F) . o

17 |Denzey ] ] ] 3 } i \\

1E [A Bec OO0GR4_ DODagd O Dobed 15 4 \\\

1_§IrE TV0E=DT| Z10E+DT. 2 10DE+D7 -

70| b Loomm -

21 |Suppord Condian 1.5 //
| 33 [He. [ r] i //

23[R E 1 1 :

WAy | i o o ;
& 0 &2 . . e . . i
20 Lainl Load ] i 2 ] [ L] ] [—}
37 [Jainl ]
_!iF iian Mhie 3, M= 3

a8 [Py -30.00

an

n

A B [+ | B E F [ 6 o | g — [ |

|
EAT]

n Juoint Load - Displacemen | iiember Asial Forces | Suppon Resclion |
3| Jnin) [ Py i by | I ] Jain By | Ry |
| 36 | 1 [LYu ] 0.0 0, 00000 0000 140 4167 -4 167 1 2 800 13
£l 2 0000 0000 000000 00000 2060 0.000 0.000 2 12 500 16 GET
| 3 10,000 200 00Mas 000054 350 20E33 X80
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Displacement

1] 1 z 3 4 5 [ 7
Max Displacement, J.3 = -0.00054

Axial

45 -
4
35
34
2.5
2 4
15
1
05

05 4 1 2 3 4 5 = g

K

May Auial, M3 = -200833

Figure 7.7: Charts of displacements and diagram of axial forces

Note:

e Color coding for axial forces is the same as used in FRAME2D. Lines - which are lines
that perpendicular to long section - of member 1 and 3 are red; it means negative
axial forces occurred on members (compression).
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7.2 APPLICATION

Now, TRUSS2D will be used to analyze a truss bridge with geometry as shown in Figure 7.8.
Given number of bridge joints = 8, number of members = 12, which is supported by a pin
and a roll support. Each member of truss is made of the same linear elastic material with E
= 2,100,000 kg/cm? and cross-sectional area A = 132 cm?2. The loading data is given as
follows:

- Vertical load = 40 tons and horizontal load = 2 tons, at the joint as shown in Figure
7.8.
- Selfweight of all the members.

- r?tun 43

40 ton

Figure 7.8: A truss bridge structure

The data of geometry, material and loading are then inputted in the input-output form of
TRUSS2D as shown in Figure 7.9. Numbering system of a given truss bridge can be seen in
the chart window (only available in Excel 2003) or in the worksheet shown as below:
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Geometry

. c 1 D E ) H | ] F] K L "] M
1 |TRUS2D v.1.0 (Program for 2D TRUSS Analysis)
]
i'l'rﬂl: Bincge1
4 M= Pt Geometri FLUN Progham
| 5 |HNM= ] 13
L E
T INPUT
8 |Jaint Coordinates
'l|.hﬂ'rtrlﬂ 1 £ i q ] T 1}
10 [¥_coond (1] L] LA ] 1040 L] EE] 150 L]
1.} ¥_coord 0.0 5.0 [713] (] [} 510 0.0 0.0
1
13_|Bemamnrrrurmnuan
14 M [ ] E] [] 4 [ T B ] 0 ik (¥} [E]
j!imlt i i Fl F] k] [ [] [ [ 7 3] F 5
16 [Jing F 3 ] [] N ] ] T ¥ ] B L] []
_1'[DIII'M-" F B3 flE] [l E] 783 pNE] ¥ ] TH] ] T.5] ] flE] .83 7.8
16 [A Bt [EiEEF 0013y 00732 0013 o132 [T EEF] [T R T TP [LEEF [N IEF [T LEF] [IIEH L EIEH
_1_E|E Z10E+07 F10E«O07 Z00E«D7 Z1DE«0T J10E+DT 310E+D7 210E+07 110E+07 Z10E+O07 2 W0E«07| T10E«0T 210E«D7 210E+07
A0 |
[ 27 [Supgpon Condien
!I|_E i ]
: ] [1]
TL i i
Jaint Load
5
200
4000
Junidd Load - Ceiplatemnesd | Meter Fiiices | 5 Reachion
P Py 0 [ Dy | Mamno | Fhwal [ Jomt R Ay
1 Lo -0 E24 000000 Qoo 1.5 E0E 1 2000 203 TEF
] 000 M8 0OMER  O00ET S0 25163 ] 0000 A
3 D000 L7 O000ds!  DO0oes 3.50 1004
4 0000 0778 0O0BS  OOOWT4 &0 44 504
5 2000 4106 00008 DDMTISSD -5 163
] 0o <12 ooe OooEis s o&?
T 00000 DITE 0Oo01E3| DD0oes T &0 4 30
B [ili i ] DEM oo OO 8 &0 B[]
3.50 BN
&0 -FAN63
1171 37 500
1271 -0 156
13.71 -29.639
Figure 7.9: Input-output form of TRUSS2D for given truss bridge
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Displacement
E -
A4
4
3 -
2
7] 10 15 20 25
2
3
Max Displacement, J.4 = -0.00474

Axial
T A
E
A4
1 \ /
3
N \ /
: 5 10 15 \/2'0 o5
e

Mlax Agial, M4 = 44304

Figure 7.10: Charts of displacements and diagram of axial forces for given truss
bridge

For a kind of truss, for instance, a truss tower that requires extended upward lengthwise
chart, you can change a chart aspect ratio by resizing it. To do this, take the following steps:

¢ C(lick mouse on chart > move pointer on chart border > drag the sizing handles that
located in the border to the size, e.g. like a chart size as shown below.

e The other way is to click mouse on chart > Format tab > in the Size group > enter
the value in Shape Height and Shape Width.

e If font sizes change during chart resizing, click on the chart or at any text and then
set the font size through Font Size setting on the Ribbon.
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Geometry

MJ=12, NM=23

25 4

Displacement

Axial

Max Displacement, J.6=0.01443

Max Axial M.8 =-5.424
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CHAPTER 8

BEAM ON ELASTIC FOUNDATION

Beam loaded on elastic foundation (BOF) is a theory that is often used in force -
displacement prediction for the structural analysis that interacts directly with the ground.
Elastic foundation is an approach to soil behavior as a collection of linear elastic springs,
independent and one with another unrelated (Winkler soil). This theory is more solved by
numerical methods, especially by finite element method (FEM).

The fundamental of FEM for BOF used herein are Equation 4.13 until 4.18, and the
notations are used to express the relationship of external force-displacement components
to those at nodes and internal force-deformation components on elements of finite element
in Figure 8.1. Elastic foundation is represented by a series of spring constant at element
nodes.

Nodal P-X: Equilibrium P-F:

P,- X P, ~ X

2 e 4 4
I N
| \L{\ 2

\\ no no.

nodal elenen

— \n°
¢

Member F-d:

f- 2m % %

Kl F3' (13 F4 - o,
ll-l + FE ‘F + Fa
L L
F,= Kld
F, = Kad

Figure 8.1: Force-displacement components at nodes and internal force-deformation
components on elements of finite element

The relationship between load {P} and internal forces {F} is expressed as {P} = [A] {F},
where:

An Introduction to Excel for Civil Engineers 180




1 0 00
L L
[Al=] 0 1 0 0
LI BN
L L L i

The relationship between internal forces {F} and element deformations {d} is expressed as
{F} = [S] {d}, and from elastic behaviour of the beam we may write:

d; s dy  ds
4EI 2EI i
- 0 0 |-f
L L
2EI 4E]
— 0 0 |F
[S1=| L L F
0 0 K 0|
o 0 o0 x|
Notes:
o F modulus of elasticity of element (beam)
o ] moment of inertia of element

e Ki, K2 soil spring constant = (L/2).B.Ks
e B width of beam
e Ks modulus of subgrade reaction.

Foundation displacements {X} and internal forces {F} can be obtained using Equation 4.16
and 4.18:

X, P | M
X, [PV
= {[A][S][A]"
X, { } P M
X, P,|V
FIM X,
F|M X
P = [S]AT 1t
|V X,
F,|V X,
Notes:
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e {[A][SI[A]"}' inverse of global stiffness matrix

e [S][A]T element matrix

e M moment component

o V vertical force component

o [ F magnitude of moment at element ends

Furthermore, in developing the program it is convenient to give boundary condition that
restricts displacement by means of giving a fixed support at selected node. The magnitude
of displacement at this node is = 0.

The advantage of FEM over classical solution of BOF is that properties from element and
soils that are not constant such as weights, dimensions, flexural rigidities of beam and soil
Ks along the beam can be easily incorporated into the calculation.

8.1 CASE EXAMPLE

An application program for beam on elastic foundation as described above is named BOF,
which is used the same programming structure as previous TRUSS2D or FRAME2D. This
program is now used for a footing analysis above ground with soil modulus Ks. The footing
geometry and loading condition are as shown in Figure 8.2.

Given example:

Modulus of elasticity of the footing, E = 217000 ton/m?
Height x width x length of the footing=0.3x2x2m

Ks = 1800 ton/m3

Vertical load = 20 tons and moment load = 4 ton.m, acting in the column axis, right in the
center of the footing.
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20ton

0.3m

20m

Figure 8.2: Footing on elastic foundation analysis

The input and output data of the given example is presented in the input-output form of

BOF in Figure 8.3. The footing structure consists of 10 members, with a continuous
numbering system as shown in the following worksheet chart:

Geometry

U i
1
1
[
[
o
o
&
&
i
|
[
i
I
o
(=1
(=]

ra 'll-';
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A | B [ ¢ [ © [ E [ F | Ho [ [ 0 ]k [ L
1 |[BOF v.1.0 {Program for Eeam on Elastic Foundation)
| 2 |
3 |Title= Footing1
4 [Nl= 11
| 5 [N = 10 Plat Geom etri RUM P rogram
| B |E= 217E+0B
7 |INPUT
8 [Joint Data:
Y |Jaint Ma. 1 2 3 L] ] a 7 g ] 10 11
10 [¥_coord 0.00 0.20 0.40 0.60 0.8a 1.00 1.15 1.40 1.60 1.80 2.00
11 |¥_coard 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
12 [Ks* 1,800.0 1,800.0 1,800.0 1,6800.0 1,800.0 1,800.0 1,800.0 1,800.0 1,800.0 1,800.0 1,800.0
13
14 |Element Data:
15 [Ma. 1 2 3 4 a G 7 g 4 10
16 [J1st 1 2 3 [] A A 7 E] ] 10
17 [J 2nd 2 3 4 ] 5] 7 g 9 10 11
18 [t= 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30 0.30
189 (B = 2.00 2.00 2.00 2.00 2.00 2.00 2.00 2.00 2.00 2.00
20 [Pressure™ 0.00 0.o0 0.0n 0.00 0.oa n0.0n 0.00 0.on 0.00 0.00
21
22 |Bupport Condition:
23 [Ma.
24 |Rotation
24 [Translation
26
27 [Jaint Load:
28 [Joint A
29 [Mament 2.00
30 [VYertical 20.00
31 [Mote: * Modulus of subgrade reaction unit FL™3)
a2 **Perpendicularto elemen axis (unit FL2)
3
ORI n Berahon i}
i nKe =0
] Jiilfil Load - Leaplaaenanl - Pradaum
17 Jared ' M F TH Ol el |_|'|-|-||-|-|.-|: Lon Pie 21 l.m-uu-i k1 s I sy (F
N 1 (L —Obon  oooon]  000Ves 1277 1.0 30 T a0 000 J60 oo Taoa )
) 0.00f 000 0, DO A B0, 00 B0 000 1T T as
d0 1 0nooc [e)eali] 000714 LR 60 D0l & 2T L 170
T 4 0 0oc [ 7] 000730 450 0oL F Lk} B14] 142
| a3 ] n.noo 600 0.00348 370 00¢ 170 G0 k! R
4 B 3 0of 10 00 et ] f 376 (00 a6t BT
44 [l [} 10 0i] 0 Doasa FL ] A b T
4= (] 0 00c 0 000 (1 81 1 0 000 0458 L
48 ] 0 Do (sl i 0 0080 180 00 ‘il 4. ThE
a7 ] 0 0oL (A N5 ali] 0l iu (i) 2 214
i L] [l [N ali] {1} iy il
Tl
Figure 8.3: Input-output form of BOF for footing example
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Notes:

¢ In the input-output program, in Join - Displacement - Pressure column contains
output data of soil pressures. In practice, soil pressures result is to be checked
whether the given loading on the foundation does not exceed the allowable bearing
capacity of the soil (ga). Thus the maximum value should not exceed qa.

e Unlike FRAME2D and TRUSS2D, there is iterative process in BOF to check whether
there are nodes that tend to separate from the soil (x < 0), because the soil spring
only accept pressure. Therefore ASAT matrix needs to be rebuilt with Ks = 0 at those
nodes. Here, foundation selfweight shall be incorporated into the calculation. The
result is then checked and if necessary, repeats this step until convergence is
achieved, where,

Convergence = number As(n) = number As(n-1), at iteration nth.
As is active spring at X positive.

e For a case of retaining wall or pile foundation where the soil spring is modeled on
both sides of the structure, the soil spring would always work where the one will be
active and the other will be non-active. Thus, it is convenient to give an option to
select limits on nodes where iteration will be performed. The intended limits can be
found in Chapter 8, where BOF is modified for vertical structures.

¢ Sign convention of moments and shear forces for graphic despiction is to follow the
sign convention described in Chapter 6.2, which is based on the changes of structure
shape after loading. Also, blue line in the curve is for positive direction and red line
for a negative direction.
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8.1 APPLICATION

The following example is just a program verification on a beam problem with uniform load
as seen in Figure 8.5, and the results are then compared with the output of FRAME2D for
the same problem. Both programs should provide the same result because they use the
same analysis method and theory of structure as well.

Here, no soil property is involved so that Ks = 0. There are 3 supports of the beam, which is
fixed at point A (R=1, T = 1), pinned at point B(R=0, T = 1) and fixed at point C(R=1,T =
1).

The given data as below:

Beam:

Length =18 m
Width =2 m
Height=0.5m
Load:

Uniform load = 0.6 ton/m’/m width of the beam

The output of BOF is presented in Figure 8.6.

o g =058 ton/m’

?IIIIIE?TIIITIIITTIIIZIl:f%

é _

74 A rhrrire. B €
H 10m r}' BEm ¥

Figure 8.5: Beam with uniform load of q
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Figure 8.5: BOF solution for beam example
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CHAPTER 9

LATERALLY LOADED STRUCTURE

Theory of beam on elastic foundation can also be applied for the analysis of structures
subjected to lateral loads. Here, BOF program was slightly modified in which the
orientation of the beam is now perpendicular to X-axis, and the external forces -
displacement can be set whether lead to positive or negative axis. Load on nodes profile
also to be displayed for a quick verification on inputted pressure magnitudes at both
elements ends. The program for the laterally loaded structure is named XLAT.

9.1 CASE EXAMPLE

Given retaining wall example with geometry model and soil, pile and anchor data shown in
Figure 9.1. The figure also shows finite element (FE) model and numbering system.

Find:

- Magnitude of displacements, distribution of moments and shear forces along the wall for
design purpose.
- Forces and stress acting on anchor for design purpose.

After the FE model (Figure 9.1) is established, now is to find lateral pressure behind the
wall acting from ground surface to the dredge line using active pressure coefficient from
Coulomb or Rankine. You can either input the lateral pressure to 1 node below the dredge
line.
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Concrete FE Model
WALL q=2 ton'mé

EEEEEEER
RSN RN R

NJ =15
NM =14

— 91 (%— g
A N prxﬁ X
2 ia— P =X
1.5m Sand Py- X, O
Anchor Red:
I L=6m A M Soil:
A » . Area= 126 cm? fﬂ"ﬁ“' Mf“ K:I=. As + Bs.7n
¥= 175 ton/'m? = Spacectcrod=3m ‘Q"_Cho'_.' i | '
1.5m ¢=135° K = AE/s.L o
Ka = 0.27
y GWL
Zm y'=1ton/m?
L Excavation point
Y —— W#O
SN RN .
Soil:
2 m Ks = As + Bs.Z"
Concrete WALL, t=0.6 m
T E=2.17 x 10° ton/m?
v L] -
-
t

Figure 9.1: Model of retaining wall

Slight modifications were made in calculating fixed-end forces of element to take pressure
profile that increases linearly with depth (triangular distribution) into account. See the
description on this picture:

INPUT: CALCULATED:
a(FL)

Pressure 2 [ | D
Pressure 1 T L

[ |
member

The code is as follows:

"member fixed-end forces due to pressure
For i = 1 To NM
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With Member (i)

d = Abs(.Presl - .Pres2)

sq = Application_Min(.Presl, _Pres2)

"rectangular part

w = sqg * .bm
Pa(ldm(l, 1), 1) -w * .Lh ~ 2 / 12 "moment
Pa(ldm(2, 1), 1) = -w * _Lh /7 2 "horizontal
Pa(ldm(3, 1), i) =w * _Lh ~ 2 / 12 "moment
Pa(ldm(4, 1), 1) = -w * _Lh / 2 "horizontal

"triangular part & summing

w=d* _bm

Pa(ldm(1, 1), 1) = Pa(ldm(1, 1), 1) + (-w * .Lh ~ 2 / 30) "moment
Pa(ldm(2, 1), 1) = Pa(ldm(2, i), 1) + (-w * _Lh * 3 / 20) "horizontal
Pa(ldm(3, 1), i) = Pa(ldm(3, i), i) + (w * _Lh ~ 2 / 20) "moment
Pa(ldm(4, 1), i) = Pa(ldm(4, i), 1) + (-w * _Lh * 7 / 20) "horizontal
End With
Next i

Equivalent load at node due to pressure on element:

"equivalent joint load due to pressure
For i = 1 To NM
For j =1 To 4
For n =1 To 4
Peq(ldm(j, i), i) = -Pa(ldm@, i), i)
Next n
Next j
Next i
"sum load = joint load + eq.load
For i = 1 To NP
Ps(i) = PJ(i)

Next i

"load superposition
For i = 1 To NM
For j =1 To 4
Ps(ldm(j, 1)) = Ps(ldm(J, i)) + Peq(ldm(g, i), i)
Next j
Next i
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Notes:

e The above code is the same as used in the previous programs to find the equivalent
load on nodes.

e Variable Idm states displacement index of elements ends. It has been described
earlier in the previous chapters.

To generalize program where variation in the physical characteristics of the structure can
be incorporated into calculation, thus the input of height of beam, t, in BOF is replaced by
moment of inertia, I, in XLAT:

7 |INPUT

8 |Joint Data:
9 [Joint Mo,
10 [¥_coord
11 |¥_coord
12 |Ks*

13 |Spring™
14 |Element Data:

15 M. Inertia moment

16 |J1st input
17 [

12nd
CHED
19 |[B=
20 |Pressure1™™
21 |Pressure2™*
22 |Suppor Condition:
23 |Mo.
24 |Rotation
25 |Translation
26

The following chart window (Excel 2003) will appear by clicking on Plot Geometry button.
It shows finite element geometry and pressure profile that have been inputted into the
program refer to Figure 9.1.
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&Y [XLAT Ex.xIs]Sheet1 Chart 1 X

Geometry and Pressure Profile

on 1.0 20 3n

M =15 k=14

Modulus of subgrade reaction or spring constant of the soil (Ks) of sand layer in the front of
the wall is assumed to increase with depth by the approach taken below:

ks =As + Bs.Zn. ton/m3,
=1000 + 2000.Z» > above GWL
=600+ 1100. Z» = below GWL
where,
As = 40(c.Nc+0.5y.B.Ny)
Bs = 40(y.Nq)
z = depth from ground surface
Nc, Ny, Nq = bearing capacity factors
n = 0.5, adopted exponent for non-linearity of Ks

Anchor rods are made of steel, with the specification shown in Figure 9.1. The value of rod
anchor spring per meter width of the wall is obtained by the formula:
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AE
sL

K =

12.6(2.0x107)

3(6)10° =1400 ton/m.

Input-output form of XLAT is shown in Figure 9.2 below:

[ 8 C I [ k% —m— g & W & [—F—1
1 |XLAT w10 (Program for Laterally Loaded Structurs)
=B
I ?_.;Trln- wall
4 M= 15 J s = T
5 |NM= 14 Plal 0 sk BN P mprsn
6 E= 117E+0R
7 mlT
B [deini Data
" [Jeinita T 7 E] [ 5 3 7 [ [] I T I 13 i =
10 [%_toard ] o0 LT won 700 100 () (5 [0 L] ELL] won T00 00 (=]
11 [¥_ioany T L] ] ER]] 500 [E:] L1 1.5 L] 250 f[] (] .00 [ [(RN]
13 K=" TpoaD 24142 30000 34405 | 38384 | 41623 G dB4i | 36574 | 30000 | 38338 3047 31797 | 3J64d | 3A0i% | 38i03
13 |Egerag™ 74000
i [Emimeni Coala
15 [Ho. T 3 3 [ 5 B i g q 1] K 12 13 T4
16 [0 i 7 ] [ g g 7 5 (] i K iH K 4L
|17 [and z ] [] B B T [ E L] i [H 13 Tt 1=
1B [I= UGie00___OoTe00__OGI@00__OG01800_ G01800  GOVADD 001600 001800 O01S00 _ 0G0UG00__ 00100, 001800 GO1600 601800
Wi e i i e L L A T
_zu"ﬁusmv' (2] iEL] T 128 (KE] 172 T8 108 ] ]
1 |Prossrei] [KL] T 135 1,40 177 188 00 2.3 FET] 780
23 [Bmwart Condin
FERCTIE
24 [Fofagon
25 [Tranalsion
L3
2;" el Load
ELREET]
lﬂ Moman
| 30 [Honznnga
_51 [Hale * Moculus of subgrade machon [unf FL-3) == Flear end - far end. Perperadiculn 0 ekmen mes [unk FL3)
gg = Jgint spring, in %-ads dracion ol FL%1)
-j;-;,'lIIHIT 1 Reralan s I
£} Nia=0=
“ .\1f|1|.lu|-d-{l: Cman T - = h_rlthHf T p - -r Henion -
| duint Wartms | Hofnlal T | Bl |ll LAY LI Fl 4 | __ . 1] |
B SR ﬁL-" o — O — T Ty t-'ﬁ‘ﬁ
II_ |||| e 0 3m 0 Dp0en 0 DEin ||||I'.1| 4040 0 a0 O opan ooy 0 3am n I“U [LRe i)
an 1 (T o8 000080, ODEAPR 0080 1850 ] 0 a0 (1T ners 00 [ (K30 1|;u ~r_|
LA | L] [iTiEY) [ 0 i [ LR Thy 0000 &80 1400 en il 0] B ia] =i Fii [N B b an L] inm
i 8 oos  af41 00p0te DosabT 0060 S0 0090 0oaa  nTtE o1 EM D000, BOOD 2436 Dd4dE
III [] [ 1 E1 0 Gbdkn O OEdEn [N Y] b b6 a6 LR ST FEFE [T 0 iGh LR 1 &T
i ' 008 nar 0000K)  0ORET 080 TME0 0 630 0030 211 1018 0000 0000 B} B
l5: L} oo 1 48 0 nboe 0o 0oo0 amAn 0mn ooan 1038 < hpon o mo bdap 2 44D
| 0 nom 1418 -0D0OM  OOKIED 0090 BAEAD omee  noan rmd 1oy D006l BOOD 6843 - EA)
IJI 19 (115 T Rl iE] 008 83 0 00 1 A (R PR ] FAFE) -0 eAw el [LR. ] s ] -1 1as
| " 104 0B14 -0DeOTE 0ODINE 1534100 5 T T o 0133 peEs mms nsEr o1 A
ll_ 12 [1ie] 0080 0 pE0dn oopoFr 48130 ',v'! P aid [ FER 12] 01y 0 s DS 0 B 4347
i | 11 006 nos 000G oogada 1,298/ 11.0 8 B0 BANE .0 DD D ool pI9E 410
a1 14 000 000 000076 0DEOD 0046 1405 #1118 BITSEX 0140 DoOB 0O Dl Bmp emm
71| W 00e 000 00007 0080 Fil
1]
Figure 9.2: Input-output form of XLAT for retaining wall
Notes:
e Unit used in this example is ton - meter to equalize the values of calculation
parameters used in this example.
e In the form, there is an input for joint excavation (point O) that is J excavation, as

input, in which iterative process done from the top of the wall up to this point. Note
that, iteration is not done below point O because the presence of soil spring on both
sides of the wall. Definition of the iteration and its purpose are described in Chapter
8.
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e To perform iterative process (to check the soil spring direction) up to joint n, enter J
excavation = n + 1. In relation with this, iteration is not performed if ] excavation =
1.

e To design the anchor rod, please check the reaction force in anchor and calculated
the stress with steps below:

Anchor
spring
/ reaction
Mernber Qutput 7

Marnent (F.L) | SailSpring Reagtion (F) | Shear (F)

0.000 0.077 0.000 0.000 0,153 -0.153
-0.077 0.349 0.000 0.000 0.541 -0.541
-0.349 0.873 0.000 0.000 1.047 -1.047
-0.873 0716 #@ 0.000 -3.181 3.181

0.718 -1.934 d.000 0.000 -2.438 2438

1.934 2722 0.000 0.000 -1.578 1.578

2722 -3.025 0.000 0.000 0607 0.607

3.025 -2.804 0.000 0.000 0.440 -0.440

2.804 2027 0.000 0.000 1553 -1.553

2.027 -0.659 0.000 0.883 2735 2735

0.659 0.132 0.853 0.615 1.582 -1.582
0132 0.308 0.615 0.324 0.352 -0.352
-0,308 0.160 0.324 0.012 -0.296 0.296
-0.160 0.000 0.012 -0.320 -0.320 0.320

Check:

Payia = 3 x 4.852 = 14.557 ton (c.t.c = 3 m)

P 14.557
f‘s = axial _

=1.155 ton/cm?
A 12.6

So, the specification chosen for the anchor rod must be adequate to resist the above
force and stress.

The result of moments and shear forces are then made into diagram shown in Figure 9.3.
For the wall design purposes, it can be taken maximum positive bending moment (blue
line) working below anchorage, while negative moments (red line) is located around the
anchor and around the wall tip.
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Load on Hodes Displacement Moment Shear

L S Rr SEECTER

*
L

+ : ;

oQos 0004 0002 -0.p02
o H 1
4 2 0 z 4
00 08 10 15 4 2 o 2
Max Displacement, J.1 = 0.00436 Mz Moment, J & = 3.025 Max Shear, M4 = 3181

Figure 9.3: XLAT output chart

9.2 APPLICATION

Given pile foundation example with a diameter of 0.406 m embedded in sand layer to a
depth of 16 meters. Pile and soil data are as shown in Figure 9.4. Pile head is assumed as
fixed connection against rotation but free to translate.

Find:

- Maximum load applied on the pile head for its limited magnitude of displacement of the
pile head.
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Pile
Foundation

T T e Yo GWL

Sand
¥ =9.9 kN/m?
$=32°

Soil modulus:

Ks = 5,000 + 12,000.2"
n=105

16 m

Pile:

Dia.=0406 m
™ E=2.1x%10°kPa
1=0.349 % 10-F m*

Figure 9.4: Pile foundation example

XLAT results of this example are shown in charts in Figure 9.5, where horizontal load, H, is
adopted = 100 kPa. Displacement that occurs in the pile head is 0.0054 m (at joint 1) as
shown in the Figure. From load and displacement linear relationship, any increase of load
of 1 kPa will produce pile head displacement of 0.054 mm.

Thus, for a case where pile head displacement is limited to 5 mm, the allowed maximum
load is then = 5/0.054 kPa = 92.6 kPa.
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Load on Hodes
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Shear

Max Shear, M1 = -93.705

-160

Figure 9.5: XLAT chart for pile foundation example
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CHAPTER 10

ONE DIMENSIONAL CONSOLIDATION

In this chapter we will apply numerical solution using finite difference (FD) method for
Terzaghi’s theory of one dimensional consolidation. This method is based on a grid of time,
t, versus depth, h, as shown in Figure 10.1. The depth of soil layer is divided into m equal
parts of thickness Az, while the period of time is divided to n equal parts of interval At.

The equation of one-dimensional consolidation according to Terzaghi's theory is:

ou o’u

—=c,— 10.1
ot ' oz’ ( )
Finite difference forms of Taylor series for the first and second order derivatives of
functions have been shown in Chapter 5, and for both sides of Equation 10.1 can be
written:

ou _ ui+1.j _ui,j

ot At
o’u _ ui—l,j - 2ui.j + ui+1$j
0z’ AZ’

Substituting these values into Equation 10.1 obtains finite difference approach to one-
dimensional consolidation equation as follows:

Ui =Uij+ fuij+uis,j—2Uj) (10.2)
where,
c, At
ﬂ - (AZ)2

¢,  coefficient of consolidation
u;j excess pore pressure at depth i and time j.

f is referred to as a operator of Equation 10.2, and to make solution converge this
value should not exceed %2. The value lies between 1/6 and %2 (R.F. Craig, 1987).

For a period of time t in an open layer:
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C,(NAt
T, =W = 4/n/m? (10.3)

In case of half-closed layer, the denominator becomes (mA4z)2:
Ty = fn/m? (10.4)
T, is a time factor for consolidation

In case of impermeable boundary, where no flow across the boundary:

ou ) T
—=0,o0rinFD form: —L—"L =0
oz 2Az

For an impermeable boundary, Equation 10.2 becomes:
Ui =uij+ fQRuiyj-2u)j) (10.5)

The degree of consolidation (U) at time t can then be obtained by finding area under initial
isochrone (from initial excess pore pressure distribution) and area under isochrone at time
t, given by the following equations:

half closed layer:
d
Iou dz
U=1-- (10.6)
J. u,dz
0
open layer:
2d
u dz
U=1--5 (10.7)
u;dz

where d is the thickness of clay layer. Isochrone is a curve of excess pore water pressure,
ue plotted against depth for certain t as shown in Figure 10.2. The blue line represents a
variation of the initial u while the magenta line represents the pressure at time t.

Both Equation 10.2 and Equation 10.5 can be easily programmed, because the analysis is
based on an equilaterally grid. This looks like to build an array of function values (u) with
size of, for example, m x n (see Figure 10.1). The solution is simply taking a looping through
grid points in an array; thus, to find of excess pore water pressure at a specified period of
time (n) can be determined by giving specified value in a looping.

An Introduction to Excel for Civil Engineers 200




If m and n are referred to FD grid points as shown in Figure 10.1, thus, the code for half-
closed layer can be written:

"Finite difference approximation:
For J =0 Ton
For i =1 Tom-1
u(if, j + 1) = u(i, j) + Beta * (u(i - 1, j) +u(@i + 1, j) - 2 * u(i,
)
Next i
"on impermeabel boundary (at m points):
i=m: u@i, j +1)=u(i, j) +Beta™* @2 *u@i -1, j) -2 *u(i, J))
Next j

h
t
A=

r— 1T 1T "1 7

Figure 10.1: Grid of time versus depth
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FPore Water Pressure

Depth,
M

Figure 10.2: Isochrone example at specified time

In practice, the use of Taylor series adopts the first few terms omitting the higher order
derivatives and the error due to truncate the series can be reduced to minimum when g =
1/6. Seeing this condition, n and m can be then directly determined to satisfy a fixed f =1/6
for both layer conditions. If m is an input data, then Equation 10.3 and 10.4 can be re-
written to determine n as follows:

im = Cells(4, 2) "no. of layer
m =10 * im
h
t

Cells(3, 2) "height of layer
Cells(b, 5) "time

cv = Cells(5, 2) "coef. of consolidation

FDCCase = Cells(3, 5) "Case of calculation

"open layered
Tv=cv*t/ (/7 2) ™2

n=15*m"2=*Tv
"half closed layered

Tv =cv*t/ h~n2

n=6*m"2=*Tv
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In the process of finding U, the input data of depth and the initial u are automatically re-
inputted by the program where is each multiplied by 10 (default by the Author) or m = 10 x
im in the above code. For doing so, the interpolation technique is done to get the adjacent
values. The discussion of numerical methods in Chapter 5 demonstrates that dividing
interval of the independent variables into smaller intervals provides the result closer to the
exact value, and it is similar to what we will be doing here in the process of finding U
(numerical integration) as well as final u (numerical differential).

Manipulation for getting smaller FD grid interval is as follows:

- Code to get initial depth input, dz, and initial u, IP:

For i = 0 To im
dZ¢i) =1 * h / im
IP(i) Cells(9 + i, 2)

Next 1

Re-inputted with a divisor 10 and perform interpolation to get adjacent values using
rsdZ and RSIP variables:

n=1

rsdz(0) = dz(0)

rsiP(0) = 1P(0)

For i =0 To im - 1
For j =1 To 10

rsiP(G) =3 * (IP(G + 1) - IP(i)) 7/ 10
rsdz(§j) = j * (dz(i + 1) - dz(i)) / 10
rsiP(n) = rsIPQ) + IP(i)
rsdZ(n) = rsdz(j) + dz(i)
n=n+1
Next j

Next i

Running the code will result:

Initial data:
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Depth Initial
(H/m) | Pressure
0.00 0.00
2.00 7.50
4 .00 15.00
6.00 22.50
8.00 30.00
Re-inputted:
Depth Initial
(H/m) | Pressure
0.00 0.00
0.20 0.75
0.40 1.50
0.60 2.25
0.80 3.00
1.00 3.75
1.20 4.50
1.40 5.25
1.60 6.00
1.80 6.75
2.00 7.50
2.20 8.25
2.40 9.00
2.60 9.75
2.80 10.50
3.00 11.25
3.20 12.00
3.40 12.75
3.60 13.50
3.80 14.25
4_00 15.00
4_.20 15.75
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4.40 16.50
4.60 17.25
4.80 18.00
5.00 18.75
5.20 19.50
5.40 20.25
5.60 21.00
5.80 21.75
6.00 22.50
6.20 23.25
6.40 24 .00
6.60 24.75
6.80 25.50
7.00 26.25
7.20 27.00
7.40 27.75
7.60 28.50
7.80 29.25
8.00 30.00

Figure 10.2 shows example of open layer isochrone at time t with initial u increases linearly
with depth. The area under isochrone curve between y = 0 and y = 8 is then sought. For
doing so, FDC uses trapezoidal method (in h/m unit) in which the total area is cumulative
sum of h/m segment areas done in a looping over values of re-input dZ and IP. A detailed
code can be found in FDC program in the Attachment.

10.1 APPLICATION 1

The profile of excess pore water pressure (u) over the depth in saturated clay layer from
impact load is equal to the vertical stress distribution below foundation as in Problem 4 of
Chapter 3, as shown in table below:
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Depth (m) u (ton/m?2)
0.0 10.00
0.5 9.76
1.0 8.63
1.5 7.01
2.0 5.49
2.5 4.28
3.0 3.36
3.5 2.68
4.0 2.17
4.5 1.79
5.0 1.49
5.5 1.26
6.0 1.08

Suppose the clay layer is half-closed layer, where water flows across the upper limit. Given
cv = 7.19 m2/year and the thickness of layer is 6 m. Find the distribution of u and average
degree of consolidation (U) at 6 months.

Answer

FDC result is shown as the following:

Depth Initial | After (t)

(H/m) | Pressure | Pressure | ave U
0.00 10.00 0.00 46%
0.50 9.76 0.55
1.00 8.63 1.06
1.50 7.01 1.52
2.00 5.49 1.89
2.50 4.28 2.17
3.00 3.36 2.35
3.50 2.68 2.46
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4.00 2.17 2.51
4.50 1.79 2.51
5.00 1.49 2.50
5.50 1.26 2.48
6.00 1.08 247

10.2 APPLICATION 2

From field piezometers measurement on the clay layer beneath embankment, the
distribution of excess pore water pressure, u (after subtracted by its theoretical pressure)
is shown in the table below:

Depth (m) u (kN/m?2)
0.0 39.00
2.0 44.40
4.0 50.50
6.0 45.50
8.0 42.40
10.0 40.00

Answer

The input-output form FDC is shown below:
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A,

B |

c | D [ E ]

F | ¢ | H

TR S I I [ [ 107 1Y ] Y P )N R R ) S ) G [

H= 10 i Condition: 1
fm a
Cw= 21 i fyear t= 1
Initial After () Graph:

Depth (Him)| Pressure  Pressure ave U

0.00 35.00 0.00 24%

2.00 44.40 21.44

4.00 50.50 35.39

5.00 45.50 42.03

8.00 42.40 29.44

10.00 40.00 0.00

Depth,

FDC v.1.0 Program for One Dimensional Consolidation Analysis

1 =0pen Layered
2 = Half Closed Layered
year(s)

Pore Water Pressure
0 20 40

RUN

60

Notes:

e The advantage of finite difference method is that any pattern of excess pore water
pressure can be incorporated into the calculation. The input data can be based on
the initial field condition or load that works gradually, for examples, in the

completion of the consolidation problem below dam or embankment of soil.

e The purpose of FDC programming for one-dimensional consolidation based on
numerical methods has actually been achieved, that is at the stage where the degree
of consolidation based on areas under isochrone at time t can be calculated.
However, if you wish to go further with the solution, a curve of t versus U as shown
below can also be presented. This curve is created automatically by the program to
include 10 different t values into a looping, starts with t = 0.1 (years), then t=0.5, 1,
2, and so on, and plotted on a semi-log chart.
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A | B c | o | E | F | & [ H [T o T J 1 k [ L | ™
15 t (years) 0.1 05 1.0 20 40 8.0 16.0 32.0 £4.0 128.0
16 Ave. U 10% 21% 31% 44% £3% 84% o7%  100%  100% 100%
17
ﬁ t (years)
19 0.1 1 10 100 1000
BN 0% : : :
| 21 | : : ;
73 10% B ' SRR RS RN 8 B B N SRR U R
3] gy LI
|24 | 0
| 25| 30% | U R
| 25| 0% | U R
27| > :
;|| ¢ =0% fecmzezad S U S 1
151 = :
| 2 B0% focmzezad S U S 1
| 30| :
| 31| 70% qeneend SR S N L
32 B0% | S U S 1
| 33| :
En 90% Hoomnased SR S N L
35 100% :
| 36 |
| 37|
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CHAPTER 11

AUTOCAD SCRIPT FILE

To graphically depict outputs of a program, alternatively, you can plot the outputs in
AutoCAD software instead of using Excel chart. Here, you can work further with charts
drawing with either a 2D or 3D model. The main advantage of AutoCAD is because this
software is specifically built for composing drawings.

Script file meant here is a text file that contains a sequence of commands executed by
AutoCAD. The sequence of commands can be made on a worksheet or VBA to speed up and
simplify the process of creating drawings. The script file is made by a word processor such
as Win. Notepad or Microsoft Word in ASCII format and given with a .scr extension.

In this discussion, we will be working with AutoCAD 2007 version.

11.1 CREATING SCRIPTS IN WORKSHEET

Before creating a script, you should get familiar with AutoCAD commands and associated
sequence of entries through command prompt (not remotely via menu button). For
example, a command to create a line is Line, and followed by entries from coordinates of
the first point, second and so on and ended by pressing Enter.

Example 1

The following is an example of steps sequence in AutoCAD to create a drawing of 3 lines
segments using Line command through command prompt:

Command: line

Specify first point: 0,0

Specify next point or [Undo]: 1,1
Specify next point or [Undo]: 2,3
Specify next point or [Close/Undo]: 3,3

[Enter]
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From the above steps, it can therefore be made the following text (script) replaces what
was done above:

Line
0,0
1,1
2,3

3,3 [type 2 blank spaces for an Enter, to end Line command]

Open Notepad program, type the script above, and do not forget to type 2 blank spaces
after the coordinates of the last point to end the Line command. Afterward, save it with .scr
extension, for example named Line.scr. Now, open your AutoCAD, type scr at the command
prompt to display the Select Script File dialog box as below:

Bl select Script File

Lookjr ¢ Favontes v ¥ q x E" Viewa = Tools =
Mlame -~ Sirs | Typa [Drate ModiFied
L ASUS E-Service Fie Folder Bf2Sf2006 139 P
L1 >
Flepame: | NEW Duasang scy <|[_gpen [+
Flesof fpa | Serpt sl -

Select Line.scr file at the location you have placed before and click Open, then AutoCAD
will execute all commands in script file. The result is shown as below:
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>HPMHAE - a8 0 0

(4 4 | pl EITER L spautt f Layout2 f

Specify next point or [Cloge/Undo]: 3,3
Specify next point or [Close/Tndo] :

C ortnatd
Notes:

e AutoCAD commands consist of prompt entries that include some options that must
be entered in by the user. These options can also be 1). A command related to the
main command and, 2). Attributes to an object, for example, properties of a line, a
circle or a rectangle.

e The best way to understand a sequence of a command (e.g. Line) is firstly to trying
out it in AutoCAD, then noted down all entries, including the requested options

associated with the main command. This becomes the basis used for preparing the
script later.

The following is Line command and the required prompt entries:

M 4 0 M
__ Command

— .
Command: line K/ Entry (Coordinate)

Specify first point:
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Options:

o O

1 1

¥
k-

TR g

o

(s} H—

P 4 ]
L

= E)

firaci sl et Option Clase and Undo
Ppeaut E__H.Fﬂ“

e Pressing Enter at the last line is to end the command, so lines are drawn up to point
coordinates of the previous line. Pressing u is to do Undo command; undo the
previous line segment, while c is to do Close command; close the last segment by
connecting it to the first segment.

e Pressing Enter on keyboard is to end a command. In script, it is done by giving one
blank space or create a blank line.
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e Some AutoCAD commands display a dialog box to enter its data. To display prompt
entries entered from keyboard (i.e. line by line through the command line), use a "-"
before the command, such as: -Style, -Block or -Layer.

e To join two or more data between cells on a worksheet, use hyphen "&" (in
quotation marks). It is the same as used in VBA to combine string and numerical
data.

e Script can be extended vertically or horizontally. In the extended horizontally script,
any data entered to next data must be separated by an empty space, including an
empty space of pressing Enter.

e Every time you run a script file, object snap must be inactive or in off mode, so that it
gives the actual results. Click the Osnap button to make the mode on or off.

The other examples of AutoCAD commands and prompt entries:

e Below are options in Text command. The letter "j" stands for Justify command,

taken from the first letter.

ML p | R Lavout f Layout? f

Current text style: frowant™ Text height: 2.0000
Specify atart point of text or [Juacify/3cyle]: 3

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/ TR/ ML/ MC/MR/EBL/EC/EBR] :

e Options in Layer command.

WALEER Layout! { Layout? /

Comand: —layer
Current laver: Ly

Enter an option [?/Make/3ec/New/dN/OFF/Color/Ltype/LWeight/NiTerial/Ploc/Freeze/ Thaw/Lock/ Unlock/stice] :

e Prompt entry for Color properties (Layer > Color).

44 » | v EEREI Lavoutl {Layout? /

[ 2/ Make/Sec/HNew/ O/ OFF/ Color/Loype/Leight /HATerial/FPlot/Freeze/ Thaw/Lck/ UTnlock
Jatlte] @ o

ew color [Truecolor/COlorbook]
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Example 1 shows how to draw a line using script written manually. For line depiction
which comprises many segments (tens or hundreds), the manual method is rarely used.
Creating AutoCAD script on a worksheet is a way to simplify and shorten the job of creating
AutoCAD drawings, by relying on the Excel menu such as Copy, Paste, and its built-in
functions.

Example 2

Example 1 is now made on the worksheet as follows:

A B C D
1 a space
Zd X Y
3 0 0 line0,0 &=="line"&A3&", "&R3I&™
4 1 11,1 =A4E","EBAG™
5 2 323 } Result of copying ce
F 3 313 fromC4 to C5:C6

Prior to the first coordinates entry of (0,0) after the Line command it must be given 1
blank space to execute the command, the same is done by pressing Enter in AutoCAD. The
second coordinates of (1,1) and so on, should be placed in different line that is on cell C4,
C5, and so on, so as to be able to write the next script by copying the formula on cell C4. The
last coordinates of (3,3) on cell C6, need to be added a blank space at the end of the line to
end the Line command:

=A6&II’II&B6&H n
Next is to create a script file with the following steps:

1. Select a range C3 to C6, then Copy by clicking the Copy icon on the toolbar or

pressing Ctrl+C.
A | e | c | D |
1
2 X i
3 0 0 line 00
4 1 1 1.1
5 2 3 2.3
? 3 3 |33 |

2. Open Notepad program, and then Paste (Ctrl + V) the range.
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& Line1 - Notepad

File Edit Search Help

line A,8
1,1
2,3
3,3

3. Save the file with the .scr extension, for example, Linel.scr and place it, for example,
in the directory C.

4. Open AutoCAD. Type script or scr at the Command prompt, or via Tools > Run
Script.

5. From Directory C, select Linel.scr file, and click Open.

6. To fit the drawing on the screen, then type Zoom > Extents.

The result is appeared as below:
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Example 3

In a pile foundation work, the number of blows from driving hammer to penetrate piles is
noted until it reaches a depth of 28 meters. The obtained data is presented in Table 10.1.

Table 10.1: Number of Blows versus Pile Penetration

Pile Number | Cumulativ
Penetration of e
(m) blows/m' Blows
1 18 18
2 12 30
3 9 39
4 11 50
5 15 65
6 23 88
7 29 117
8 30 147
9 28 175
10 38 213
11 34 247
12 40 287
13 47 334
14 48 382
15 73 455
16 90 545
17 81 626
18 78 704
19 78 782
20 74 856
21 82 938
22 91 1029
23 101 1130
24 108 1238
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25 120 1358
26 152 1510
27 163 1673
28 212 1885

The data in Table 10.1 will be plotted in Cartesian coordinate system, where X-coordinate
is the number of blows/meter and the Y-coordinate is the penetration of the pile in meter.
Thus, it is required a graph form, where the data have to fit with the form created. The
penetration depth on the Y-axis then is made to increase downward to state depth below
ground level, while the number of blows on the X-axis increases to the right. It looks like
below.

BLOWS/METER

P0.0) 50 100 150 200 250 300

on

OM (W

20

FILE FENETRAT

25

30

The position of the form is placed at the bottom right of the origin P(0,0) in AutoCAD
drawing area. The scale made is:

e X-coordinate: 1 unit = 10 blows
e Y-coordinate: 1 unit = 1 meter

With such scale, script for the data on the X-axis should be divided by 10, while the data on
the Y-axis is divided by -1 for it has a negative direction to the origin P(0,0). Script on the
worksheet is created as follows:
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A B C ] E F

T} & Penetration Data

2

3 Penetration| Elow Count | Accumulation

Pile No. Script

4 {m) Blows/m’ Blows/m’

5 1 1 18 18 line 18,1 ¢= ="line "&C5/108", "8&B65/-1
-] 2 12 30 12.-2 - =(E/105" "LBE/ -1

7 3 ] 39 03,-3 m

8 a 11 50 11.-4

9 5 15 65 15.-5

10 6 23 BB 23.-6

11 7 23 117 28,7

12 8 3 147 3-8

13 g 23 175 2.5.-9

14 10 33 213 38.-10

15 11 34 247 34-11

16 12 =] 287 &-12

17 13 47 334 47,-13

18 2 23 382 48.-14

15 15 EE 233 73,15 I Result of copying cell
20 16 £ 345 5-18 from E6to E7E31
21 17 8l 626 8.1,-17

22 18 73 70 78.-18

23 19 72 782 78,-1%

24 20 74 E56 74-20

25 pa | 82 238 82.-21

<b el -1 1029 91,-22

27 23 101 1130 10.1,-23

28 24 108 1238 10.8,-24

29 25 110 1358 12-25

30 26 152 1510 15.2,-26

31 27 163 1673 16.3,-27 =

32 28 212 1885 21228 4= =w(32/10&", "&E32/-18" "
33

Furthermore, the script will be then saved into a file with the .scr extension. When the file
runs, the following graph is shown in AutoCAD:
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BLOWSMETER
0 50 100 150 200 250 300

10 i

20 L

PILE PEMETRATIOM (METER)
-
i

30

Example 4

In this example a script will be created, where the cumulative blows will also be plotted on
the graph. Thus, both of number of blows/meter and its accumulation are related to the
same Y-axis (against pile penetration). But by seeing the cumulative blows has a range of
values up to thousands, then a scale of 1 unit = 100 blows is given so that the values can
conveniently fit in the graph form.

The result of cumulative blows is drawn using Pline with line thickness 0.1 unit. To create
an AutoCAD script, a new column is then created named Script 2 (next to Script), contains
formulas as shown below:
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) B C D E F G

1 |Pile Penetration Data

2

3 Pile No. Penetration| Blow Count | Accumulation Seript Script 2

- [m) Blaws/m' Blows/m

5 1 1 18 18 nelB-1 [plineD1B-1wi.l ="pline "&D5/1008","&B5/-18" w 0.1
B 2 12 30 12,2 0.3,-2 =D6/1008","&Ba/-1
7 3 9 39 0.9-3 0.39 -3 T -

B 4 11 50 11,4 0.5-4

9 5 15 B5 155 0.65,-5

10 ] 23 BB 2.3,-b 0.BB.-6

11 7 29 117 28-7 117-7

127 B 30 147 3,8 147-8

13 9 28 175 28,9 1759

14 10 38 213 3.8-10 2.13.-10

15 11 34 247 34-11 247-11

15 12 i3 287 12 287-12

17 13 47 334 713 3.34.-13

13 14 ZB 382 B-14 3.82-14

19 15 73 455 7.3,-15 455-15 = Result of copying cell
20 1 g 345 5,-16 5.45.-16 from FEto F7-F31
21 17 81 626 B.1-17 6.26,-17

22 1B 78 704 7.8,-18 7.04.-18

23 19 78 782 78,19 7.82-19

24 20 74 856 7.4.-20 B.56,-20

25 21 B2 038 g

26 22 91 1029

27 23 10 1130

28 24 108 1238

29 25 120 1358

30 25 152 1510

31 27 163 1673 -

32 28 212 1BBS =032/100&", "&B32/-1&" "
33

(9T
I

Next step is to combine both two scripts from blows count and its accumulation into a
single file. At first you have to select a range E5 to E32, then copy and paste it into Notepad
and then followed by range F5 to F32. The contents of the script file will look as below:

line 1.8,-1
1.2,-2
0.9,-3
1.1,-4
1.5,-5
2.3,-6
2.9,-7
3,-8

2.8,-9
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3.8,-10
34,-11
4,-12
4.7,-13
4.8,-14
7.3,-15
9,-16
8.1,-17
7.8,-18
7.8,-19
7.4,-20
8.2,-21
9.1,-22
10.1,-23
10.8,-24
12,-25
15.2,-26
16.3,-27
21.2,-28
pline 0.18,-1 w 0.2
0.3,-2
0.39,-3
0.5,-4
0.65,-5

0.88,-6

An Introduction to Excel for Civil Engineers 222




1.17,-7
1.47,-8
1.75,-9
2.13,-10
2.47,-11
2.87,-12
3.34,-13
3.82,-14
4.55,-15
5.45,-16
6.26,-17
7.04,-18
7.82,-19
8.56,-20
9.38,-21
10.29,-22
11.3,-23
12.38,-24
13.58,-25
15.1,-26
16.73,-27

18.85,-28

When the file runs, the following graph is shown in AutoCAD:
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Example 5

In this example, we will create a Layer in AutoCAD for each pile data. For doing so, now is
given 2 piles driving data, with location name PT-1 and PT-2, where each pile driving data
will be put into Layer by its location name. You, who are accustomed to using AutoCAD, of
course, will understand the importance of working with Layer.

To create a layer click the menus Layer > Make, and then define the layer name. If
combined with the driving data the script is as follows:

"Layer make PT-1 line 1.8,-1”
The letter "m" can stand for Make, thus shortened to:
"Layer m PT-1 line 1.8,-1"

To customize each layer, it will be given a unique color. For example, line in layer PT-1 is
blue, while in PT-2 is magenta. Now, the script becomes:

"layer m PT-1 c blue line 1.8,-1”

Script created above is only written in the first line (row). The next line will only be the
coordinates of points entered into a layer. It is shown as below:
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) E C [u] E F G

1 Pile Penetration Dlata

2

& File Mo. Penetration | Blow Count | Accumulation Seript Soript 2
4 [m) =] = BElowsim'

b 1 1 18 18 layerm PT-1blue line 1.4.-1 pline 0L18,-1w 01 Cell ES ="layer m FT-1c blue line "&CEMH0E" " &E5-1
[ 2 12 30 12,-2 0.3,-2

7 3 ] 33 0.3,-3 0.33,-3

g 4 1 1] 11-4 0.5.-4

) [ 19 3] 15,-8 0.65,-5
0 [ 23 i 238 0885
1 7 29 17 29,7 1177

12 g 20 47 3-8 147.-8
13 ) 28 17 289 1.75,-9
14 10 38 213 3.8,-10 213,10
15 1 34 247 34,1 2471
16 12 40 287 412 28712
17 13 47 334 47,13 334,13
12 14 45 382 43,14 38214
13 15 T3 455 T.3-18 4 56,15
20 16 a0 545 9,16 5.45.-16
21 17 21 E2E 8117 B.2E-17
bl 13 78 704 7.8.-18 7.04.-18
23 13 L] i T.5.-19 Th82-19
24 20 4 256 T.4.-20 856,20
20 21 g2 938 8.2,-21 9.38.-21
il 22 kLl 1023 91,22 10.29,-22
27 23 101 130 101,23 1.3,-23
28 24 108 1238 102,24 12,3824
24 20 120 1308 12,-26 135820
a0 6 152 1510 15.2,-26 15.1,-26
| 27 163 1673 16.3,-27 16.73,-27
a2 28 212 1285 21.2,-28 19.85,-28
a3 2 1 L3 L3 layer m PT-1emagenta line 1E-1 | pline 061w 01 Cell E22 ="layerm PT-1c magenta line "%C33A08" "&E33-1
4 2 3 24 0.3.-2 0.24,-2
35 3 [ 0 062 0.3,-3

To select the script, take these steps, firstly you have to copy the value of cells E5 to E32
and then cells D5 to D32, secondly, select cells E33 to E61 and D33 to D61. By doing so, the
script of number of blows and the cumulative blows of each pile are put into the layer that
corresponds to the location number.

The script in Notepad is shown below:
layer m PT-1 c blue line 1.8,-1

1.2,-2

0.9,-3

1.1,-4

1.5,-5

2.3,-6

2.9,-7

3,-8
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2.8,-9
3.8,-10
34,-11
4,-12
4.7,-13
4.8,-14
7.3,-15
9,-16
8.1,-17
7.8,-18
7.8,-19
7.4,-20
8.2,-21
9.1,-22
10.1,-23
10.8,-24
12,-25
15.2,-26
16.3,-27
21.2,-28
pline 0.18,-1 w 0.1
0.3,-2
0.39,-3
0.5,-4

0.65,-5
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0.88,-6
1.17,-7
1.47,-8
1.75,-9
2.13,-10
2.47,-11
2.87,-12
3.34,-13
3.82,-14
4.55,-15
5.45,-16
6.26,-17
7.04,-18
7.82,-19
8.56,-20
9.38,-21
10.29,-22
11.3,-23
12.38,-24
13.58,-25
15.1,-26
16.73,-27
18.85,-28
layer m PT-2 c magenta line 1.6,-1

0.8,-2
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0.6,-3

1.3,-4

1.2,-5

1.6,-6

2.5,-7

2.9,-8

3.2,-9

3.6,-10
3.9,-11
4.1,-12
4.9,-13
4.7,-14
5.7,-15
7.4,-16
5.9,-17
5.6,-18
5.7,-19
5.9,-20
6.4,-21
6.9,-22
7.1,-23
7.7,-24
8.4,-25
9.3,-26

10.3,-27
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11.4,-28
12.5,-29
pline 0.16,-1 w 0.1
0.24,-2
0.3,-3
0.43,-4
0.55,-5
0.71,-6
0.96,-7
1.25,-8
1.57,-9
1.93,-10
2.32,-11
2.73,-12
3.22,-13
3.69,-14
4.26,-15
5-16
5.59,-17
6.15,-18
6.72,-19
7.31,-20
7.95,-21
8.64,-22

9.35,-23
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10.12,-24
10.96,-25
11.89,-26
12.92,-27
14.06,-28
15.31,-29
The result in AutoCAD:

AukoCAD Classic -

| ||| v Q¥ 'Dm FT2 w s A ||| W eyLaper w
0

v 2Y'omo
u :;; _: :_I- Fiytm 250 300

FILE PENETRATION (METER)

EPRE - @00 LOONNIDLNN

% 500 1000 1500 2000 2500 3000
| CUMULATIVE BLOWS

Layers created in AutoCAD can be seen in a combo-box for layers, at the top-middle of the
AutoCAD drawing area. Each layer can be displayed individually or together with other
layer. To disable or enable a layer, click the mouse on the light icon _¥_in the combo-box.

Note:

e Discussion on script of AutoCAD will take very long time for there are such many
drawing features in AutoCAD. The detail is beyond the scope of this book. It is
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expected that readers can get the ideas from the all examples above. The next step
could be started by making some drawings as Block, which is then inserted using
the Insert command. You can insert block such as markers, a shading object, an
arrow or a form into a drawing area as many as required.

11.2 CREATING SCRIPTS IN VBA

The advantage of VBA is its ability to create a file with ASCII format that contains text. File
is created using the CreateTextFile method with the following syntax:

object.CreateTextFile(filename[, overwrite[, unicodel]]

Description:
object Name of FileSystemObject or Folder object
filename String, name of a file to create

overwrite Optional. Boolean value, if TRUE indicates that file can be overwritten, or vice
versa. If omitted, the value is FALSE.

unicode Optional. Boolean value, indicates whether that file is created as Unicode file
(TRUE) or ASCII (FALSE). If omitted the value is FALSE.

Example

Sub Createfile()
Set fso = CreateObject("'Scripting.FileSystemObject')
Set myfile = fso.CreateTextFile(''c:\testfile.txt", True)
myfile.WriteLine ("Write this text")
myFfile_Close
End Sub
For accessing a file that has been created, use the Open command. The Open syntax itself

consists of several parts with the descriptions that are quite detailed, however it will not be
fully written here. For the purpose of creating a script file, use the following syntax:

Open "c:\testfile.scr" For Output As #1
Print #1, "text”

Write #1, variable

Print #1, numeric & "text " & numeric
Close #1

Descriptions:
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Open command is used for accessing a file named "testfile", to write script into a file.
At the end of code, is to close the open file using Close command. With the above
program the file will then be automatically named "filename" and stored in the
directory C. Extension scr (*.scr) is to make a script file as an AutoCAD file.

Print and Write statement is used to write data to a file. Sign "&" after the Print
statement is to merge text and numerical characters. Statement of Write #1, var x, y
var, var z is where each variable separated by a comma.

If a file written in the directory does not exist, then a file will be created. By this
default, the Open and Close command is more practical to use than the
CreateTextFile method, because it can create a file and accessing any file at the same
time.

If the existing file is in a folder, it must be fully written the following folder and file
name as well (for example, c:\MyFolder\testfile.scr). If you want to create a new
folder, use MKDir statement.

Example 1

Creating a file and accessing to write text.

Open "c:\testfile" For Output As #1 "open File
Print #1, "write this text" "write text to file
Close #1

With the above code, thus the testfile file contains text "write this test" can be accessed in
directory C. When opened with Notepad program, it looks like this:

File Edit Format Wiew Help

I testfile - Notepad g@@

write this text

Example 2

Now, we will use VBA for creating script. Example 2 of Section 11.1 will be adopted for this
example, and for your convenience is re-shown below:
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1 d space
2 |x Y

3 0 0 line 0,0 +=="line "&A3E","&BI&""
4 1 111 =A4E","&BAE™

5 2 323 ]_ Result of copying ce
6 3 3133 from C4 to C5:C6

7

By using VBA, formulas in column C are then no longer needed. However, the worksheet

form is now changed by adding a file name and a command button.

A B = D E
1
2 X Y File Name = c\myScript.scr
3 0 0
4 1 L Produce Script
3 2 3
6 3 3
7

The code can be written as follows:

Private Sub CommandButtonl Click()
Dim myFile As String

myFile = Cells(2, 5)

Open myFile For Output As #1

For i =1 To 3

Print #1, "line " & Cells(2 + i1, 1) & "," & Cells(2 + i, 2) _

& ™ " & Cells@@ + i, 1) & ",” & Cells(3 + i, 2)
Write #1, "an empty line for pressing Enter
Next i
Close #1
End Sub

To run the above program is by clicking the command button named Produce Script. The

resulting script file contains the following text

' myScript.scr - Notepad ﬁa
File Edit Formak  Wiew Help
Tine 0,0 1,1 ~
Tine 1,1 2,3
Tine 2,3 3,3

i
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To run the script above, firstly, open your AutoCAD, then type scr in command prompt or
via Tools > Run Script. From the Select Script File dialog box, select myScript.scr, then the
line segments with the coordinates as in the script file will be created in AutoCAD.

Example 3

In creating line, it is highly recommended to create a table of joints so creating lines to be
more convenient, especially when it comprises many segments and not all of them are
continuous. See the previous examples in Chapter 1. Next is an example of worksheet data
for creating lines. Now, it has an input to add a new folder to make your files storage tidy.

& B C D E F G H | J K
1 Create Lines - : Folder Name = c:\myScriptFolder
Produce 5Script £ :
2 File Name = myScript.scr
3 : Coordinate
Joint = -
4 X y Line Joint
3 1 1.0 1.0 1 1 2 Joint No. =
6 2 2.0 3.0 2 2 3 Line No. = 3
7 3 5.0 4.0 3 2 4
8 4 3.0 1.0
9
10
The code:

Dim npt, nln, i

Dim myFolder, myFile

myFolder = Cells(1, 10)

myFile = Cells(2, 10)

npt = Cells(5, 10)

nln = Cells(6, 10)

ReDim x(npt), y(npt)

ReDim x1(nln), y1(nln), x2(nln), y2(nIn)

"Read joint coord

For 1 = 1 To npt

x(i) = Cells(4 + i, 2)
y(i) = Cells(4 + i, 3)
Next i

"Read lines data

For 1 = 1 To nln
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x1(i) = x(Cells(4 + i, 6))
y1(i) = y(Cells(4 + i, 6))
x2(1) = x(Cells(@4 + i, 7))
y2(i) = y(Cells(4 + i, 7))
Next i
Set fso = CreateObject("'Scripting.FileSystemObject')

IT fso.FolderExists(myFolder) = True Then
Filename = myFolder & "\" & myFile "file with directory and folder
Else
MkDir (myFolder)
Filename = myFolder & '"\" & myFile
End IFf

Open Filename For Output As #1

For i = 1 To nin

Print #1, “Line"

Write #1, x1(i), yl(i)

Write #1, x2(i), y2(i)

Write #1, "an empty line for pressing Enter
Next i

Close #1
End Sub

The content of script file:

B myScript.scr, - Notepad

File Edit Format Wiew Help

ll(
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When the script has run in AutoCAD, the result looks as follows:

T Rl F W Wedeet Foewmel  Todks (ems  Deneienn Mool Wiedbes

L | ]
y

CE RO OLEONTR LN
1

*EFNRE
-

A
T

|

!

O—= X

WAk M) Model {Lapout] ) LapomdZ f

C

r.-l\:\.lin?I'r.nJ. Specily oppoaiiE® COTEETI

!-.'og—y.-e—.-! .

The use of AutoCAD script in civil engineering field is quite popular because both Excel and
AutoCAD could be found easily (who does not have?) and became a must standard
softwares for civil engineers. Example 4 to 7 in the next pages are AutoCAD drawings
produced from script files contained large amount of data. They are created for their
respective interests.

Example 4 (next page):
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Figure 11.1: Profile of undrained shear strength of the soil versus depth from various
test results

Example 5:

DUTCH CONE PENETRATION TEST
Prefect : . :

CPT He. -

Come Resistance (MN/m2) Toen] Friction (MN/m2) Friction Ratio (%)
& 10 15 20 2% 0 01020304050 2 4 8 8 10

==

""‘“\nf\\ N Ny

=l
M

DEFTH BELOW GROUND (m)

Yok N
—

Figure 11.2: Result of Dutch Cone Penetration Test
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Example 6

RL (m)
10 5
= -

Figure 11.3: Long section of the soil profile

Example 7

"

Figure 11.4: Bending moment-Z diagram from 3D frame analysis result
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Figure 11.5: Bending moment-Y diagram from 3D frame analysis result

Figure 11.6: Diagram of bending moment-Z and bending moment-Y are displayed
together
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ATTACHMENT: PROGRAM CODE
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Modulel (FRAME2D)

"FRAME2D v.1.0 Program for 2D Frame Analysis, 2004
"by: Gunthar Pangaribuan - Refer to the book:

"An Introduction to: Excel for Civil Engineers

Option Explicit
Option Base 1
Public 1 As Integer, j As Integer, n As Integer
Type Joint_Data
X As Double
y As Double
End Type

Type Member_Data
J1 As Integer
J2 As Integer
Dens As Double
Ax As Double
E As Double
Iz As Double
El As Double
Ix As Double
ly As Double
Lh As Double
Cx As Double
Cy As Double

End Type

Public ChartWindow As Boolean
Public NP As Integer
Public DOF As Integer
Public NR As Integer
Public NJ As Integer
Public NM As Integer
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Public Member() As Member_ Data
Public Joint() As Joint Data

Public NS As Integer "no. of support
Public NUNI As Integer

Public UNI() As Double

Public GS() As Double "global stiffness
Public Fm() As Double

Public Rs() As Integer

Public DFR() As Double

Public Idm() As Integer

Public Idj() As Integer

Public Irj() As Integer

Public Psum() As Double

Public Pmm() As Double

Public Pj() As Double

Public Xs() As Double

Public Xm() As Double

Public uscale As Integer

Public XAx _Wd As Double

Public YAx Wd As Double

Sub FRAME2D()

On Error GoTo ErrMsg

Const NDJ = 3

Dim NLJ As Integer "no of joint load

NJ = Cells(4, 2)

NM = Cells(5, 2)

uscale = Cells(4, 5)

"X-range:

XAx_Wd = Application.Max(Rows(*'10:10"")) - Application_Min(Rows(''10:10"))
"Y-range:

YAX Wd = Application.Max(Rows(*'11:11")) - Application.Min(Rows(''11:11"))
NS = Application.Count(Rows('22:22"))

NLJ = Application.Count(Rows(*'27:27""))

NUNI = Application.Count(Rows(*'32:32"))
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"Total number of joint displacement, NP:
NP = NDJ * NJ

ReDim Joint(NJ) As Joint_Data

ReDim Member(NM) As Member_Data

ReDim MS(6, 6, NM) As Double "member stiffness matrix
ReDim spn(NS) As Integer

ReDim UNI(NM)

ReDim GS(NP, NP) “global stiffness matrix
ReDim Idm(6, NM) "displacement index
ReDim PJ(NP) "joint load vector

ReDim Pmm(NP, NM) "fixed-end forces

ReDim Psum(NP) "sum load matrix vector
ReDim Xs(NP) "joint deformation vector
ReDim Xm(6, NM) "member deformation

ReDim Fm(6, NM) "member forces

ReDim Rs(NP)

"Read Input Data

"Read joint coordinates
For i = 1 To NJ
With Joint(i)
-x = Cells(10, 1 + 1)
.y = Cells(11, 1 + 1)
End With

Next 1

"Read member data
For i =1 To NM
With Member (i)

2J1l = Cells(14, 1 + 1)
.J2 = Cells(15, 1 + 1)
.Dens = Cells(16, 1 + i)
Ax = Cells(17, 1 + 1)

.E = Cells(18, 1 + 1)
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z Cells(19, 1 + 1)
.El = .E* .1z

-Ix = Joint(.J2).x - Joint(.J1).x
ly = Joint(.J2).y - Joint(.Jl).y
-Lh = Sgr(.Ix ~ 2 + 1y ™ 2)
.Cx = _Ix / .Lh
.Cy = .1y / .Lh
End With

Next i

IT ChartWindow = True Then Call PlotGeometry: Exit Sub
Application.ScreenUpdating = False

"Read joint load

For i = 1 To NLJ
n = Cells(27, 1 + i)
PJ(3 *n -2) =Cells(28, 1 + 1)
PJ(3 * n - 1) = Cells(29, 1 + i)
Pj(3 * n) = Cells(30, 1 + i)

Next i

"Read uniform load

For i = 1 To NUNI
n = Cells(32, 1 + i)
UNI(n) = Cells(33, 1 + i)

Next 1

"restrain list and support (Rs) index
For i = 1 To NS
spn(i) = Cells(22, 1 + i)
Rs(3 * spn(i) - 2) Cells(23, 1 + 1)
Rs(3 * spn(i) - 1) Cells(24, 1 + )
Rs(3 * spn(i)) = Cells(25, 1 + i)
Next i

DOF = 0
For i =1 To NP
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If Rs(i) = O Then DOF = DOF + 1

Next 1

"#restrained joint
NR = NP - DOF

ReDim DFX(NDJ * NS, DOF) As Double "[KbFf]Jaccording to Eq. 4.12
ReDim DFR(DOF, DOF) As Double "[KFF]™-1 according to Eq. 4.9
ReDim RI(NDJ * NS) As Double "support reactions

ReDim Idj(DOF) “"free displacement index

ReDim Irj(NDJ * NS) “"support displacement index

"Structure Analysis

Call Mindex(ldm, I1dj, Irj)
Call stiff_Mtx(MS, GS)
Call MInvers(DFX, DFR)

"generate load

Call Genload(Pmm, Psum)
"determine displacements
Call DISP(Xs, Xm)

"clear previous results

Dim LastRow

LastRow = ActiveSheet.UsedRange.Rows.Count
Range(Cells(39, 1), Cells(LastRow, 18)).ClearContents
*1.Print Load

For i = 1 To NJ

Cells(38 + i, 1).NumberFormat = "O"
Cells(38 + i, 1) = i
Cells(38 + i, 2).NumberFormat = *0.000"

Cells(38 + 1, 2) =Psum(B3 * i - 2)
Cells(38 + 1, 3).NumberFormat ''0.000"

An Introduction to Excel for Civil Engineers 246




Cells(38 + 1, 3) =Psum(B3 * i - 1)
Cells(38 + 1, 4).NumberFormat = "0.000"
Cells(38 + 1, 4) = Psum(3 * 1)

Next 1

"2. Print Joint displacement
For i = 1 To NJ

Cells(38 + 1, 5).NumberFormat = *0.00000"
Cells(38 + 1, 5) = Xs(B3 * 1 - 2)
Cells(38 + i, 6)_.NumberFormat = '0.00000"
Cells(38 + 1, 6) = Xs(B3*1i1 - 1)
Cells(38 + 1, 7)-.NumberFormat = *0.00000"
Cells(38 + 1, 7) = Xs(8 * 1)

Next i

"{F}m=[K]Im.{X}m

For i = 1 To NM
For j =1 To 6
Fm@, i) =0
For n =1 To 6
Fm(g, 1) = Fm@, 1) + MS{@, n, i) * Xm(n, i)
Next n
Next j
Next i

"Print member foces
For i = 1 To NM
With Member (i)
Cells(38 i, 8).NumberFormat "o
Cells(38 + i, 8 =i & "./" & Format(.Lh, "0.0")
Cells(38 i, 9)_NumberFormat '*0.000™

+

+

+

Cells(38 + i, 9) = Pmm(ldm(1, 1), 1) + Fm(1, 1)
Cells(38 + i, 10).NumberFormat = "0.000"
Cells(38 + 1, 10) = Pmm(Idm(2, 1), 1) + Fm(2, 1)
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Cells(38 +
Cells(38 +
Cells(38 +
Cells(38
Cells(38
Cells(38
Cells(38
Cells(38 +
End With

Next i

+ o+ o+

+

For i =1 To 3 * N

S

For J = 1 To DOF

RI(i) = RJ
Next j

Next i

For i = 1 To NS
Cells(38 +
Cells(38 +
Cells(38
Cells(38
Cells(38
Cells(38
Cells(38 +
Cells(38 +

Next 1

+ o+ o+ o+
- - - - - - -

"Draw diagrams

Call PlotGeometry

Call PlotDisplacement

Call PlotMoment

Q)

15).

15)

16).

16)

17).

17)

18).

18)

11) .NumberFormat
11) = Pmm(1dm(3,
12) .NumberFormat
12) = Pmm(1ldm(4,
13) -NumberFormat
13) = Pmm(1ldm(5,
14) .NumberFormat
14) = Pmm(1dm(6,

= "0.000"
i), i) + Fm(@3,
= "0.000"
i), 1) + Fm(4,
= "0.000"
i), i) + Fm(5,
= "0.000"
i), i) + Fm(6,

+ DEX(i, ) * Xs(1dj(g))

NumberFormat
= spn(i)
NumberFormat = *
=RI(B*1 - 2)
NumberFormat = "
=RIB*i -1
NumberFormat =

"0.

-000"

Psum(Irj(3 * i

.000"

Psum(Irj(3 * i

000"

= RJ@B * i) - Psum(Irj(3 * 1))
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Call PlotShear
Call PlotAxial

Range(*"A1'™) .Select
Application.ScreenUpdating = True
Exit Sub

ErrMsg: MsgBox "Error, please check input
"FRAME2D"'

Range('A1'") .Select

Application.ScreenUpdating = True
End Sub

Module2 (FRAME2D)

Option Explicit
Option Base 1

Public T() As Double "transformation matrix,[T]

vbOKOnly + vbExclamation,

Public TT() As Double "transpose [T], used in Module 3

"indexing for matrix subscript

Sub Mindex(dindex() As Integer, IFr() As Integer,

"Member end-displacements index:
For i = 1 To NM
With Member (i)

dindex(1, i) =3 * .J1 -
dindex(2, i) =3 * J1 -1
dindex(3, i) =3 * .J1
dindex(4, i) =3 * .J2 - 2
dindex(5, i) =3 * .J2 - 1
dindex(6, i) = 3 * .J2
End With

Next i

*Joint free displacement index, IFr and support index, IFx:
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1
J=1
For 1 = 1 To NP

IT Rs(i) = 0 Then IFr(n) = i: n=n+1
Next i
n=1
For 1 = 1 To NS

n = Cells(22, 1 + i)

IFX(3* i -2) =3 *n -
IFX(3* i -1)=3*n-1
IFX(3 * i) = 3 * n

Next i

End Sub

N

Sub Stiff Mtx(MK() As Double, S() As Double)
Dim sml As Double, sm2 As Double, sm3 As Double, sm4 As Double, sm5 As Double
ReDim M(6, 6, NM) As Double

"Building stiffness matrix

For i = 1 To NM
With Member(i)
sml = _Ax * _E / _Lh
sm2 =12 * .E * _1z / (-.Lh ~ 3)
sm3 =6* _E* .1z / (.Lh » 2)
smd =4 * E* 1z / .Lh
smb =2 * _E* _1z / _Lh
“"Member stiffness
MK(1, 1, i) = sml: MK(1, 4, i) = -sml

i

MK(2, 2, 1) = sm2: MK(2, 3, 1) sm3: MK(2, 5, 1)
sm3

MK(3, 2, 1) = sm3: MK(3, 3, 1)
sm5

MK(4, 1, i) = -sml: MK(4, 4, i) = sml
)

MK(5, 2, 1) = -sm2: MK(, 3, 1) = -sm3: MK(, 5, i) = sm2: MK(5, 6, i)
-sm3

MK(6, 2, i) = sm3: MK(6, 3, 1) = smb: MK(6, 5, i) = -sm3: MK(6, 6, i)
sm4

-sm2: MK(2, 6, i)

smd: MK(3, 5, 1)

-sm3: MK(3, 6, i)

"Member global stiffness
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M@, 1, i)
.Cx * _Cy: M(1, 3,

sml * .Cx ~ 2 + sm2 * _.Cy ~ 2: M, 2,
i) = -sm3 * _Cy

i) = (smi1 - sm2) *

M@, 4, i) = -M(, 1, i): M@, 5, i) = -(sm1 - sm2) * .Cx * .Cy: M(1, 6,
i) = M, 3, 1)

M2, 1, 1) = M, 2, 1): M2, 2, i) =sml * .Cy 2 + sm2 * .Cx N 2: M(2,
3, 1) = sm3 * _Cx

M2, 4, i) = ML, 5, 1): M2, 5, i) = -M(2, 2, 1): M2, 6, i) = M2, 3,
D)

M(@3, 1, i) = M(, 3, i): M@, 2, i) = M2, 3, i): M@, 3, i) = sm4d

M(3, 4, 1) = -M(1, 3, 1): M3, 5, 1) = -M(2, 3, 1): M(B, 6, 1) = smb5

M4, 1, i) = M(, 4, 1): M@, 2, i) = M, 5, 1): M, 3, 1) = -M(, 3,
)

M4, 4, i) = M@, 1, 1): M@, 5, i) = M@, 2, i): MU, 6, 1) = -M(Q, 3,
D)

MG, 1, 1) = M@, 5, 1) MG, 2, 1) = =M, 2, 1): MG, 3, 1) = =M, 3,
)

M(5, 4, 1) = M, 2, 1): MG, 5, 1) = M2, 2, 1): MG, 6, 1) = -M(2, 3,
)

M(6, 1, i) = M(1, 3, i): M6, 2, 1) = M(2, 3, i): M(6, 3, i) = M(3, 6, i)

M(6, 4, 1) = -M(L, 3, 1): M(6, 5, 1) = -M(2, 3, 1): M(6, 6, 1) = M(3, 3,
)

"Structure stiffness matrix

"Storing members and superposition

For j =1 To 6

For n =1 To 6
s(ldm(g, 1), ldm(n, 1)) = s(ldm(, i), ldm(n, 1)) + M@, n, i)
Next n

Next j

End With
Next i
End Sub
"Global matrix
Sub MInvers(SR() As Double, SD() As Double)
Dim n As Integer
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"submatrix Stiffness, KBF
For i = 1 To DOF
For J =1 To 3 * NS
SR, 1) = GS(rjd). 1dj(i))
Next j

Next 1

"submatrix Stiffness, KFF
For i = 1 To DOF
For J = 1 To DOF
Sb(i, j) = GS(Idj(i), 1did))
Next j
Next i

"Inverse []
For i = 1 To DOF
For J = 1 To DOF
IT jJ <> 1 Then SD(i, j)
Next j
For n = 1 To DOF
IT n =1 Then GoTo 10
For J = 1 To DOF
IT jJ <> 1 Then SD(n, j)
Next j
10 Next n
For n = 1 To DOF
IT n <>1i Then SD(n, i)
Next n
SD(i, i) =1 / SD(, 1)

Next 1

End Sub

-SD(n,

sD(i, j) / Sb(i, i)

Sb(n, J) - SD(i, j) * SD(n, i)

i) /7 SD(i, 1)

Sub Genload(Pa() As Double, Ps() As Double)

ReDim TT(6, 6, NM) As Double

ReDim Peq(NP, NM) As Double "equivalent load due to selfweight

Dim w As Double
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"member fixed-end forces due to selfweight + uniform load
For i = 1 To NM
With Member (i)

w = _Dens * _AX
Pa(ldm(l, 1), 1) = .Cy *w * _Lh / 2
Pa(ldm(2, 1), i) = .Cx *w * _Lh /7 2 + (UNI(i) * .Lh 7 2)
Pa(ldm(3, 1), i) = (.Cx *w * _Lh ~ 2 / 12) + (UNI(i) * .Lh ~ 2 /7 12)
Pa(ldm(4, i), i) = .Cy *w * _Lh / 2
Pa(ldm(5, i), i) = .Cx *w * _Lh /7 2 + (UNI(i) * .Lh /7 2)
Pa(ldm(6, i), i) = -(.Cx *w * _Lh ~ 2 / 12) - (UNI(i) * .Lh ~ 2 /7 12)
End With
Next i

"Transformation matrix (transpose)
For i = 1 To NM
With Member (i)

TT(L, 1, i) = .Cx: TT(1, 2, i) = -.Cy
TT(2, 1, i) = .Cy: TT(2, 2, i) = .Cx
TT(3, 3, i) =1
TT(4, 4, i) = .Cx: TT(4, 5, i) = -.Cy
TT(5, 4, i) = .Cy: TT(5, 5, i) = .Cx
TT(6, 6, i) = 1
End With

Next i

"equivalent joint load due to selfweight + UNI in global system
(superposition)

For i = 1 To NM
For j =1 To 6
For n =1 To 6
Peq(ldm(@, 1), i) = Peq(ldm, 1), i) + TT{, n, i) * -Pa(ldm(n,

1), 1)
Next n
Next j
Next i

"sum load = joint load + eq-load
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For i =1 To NP
Ps(i) = Pj(i)

Next 1

"load superposition
For i =1 To NM
For j =1 To 6

Ps(ldm(j, i)) = Ps(ldm(j, i)) + Peq(ldm(j, i), i)

Next j

Next i

End Sub

Sub DISP(x() As Double, X2() As Double)
ReDim X2(6, NM) As Double

ReDim Xi(6, NM) As Double

ReDim T(6, 6, NM) As Double

"Joint Displacement {X} = [SD]™-1.{P}
For i = 1 To DOF
*x(Idj(i)) =0
For J = 1 To DOF
x(Idj(i)) = x(idj(i)) + DFR(i, j) * Psum(1dj(g))
Next j

Next i

"Numbering of global {X}(NP) to global {Xi} elemen
For i = 1 To NM
For j =1 To 6
Xi(, i) = x(ldm@, 1))
Next j
Next i

"Transforming {Xi} to local coordinates
"Transformation matrix:
For i =1 To NM

With Member (i)
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T(L, 1, i) = .Cx: T@, 2, i) =
T2, 1, i) = -.Cy: T, 2, i) =
TG, 3, i) =1

T4, 4, 1) = .Cx: T4, 5, 1) =
T(, 4, 1)) = -Cy: T, 5, 1) =
T(6, 6, i) =1

End With

Next i

"member deformation, tranformed{X} = [T]-{Xi}

For i = 1 To NM
For j =1 To 6
X2, i) =0
For n =1 To 6

X2g, 1) = X2g, 1 + T4, n,

Next n
Next j

Next i

End Sub

Module3 (FRAME2D)

i) * Xi(n,

"This module consist of only code to create charts

Option Explicit
Option Base 1

Sub PlotGeometry()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant

Dim am As Integer
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"member coordinates
For i =1 To NM
With Member (i)

Cx1 = Joint(.J1).x

Cyl = Joint(.J1l).y

Cx2 = Joint(.J2).x

Cy2 = Joint(.J2).y
End With

mxVal (i) = Array(Cxl, Cx2)

myVal (i) = Array(Cyl, Cy2)

tagxVvVal (i) = Array((Cx1 + Cx2) / 2)

tagyVal (i) = Array((Cyl + Cy2) / 2)
Next i

ActiveSheet.ChartObjects(*"Chart 1').Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

"creating joints
For i = 1 To NJ
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = Joint(i).x
-SeriesCollection(i).Values = Joint(i).y
-SeriesCollection(i).Name = "J" & i
End With
"node marker
ActiveChart.PlotArea.Select
ActiveChart.SeriesCollection(i).-Select
With Selection
3 “red
3

-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex
-MarkerStyle = xICircle
-MarkerSize = 6

-Shadow = False
-ApplyDatalLabels AutoText:=True, LegendKey:=

False, ShowSeriesName:=True,
Showvalue:=False, _
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ShowPercentage:=False, ShowBubbleSize:=False
End With

ActiveChart.SeriesCollection(i).DatalLabels.Select
With Selection
-HorizontalAlignment = xlICenter
-VerticalAlignment = xlICenter
-ReadingOrder = xIContext
-Position = xlLabelPositionRight
-Orientation = xlIHorizontal
End With
With Selection.Font
-Name = "Arial”
-FontStyle = "Regular™
.Size = 8
End With

Next 1

ActiveSheet.ChartObjects(*"Chart 1')_Activate
ActiveChart.ChartArea.Select

n =NJ + NM

"creating member lines
For i = NJ +1 Ton
With ActiveChart

-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mxVvVal (am)
-SeriesCollection(i).Values = myval(am)
-SeriesCollection(i).Name = "=""m

End With

ActiveChart.SeriesCollection(i).Select

With Selection

-MarkerBackgroundColorIndex = xINone

xINone

-MarkerForegroundColorIndex
-MarkerStyle = xINone

.Smooth = False
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End With
With Selection.Border
-ColorIndex = 5
-Weight = xI1Thin
-LineStyle = xlIContinuous
End With
am = am + 1

Next i

"creating member name tags
am = 1
For i = n+ 1 Ton + NM
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i).-XValues = tagxVal(am)
-SeriesCollection(i).Values = tagyVal (am)
.SeriesCollection(i).Name = "M" & am
End With
ActiveChart.PlotArea.Select
ActiveChart.SeriesCollection(i).Select
With Selection
-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex
-MarkerStyle = xlSquare
-Smooth = False

-MarkerSize = 6

-Shadow = False
-ApplyDatalLabels AutoText:=True, LegendKey:= _

False, ShowSeriesName:=True,
Showvalue:=False, _

ShowPercentage:=False, ShowBubbleSize:=False
End With
ActiveChart.SeriesCollection(i).DatalLabels.Select
With Selection.Font

-Name = "Arial”

-.FontStyle = "Regular"

.Size = 8
End With
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am = am + 1

Next 1

ActiveChart.ChartArea.Select

With ActiveChart
-Axes(xICategory, xIPrimary).HasTitle = True
-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _
"NJ = " & Format(NJ, ""0™) & ", NM = " & Format(NM, *0')

End With

ActiveChart.ShowWindow = True

End Sub

Sub PlotDisplacement()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2
ReDim mxValbf(NM) As Variant, myValbf(NM) As Variant
ReDim mxValaf(NM) As Variant, myValaf(NM) As Variant

Dim am As Integer, scale Y As Single, scale X As Single, scx As Single
Dim Xmax As Double, at_joint As Integer

ActiveSheet.ChartObjects(*"Chart 2').Activate
ActiveChart.ChartArea.Select
Selection.ClearContents

"scale for displacement

"user scale: max displacement are drawn up to 10% of the axis range

"or follows formula: X-range or Y-range * 10% = Xmax
"determine max. joint-X and Y displacement

"(user function UXMax written at the end of this module):
Xmax = Application. index(UXMax(Xs, NP), 1)
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at_joint = Application.index(UXMax(Xs, NP), 2)
scx = (Application.Max(XAx_Wd, YAx Wd) * 10 / 100) / Abs(Xmax)
IT uscale = 1 Then

scale X = 1
scale Y =1

Elself uscale = 0 Then
scale X = scx
scale_Y = scx

Else
scale X =
scale Y =

End IFf

"member coordinates: before & after loading
For i = 1 To NM
With Member (i)
Cx1 = Joint(.J1l).x

Cyl = Joint(.Jl).y

Cx2 = Joint(.J2).x

Cy2 = Joint(.J2).y
mxValbf(i) = Array(Cx1, Cx2)

myValbf(i) = Array(Cyl, Cy2)
Cx1 = Joint(.J1).x + scale X * Xs(3 * .J1 - 2)

Cyl = Joint(.J1l).y + scale Y * Xs(3 * .J1 - 1)
Cx2 = Joint(.J2).x + scale_ X * Xs(3 * .J2 - 2)
Cy2 = Joint(.J2).y + scale Y * Xs(3 * .J2 - 1)

mxValaf(i) = Array(Cx1, Cx2)
myValaf(i) = Array(Cyl, Cy2)

End With
Next i
am = 1

"creating member lines: before loading
For i = 1 To NM
With ActiveChart
-SeriesCollection.NewSeries

.SeriesCollection(i).XValues = mxValbf(am)
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-SeriesCollection(i).Values =
.SeriesCollection(i).Name =
End With

ActiveChart.SeriesCollection(i).-Select

With Selection
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColorIndex = 5
-Weight = xIThin
.LineStyle = xlIContinuous

End With
am = am + 1
Next i
n = NM + NM
am = 1

"creating member lines: after loading
For 1 = NM + 1 To n
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i).XValues
-SeriesCollection(i).Values =
-SeriesCollection(i).-Name =
End With

ActiveChart.SeriesCollection(i).Select

With Selection
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColoriIndex = 7
-Weight = xIMedium
-LineStyle = xlIContinuous

End With

am = am + 1
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Next 1

ActiveChart.ChartArea.Select
With ActiveChart

-Axes(xICategory, xIPrimary).HasTitle = True

-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _

"Max Displacement, J." & at joint & " = " & Format(Xmax, '0.00000"™)
End With

End Sub

Sub PlotMoment()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

Dim Cmx1, Cmx2, Cmyl, Cmy2
ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim moxVal(NM) As Variant
ReDim moyVal(NM) As Variant
ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant

ReDim mjxVal(NM + NM) As Variant
ReDim mjyVal(NM + NM) As Variant
ReDim mcolor(NM + NM) As Variant
ReDim Pm_LM(3, NM) As Double
ReDim Pm_RM(3, NM) As Double
ReDim Pm_LT(3, NM) As Double
ReDim Pm_RT(3, NM) As Double

Dim am As Integer, scm As Single, scale_Y As Single, scale X As Single

Dim Mmax As Double, at joint As Integer, L_I As Integer, L_Il As Integer
ActiveSheet.ChartObjects(*"Chart 3').Activate

ActiveChart.ChartArea.Select

Selection.ClearContents
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"analogous to plot displacement for scaling

Mmax = Application. index(UMMax(Pmm, Fm, NM), 1)
at_joint = Application.index(UMMax(Pmm, Fm, NM), 2)

scm = (Application_Max(XAx_Wd, YAx Wd) * 15 / 100) / Abs(Mmax)

If uscale = 1 Then
1

scale Y = 1

scale X

Elself uscale = 0 Then
scale X = scm
scale Y = scm

Else
scale X =
scale Y =

End If

"member moment, consider only 3rd and 6th vectors

For 1 =1 To NM

)

Pm_LM(2, 1) = Pmm(ldm(3, 1), i) + Fm(3,
Pm_RM(2, 1) = -(Pmm(ldm(6, 1), i) + Fm(6,
Next i

1))

“transform member moment to global axis by using [TT]

"the drawing should be in global coordinates

For 1 =1 To NM
For j =1 To 3
For n =1 To 3

Pm LT, 1) =
Pm RT(g, 1) =
Next n
Next j
Next i

For i = 1 To NM
With Member (i)
Cx1 = Joint(.J1l).x
Cyl = Joint(.Jl).y
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Cx2
Cy2

Joint(.J2).x
Joint(.J2).y

"assign force coordinates
Pm_LT(1, 1) "x direction
Pm_LT(2, i) "y direction
Pm_RT(1, i)
Pm_RT(2, i)

Cmx1l = Cx1 + scale X

Cmyl = Cyl + scale Y

Cmx2 = Cx2 + scale X

Cmy2 = Cy2 + scale Y
End With

"member coordinates

*

*

*

*

mxVal (i) = Array(Cx1l, Cx2)
myVal (i) = Array(Cyl, Cy2)

"moment coordinates

moxVal (i) = Array(Cmx1, Cmx2)
moyVal (i) = Array(Cmyl, Cmy2)

"member-joint coordinates
mjxvVal(2 * i - 1)

mjyval(2 * 1 - 1)

Array(Cx1l, Cmx1)
Array(Cyl, Cmyl)

"mcolor: define color for positive/negative value
mcolor(2 * 1 - 1) = -(Pmm(1dm(3, 1), i) + Fm(3,

mjxvVal (2 * i
mjyval (2 *

mcolor(2 *

)
)
)
Next i

"creating member lines

For i =1 To NM
With ActiveChart

.SeriesCollection.NewSeries

-SeriesCollection(i).XValues

-SeriesCollection(i).Values =

.SeriesCollection(i).Name =

End With

= Array(Cx2, Cmx2)
Array(Cy2, Cmy2)

(PmmCldm(6, i), i) + Fm(6, i))

mxVal (1)
myVal (i)

ActiveChart.SeriesCollection(i).-Select

With Selection

-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex

-MarkerStyle = xINone
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-Smooth = False

End With

With Selection.Border
-ColorIndex = 5
-Weight = xIThin
-LineStyle = xlIContinuous

End With

Next i

L1 = NM + NM

am = 1

"creating moment lines

For i = NM + 1 To L_I
With ActiveChart

-SeriesCollection.NewSeries
.SeriesCollection(i).XValues
.SeriesCollection(i).Values

-SeriesCollection(i)-Name =

End With

moxVal (am)

moyVal (am)

ActiveChart.SeriesCollection(i).Select

With Selection

-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex

-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColoriIndex = 7
-Weight = xI1Thin
-LineStyle = xlIContinuous

End With

am = am + 1

Next i

NM + NM + NM + NM

L 11
am =1
"creating joint lines to axis

An Introduction to Excel for Civil Engineers

xINone

xINone

265




For 1 = L_1 +1 To L_I1
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mjxVal (am)
-SeriesCollection(i).Values = mjyval(am)
.SeriesCollection(i).Name = "="""""
End With
ActiveChart.SeriesCollection(i).-Select
With Selection

xINone

-MarkerBackgroundColorIndex

-MarkerForegroundColorilndex = xINone

-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
IT mcolor(am) < O Then
-.Colorilndex = 3
Else
-ColorIndex = 5
End If
-Weight = xIMedium
.LineStyle = xlIContinuous
End With

am = am + 1
Next 1

ActiveChart.ChartArea.Select

With ActiveChart
-Axes(xICategory, xIPrimary).HasTitle = True
-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _
"Max Moment, J."™ & at_joint & " = " & Format(Mmax, ""0.000')

End With

End Sub
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Sub PlotShear()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

Dim Cmx1, Cmx2, Cmyl, Cmy2
ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim shxVal(NM) As Variant
ReDim shyVal(NM) As Variant
ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant

ReDim mjxVal(NM + NM) As Variant
ReDim mjyVal(NM + NM) As Variant
ReDim scolor(NM + NM) As Variant
ReDim Ps_LM(3, NM) As Double
ReDim Ps_RM(3, NM) As Double
ReDim Ps_LT(3, NM) As Double
ReDim Ps_RT(3, NM) As Double

Dim am As Integer, scs As Single, scale_Y As Single, scale X As Single

Dim Smax As Double, at joint As Integer, L_I As Integer, L_Il As Integer

ActiveSheet.ChartObjects(*"Chart 4')_Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

"analogous to with plot displacement for scaling

Smax = Application.index(USMax(Pmm, Fm, NM), 1)

at_joint = Application.index(USMax(Pmm, Fm, NM), 2)

scs = (Application.Max(XAx_Wd, YAx Wd) * 15 / 100) / Abs(Smax)

IT uscale = 1 Then

scale X = 1
scale Y =1
Elself uscale = 0 Then

scale X = scs
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SCSs

scale Y
Else

scale_X

scale Y
End If

"member moment, consider only 2nd and 5th vectors

For 1 =1 To NM

Ps_LM(2, 1) = (Pmm(ldm(2, i), 1) + Fm(2,
Ps RM(2, 1) = -(Pmm(ldm(5, 1), i) + Fm(,
Next i

1))
)

“transform member shear to global axis by using [TT]

"the drawing should be in global coordinates
For i = 1 To NM
For j =1 To 3
For n =1 To 3

Ps LT, 1) = Ps LT, 1) + TTQ,
Ps RT(g, 1) = Ps RT(g, 1) + TTQ,
Next n
Next j
Next i

For 1 = 1 To NM
With Member (i)
Cx1 = Joint(.J1l).x

Cyl = Joint(.Jl).y
Cx2 = Joint(.J2).x
Cy2 = Joint(.J2).y

"assign force coordinates

n, 1) * Ps_LM(n,
n, 1) * Ps_RM(n,

Cmx1l = Cx1 + scale X * Ps LT(1, i) "x direction

Cmyl = Cyl + scale Y * Ps LT(2, 1) "y direction

Cmx2 = Cx2 + scale X * Ps_RT(1, 1)
Cmy2 = Cy2 + scale Y * Ps_RT(2, 1)
End With
"member coordinates
mxVal (i) = Array(Cxl, Cx2)
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myVal(i) = Array(Cyl, Cy2)
"shear coordinates
shxVval (i)
shyVal (i)
"member-joint coordinates
mjxvVal(2 * 1 - 1)
mjyval(2 * 1 - 1)
scolor(2 * 1 - 1)

Array(Cmx1, Cmx2)
Array(Cmyl, Cmy2)

Array(Cx1l, Cmx1)
Array(Cyl, Cmyl)
(Pmm(ldm(2, i), i) + Fm(2, i))

mjxVal(2 * 1) = Array(Cx2, Cmx2)
mjyval(2 * 1) = Array(Cy2, Cmy2)
scolor(2 * 1) = -(Pmm(1ldm(5,

Next 1

"creating member lines
For i = 1 To NM
With ActiveChart

.SeriesCollection.NewSeries

-SeriesCollection(i).XValues

-SeriesCollection(i).Values
-SeriesCollection(i).-Name =
End With

i), i) + Fm(, 1))

= mxVal (i)

myVal (1)

ActiveChart.SeriesCollection(i).Select

With Selection
-MarkerBackgroundColorIndex
-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColorIndex = 5
-Weight = xIThin
.LineStyle = xlIContinuous

End With
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"creating shear lines

For 1 = NM + 1 To L_I

With ActiveChart
-SeriesCollection.NewSeries

-SeriesCollection(i).-XValues = shxval(am)

-SeriesCollection(i).Values = shyval(am)

.SeriesCollection(i).Name = "=
End With
ActiveChart.SeriesCollection(i)-Select
With Selection
-MarkerBackgroundColorlndex = xINone

-MarkerForegroundColorIndex = xINone

-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-.Colorilndex = 7
-Weight = xI1Thin
-LineStyle = xlIContinuous

End With

am = am + 1

Next 1

LIl =NM + NM + NM + NM
am = 1
"creating joint lines to axis
For i =L 1+ 1 To L_Il
With ActiveChart
-SeriesCollection.NewSeries

-SeriesCollection(i).-XValues = mjxval(am)

-SeriesCollection(i).Values = mjyval(am)

.SeriesCollection(i).Name =
End With
ActiveChart.SeriesCollection(i).-Select
With Selection

-MarkerBackgroundColorlndex = xINone

xINone

-MarkerForegroundColorIndex
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-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
IT scolor(am) < 0 Then

-ColoriIndex = 3
Else
-ColorIndex = 5
End IT

-Weight = xIMedium
-LineStyle = xlIContinuous
End With
am = am + 1

Next 1

ActiveChart.ChartArea.Select

With ActiveChart
-Axes(xICategory, xIPrimary).HasTitle = True
-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _
"Max Shear, J." & at_joint & " = " & Format(Smax, '"0.000')

End With

End Sub

Sub PlotAxial()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

Dim Cmx1, Cmx2, Cmyl, Cmy2
ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim saxVal(NM) As Variant
ReDim sayVal(NM) As Variant
ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant
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ReDim mjxVal(NM + NM) As Variant
ReDim mjyVal(NM + NM) As Variant
ReDim acolor(NM + NM) As Variant
ReDim Pa_LM(3, NM) As Double
ReDim Pa_RM(3, NM) As Double
ReDim Pa_LT(3, NM) As Double
ReDim Pa_RT(3, NM) As Double

Dim am As Integer, sca As Single, scale_Y As Single, scale X As Single
Dim Amax As Double, at_joint As Integer, L_I As Integer, L_Il As Integer

ActiveSheet.ChartObjects(*"Chart 5').Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

"analogous to plot displacement for scaling

Amax = Application.index(UAMax(Pmm, Fm, NM), 1)

at_joint = Application.index(UAMax(Pmm, Fm, NM), 2)

sca = (Application_Max(XAx_Wd, YAx Wd) * 15 / 100) / Abs(Amax)

If uscale = 1 Then
scale X = 1

scale Y = 1

Elself uscale = 0 Then
scale X = sca
scale Y = sca

Else
scale X =
scale Y =

End IF

"member axial, consider only 1st and 4th vectors
For i = 1 To NM

Pa_LM(2, 1) = -(Pmm(ldm(1, 1), i) + Fm(1, 1))
Pa_RM(2, 1) = (Pmm(ldm(4, 1), i) + Fm(4, 1))
Next i
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"transform member axial to global axis by using [TT]
"the drawing should be in global coordinates
For i = 1 To NM
For j =1 To 3
For n =1 To 3

Pa LT, 1) = Pa LT, 1) + TT(J, n, i) * Pa_LM(n,
Pa RT(J, i) = Pa_RTQ, i) + TT{@, n, i) * Pa_RM(n,
Next n
Next j
Next i

For i = 1 To NM
With Member (i)
Cx1 = Joint(.J1).x

Cyl = Joint(.J1l).y

Cx2 = Joint(.J2).x

Cy2 = Joint(.J2).y

"assign force coordinates

Cmx1 = Cx1 + scale X * Pa_LT(1, 1)

Cmyl = Cyl + scale Y * Pa_LT(2, 1)

Cmx2 = Cx2 + scale X * Pa_RT(1, 1)
)

Cmy2 = Cy2 + scale Y * Pa_ RT(2, i
End With
"member coordinates
mxVal (i) = Array(Cx1l, Cx2)
myVal (i) = Array(Cyl, Cy2)
"axial coordinates
saxVal (i) = Array(Cmx1, Cmx2)
sayVal (i) = Array(Cmyl, Cmy2)
"member-joint coordinates
mjxvVal(2 * i - 1)
mjyval(2 * 1 - 1) Array(Cyl, Cmyl)
acolor(2 * i1 - 1) -(Pmm(ldm(1, i), 1) + Fm(1, 1))
mjxvVal(2 * 1) Array(Cx2, Cmx2)
mjyval (2 * i) Array(Cy2, Cmy2)
acolor(2 * 1) Pam(ldm(4, i), i) + Fm(4, 1)

Array(Cx1l, Cmx1)

Next 1
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"creating member lines
For 1 = 1 To NM

With ActiveChart
-SeriesCollection._NewSeries
.SeriesCollection(i).XValues
.SeriesCollection(i).Values
-SeriesCollection(i)-Name =

End With

ActiveChart.SeriesCollection(i).

With Selection
-MarkerBackgroundColorIndex
-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColorIndex = 5
-Weight = xI1Thin
-LineStyle = xlIContinuous

End With

Next 1

1 = NM + NM
=1

"creating axial lines
For 1 = NM + 1 To L_I

With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i).XValues
.SeriesCollection(i) .Values
.SeriesCollection(i).Name =

End With

ActiveChart.SeriesCollection(i).

With Selection
-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex
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-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColorlIndex = 7
-Weight = xIThin
.LineStyle = xlIContinuous
End With
am = am + 1
Next i
LIl =NM+ NM + NM + NM
am = 1
"creating joint lines to axis
For i =L 1 +1TolL_Il
With ActiveChart
-SeriesCollection.NewSeries
.SeriesCollection(i).XValues
-SeriesCollection(i).Values
-SeriesCollection(i)-Name =
End With
ActiveChart.SeriesCollection(i).
With Selection
-MarkerBackgroundColorIndex
-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
IT acolor(am) < 0 Then
-ColorIndex = 3
Else
.Colorilndex = 5
End IT
-Weight = xIMedium
-LineStyle = xlIContinuous
End With

am = am + 1
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Next 1
ActiveChart.ChartArea.Select
With ActiveChart

.Axes(xICategory, xIPrimary).HasTitle = True

-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _

"Max Axial, J." & at _joint & " = " & Format(Amax, '"0.000")
End With

End Sub

"user function to determine maximum value of
"X1 and X2 (rotation X3 is not included)

Function UXMax(Xs, NP) As Variant

Dim Abs FXMax As Double
Dim FXMax As Double

Abs_FXMax = Abs(Xs(1))

FXMax = O
n=1
J=3

For 1 = 2 To NP

Select Case 1

Case j
i=3+3
n=n+1

Case Else

If Abs(Xs(i)) > Abs_FXMax Then
Abs_FXMax = Abs(Xs(1))
FXMax = Xs(i)
UXMax = Array(FXMax, n)
"UXMax keeps origin value(+ or - value)

End IT

End Select
Next i

End Function
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"user function to determine maximum value of
"moment, F3 (F1 and F2 are not included)

Function UMMax(Pmm, Fm, NM) As Variant
Dim Abs_FMMax As Double
Dim FMMax As Double

Abs FMMax = O
n=2=0
For i = 1 To NM
I Abs(Pmm(ldm(3, 1), i) + Fm(3, 1)) > Abs_FMMax Then
Abs FMMax = Abs(Pmm(ldm(3, i), 1) + Fm(3, 1))
FMMax = -(Pmm(ldm(3, i), 1) + Fm(3, 1))
n = Member(i).J1l
UMMax = Array(FMMax, n)
End IFf
I Abs(Pmm(ldm(6, 1), i) + Fm(6, 1)) > Abs_FMMax Then
Abs_FMMax = Abs(Pmm(ldm(6, i), i) + Fm(6, i))
FMMax = Pmm(ldm(6, 1), 1) + Fm(6, i)
n = Member(i).J2
UMMax = Array(FMMax, n)
End IFf
Next i

End Function

"user function to determine maximum value of
"shear force, F2 (F1 and F3 are not included)
Function USMax(Pmm, Fm, NM) As Variant

Dim Abs_FSMax As Double
Dim FSMax As Double

Abs FSMax = 0
n=2=0
For i = 1 To NM
I Abs(Pmm(ldm(2, 1), i) + Fm(2, 1)) > Abs_FSMax Then
Abs FSMax = Abs(Pmm(ldm(2, i), 1) + Fm(2, 1))
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FSMax = (Pmm(ldm(2, 1), i) + Fm(2, 1))
n = Member(i).J1l
USMax = Array(FSMax, n)

End IT

If Abs(Pmm(1dm(5, i), i) + Fm(5, i)) > Abs FSMax Then
Abs FSMax = Abs(Pmm(ldm(5, i), 1) + Fm(5, 1))
FSMax = -(Pmm(ldm(5, i), 1) + Fm(5, 1))
n = Member(i).J2
USMax = Array(FSMax, n)

End If

Next i

End Function

"user function to determine maximum value of
"axial force, F1 (F2 and F3 are not included)
Function UAMax(Pmm, Fm, NM) As Variant

Dim Abs FAMax As Double
Dim FAMax As Double

Abs FAMax = 0
n=2=0
For i = 1 To NM
I Abs(Pmm(ldm(1, 1), i) + Fm(1, 1)) > Abs_FAMax Then
Abs_FAMax = Abs(Pmm(ldm(1, i), i) + Fm(1, 1))
FAMax = -(Pmm(ldm(1, i), 1) + Fm(1, 1))
n = Member(i).J1l
UAMax = Array(FAMax, n)
End IT
I Abs(Pmm(ldm(4, 1), i) + Fm(4, 1)) > Abs_FAMax Then
Abs FAMax = Abs(Pmm{ldm(4, i), 1) + Fm(4, 1))
FAMax = Pmm(ldm(4, 1), 1) + Fm(4, 1)
n = Member(i).J2
UAMax = Array(FAMax, n)
End If
Next i

End Function
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Command Button (FRAME2D)

Private Sub CommandButtonl Click()
ChartWindow = True

Call FRAME2D
End Sub

Private Sub CommandButton2 Click()
ChartWindow = False

Call FRAME2D
End Sub

Modulel (TRUSS2D)

"TRUSS2D v.1.0 Program for 2D TRUSS analysis, 2004
"by: Gunthar Pangaribuan - Refer to the book:

"An Introduction to: Excel for Civil Engineers

Option Explicit
Option Base 1

Public i As Integer, j As Integer, n As Integer

Type Joint_Data
X As Double
y As Double
End Type

Type Member_Data
J1 As Integer
J2 As Integer
Dens As Double
Ax As Double
E As Double
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Ix As Double

ly As Double

Lh As Double

Cx As Double

Cy As Double
End Type

Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public
Public

ChartWindow As Boolean
NP As Integer

DOF As Integer

NR As Integer

NJ As Integer

NM As Integer

Member() As Member_Data
Joint() As Joint Data
NS As Integer "no. of support
GS() As Double "global stiffness
Rs() As Integer

DFR() As Double

Idm() As Integer

1dj(O As Integer

IrjO As Integer

Psum() As Double

Pmm() As Double

PJ(O As Double

Xs() As Double

Xm() As Double

Fm() As Double

XAx_Wd As Double

YAx_Wd As Double

Sub TRUSS2D()

On Error GoTo ErrMsg

Const NDJ = 2
Dim NLJ As Integer "no of joint load
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NJ Cells(4, 2)

NM = Cells(5, 2)

"X-range:

XAx_Wd = Application.Max(Rows(*'10:10"")) - Application_Min(Rows(''10:10"))
"Y-range:

YAX Wd = Application.Max(Rows(*'11:11")) - Application.Min(Rows('11:11"))
NS = Application.Count(Rows('22:22"))

NLJ = Application.Count(Rows(*'27:27""))

"Total number of joint displacement, NP:

NP = NDJ * NJ

ReDim Joint(NJ) As Joint_Data

ReDim Member(NM) As Member_Data

ReDim MS(4, 4, NM) As Double "member stiffness matrix
ReDim GS(NP, NP) "global stiffness matrix
ReDim Idm(4, NM) “displacement index
ReDim PjJ(NP) "joint load vector

ReDim Pmm(NP, NM) "fixed-end forces

ReDim Psum(NP) “sum load matrix vector
ReDim Xs(NP) "joint displacement vector
ReDim Xm(4, NM) "member deformation

ReDim Fm(4, NM) "member forces

ReDim Rs(NP)

ReDim spn(NS) As Integer

"Read Input Data

"Read joint coordinates
For i = 1 To NJ
With Joint(i)
-x = Cells(10, 1 + 1)
.y = Cells(11, 1 + 1)
End With

Next 1
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"Read element data
For 1 =1 To NM
With Member (i)

.J1 = Cells(15, 1 + 1)
.J2 = Cells(16, 1 + 1)
.Dens = Cells(17, 1 + 1)
_Ax = Cells(18, 1 + 1)

-E = Cells(19, 1 + 1)

Ix = Joint(.J2).x - Joint(.J1).x
ly = Joint(.J2).y - Joint(.Jl).y
Lh = Saqr(.Ix ~ 2 + _ly ™ 2)

.Cx = .Ix / .Lh

.Cy = .1y / _Lh

End With

Next 1

IT ChartWindow = True Then Call PlotGeometry: Exit Sub

Application.ScreenUpdating = False

"Read joint load
For 1 = 1 To NLJ
n = Cells(27, 1 + i)
Pj(2 *n - 1) = Cells(28, 1 + i)
PJ(2 * n) = Cells(29, 1 + 1)
Next i

"restrain list and support (Rs) index
For i = 1 To NS

spn(i) = Cells(22, 1 + i)

Rs(2 * spn(i) - 1) = Cells(23, 1 + 1)

Rs(2 * spn(i)) = Cells(24, 1 + 1)
Next i

DOF = O

For i =1 To NP
IT Rs(i) = 0 Then DOF = DOF + 1
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Next 1

"#restrained joint
NR = NP - DOF

ReDim DFX(NDJ * NS, DOF) As Double "[KbFf]Jaccording to Eq. 4.12
ReDim DFR(DOF, DOF) As Double "[KFF]™-1 according to Eq.

ReDim RIJ(NDJ * NS) As Double "support reactions
ReDim 1dj(DOF) “free displacement index
ReDim Irj(NDJ * NS) “support displacement index

"Structure Analysis

Call Mindex(ldm, I1dj, Irj)
Call Stiff Mtx(MS, GS)
Call MInvers(DFX, DFR)
"generate load

Call Genload(Pmm, Psum)
"determine displacements
Call DISP(Xs, Xm)

"clear previous content

Dim LastRow

LastRow = ActiveSheet.UsedRange.Rows.Count
Range(Cells(35, 1), Cells(LastRow, 10)).ClearContents

*1.Print Load

For i = 1 To NJ
Cells(34 + 1, 1).NumberFormat = 0"
Cells(34 + i, 1) =i
Cells(34 + i, 2).NumberFormat ''0.000"
Cells(34 + 1, 2) =Psum(2 * i - 1)
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Cells(34 + i1, 3).NumberFormat = "0.000"
Cells(34 + 1, 3) = Psum(2 * 1)
Next i

"2. Print Joint displacement

For i = 1 To NJ
Cells(34 i, 4)_.NumberFormat = "'0.00000"
Cells(34 + i, 4) =Xs(2 *i - 1)

+

+

Cells(34 + 1, 5).NumberFormat = *0.00000"
Cells(34 + i, 5) = Xs(2 * 1)
Next i

"{F3m=[K]Im.{X}m

For i = 1 To NM
For j 1 To 4
Fm(, i) =0
For n =1 To 4
Fm@, 1) = Fm@, 1) + MS, n, 1) * Xm(n, i)

Next n

Next j

Next i

*Print member foces
For i = 1 To NM
With Member (i)
Cells(34 + 1, 6).NumberFormat = 0"
Cells(34 + i1, 6) =1 & "./" & Format(.Lh, "0.0")
Cells(34 + 1, 7)-.NumberFormat = "0.000"
Cells(34 + i, 7) = Pmm(ldm(1, i), i) + Fm(1, i)
Cells(34 + 1, 8).NumberFormat = *0.000"
Cells(34 + i, 8) = Pmm(1dm(3, i), i) + Fm(3, i)
End With

Next 1
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For i =1 To 2 * NS
For J = 1 To DOF

RJI(i) = RI(i) + DFX(i, j) * Xs(1di(G))

Next j
Next 1

For i = 1 To NS

Cells(34 + 1, 9).NumberFormat = "0"
Cells(34 + i, 9) = spn(i)
Cells(34 + 1, 10) _NumberFormat = "0.000"
Cells(34 + i, 10) = RI(2 * i - 1) - Psum(Irj(2 * i - 1))
Cells(34 + i, 11)._.NumberFormat = "0.000"
Cells(34 + i, 11) = RI(2 * i) - Psum(Irj(2 * 1))
Next i

Call PlotGeometry
Call PlotDisplacement
Call PlotAxial

Range(""A1'™) .Select
Application.ScreenUpdating = True

Exit Sub

ErrMsg: MsgBox "Error, please check input
"TRUSS2D"

Range(*'A1'") .Select
Application.ScreenUpdating = True

End Sub
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Module2 (TRUSS2D)

Option Explicit

Option Base 1

Public T() As Double "transformation matrix

Public TT() As Double "transpose [T], used in Module 3

"Indexing for matrix subscript
Sub Mindex(index() As Integer, IFr() As Integer, IFx() As Integer)

"Member end-displacements index:
For i =1 To NM
With Member (i)

index(1, i) =2 * J1 -1
index(2, 1) =2 * _J1
index(3, 1) =2 * .J2 -1
index(4, i) =2 * _.J2
End With

Next i

*Joint free displacement index, IFr and support index, IFx
n=1
j=1
For i = 1 To NP
IT Rs(i) = 0 Then IFr(n) = i: n=n+1

Next i
n=1
For i = 1 To NS
n = Cells(22, 1 + i)

IFX(2*i-1)=2*n-1
IFX(2 * 1) =2 *n

Next 1

End Sub
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Sub Stiff Mtx(MK() As Double, S() As Double)
Dim sms As Double
ReDim M(4, 4, NM) As Double

"Building global stiffness matrix
For i = 1 To NM
With Member (i)
sms = _Ax * _E / _Lh
“Member stiffness
MK(1, 1, 1) = sms: MK(1, 3,
MK(3, 1, i) = -sms: MK(3, 3,
"Member global stiffness

M(1, 1, 1) = sms * .Cx * .Cx: M(1, 2, 1) = sms * .Cx * .Cy: M(1, 3, 1) =
-M(1, 1, 1): M, 4, 1) = -M(Q, 2, 1)

M2, 1, i) = M(L, 2, i)z M(2, 2, i) = sms * .Cy * .Cy: M(2, 3, i) = M(Q,
4, i): M2, 4, i) = -M(2, 2, i)

M(3, 1, i) = M(L, 3, i): M@, 2, i)
i): M3, 4, i) = M2, 2, i)

M(4, 1, i) = M(L, 4, i): M(4, 2, i)
i): M(4, 4, i) = M2, 2, i)

"Storing members and superposition
For j =1 To 4
For n =1 To 4
S(ldm(@@, i), Idm(n, i)) = S(dm@, i), Idm(n, i)) + M{, n, i)

Next n

i) = -sms
i

) = sms

M(2, 3, i): M(3, 3, i) = M(, 1,

M(2, 4, i): M(4, 3,

-
o/
1
=
~
w
N

Next j
End With
Next i
End Sub
"Global matrix
Sub MInvers(SR() As Double, SD() As Double)

Dim n As Integer

"submatrix Stiffness, KRF
For i = 1 To DOF
For j =1 To 2 * NS
SRA., 1) = 6SUrjg). 1di(i))
Next j
Next i
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"submatrix Stiffness, KFF
For i = 1 To DOF
For J = 1 To DOF

Sb(i, §) = 6S(udj (i), 1didd)

Next j

Next 1

"Inverse []
For i = 1 To DOF
For J = 1 To DOF
If j <> 1 Then SD(i, J)
Next j
For n = 1 To DOF
IT n =1 Then GoTo 10
For J = 1 To DOF
IT j <> 1 Then SD(n, j)
Next j
10 Next n
For n = 1 To DOF
IT n <> 1i Then SD(n, i)
Next n
SD(i, i) =1 / SD(, 1)

Next 1

End Sub

SD(i, j) 7/ SD(i, i)

Sb(n, J) - SD(Ci, j) * SD(n,

-SD(n, 1) 7 SD(i, i)

Sub Genload(Pa() As Double, Ps() As Double)

ReDim TT(4, 4, NM) As Double

ReDim Peq(NP, NM) "equivalent load due to selfweight

Dim ldx As Integer, W As Double

"member fixed-end forces due to selfweight

For i = 1 To NM
With Member (i)
W = _Dens * _AX
Pa(ldm(1, 1), i)
Pa(ldm(2, 1), i)

Cy *W=* _Lh / 2
Cx * W *

.Lh 7 2
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Pa(ldm(3, i), i) = .Cy *W * .Lh /7 2
Pa(ldm(4, i), i) = .Cx *W * .Lh / 2
End With

Next i

"Transformation matrix (transpose)
For i = 1 To NM
With Member (i)

TT(1, 1, i) = .Cx: TT1(8, 3, 1) = T1(4, 1, i): T1Q, 2, i) = -.Cy: TT1(8,
4, 1) =TT, 2, 1)

TT(2, 1, i) = .Cy: TT(4, 3, i) = TT(2, 1, i): TT(2, 2, i) = .Cx: TT(4, 4,
1

i) =TT, 2, 1)
End With
Next i

"equivalent joint load due to selfweight in global system
For i =1 To NM
For j =1 To 4
For n =1 To 4

Peq(ldm(j, 1), i) = PeqUdm(g, 1), 1) + TT{, n, i) * -Pa(ldm(n,
1), i)
Next n
Next j
Next i

"sum load = joint load + eq.load
For i = 1 To NP
Ps(i) = Pj(i)

Next 1

"load superposition
For i = 1 To NM
For j =1 To 4
Ps(ldm(j, 1)) = Ps(ldm(j, i)) + Peq(ldm(jG, i), i)
Next j

Next 1

End Sub
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Sub DISP(x() As Double, X2() As Double)
ReDim X2(4, NM) As Double

ReDim Xi(4, NM) As Double

ReDim T(4, 4, NM) As Double

"Joint Displacement {X} = [SD]™-1.{P}
For i = 1 To DOF
x(Idj(i)) =0
For jJ = 1 To DOF
x(1dj(i)) = x(Idj(i)) + DFR(i, j) * Psum(1dj(G))
Next j

Next 1

"Numbering of global {X}(NP) to global {Xi} elemen
For i = 1 To NM
For j =1 To 4
Xig, 1) = x(idn@, 1))
Next j

Next i

"Transforming {Xi} to local coordinates
"Transformation matrix:
For i = 1 To NM

With Member (i)

T, 1, i) = .Cx: T(3, 3, i) = T, 1, i): T(L, 2, i) = .Cy: T(3, 4, i) =
T, 2, i)

T2, 1, i) = -.Cy: T4, 3, i)
=T(2, 2, 1)

End With

Next i

T2, 1, i): T, 2, i) = .Cx: T(4, 4, i)

"member deformation, tranformed{X}
For i = 1 To NM
For j =1 To 4
X2(g, i) =0
For n =1 To 4
X2, 1) = X2, i) + TG, n, i) * xXi(n, i)

Next n

[r].{xi}
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Next j
Next i

End Sub

Module3 (TRUSS2D)

"This module consist of only code to create charts
Option Explicit

Option Base 1

Sub PlotGeometry()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant

Dim am As Integer
"member coordinates

For i = 1 To NM
With Member (i)

Cx1 = Joint(.J1).x

Cyl = Joint(.Jl).y

Cx2 = Joint(.J2).x

Cy2 = Joint(.J2).y
End With

mxVal (i) = Array(Cxl, Cx2)
myVal (i) = Array(Cyl, Cy2)
tagxval (1) Array((Cx1 + Cx2) 7/ 2)
tagyVval (1) Array((Cyl + Cy2) / 2)

Next 1

ActiveSheet.ChartObjects(''"Chart 1').Activate
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ActiveChart.ChartArea.Select

Selection.ClearContents

"creating joints
For i = 1 To NJ
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = Joint(i).x
-SeriesCollection(i).Values = Joint(i).y
-SeriesCollection(i).Name = "J" & i
End With
"node marker
ActiveChart.PlotArea.Select
ActiveChart.SeriesCollection(i)-Select
With Selection
-MarkerBackgroundColorlndex = 3 "red
3

-MarkerForegroundColorIndex
-MarkerStyle = xICircle
-MarkerSize = 6

-Shadow = False
-ApplyDatalLabels AutoText:=True, LegendKey:= _

False, ShowSeriesName:=True, ShowCategoryName:=False,
Showvalue:=False, _

ShowPercentage:=False, ShowBubbleSize:=False
End With

ActiveChart.SeriesCollection(i).DataLabels.Select
With Selection

-HorizontalAlignment = xlCenter

-VerticalAlignment = xlICenter

-ReadingOrder = xIContext

-Position = xlLabelPositionRight

-Orientation = xIHorizontal
End With
ActiveChart.SeriesCollection(i).DatalLabels.Select
With Selection.Font

-Name = "Arial”

-FontStyle = "Regular™
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.Size = 8
End With

Next 1

ActiveSheet.ChartObjects("Chart 1').Activate
ActiveChart.ChartArea.Select

n=NJ + NM

"creating member lines
For i = NJ +1 Ton
With ActiveChart

-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mxVval(am)
-SeriesCollection(i).-Values = myVal(am)
.SeriesCollection(i).Name = "="""""

End With

ActiveChart.SeriesCollection(i).-Select

With Selection

xINone

-MarkerBackgroundColorIndex
xINone

-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColoriIndex = 5
-Weight = xIThin
-LineStyle = xlIContinuous

End With

am = am + 1

Next 1

"creating member name tags

am = 1

For i =n+ 1 Ton + NM
With ActiveChart

.SeriesCollection.NewSeries
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-SeriesCollection(i).-XValues = tagxVal(am)
.SeriesCollection(i).Values = tagyVal (am)
-SeriesCollection(i).Name = "M" & am

End With

ActiveChart.PlotArea.Select

ActiveChart.SeriesCollection(i).Select

With Selection
-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex
-MarkerStyle = xISquare
-Smooth = False

-MarkerSize = 6

-Shadow = False
-ApplyDatalLabels AutoText:=True, LegendKey:= _

False, ShowSeriesName:=True, ShowCategoryName:=False,
ShowValue:=False, _

ShowPercentage:=False, ShowBubbleSize:=False
End With
ActiveChart.SeriesCollection(i).DatalLabels.Select
With Selection.Font

-Name = "Arial”

-.FontStyle = "Regular™

.Size = 8
End With

am = am + 1

Next 1

ActiveChart.ChartArea.Select

With ActiveChart
-Axes(xICategory, xIPrimary).HasTitle = True
-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _
"NJ = " & Format(NJ, "0"™) & ", NM = " & Format(NM, "'0')

End With

ActiveChart.ShowWindow = True

End Sub
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Sub PlotDisplacement()
On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2
ReDim mxValbf(NM) As Variant, myValbf(NM) As Variant
ReDim mxValaF(NM) As Variant, myValaf(NM) As Variant

Dim am As Integer, scx As Single

Dim Xmax As Double, at_joint As Integer

ActiveSheet.ChartObjects(''Chart 2').Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

"scale for displacement

"user scale: max displacement are drawn up to 10% of the axis range

"or follows formula: X-range or Y-range * 10% = Xmax

"determine max. joint-X and Y displacement

"(user function UXMax written at the end of this module):

Xmax = Application. index(UXMax(Xs, NP), 1)

at_joint = Application.index(UXMax(Xs, NP), 2)

scx = (Application_Max(XAx_Wd, YAx _Wd) * 10 / 100) / Abs(Xmax)

"member coordinates: before & after loading
For i = 1 To NM
With Member (i)

Cx1 = Joint(.J1).x
Cyl = Joint(.Jl).y
Cx2 = Joint(.J2).x
Cy2 = Joint(.J2).y

mxValbf(i) = Array(Cx1, Cx2)

myValbf(i) = Array(Cyl, Cy2)
Cx1 = Joint(.J1).x + scx * Xs(2 * .J1 - 1)
Cyl = Joint(.Jl).y + scx * Xs(2 * .J1)
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Cx2 = Joint(.J2).Xx + scx * Xs(2 * .J2 - 1)
Cy2 = Joint(.J2).y + scx * Xs(2 * .J2)
mxValaf(i) = Array(Cx1, Cx2)
myValaf(i) = Array(Cyl, Cy2)
End With
Next i
am = 1

"creating member lines: before loading
For i = 1 To NM
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mxValbf(am)
-SeriesCollection(i).Values = myValbf(am)
-SeriesCollection(i).Name = "="m
End With
ActiveChart.SeriesCollection(i).Select
With Selection
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColorIndex = 5
-Weight = xI1Thin
-LineStyle = xlIContinuous
End With

am = am + 1

Next 1
n = NM + NM
am = 1

"creating member lines: after loading
For i = NM + 1 To n
With ActiveChart
-SeriesCollection._NewSeries
-SeriesCollection(i)-XValues = mxVvValaf(am)

.SeriesCollection(i).Values = myvValaf(am)
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.SeriesCollection(i).Name =
End With
ActiveChart.SeriesCollection(i).-Select
With Selection

-MarkerStyle = xINone

-Smooth = False
End With
With Selection.Border

-ColoriIndex = 7

-Weight = xIMedium

-LineStyle = xlIContinuous
End With

am = am + 1

Next 1

ActiveChart.ChartArea.Select
With ActiveChart

End

End Sub

.Axes(xICategory, xIPrimary).HasTitle = True

-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _

"Max Displacement, J." & at _joint & " = " & Format(Xmax, '0.00000")

With

Sub PlotAxial Q)

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

Dim Cmx1, Cmx2, Cmyl, Cmy2
ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim saxVal(NM) As Variant
ReDim sayVal(NM) As Variant
ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant

ReDim mjxVal(NM + NM) As Variant
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ReDim mjyVal(NM + NM) As Variant
ReDim acolor(NM + NM) As Variant
ReDim Pa_LM(2, NM) As Double
ReDim Pa_RM(2, NM) As Double
ReDim Pa_LT(2, NM) As Double
ReDim Pa_RT(2, NM) As Double

Dim am As Integer, sca As Single

Dim Amax As Double, at _member As Integer, L 1 As Integer, L 11 As Integer

ActiveSheet.ChartObjects(''Chart 3').Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

"analogous to plot displacement for scaling

Amax = Application.index(UAMax(Pmm, Fm, NM), 1)

at_member = Application.index(UAMax(Pmm, Fm, NM), 2)

sca = (Application_Max(XAx_Wd, YAx Wd) * 10 / 100) / Abs(Amax)

For 1 =1 To NM

Pa LM(2, 1) = -(Pmm(ldm(1, i), i) + Fm(1, 1))
Pa RM(2, 1) = (Pmm(ldm(3, 1), 1) + Fm(3, 1))
Next 1

"transform member axial to global axis by using [TT]
"the drawing should be in global coordinates
For i = 1 To NM
For j =1 To 2
For n =1 To 2

Pa_LT(, i) = Pa LT, i) + TT(Q, n, i) * Pa_LM(n, i)
Pa RT(j, i) = Pa RT({, i) + TT(g, n, i) * Pa RM(n, i)
Next n
Next j
Next i

For i = 1 To NM
With Member (i)
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Cx1 = Joint(.J1l).x
Cyl = Joint(.JD).y
Cx2 = Joint(.J2).x
Cy2 = Joint(.J2).y

"assign force coordinates
Cmx1 Cx1 + sca * Pa LT(1, i
Cmyl = Cyl + sca * Pa LT(2, i
Cmx2 = Cx2 + sca * Pa_RT(1, i
Cmy2 = Cy2 + sca * Pa_RT(2,
End With
"member coordinates
mxVal (i) = Array(Cxl, Cx2)
myVal (i) = Array(Cyl, Cy2)
"axial coordinates
saxVal (i) = Array(Cmx1l, Cmx2)
sayVal (i) = Array(Cmyl, Cmy2)

"member-joint coordinates
mjxVal(2 * 1 - 1)
mjyval(2 * 1 - 1)

Array(Cx1, Cmx1)
Array(Cyl, Cmyl)

"mcolor: define color for positive/negative value
acolor(2 * i1 - 1) = -(Pmm(ldm(1, 1), i) + Fm(1, 1))

mjxVal(2 * 1)
mjyval(2 * 1)
)

acolor(2 *

Array(Cx2, Cmx2)
Array(Cy2, Cmy2)
Pmm(ldm(3, i), i) + Fm(3,

Next 1

"creating member lines
For i = 1 To NM
With ActiveChart

-SeriesCollection.NewSeries
.SeriesCollection(i).XValues = mxVval (i)
-SeriesCollection(i).Values = myval (i)
-SeriesCollection(i).Name = "=""r

End With

ActiveChart.SeriesCollection(i).Select

With Selection
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xINone

-MarkerBackgroundColorIndex
xINone

-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
.Colorilndex = 5
-Weight = xI1Thin
-LineStyle = xlIContinuous
End With

Next 1

L1 =NM+ NM

am = 1

"creating axial lines

For 1 = NM + 1 To L_I

With ActiveChart

-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = saxVal (am)
-SeriesCollection(i).Values = sayVal(am)
.SeriesCollection(i).Name = "="""""

End With

ActiveChart.SeriesCollection(i).-Select

With Selection

xINone

-MarkerBackgroundColorIndex

-MarkerForegroundColorilndex = xINone

-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-Colorindex = 7
-Weight = xIThin
-LineStyle = xlIContinuous

End With

am = am + 1

Next 1
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LIl =NM+ NM + NM + NM

"creating joint lines to axis
For i =L 1+ 1 ToL_Il
With ActiveChart
-SeriesCollection.NewSeries
.SeriesCollection(i).XValues
-SeriesCollection(i).Values
-SeriesCollection(i)-Name =
End With

mjxVvVal (am)
mjyVal (am)

ActiveChart.SeriesCollection(i).Select

With Selection
-MarkerBackgroundColorIndex
-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
IT acolor(am) < 0 Then
-ColoriIndex = 3
Else
.Colorilndex = 5
End IT
-Weight = xIMedium
-LineStyle = xlIContinuous

End With

am = am + 1

Next 1

ActiveChart.ChartArea.Select
With ActiveChart

-Axes(xICategory, xIPrimary).HasTitle = True
-Axes(xICategory, xIPrimary)._AxisTitle._Characters.Text
"Max Axial, M." & at member & " = ' & Format(Amax, ""0.000")

End With

End Sub
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"user function to determine maximum value of

"joint X1 and X2

Function UXMax(Xs, NP) As Variant

Dim Abs FXMax As Double
Dim FXMax As Double
ReDim Idis(NP) As Double

"Joint displacement index

n=1

For 1 = 2 To NP Step 2
Idis(i - 1) =n
Idis(i) = n

n=n+1

Next 1

Abs FXMax = 0O
n=2=0
For i = 1 To NP
IT Abs(Xs(i1)) > Abs_FXMax Then
Abs FXMax = Abs(Xs(i))
FXMax = Xs(i)
n = Idis(i)
UXMax = Array(FXMax, n)

"UXMax keeps origin value(+ or - value)

End If
n=n+.i

Next 1

End Function

"user function to determine maximum value of

"axial force, F1

Function UAMax(Pmm, Fm, NM) As Variant

Dim Abs FAMax As Double

An Introduction to Excel for Civil Engineers

302




Dim FAMax As Double

Abs FAMax = 0
n=2=0
For i = 1 To NM
I Abs(Pmm(ldm(1, 1), i) + Fm(1, 1)) > Abs_FAMax Then
Abs FAMax = Abs(Pmm(ldm(1, 1), 1) + Fm(1, 1))
FAMax = -(Pmm(ldm(1, i), i) + Fm(1, 1))
n =1
UAMax = Array(FAMax, n)
End IFf
I Abs(Pmm(1dm(3, 1), i) + Fm(3, 1)) > Abs_FAMax Then
Abs_FAMax = Abs(Pmm(ldm(3, i), i) + Fm(3, 1))
FAMax = Pmm(ldm(3, 1), 1) + Fm(3, 1)
n=-1=a
UAMax = Array(FAMax, n)
End IFf
Next i

End Function

Command Button (TRUSS2D)

Private Sub CommandButtonl Click()
ChartWindow = True

Call TRUSS2D
End Sub

Private Sub CommandButton2_Click()
ChartWindow = False

Call TRUSS2D
End Sub
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Modulel (BOF)

"BOF v.1.0 Program for Beam on Elastic Foundation, 2004
"by: Gunthar Pangaribuan - Refer to the book:

"An Introduction to: Excel for Civil Engineers

Option Explicit

Public 1 As Integer, j As Integer, n As Integer

Type Joint Data
X As Double
y As Double
Ks As Double
Sp As Double
End Type

Type Member_Data
J1 As Integer
J2 As Integer
tm As Double
bm As Double
El As Double
Ix As Double
ly As Double
Lh As Double
Cx As Double
Cy As Double
Kml As Double
Km2 As Double
Pres As Double

End Type

Public ChartWindow As Boolean
Public NP As Integer
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Public DOF As Integer

Public NR As Integer

Public NJ As Integer

Public NM As Integer

Public Member() As Member_Data
Public Joint() As Joint _Data
Public Em As Double

Public Km() As Double

Public NS As Integer "no. of support
Public GASAT() As Double "global stiffness matrix
Public Rs() As Integer

Public DFR() As Double

Public Idm() As Integer

Public Idj() As Integer

Public Irj() As Integer

Public Psum() As Double

Public Pmm() As Double

Public Pj() As Double

Public Xs() As Double

Public Xm() As Double

Public Fm() As Double

Public mmomen1l() As Double
Public mmomen2() As Double
Public shearl() As Double
Public shear2() As Double

Sub BOF()

On Error GoTo ErrMsg

Const NDJ = 2
Dim NLJ As Integer "no of joint load

Dim Ksn As Integer

NJ = Cells(4, 2)
NM = Cells(b, 2)
Em = Cells(6, 2)
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NS = Application.Count(Rows("'23:23"))
NLJ Application.Count(Rows(''28:28"))
Ksn = Application.Count(Rows(''12:12"))

"Total number of joint displacement, NP:
NP = NDJ * NJ

ReDim Joint(NJ) As Joint_Data

ReDim Member(NM) As Member_Data

ReDim ESAT(4, 4, NM) As Double "member matrix refer to the book
ReDim GASAT(NP, NP) "global stiffness matrix refer to the book
ReDim Idm(4, NM) " displacement index

ReDim PjJ(NP) "joint load vector

ReDim Pmm(NP, NM) "fixed-end forces
ReDim Psum(NP) "sum load vector

ReDim Xs(NP) "joint displacement vector
ReDim Xm(4, NM) * member deformation

ReDim Fm(4, NM) "member forces

ReDim mmomenl(NM)

ReDim mmomen2(NM)

ReDim shearl1(NMm)

ReDim shear2(NM)

ReDim Rs(NP)

ReDim spn(NS) As Integer
Dim mshear As Double

"Read Input Data

"Read joint data - in order
For i = 1 To NJ
With Joint(i)
.x = Cells(10, 1 + 1)
.y = Cells(11, 1 + 1)
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Ks = Cells(12, 1 + 1)
.Sp = .Ks * Xs(2 * i) "soil pressure
End With

Next 1

"Read member data
For i =1 To NM
With Member (i)

.J1 = Cells(16, 1 + 1)
.J2 = Cells(17, 1 + )
-tm = Cells(18, 1 + i)
.bm = Cells(19, 1 + 1)

-El =Em * 1/ 12 * _bm * .tm ~ 3
-Ix = Joint(.J2).x - Joint(.J1).x
ly = Joint(.J2).y - Joint(.Jl).y

Lh = Saqr(.Ix ~ 2 + _ly N 2)
.Cx = _Ix / .Lh

.Cy = .1y / _Lh

-Pres = Cells(20, 1 + 1)

Kmi = 0.5 * .Lh * _bm * Joint(.J1).Ks
Km2 = 0.5 * _Lh * _bm * Joint(.J2).Ks

End With
Next i
"end spring:
With Member(1)

-Kml = _Lh * _bm * Joint(.J1l).Ks
End With
With Member(NM)

-Km2 = _Lh * _bm * Joint(.J2)_Ks
End With

IT ChartWindow = True Then Call PlotGeometry: Exit Sub

Application.ScreenUpdating = False
"Read joint load

For i = 1 To NLJ
n = Cells(28, 1 + i)
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Pj(2 *n - 1) =Cells(29, 1 + 1)
Pj(2 * n) = Cells(30, 1 + i)
Next 1

"restrain list and support (Rs) index
For i = 1 To NS
spn(i) = Cells(23, 1 + 1)
Rs(2 * spn(i) - 1) = Cells(24, 1 + 1)
Rs(2 * spn(i)) = Cells(25, 1 + 1)

Next i

DOF = 0
For 1 = 1 To NP
IT Rs(i) = 0 Then DOF = DOF + 1

Next 1

"#restrained joint (zero displacement)
NR = NP - DOF

ReDim DFX(NDJ * NS, DOF) As Double ®[KbfJaccording to Eq. 4.12
ReDim DFR(DOF, DOF) As Double "[KFF]™-1 according to Eq. 4.9
ReDim RIJ(NDJ * NS) As Double "support reactions

ReDim Idj(DOF) “free displacement index

ReDim Irj(NDJ * NS) “support displacement index

ReDim nAs_Now(NJ) As Integer

Dim nAs_Last As Integer

Dim ITR As Integer

Dim ITR _Continue As Boolean

ITR_Continue = True

ITR = 1

"clear previous content
Dim LastRow

LastRow = ActiveSheet.UsedRange.Rows.Count
Range(Cells(38, 1), Cells(LastRow, 16)).ClearContents
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"Structure Analysis

Do

Call Mindex(ldm, Idj, Irj)
Call FEM(ESAT, GASAT)

Call MInvers(DFX, DFR)
Call Genload(Pmm, Psum)
Call DISP(Xs, Xm)

"Print used springs
For i = 1 To NM
With Member (i)
Cells(37 + i, 8).NumberFormat = *0.000"
Cells(37 + i, 8) = .Kml
Cells(37 + 1, 9).NumberFormat
Cells(37 + i, 9) = .Km2
End With

Next i

''0.000™

n==0
For i = 1 To NJ
"re-input joint"s Ks and Sp if Xs < 0
With Joint(i)
IT Xs(i * 2) <0 And .Ks > 0 Then
.Ks =0
.Sp = .Ks * Xs(2 * i)
n=n+1
End If
End With

Next 1

"re-input member®s soil K
For i = 1 To NM
With Member (i)
Kml = 0.5 * _Lh * _bm * Joint(.J1).Ks

An Introduction to Excel for Civil Engineers 309




Km2 = 0.5 * _Lh * _bm * Joint(.J2).Ks
End With
Next i
With Member(1)
-Kml = _Lh * _bm * Joint(.J1).Ks
End With
With Member(NM)
-Km2 = _Lh * _bm * Joint(.J2)_Ks
End With

"check no. of active spring between 2 iterations
nAs_Now(ITR) = NJ - n
nAs_Last = nAs Now(ITR - 1)

IT nAs_Now(ITR) = nAs_Last Or n = 0 Then
ITR_Continue = False
Cells(34, 3) = ITR - 1
Cells(35, 3) = nAs_Now(ITR)

End IT

ITR=1TR + 1

Loop Until 1TR_Continue = False

"1. Print Load
For 1 = 1 To NJ

Cells(37 + 1, 1).NumberFormat = 0"
Cells(37 + i1, 1) =1
Cells(37 + 1, 2).NumberFormat = "0.000"

Cells(37 + i, 2) = Psum(2 * i - 1)
Cells(37 + 1, 3)-NumberFormat '*0.000™"
Cells(37 + i, 3) = Psum(2 * 1)

Next i
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"2. Print Joint displacement and soil pressure
For i = 1 To NJ
Cells(37 i, 4) _NumberFormat = '*0.00000"
Cells(37 + i, 4) =Xs(2 * i - 1)
Cells(37 + i, 5).NumberFormat = '0.00000"
Cells(37 + 1, 5) = Xs(2 * 1)
Cells(37 + 1, 6).NumberFormat
With Joint(i)
Sp = .Ks * Xs(2 * 1)
Cells(37 + i, 6) = .Sp
End With

Next 1

+

+

''0.000™

"{Fm=[SIm.{X}s or [FIm=[S]-[A]IT-[X]s
"there is already calculated S.A"T,
For 1 = 1 To NM
For j 1 To 4
Fm@, 1) =0
For n =1 To 4
Fm((g, 1) = Fm(g, 1) + ESAT, n, 1) * Xm(n,
Next n

Next j

Next 1

"Print member foces
For i = 1 To NM
With Member (i)
"no/length

Cells(37 + 1, 7).NumberFormat = "0"

)

Cells(37 + i, 7) = i & "./" & Format(.Lh, "0.00")

"moment

mmomenl(i) = Fm(1, 1) + Pmm(ldm(1, 1), i)
Cells(37 + i, 10).NumberFormat = "0.000"
Cells(37 + 1, 10) = mmomenl(i)
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''0.000™

ll0 R 000"

''0.000™

mmomen2(i) = Fm(2, 1) + Pmm(ldm(3, 1), i)
Cells(37 + 1, 11).NumberFormat

Cells(37 + 1, 11) = mmomen2(i)

"spring

Cells(37 + 1, 12)_NumberFormat

Cells(37 + 1, 12) = Fm(3, 1)

Cells(37 + 1, 13).NumberFormat

Cells(37 + 1, 13) = Fm(4, 1)

"shear

IT Ksn = 0 Then

"internal forces with support

mshear = (Fm(1, 1) + Fm(2,

shear1(i) = mshear + Pmm(ldm(2, i), 1)

i)) / .Lh

shear2(i) = -mshear + Pmm(ldm(4, i),

Else

"as per reference - with springs
i)) / .Lh

mshear = (Fm(1, 1) + Fm(2,
shearl(i) = mshear
shear2(i) = -mshear

End If

Cells(37 + i, 14) _NumberFormat
Cells(37 + 1, 14) = shearl(i)
Cells(37 + 1, 15)_NumberFormat
Cells(37 + 1, 15) = shear2(i)

End With

Next 1

For i =1 To 2 * NS
For J = 1 To DOF

"'0.000"

''0.000"

RI(i) = RI(i) + DFX(i, j) * Xs(1dji(G))

Next j

Next i

For i = 1 To NS
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Cells(37 + 1, 16)_.NumberFormat = "Q0"
Cells(37 + 1, 16) = spn(i)
Cells(37 + 1, 17)_NumberFormat = "0.000"

Cells@37 + i, 17) =RI(2 * i - 1) - Ppsum(Irj(2 * i - 1))
Cells(37 + i, 18).NumberFormat = *0.000"
Cells(37 + i1, 18) = RJI(2 * 1) - Psum{Irj(2 * 1))

Next i

"create graphs

Call PlotGeometry
Call PlotDisplacement
Call PlotMoment

Call PlotShear

Call PlotSoilPressure

Range(*'A1'") .Select
Application.ScreenUpdating = True
Exit Sub

ErrMsg: MsgBox "Error, please check input ...', vbOKOnly + vbExclamation,
""BOF"

Range("A1'™) .Select
Application.ScreenUpdating = True
End Sub

Module2 (BOF)

Option Explicit
"Indexing for matrix subscript
Sub Mindex(index() As Integer, IFr() As Integer, IFx() As Integer)

"Member end-displacements index:
For i = 1 To NM
With Member (i)
index(1, 1)
index(2, 1)

2* .J1 -1
2* .31
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index(3, 1) =2 * .J2 -1
index(4, 1) =2 * _.J2
End With

Next i

"Joint free displacement index, IFr and
"restraint (support) index, IFx
n=1
For i = 1 To NP
IT Rs(i) = 0 Then IFr(n) =iz n=n+1

Next 1

n=1
For 1 = 1 To NS
n = Cells(23, 1 + 1)

IFrK2*i-1)=2*n-1
IFX(2 * 1) =2 *n
Next i

End Sub

Sub FEM(SAT() As Double, GS() As Double)
ReDim ASAT(4, 4, NM) As Double

"Assembly finite element matrix, Eq.4.16 & 4.17
For i = 1 To NM

With Member (i)

"member SANT matrix:

"from internal forces F - deformation d relationship, F = S.d or F =
S.ANT.X

SAT(1, 1, i) =4 * _El / .Lh: SAT(2, 2, i) =6 * _El / .Lh ~ 2

SAT(1, 3, i) =2 * _El / .Lh: SAT(1, 4, i) = -6 * _El / .Lh ~ 2

SAT(2, 1, i) =2 * _El / .Lh: SAT(2, 2, i) =6 * _El / .Lh ~ 2

SAT(2, 3, i) =4 * _El / .Lh: SAT(2, 4, i) = -6 * _El /7 .Lh ~ 2

SAT(3, 2, 1) = .Kml

SAT(4, 4, 1) = _Km2

"Member global stiffness (member ASA™T)

ASAT(1, 1, i) =4 * _El / .Lh: ASAT(4, 2, i) =6 * _El / .Lh ~ 2
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ASAT(1, 3, i) = 2 * _El / _Lh: ASAT(1, 4, i) = -6 * _EI / .Lh ~ 2

ASAT(2, 1, i) = 6 * _El / _Lh ~ 2: ASAT(2, 2, i) = 12 * _El / .Lh ~ 3 +
-Kml

ASAT(2, 3, 1) =6 * _El / _Lh ™~ 2: ASAT(2, 4, i) = -12 * _E1 / .Lh ~ 3

ASAT(3, 1, i) =2 * _El / _Lh: ASAT(3, 2, i) =6 * _.El / .Lh 2

ASAT(3, 3, i) = 4 * _El / _Lh: ASAT(3, 4, i) = -6 * _EI / .Lh ~ 2

ASAT(4, 1, i) = -6 * _El / .Lh ~ 2: ASAT(4, 2, 1) = -12 * _El / .Lh ~ 3
- ASAT(4, 3, i) = -6 * _El / .Lh ~ 2: ASAT(4, 4, i) =12 * .El / .Lh ~ 3 +
-Km

"Storing members and superposition(global ASA"NT)
For j =1 To 4
For n =1 To 4
GS(tdm(g, i), Idm(n, i)) = cS(dm(g, i), Idm(n, i)) + ASAT(, n,

Next n
Next j
End With

Next 1

End Sub
"Global matrix
Sub MInvers(SR() As Double, SD() As Double)

Dim n As Integer

"submatrix Stiffness, KRF
For i = 1 To DOF
For j =1 To 2 * NS
SR, 1) = GASATUrj(d), 1dj(i))
Next j

Next 1

"submatrix Stiffness, KBF
For i = 1 To DOF
For jJ = 1 To DOF
SD(i, ) = GASAT(ldj(i), 1dj(d))
Next j
Next i
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"Inverse []
For i = 1 To DOF
For J = 1 To DOF
IT jJ <> 1 Then SD(i, j)
Next j
For n = 1 To DOF
If n =1 Then GoTo 10
For jJ = 1 To DOF
IT jJ <> 1 Then SD(n, j)
Next j
10 Next n
For n = 1 To DOF
IT n<>1 Then SD(n, 1)
Next n
SD(i, i) =1 / SD(i, 1)
Next i

End Sub

SD(i, j) / SD(i, i)

Sb(n, j) - Sb(i, j) * SD(n,

-sD(n, i) 7/ SD(i, i)

Sub Genload(Pa() As Double, Ps() As Double)

ReDim TT(4, 4, NM) As Double

ReDim Peq(NP, NM) "equivalent load

Dim Idx As Integer, w As Double

"member fixed-end forces due to pressure

For i =1 To NM
With Member (i)

w = _Pres * _bm
Pa(ldm(l, i), i) = -w * _Lh ~ 2 / 12
Pa(ldm(2, 1), i) = -w * _Lh 7 2
Pa(ldm(3, i), i) =w * .Lh ~2 7/ 12
Pa(ldm(4, i), i) = -w * _Lh /7 2
End With

Next i

"equivalent joint load due to pressure
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For i = 1 To NM
For j =1 To 4
For n =1 To 4
Peq(ldm(j, i), i) = -Pa(ldm(@, i), i)
Next n
Next j
Next i

"sum load = joint load + eq-load
For i = 1 To NP

Ps(i) = PJ(i)
Next i

"load superposition
For i = 1 To NM
For j =1 To 4
Ps(ldm@, 1)) = Ps(ldm(@, 1)) + Peq(ldm(g, 1), 1)
Next j
Next i

End Sub

Sub DISP(x() As Double, Xi() As Double)
ReDim T(4, 4, NM) As Double

"Joint Displacement {X} = [SD]™-1.{P}
For i = 1 To DOF
x(Idj(i)) =0
For jJ = 1 To DOF
x(1dj(i)) = x(0dj(i)) + DFR(i, J) * Psum(ldj(d))
Next j
Next i

"Numbering of global {X}(NP) to global {Xi} member
For i = 1 To NM
For j =1 To 4
Xig, 1) = x(idn@, 1))
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Next j
Next i

End Sub

Module3 (BOF)

Option Explicit
Option Base 1
Sub PlotGeometry()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant

Dim am As Integer
"member coordinates

For 1 = 1 To NM
With Member (i)

Cx1 = Joint(.J1).x

Cyl = Joint(.J1l).y

Cx2 = Joint(.J2).x

Cy2 = Joint(.J2).y
End With

mxVal (i) = Array(Cxl, Cx2)
myVal (i) = Array(Cyl, Cy2)
tagxval (i)
tagyVval (1)

Next 1

ActiveSheet.ChartObjects('"Chart 1').Activate

ActiveChart.ChartArea.Select
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Selection.ClearContents

"creating joints + name tags
For i = 1 To NJ
With ActiveChart
-SeriesCollection.NewSeries
.SeriesCollection(i).XValues = Joint(i).x
-SeriesCollection(i).Values = Joint(i).y
-SeriesCollection(i).-Name = "J" & 1
End With
"node marker
ActiveChart.PlotArea.Select
ActiveChart.SeriesCollection(i).-Select
With Selection
3 "red
3

-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex
-MarkerStyle = xICircle
-MarkerSize = 6

-Shadow = False
-ApplyDatalLabels AutoText:=True, LegendKey:= _

False, ShowSeriesName:=True, ShowCategoryName:=False,
ShowValue:=False, _

ShowPercentage:=False, ShowBubbleSize:=False
End With

ActiveChart.SeriesCollection(i).DataLabels.Select

With Selection
-HorizontalAlignment = xlCenter
-VerticalAlignment = xlICenter
-ReadingOrder = xlContext
-Position = xlLabelPositionAbove
-Orientation = xlHorizontal
-Font_Name = "Arial”
-Font_FontStyle = "Regular™
-Font._Size = 8

End With

Next i
ActiveSheet.ChartObjects("Chart 1')._Activate
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ActiveChart.ChartArea.Select

n =NJ + NM

"creating member lines
For i = NJ +1Ton
With ActiveChart

-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mxVal (am)
-SeriesCollection(i).-Values = myVal(am)
.SeriesCollection(i).Name = "="""""

End With

ActiveChart.SeriesCollection(i).-Select

With Selection

xINone

-MarkerBackgroundColorIndex
xINone

-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColoriIndex = 5
-Weight = xIThin
-LineStyle = xlIContinuous

End With

am = am + 1

Next 1

"creating member name tags
am = 1
For i =n+ 1 Ton + NM
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = tagxVal(am)
-SeriesCollection(i).Values = tagyVal (am)
-SeriesCollection(i).Name = "M" & am
End With
ActiveChart.PlotArea.Select
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ActiveChart.SeriesCollection(i).Select
With Selection

-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex
-MarkerStyle = xISquare
-Smooth = False

-MarkerSize = 6

-Shadow = False
-ApplyDatalLabels AutoText:=True, LegendKey:= _

False, ShowSeriesName:=True, ShowCategoryName:=False,
ShowValue:=False, _

ShowPercentage:=False, ShowBubbleSize:=False
End With
ActiveChart.SeriesCollection(i).DatalLabels.Select
With Selection
-HorizontalAlignment = xlICenter
-VerticalAlignment = xlICenter
-Position = xlLabelPositionAbove
-Orientation = xlIHorizontal
-Font_Name = "Arial”
-.Font._FontStyle = "Regular"
-Font.Size = 8
End With
am = am + 1

Next i

ActiveChart.ChartArea.Select

With ActiveChart
-Axes(xICategory, xIPrimary).HasTitle = True
-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _
"NJ = " & Format(NJ, "0"™) & ", NM = " & Format(NM, "'0'")

End With

ActiveChart.ShowWindow = True

End Sub
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Sub PlotDisplacement()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2
ReDim mxValbf(NM) As Variant, myValbf(NM) As Variant
ReDim mxValaF(NM) As Variant, myValaf(NM) As Variant

Dim Xmax As Double, At _joint As Integer, am As Integer

ActiveSheet.ChartObjects(*"Chart 2').Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

Xmax = Application. index(UXMax(Xs, NP), 1)
At_joint = Application.index(UXMax(Xs, NP), 2)

"member coordinates: before & after loading
For i = 1 To NM
With Member (i)
Cx1 = Joint(.J1).x

Cyl = Joint(.Jl).y
Cx2 = Joint(.J2).x
Cy2 = Joint(.J2).y

mxValbf(i) = Array(Cx1, Cx2)
myValbf(i) = Array(Cyl, Cy2)
Cx1 = Joint(.J1).x + .Cy * Xs(2 * .J1)

Cyl = Joint(.J1).y + .Cx * Xs(2 * .J1)
Cx2 = Joint(.J2).x + .Cy * Xs(2 * .J2)
Cy2 = Joint(.J2).y + .Cx * Xs(2 * .J2)

mxValaf(i) = Array(Cxl, Cx2)
myValaf(i) = Array(Cyl, Cy2)

End With
Next i
am = 1

"creating member lines: before loading
For i =1 To NM
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With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mxValbf(am)
-SeriesCollection(i).Values = myValbf(am)
-SeriesCollection(i).Name = "=""""
End With
ActiveChart.SeriesCollection(i).Select
With Selection
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColorIndex = 5
-Weight = xI1Thin
-LineStyle = xlIContinuous
End With

am = am + 1

Next 1
n = NM + NM
am = 1

"creating member lines: after loading
For i = NM + 1 To n
With ActiveChart
-SeriesCollection._NewSeries
-SeriesCollection(i)-XValues = mxVvValaf(am)
.SeriesCollection(i).Values = myvValaf(am)
-SeriesCollection(i).Name = "=""m
End With
ActiveChart.SeriesCollection(i).Select
With Selection
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColoriIndex = 7
-Weight = xIMedium
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-LineStyle = xlIContinuous
End With
am = am + 1

Next 1

ActiveChart.ChartArea.Select
With ActiveChart

-Axes(xICategory, xIPrimary).HasTitle = True

-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _

"Max Displacement, J." & At _joint & " = " & Format(Xmax, '0.00000")
End With

End Sub

Sub PlotMoment()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

Dim Cmx1, Cmx2, Cmyl, Cmy2
ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim moxVal(NM) As Variant
ReDim moyVal(NM) As Variant
ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant

ReDim mjxVal(NM + NM) As Variant
ReDim mjyVal(NM + NM) As Variant
ReDim mcolor(NM + NM) As Variant

Dim Mmax As Single, At joint As Integer, am As Integer, L 1 As Integer, L_1I
As Integer, _

L IlIl As Integer, L_IV As Integer
ActiveSheet.ChartObjects(*"Chart 3').Activate

ActiveChart.ChartArea.Select

Selection.ClearContents
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Mmax = Application. index(UMMax(Pmm, Fm, NM), 1)
At_joint = Application. index(UMMax(Pmm, Fm, NM), 2)

For i = 1 To NM
With Member (i)

Cx1 = Joint(.J1l).x

Cyl = Joint(.JD).y

Cx2 = Joint(.J2).x

Cy2 = Joint(.J2).y
"assign coordinates
Cmx1 = Cx1

Cmyl = Cyl + mmomenl(i)
Cmx2 = Cx2

Cmy2 = Cy2 - mmomen2(i)

End With

"member coordinates
mxVal (i) = Array(Cxl, Cx2)
myVal (i) = Array(Cyl, Cy2)
"moment coordinates
moxVal (i) = Array(Cmxl, Cmx2)
moyVal (i) = Array(Cmyl, Cmy2)
"member-joint coordinates
mjxVal(2 * 1 - 1) Array(Cx1, Cmx1)
mjyval(2 * 1 - 1) Array(Cyl, Cmyl)

"mcolor: define color for positive/negative value

mcolor(2 * 1 - 1) = mmomenl(i)

mjxVal(2 * 1) Array(Cx2, Cmx2)

mjyval(2 * 1) Array(Cy2, Cmy2)
i)

mcolor(2 * mmomen2(i)

Next 1

"creating member lines
For i = 1 To NM
With ActiveChart
-SeriesCollection._NewSeries
.SeriesCollection(i).-XValues = mxVvVal (i)

.SeriesCollection(i).Values = myval(i)
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.SeriesCollection(i).Name = "=""""
End With
ActiveChart.SeriesCollection(i)-Select
With Selection

xINone

-MarkerBackgroundColorIndex

xINone

-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColoriIndex = 5
-Weight = xIThin
-LineStyle = xlIContinuous
End With

Next 1

L1 =NM+1
LIl = NM + NM
am = 1
"creating moment lines
For i = L 1 To L_I1
With ActiveChart
-SeriesCollection.NewSeries

-SeriesCollection(i)-XValues = moxVal (am)

-SeriesCollection(i).Values = moyVal (am)

.SeriesCollection(i).Name = "="""""
End With
ActiveChart.SeriesCollection(i)-Select
With Selection

xINone

-MarkerBackgroundColorIndex

xINone

-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColoriIndex = 7
-Weight = xIThin
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-LineStyle = xlIContinuous
End With
am = am + 1

Next 1

LI = LIl +1

LIV = L_Il + NM + NM

am = 1

"creating joint lines to axis

For i = L 111 To L_IV

With ActiveChart

-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mjxVal (am)
-SeriesCollection(i).Values = mjyval (am)
-SeriesCollection(i).Name = "=""

End With

ActiveChart.SeriesCollection(i).Select

With Selection

-MarkerBackgroundColorIndex = xINone

xINone

-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
IT mcolor(am) < O Then
-ColoriIndex = 3

Else

1
a1

-ColoriIndex

End IT

-Weight = xIMedium

-LineStyle = xlIContinuous
End With

am = am + 1

Next i

ActiveChart.ChartArea.Select
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With ActiveChart
-Axes(xICategory, xIPrimary).HasTitle = True
-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _
"Max Moment, J." & At_joint & " = ' & Format(Mmax, ""0.000")
End With

End Sub

Sub PlotShear()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

Dim Cmx1, Cmx2, Cmyl, Cmy2

ReDim mxVal(NM) As Variant

ReDim myVal(NM) As Variant

ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant
ReDim shxval(NM) As Variant
ReDim shyval(NM) As Variant
ReDim sjxVal(NM + NM) As Variant
ReDim sjyVal(NM + NM) As Variant
ReDim mcolor(NM + NM) As Variant

Dim Smax As Double, At member As Integer, am As Integer, L_I As Integer, _

L_Il As Integer, L_ 111 As Integer, L_ 1V As Integer

ActiveSheet.ChartObjects(*"Chart 4').Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

Smax = Application.index(USMax(Pmm, Fm, NM), 1)
At _member = Application. index(USMax(Pmm, Fm, NM), 2)

For i = 1 To NM
With Member (i)
Cx1 = Joint(.J1l).x
Cyl = Joint(.Jl).y
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Cx2 = Joint(.J2).x
Cy2 = Joint(.J2).y
"assign coordinates
Cmx1 = Cx1

Cmyl = Cyl - shearl(i)
Cmx2 = Cx2

Cmy2 = Cy2 + shear2(i)

End With

"member coordinates
mxVal (i) = Array(Cx1l, Cx2)
myVal (i) = Array(Cyl, Cy2)
"shear coordinates
shxval (i) = Array(Cmx1, Cmx2)
shyval (i) = Array(Cmyl, Cmy2)
"member-joint coordinates
sjxval(2 * i1 - 1) Array(Cx1l, Cmx1)
sjyval(2 * 1 - 1) Array(Cyl, Cmyl)
"mcolor: define color for positive/negative value
mcolor(2 * 1 - 1) = -shearl1(i)
sjxval(2 * i) = Array(Cx2, Cmx2)
sjyval(2 * Array(Cy2, Cmy2)

mcolor(2 * shear2(i)

)
)
)
Next i

"creating member lines
For i = 1 To NM
With ActiveChart

-SeriesCollection.NewSeries
-SeriesCollection(i).-XValues = mxVal (i)
-SeriesCollection(i).-Values = myVal (i)
.SeriesCollection(i).Name = "="""""

End With

ActiveChart.SeriesCollection(i).-Select

With Selection

xINone

-MarkerBackgroundColorIndex

xINone

-MarkerForegroundColorIndex

-MarkerStyle = xINone
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-Smooth = False
End With
With Selection.Border
-ColorIndex = 5
-Weight = xIThin
-LineStyle = xlIContinuous
End With

Next i

LI =NV+1
LIl = NM + NM
am = 1
"creating shear lines
For i = L 1 To L_11
With ActiveChart
-SeriesCollection.NewSeries
.SeriesCollection(i).XValues
-SeriesCollection(i).Values
-SeriesCollection(i)-Name =
End With

shxval (am)

shyval (am)

ActiveChart.SeriesCollection(i).Select

With Selection
-MarkerBackgroundColorIndex
-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColoriIndex = 7
-Weight = xIThin
-LineStyle = xlIContinuous

End With

am = am + 1

Next i

LI =L 11 + 1
LIV = L_I1 + NM + NM
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am = 1
"creating joint lines to axis
For i = L 111 To L_1V
With ActiveChart
-SeriesCollection._NewSeries
-SeriesCollection(i).-XValues = sjxVal(am)
.SeriesCollection(i).Values = sjyval(am)
-SeriesCollection(i).Name = "="rm
End With
ActiveChart.SeriesCollection(i).Select
With Selection
-MarkerBackgroundColorIndex = xINone

-MarkerForegroundColorilndex = xINone
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
IT mcolor(am) < O Then
-ColoriIndex = 3
Else
-ColoriIndex = 5
End IFf
-Weight = xIMedium
-LineStyle = xlIContinuous
End With
am = am + 1

Next 1

ActiveChart.ChartArea.Select

With ActiveChart
-Axes(xICategory, xIPrimary).HasTitle = True
-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _
"Max Shear, M. & At _member & " = ' & Format(Smax, ""0.000")

End With

End Sub
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Sub PlotSoilPressure()
On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

Dim Cmx1, Cmx2, Cmyl, Cmy2

Dim Sp As Double

ReDim mxVal(NM) As Variant

ReDim myVal(NM) As Variant

ReDim spxVal(NM) As Variant
ReDim spyVal(NM) As Variant

ReDim spjxvVal(NM + NM) As Variant
ReDim spjyval(NM + NM) As Variant
ReDim mcolor(NM + NM) As Variant

Dim Spmax As Double, At_joint As Integer, am As Integer, L I As Integer, L_1II

As Integer

ActiveSheet.ChartObjects(*"Chart 5).Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

Spmax = Application. index(USPMax(Pmm, Fm, NM), 1)
At_joint = Application.index(USPMax(Pmm, Fm, NM), 2)

For i =1 To NM
With Member (i)
Cx1 = Joint(.J1).x

Cyl = Joint(.Jl).y
Cx2 = Joint(.J2).x
Cy2 = Joint(.J2).y

"assign coordinates
Cmx1l = Cx1 + .Cy * Joint(.J1).Sp
Cmyl = Cyl + .Cx * Joint(.J1).Sp

Cmx2 = Cx2 + .Cy * Joint(.J2).Sp
Cmy2 = Cy2 + .Cx * Joint(.J2).Sp
End With

"member coordinates
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mxVal (1)
myVal (1)

Array(Cx1l, Cx2)
Array(Cyl, Cy2)

"soil pressure coordinates

spxVal (i)
spyVal (i)

Array(Cmx1, Cmx2)
Array(Cmyl, Cmy2)

"member-joint coordinates
spjxval(2 * i1 - 1)
spjyval(2 * i1 - 1)

"mcolor: define color for positive/negative value

Array(Cx1l, Cmx1)
Array(Cyl, Cmyl)

mcolor(2 * 1 - 1) = Sp
spjxval(2 * i) = Array(Cx2, Cmx2)
spjyval(2 * i) = Array(Cy2, Cmy2)

mcolor(2 * 1) = Sp
Next i

"creating member lines
For i = 1 To NM
With ActiveChart

.SeriesCollection.NewSeries

-SeriesCollection(i)-XValues = mxVal (i)

-SeriesCollection(i).Values = myval (i)

.SeriesCollection(i).Name = "=""

End With

ActiveChart.SeriesCollection(i).-Select

With Selection

-MarkerBackgroundColorIndex = xINone

-MarkerForegroundColorIndex = xINone

-MarkerStyle = xINone

-Smooth = False
End With
With Selection.Border
.Colorilndex = 5
-Weight = x1Thin

-LineStyle = xlIContinuous

End With

Next 1
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L1 =NM + NM

"creating soil pressure lines
For 1 = NM + 1 To L_I
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i).XValues = spxVal (am)
-SeriesCollection(i).Values = spyVval(am)
-SeriesCollection(i).Name = "=""m
End With
ActiveChart.SeriesCollection(i).Select
With Selection

-MarkerBackgroundColorIndex

xINone

-MarkerForegroundColorIndex = xINone
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColorlIndex = 7
-Weight = xIThin
-LineStyle = xlIContinuous
End With
am = am + 1

Next i

LIl =NM+ NM + NM + NM

am = 1

"creating joint lines to axis

For i =L 1 +1ToL_Il

With ActiveChart

-SeriesCollection.NewSeries
.SeriesCollection(i).XValues = spjxVal(am)
-SeriesCollection(i).Values = spjyVal(am)
-SeriesCollection(i).Name = "=""r

End With

ActiveChart.SeriesCollection(i).Select

With Selection
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-MarkerBackgroundColorIndex
-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
IT mcolor(am) < O Then
-ColoriIndex = 3

Else

I
(&)]

-ColoriIndex
End IFf
-Weight = xIMedium
-LineStyle = xlIContinuous
End With
am = am + 1

Next 1

ActiveChart.ChartArea.Select
With ActiveChart

-Axes(xICategory, xIPrimary).HasTitle

-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _

xINone

xINone

"Max Pressure, J." & At_joint & " =

End With

End Sub

"user function to determine maximum value of joint translation

Function UXMax(Xs, NP) As Variant

Dim Abs_FXMax As Double
Dim FXMax As Double

Abs FXMax = 0O
n=2=0
For i = 2 To NP Step 2
IT Abs(Xs(i1)) > Abs_FXMax Then
Abs FXMax = Abs(Xs(i))
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FXMax = Xs(i)
n=1a1/72
"UXMax keeps origin value(+ or - value)
UXMax = Array(FXMax, n)
End If

Next 1
End Function

"user function to determine maximum value of member moment
Function UMMax(Pmm, Fm, NM) As Variant

Dim Abs FMMax As Double
Dim FMMax As Double

Abs FMMax = 0O
n=2=0
For i = 1 To NM
IT Abs(mmomenl(i)) > Abs_FMMax Then
Abs_FMMax = Abs(mmomenl(i))
FMMax = mmomenl(i)
n = Member(i).J1l
UMMax = Array(FMMax, n)
End IT
IT Abs(mmomen2(i)) > Abs_FMMax Then
Abs_ FMMax = Abs(mmomen2(i))
FMMax = -mmomen2(i)
n = Member(i).J2
UMMax = Array(FMMax, n)
End If

Next 1
End Function

"user function to determine maximum shear force
Function USMax(Pmm, Fm, NM) As Variant
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Dim Abs FSMax As Double
Dim FSMax As Double

Abs FSMax = 0
n=20
For i =1 To NM

IT Abs(shearl(i)) > Abs FSMax Then

Abs_FSMax = Abs(shearl(i))
FSMax = -shearl(i)

n =i
USMax = Array(FSMax, n)
End If

IT Abs(shear2(i)) > Abs_FSMax Then

Abs_FSMax = Abs(shear2(i))
FSMax = shear2(i)

n =1
USMax = Array(FSMax, n)
End If

Next i

End Function

"user function to determine maximum soil pressure
Function USPMax(Pmm, Fm, NM) As Variant

Dim Sp As Double
Dim Abs FSPMax As Double
Dim FSPMax As Double

Abs_FSPMax = 0
n=2~0
For i = 1 To NJ
Sp = Joint(i).Ks * Xs(2 * 1)
IT Abs(Sp) > Abs_FSPMax Then
Abs_FSPMax = Abs(Sp)
FSPMax = Sp

n=.1
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USPMax = Array(FSPMax, n)
End If
Next i

End Function

Command Button (BOF)

Private Sub CommandButtonl Click()
ChartWindow = True

Call BOF
End Sub

Private Sub CommandButton2 Click()
ChartWindow = False

Call BOF
End Sub

Modulel (XLAT)

"XLAT v.1.0 Program for Laterally Loaded Structure, 2004
"by: Gunthar Pangaribuan - Refer to the book:

"An Introduction to Excel for Civil Engineers

Option Explicit

Public 1 As Integer, j As Integer, n As Integer

Type Joint _Data
X As Double
y As Double
Ks As Double
Spring As Double
Sp As Double

End Type
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Type Member_Data
J1 As Integer
J2 As Integer
Im As Double
bm As Double
El As Double
Ix As Double
ly As Double
Lh As Double
Kml As Double
Km2 As Double
Presl As Double
Pres2 As Double
End Type

Public ChartWindow As Boolean
Public NP As Integer

Public DOF As Integer

Public NR As Integer

Public NJ As Integer

Public NM As Integer

Public Member() As Member_Data
Public Joint() As Joint_Data
Public Em As Double

Public Km() As Double

Public NS As Integer "no. of support
Public GASAT() As Double “global stiffness matrix
Public Rs() As Integer

Public DFR() As Double

Public Idm() As Integer

Public Idj() As Integer

Public Irj() As Integer

Public Psum() As Double

Public Pmm() As Double

Public Pj() As Double

Public Xs() As Double
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Publi
Publi
Publi
Publi
Publi
Publi

c Xm() As Double
c Fm(Q) As Double
c mmomenl() As Double
c mmomen2() As Double
c shearl() As Double
¢ shear2() As Double

Sub XLATQ

On Error GoTo ErrMsg

Const NDJ = 2

Dim N
Dim J

NJ
NM
Em

Jgrou

LJ As Integer "no of joint load

ground As Integer “excavation point

Cells(4, 2)
Cells(5, 2)
Cells(6, 2)
nd = Cells(4, 5)

NS = Application.Count(Rows("'23:23"))

NLI =

Application.Count(Rows(''28:28'"))

"Total number of joint displacement, NP:

NP =

ReDim
ReDim
ReDim
ReDim
ReDim
ReDim

ReDim

ReDim
ReDim
ReDim
ReDim

ReDim

NDJ * NJ

Joint(NJ) As Joint_Data

Member (NM) As Member_Data

ESAT(4, 4, NM) As Double "member matrix refer to the book
EASAT(4, 4, NM) As Double "member matrix refer to the book
GASAT(NP, NP) =global stiffness matrix refer to the book
Idm(4, NM) “displacement index

PJ(NP) "joint load vector

Pmm(NP, NM) =“fixed-end forces
Psum(NP) “sum load vector

Xs(NP) "joint displacement vector
Xm(4, NM) "member deformation

Fm(4, NM) "member forces
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ReDim mmomenl(NM)

ReDim mmomen2(NM)

ReDim shearl1(NM)

ReDim shear2(NM)

ReDim Rs(NP)

ReDim spn(NS) As Integer
Dim mshear As Double

"Read Input Data

"Read joint data - in order
For i = 1 To NJ
With Joint(i)
.x = Cells(10, 1 + 1)
.y = Cells(11, 1 + 1)
-Ks = Cells(12, 1 + 1)
-Spring = Cells(13, 1 + 1)
.Sp = .Ks * Xs(2 * i) "soil pressure
End With

Next 1

"Read member data
For i =1 To NM
With Member (i)

.J1 = Cells(16, 1 + 1)
.J2 = cells(17, 1 + i)
-Im = Cells(18, 1 + 1)
-bm = Cells(19, 1 + 1)

-EI = Em * _Im

-Ix = Joint(.J2).x - Joint(.J1).x
ly = Joint(.J2).y - Joint(.Jl).y
-Lh = Sgr(.Ix ~ 2 + 1y ™ 2)
-Presl = Cells(20, 1 + )

.Pres2 = Cells(21, 1 + )
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Kml = 0.5 * _Lh * _bm * Joint(.J1).Ks + Joint(.J1).Spring
Km2 = 0.5 * _Lh * _bm * Joint(.J2).Ks
End With

Next i

I ChartWindow

True Then Call PlotGeometry: Exit Sub
Application.ScreenUpdating = False

"Read joint load
For i = 1 To NLJ
n = Cells(28, 1 + i)
Pj(2 *n - 1) = Cells(29, 1 + i)
Pj(2 * n) = Cells(30, 1 + i)
Next i

"restrain list and support (Rs) index
For 1 = 1 To NS

spn(i) = Cells(23, 1 + i)

Rs(2 * spn(i) - 1) = Cells(24, 1 + i)

Rs(2 * spn(i)) = Cells(25, 1 + 1)
Next i

DOF = O
For i = 1 To NP

IT Rs(i) = 0 Then DOF = DOF + 1
Next i

"#restrained joint
NR = NP - DOF

ReDim DFX(NDJ * NS, DOF) As Double "[KbFf]Jaccording to Eq. 4.12
ReDim DFR(DOF, DOF) As Double "[KFF]™-1 according to Eq. 4.9
ReDim RIJ(NDJ * NS) As Double "support reactions

ReDim Idj(DOF) "free displacement index

ReDim Irj(NDJ * NS) “"support displacement index

ReDim nAs_Now(NJ) As Integer

Dim nAs_Last As Integer
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Dim Ksn As Integer

Dim ITR As Integer

Dim ITR _Continue As Boolean
ITR_Continue = True

ITR = 1

"clear previous content

Dim LastRow

LastRow = ActiveSheet.UsedRange.Rows.Count
Range(Cells(38, 1), Cells(LastRow, 18)).ClearContents

"Structure Analysis

Do

Call Mindex(ldm, Idj, Irj)
Call FEM(ESAT, EASAT, GASAT)
Call MInvers(DFX, DFR)

Call Genload(Pmm, Psum)

Call DISP(Xs, Xm)

"Print used springs
For i = 1 To NM
With Member (i)
Cells(37 + i, 8).NumberFormat ''0.000"
Cells(37 + i1, 8) = .Kml
Cells(37 + 1, 9)_-NumberFormat = *0.000"
Cells(37 + i, 9) = .Km2
End With

Next 1

n=2=0
For 1 = 1 To Jground - 1
"re-input joint"s Ks and Sp if Xs > 0
With Joint(i)
IT Xs(i * 2) > 0 Then
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.Ks = 0

.Sp = .Ks * Xs(2 * 1)
n=n+1
End IT

End With

Next 1

"re-input member®s soil K
For i = 1 To NM
With Member (i)

Kml = 0.5 * _Lh * _bm * Joint(.J1).Ks + Joint(.J1).Spring
Km2 = 0.5 * _Lh * _bm * Joint(.J2).Ks

End With

Next 1

"check no. of active spring between 2 iterations

nAs_Now(ITR) = NJ - n
nAs_Last = nAs Now(ITR - 1)

IT nAs_Now(ITR) = nAs_Last Or n = 0 Then

ITR_Continue False
Cells(34, 3) = ITR - 1
Cells(35, 3) = nAs_Now(ITR)
Ksn = nAs_Now(ITR)

End If

ITR=1TR + 1

Loop Until 1TR_Continue = False

"1_Print Load
For i = 1 To NJ
Cells(37 + 1, 1).NumberFormat = 0"
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+

Cells(37 + i, 1) =1

Cells(37 i, 2).NumberFormat = "'0.000"
Cells(37 i, 2) =Psum(2 * i1 - 1)
Cells(37 i, 3)_-NumberFormat = '*0.000"
Cells(37 + i, 3) = Psum(2 * 1)

Next 1

+

+

+

2. Print Joint displacement/pressure
For i = 1 To NJ

Cells(37 + i, 4)_NumberFormat = '0.00000"
Cells(37 + 1, 4) =Xs(2 *1i1 - 1)

Cells(37 + 1, 5).NumberFormat = *0.00000"
Cells(37 + 1, 5) = Xs(2 * 1)

Cells(37 + 1, 6)_-NumberFormat = *0.000"
With Joint(i)

.Sp = .Ks * Xs(2 * 1)

Cells(37 + 1, 6) = .Sp

End With

Next i

"{FIm=[SIm.-{XFIm or [FIm=[S]-[AIT-[X]s
"there is already calculated S.A"T,
ReDim tshear(4, NM)

"produce moment + soil pressure
For i = 1 To NM
For j =1 To 4
Fm@, i) =0
For n =1 To 4
Fm(g, 1) = Fm(g, 1) + ESATQ, n,
Next n
Next j

Next 1
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"Print member data
For i = 1 To NM
With Member (i)
"no/length
Cells(37 +
Cells(37 +
"moment
mmomenl (i)
Cells(37 +
Cells(37 +
mmomen2(i)
Cells(37 +
Cells(37 +
"spring
Cells(37
Cells(37
Cells(37
Cells(37
"shear

+

+

+

+

mshear = (F
shearl(i) =
shear2(i) =
Cells(37 +
Cells(37 +
Cells(37 +
Cells(37 +
End With

Next 1

For i =1 To 2 * NS
For j = 1 To DO

i, 7)-NumberFormat = 0"

i, 7) =1 & "./" & Format(.Lh,

, 10) _.NumberFormat
, 10) = mmomenl(i)

i, 11).NumberFormat
i, 11) = mmomen2(i)
i, 12) _NumberFormat
i, 12) = Fm(3, 1)

i, 13).NumberFormat
i, 13) = Fm@, 1)

m(1l, 1) + Fm(2, 1))
mshear
-mshear
i, 14) _NumberFormat
i, 14) = shearl(i)
i, 15).NumberFormat
i, 15) = shear2(i)

F

Fm(l, i) + Pmm(ldm(l, i), i)

''0.000"

Fm(2, 1) + Pmm(ldm(3, i), i)

''0.000™

ll0 R 000"

''0.000™

-Lh

''0.000"

llo R 000"

RI(i) = RICi) + DFX(i, j) * Xs(1dj(i))

Next j
Next i
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For i = 1 To NS

Cells(37 + 1, 16) _NumberFormat = 0"
Cells(37 + i, 16) = spn(i)
Cells(37 + i, 17).NumberFormat = *0.000"
Cells(37 + i1, 17) =RI(2 * 1 - 1) - Psum(Irj(2 * i - 1))
Cells(37 + 1, 18).NumberFormat = "0.000"
Cells(37 + i, 18) = RI(2 * i) - Psum(Irj(2 * i))
Next i

"create graphs

Call PlotGeometry
Call PlotDisplacement
Call PlotMoment

Call PlotShear

Call PlotLoad

Range(""A1'™) .Select

Application.ScreenUpdating = True
Exit Sub

ErrMsg: MsgBox "Error, please check input ...", vbOKOnly + vbExclamation,
“XLAT™

Range(*'A1l™) .Select

Application.ScreenUpdating = True

End Sub

Module2 (XLAT)

Option Explicit

"Indexing for matrix subscript
Sub Mindex(index() As Integer, IFr() As Integer, IFx() As Integer)

"Member end-displacements index:
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For i = 1 To NM
With Member (i)

index(1, i) = 2 * J1 -1
index(2, 1) =2 * _J1
index(3, 1) =2 * .J2 -1
index(4, i) =2 * _.J2
End With

Next i

"Joint free displacement index, IFr and
"restraint (support) index, IFx
n=1
For i = 1 To NP
IT Rs(i) = 0 Then IFr(n) = i: n=n+1

Next i
n=1
For 1 = 1 To NS
n = Cells(23, 1 + i)

IFK(2*i-1)=2*n-1
IFX(2 * 1) =2 *n
Next i

End Sub

Sub FEM(SAT() As Double, ASAT() As Double, GS() As Double)

"Clearing array
For i =1 To NP
For j = 1 To NP
GS(i, j) = O#
Next j
Next i

"Assembly finite element matrix, Eq.4.16 & 4.17

For i = 1 To NM
With Member (i)
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"member SANT matrix:

"from internal forces F - deformation d relationship, F = S.d or F =
S.ANT X

SAT(1, 1, i) =4 * _El / .Lh: SAT(12, 2, i) =6 * _El /7 .Lh ~ 2

SAT(1, 3, i) =2 * _El / .Lh: SAT(Q, 4, i) = -6 * .El / .Lh ~ 2

SAT(2, 1, i) =2 * _El / .Lh: SAT(2, 2, i) =6 * _El / .Lh ~ 2

SAT(2, 3, i) =4 * _El / .Lh: SAT(2, 4, i) = -6 * _El / .Lh ~ 2

SAT(3, 2, i) = .Kml

SAT(4, 4, i) = .Km2

"Member global stiffness (member ASA™T)

ASAT(L, 1, i) = 4 * _El / .Lh: ASAT(L, 2, i) =6 * _El / .Lh ~ 2

ASAT(1l, 3, i) = 2 * _El / .Lh: ASAT(1, 4, i) = -6 * .El / .Lh ~ 2

ASAT(2, 1, i) = 6 * _El / .Lh ~ 2: ASAT(2, 2, i) = 12 * _.El / .Lh ~ 3 +

-Kml

ASAT(2, 3, i) =6 * _El / .Lh ™~ 2: ASAT(2, 4, i) = -12 * .El / .Lh ~ 3

ASAT(3, 1, i) = 2 * _El / _Lh: ASAT(3, 2, i) =6 * _El1 / .Lh ~ 2

ASAT(3, 3, i) = 4 * _El / _Lh: ASAT(3, 4, i) = -6 * _El / .Lh ~ 2

ASAT(4, 1, i) = -6 * _El / .Lh ~ 22 ASAT(4, 2, i) = -12 * _El / .Lh ~ 3
- ASAT(4, 3, i) = -6 * _ElI / .Lh ~ 2: ASAT(4, 4, i) =12 * .El / .Lh ~ 3 +
-Km

"Storing members and superposition(global ASA"T)
For j =1 To 4
For n =1 To 4
o GS(ldm(g, 1), ldm(n, i)) = GS{ldm(g, i), ldm(n, i)) + ASAT(G, n,
i
Next n
Next j
End With

Next 1

End Sub
"Global matrix
Sub MInvers(SR() As Double, SD() As Double)

Dim n As Integer

"submatrix Stiffness, KBF
For i = 1 To DOF
For J =1 To 2 * NS
SR, 1) = GASATUrj(g)., 1dj(i))
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Next j
Next i

"submatrix Stiffness, KFF
For i = 1 To DOF
For J = 1 To DOF
SD(i, j) = GASAT(ldj(i), 1di(d))
Next j
Next i

"Inverse []
For i = 1 To DOF
For jJ = 1 To DOF
IT jJ <> 1 Then SD(i, j)
Next j
For n = 1 To DOF
ITf n =1 Then GoTo 10
For jJ = 1 To DOF
IT jJ <> 1 Then SD(n, j)
Next j
10 Next n
For n = 1 To DOF
IT n<>1 Then SD(n, 1)
Next n
SD(i, i) =1 / SD(i, 1)
Next i

sD(i, j) / Sb(i, i)

Sb(n, J) - SD(i, j) * SD(n, i)

-sD(n, i) 7/ SD(i, i)

End Sub

Sub Genload(Pa() As Double, Ps() As Double)

ReDim Peq(NP, NM) As Double "equivalent load

Dim Idx As Integer, w As Double, d As Double, sq As Double

"member fixed-end forces due to pressure
For i = 1 To NM

With Member (i)

d = Abs(.Presl - _.Pres2)

sq = Application.Min(.Presl, .Pres2)

An Introduction to Excel for Civil Engineers 350




"rectangular part

w = sq * .bm

Pa(ldm(1, 1), 1) = -w * _Lh ~ 2 / 12 "moment
Pa(ldm(2, 1), 1) = -w * _Lh / 2 "horizontal
Pa(ldm(3, 1), i) =w * _Lh ~ 2 / 12 “"moment
Pa(ldm(4, 1), i) = -w * _Lh /7 2 "horizontal

"triangular part & summing
w=d* _bm

Pa(ldm(1, 1), i) = Pa(ldm(1,
Pa(ldm(2, 1), 1) = Pa(ldm(2,
Pa(ldm(3, 1), i) = Pa(ldm(3,
Pa(ldm(4, 1), 1) = Pa(ldm(4,
End With

Next i

+ (-w * _.Lh ~ 2 / 30) "moment
+ (-w * _.Lh * 3 / 20) “horizontal

). 1)
), 1)
i), D+ WW=* _Lh 2/ 20) "moment
). 1)

+ (-w * _Lh * 7 / 20) "horizontal

"equivalent joint load due to pressure

For i = 1 To NM
For j =1 To 4
For n =1 To 4
Peq(ldm(j, 1), 1) =
Next n
Next j
Next i

"sum load = joint load + eq-.load
For i =1 To NP
Ps(i) = Pj(i)

Next 1

"load superposition
For i =1 To NM
For j =1 To 4

Ps(ldm@@, 1)) = Ps(1dm(g,

Next j

Next i

End Sub

-Pa(ldm(j, i), i)

i)) + Peq(ldm(g, 1), 1)
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Sub DISP(x() As Double, Xi() As Double)
ReDim T(4, 4, NM) As Double

*Joint Displacement {X} = [SD]™-1.{P}
For i = 1 To DOF
x(ldj(i)) =0
For J = 1 To DOF
x(1dj(i)) = x(0dj(i)) + DFR(i, j) * Psum(ldj(d))
Next j

Next i

"Numbering of global {X}(NP) to global {Xi} member
For i = 1 To NM
For j =1 To 4
Xig, i) = x(ldm@, 1))
Next j
Next i

End Sub

Module3 (XLAT)

Option Explicit
Option Base 1
Sub PlotGeometry()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2
Dim Cmx1l, Cmx2, Cmyl, Cmy2

ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant
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Dim am As Integer, L I As Integer, L_Il As Integer, L_1Il As Integer, L_IV As
Integer

Dim L_V As Integer, L_VI As Integer, L VIl As Integer, L VIIl As Integer

"member coordinates
For i =1 To NM
With Member (i)

Cx1 = Joint(.J1).x

Cyl = Joint(.Jl).y

Cx2 = Joint(.J2).x

Cy2 = Joint(.J2).y
End With

mxVal (i) = Array(Cxl, Cx2)
myVal (i) = Array(Cyl, Cy2)
tagxVval (i) Array((Cx1 + Cx2) / 2)
tagyVval (i) Array((Cyl + Cy2) / 2)

Next 1

ActiveSheet.ChartObjects(*"Chart 1')._Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

"creating joints + name tags
For i = 1 To NJ
With ActiveChart
-SeriesCollection.NewSeries
.SeriesCollection(i).-XValues = Joint(i).x
-SeriesCollection(i).Values = Joint(i).y
-SeriesCollection(i).-Name = "J" & 1
End With
"node marker
ActiveChart.PlotArea.Select
ActiveChart.SeriesCollection(i).-Select
With Selection
3 "red
3

-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex
-MarkerStyle = xICircle
-MarkerSize = 6
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-Shadow = False
-ApplyDatalLabels AutoText:=True, LegendKey:= _

False, ShowSeriesName:=True,
Showvalue:=False, _

ShowPercentage:=False, ShowBubbleSize:=False
End With

ActiveChart.SeriesCollection(i).DatalLabels.Select

With Selection
-HorizontalAlignment = xICenter
-VerticalAlignment = xlICenter
-ReadingOrder = xlIContext
-Position = xlLabelPositionRight
-Orientation = xIHorizontal
-Font_Name = "Arial”
.Font._FontStyle = "Regular"
-Font.Size = 8

End With

Next 1

ActiveSheet.ChartObjects(''"Chart 1').Activate
ActiveChart.ChartArea.Select

L1 =N+1
LIl = NJ + NM
am = 1
"creating member lines
For i = L 1 To L_11
With ActiveChart
-SeriesCollection._NewSeries
-SeriesCollection(i).-XValues = mxVval (am)
.SeriesCollection(i).Values = myval(am)
-SeriesCollection(i).Name = "=""m
End With
ActiveChart.SeriesCollection(i).Select
With Selection

-MarkerBackgroundColorIndex = xINone

-MarkerForegroundColorilndex = xINone
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-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColorIndex = 5
-Weight = xIThin
.LineStyle = xlIContinuous

End With

am = am + 1

Next i

LI = LIl +1
LIV =L 1l + NM
"creating member name tags
am = 1
For i = L_I111 To L_IV
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = tagxVal(am)
-SeriesCollection(i).Values = tagyVal (am)
-SeriesCollection(i).Name = "M" & am
End With
ActiveChart.PlotArea.Select
ActiveChart.SeriesCollection(i).-Select
With Selection

-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex
-MarkerStyle = xlSquare
-Smooth = False

-MarkerSize = 6

-Shadow = False
-ApplyDatalLabels AutoText:=True, LegendKey:= _

False, ShowSeriesName:=True, ShowCategoryName:=False,
Showvalue:=False, _

ShowPercentage:=False, ShowBubbleSize:=False
End With
ActiveChart.SeriesCollection(i).DataLabels.Select

With Selection
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-HorizontalAlignment = xlICenter
-VerticalAlignment = xlICenter

-Position = xlLabelPositionRight

-Orientation = xIHorizontal
-Font_Name = "Arial”
-.Font._FontStyle = "Regular"
-Font_.Size = 8
End With
am = am + 1

Next i

ActiveChart.ChartArea.Select
With ActiveChart

-Axes(xICategory, xIPrimary).HasTitle
-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _
"NJ = " & Format(NJ, "0"™) & ", NM = " & Format(NM, "'0'")

End With

"Draw pressure

ReDim pxVal(NM) As Variant

ReDim pyval(NM) As Variant

ReDim pjxVal(NM + NM) As Variant
ReDim pjyvVal(NM + NM) As Variant

For i = 1 To NM
With Member (i)
Cx1 = Joint(.J1l).x

Cyl = Joint(.Jl).y
Cx2 = Joint(.J2).x
Cy2 = Joint(.J2).y

"assign coordinates

Cmx1l = Cx1 + .Presl
Cmyl = Cyl
Cmx2 = Cx2 + _Pres2
Cmy2 = Cy2

End With
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"pressure coordinates
pxVal (1) Array(Cmx1, Cmx2)
pyval (i) Array(Cmyl, Cmy2)
"member-joint coordinates
pjxval(2 * i - 1) Array(Cx1, Cmx1)
pjyval(2 * i - 1) Array(Cyl, Cmyl)
pjxval(2 * 1) Array(Cx2, Cmx2)
pjyval (2 i) Array(Cy2, Cmy2)

*

Next 1

LV=L1IV+1
LVI = L IV + NM
am = 1
"creating pressure lines
For i = LV To L_VI
With ActiveChart
-SeriesCollection.NewSeries

-SeriesCollection(i)-XValues = pxVval(am)
-SeriesCollection(i).Values = pyval(am)

.SeriesCollection(i).Name =
End With
ActiveChart.SeriesCollection(i).-Select
With Selection
xINone

-MarkerBackgroundColorIndex

-MarkerForegroundColorilndex = xINone

-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-Colorindex = 7
-Weight = xIThin
-LineStyle = xlIContinuous

End With

am = am + 1

Next 1
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LVII =LVl +1
LVIIT = L_VI + NM + NM

am = 1

"creating joint lines to axis

For i = L_VII To L_VIII

With ActiveChart

-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = pjxvVal(am)
-SeriesCollection(i).Values = pjyval(am)
.SeriesCollection(i).Name = "="""""

End With

ActiveChart.SeriesCollection(i).-Select

With Selection

-MarkerBackgroundColorIndex = xINone

-MarkerForegroundColorilndex = xINone
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColoriIndex = 5
-Weight = xIMedium
-LineStyle = xlIContinuous
End With
am = am + 1

Next 1
ActiveChart.ShowWindow = True
End Sub

Sub PlotDisplacement()

On Error Resume Next
Dim Cx1, Cx2, Cyl, Cy2

ReDim mxValbf(NM) As Variant, myValbf(NM) As Variant
ReDim mxValafF(NM) As Variant, myValaf(NM) As Variant
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Dim Xmax As Double, At joint As Integer, am As Integer

ActiveSheet.ChartObjects(*"Chart 2')_Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

Xmax = Application. index(UXMax(Xs, NP), 1)
At_joint = Application.index(UXMax(Xs, NP), 2)

"member coordinates: before & after loading
For i = 1 To NM
With Member (i)
Cx1 = Joint(.J1).x

Cyl = Joint(.J1l).y
Cx2 = Joint(.J2).x
Cy2 = Joint(.J2).y

mxValbf(i) = Array(Cx1, Cx2)
myValbf(i) = Array(Cyl, Cy2)
Cx1 = Joint(.J1).x + Xs(2 * .J1)

Cyl = Joint(.J1l).y + Xs(2 * .J1)
Cx2 = Joint(.J2).x + Xs(2 * .J2)
Cy2 = Joint(.J2).y + Xs(2 * .J2)

mxValaf(i) = Array(Cx1, Cx2)
myValaf(i) = Array(Cyl, Cy2)

End With
Next 1
am = 1

"creating member lines: before loading
For i =1 To NM
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mxValbf(am)
-SeriesCollection(i).Values = myValbf(am)

.SeriesCollection(i).Name =
End With
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ActiveChart.SeriesCollection(i).Select

With Selection
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-Colorilndex = 5
-Weight = xIMedium
-LineStyle = xlIContinuous

End With

am = am + 1

Next 1
n = NM + NM
am = 1

"creating member lines: after loading
For i = NM + 1 To n
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i).-XValues =
.SeriesCollection(i).Values =
.SeriesCollection(i).Name = "=
End With

ActiveChart.SeriesCollection(i).-Select

With Selection
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColoriIndex = 7
-Weight = xIMedium
.LineStyle = xlIContinuous

End With

am = am + 1

Next i

ActiveChart.ChartArea.Select
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With ActiveChart

-Axes(xICategory, xIPrimary).HasTitle = True

-Axes(xICategory, xIPrimary)._AxisTitle.Characters.Text

"Max Displacement, J." & At _joint & " = " & Format(Xmax, '0.00000")

End With

End Sub

Sub PlotMoment()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

Dim Cmx1, Cmx2, Cmyl, Cmy2
ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim moxVal(NM) As Variant
ReDim moyVal(NM) As Variant
ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant

ReDim mjxVal(NM + NM) As Variant
ReDim mjyVal(NM + NM) As Variant
ReDim mcolor(NM + NM) As Variant

Dim Mmax As Single, At _joint As Integer, am As Integer,

As Integer, _
L 11l As Integer, L_IV As Integer

ActiveSheet.ChartObjects(*"Chart 3').Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

Mmax = Application.index(UMMax(Pmm, Fm, NM), 1)
At_joint = Application.index(UMMax(Pmm, Fm, NM), 2)

For i = 1 To NM
With Member (i)

Cx1 = Joint(.J1).x
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Cyl = Joint(.Jl).y
Cx2 = Joint(.J2).x
Cy2 = Joint(.J2).y

"assign coordinates

Cmx1l = Cx1 + mmomenl(i)
Cmyl = Cyl
Cmx2 = Cx2 - mmomen2(i)
Cmy2 = Cy2

End With

"member coordinates
mxVal (i) = Array(Cxl, Cx2)
myVal (i) = Array(Cyl, Cy2)
"moment coordinates
moxVal (i) = Array(Cmx1, Cmx2)
moyVal (i) = Array(Cmyl, Cmy2)
"member-joint coordinates
mjxvVal(2 * 1 - 1) Array(Cx1l, Cmx1)
mjyval(2 * 1 - 1) Array(Cyl, Cmyl)

"mcolor: define color for positive/negative value

mcolor(2 * i - 1) = mmomenl(i)
mjxVal(2 * 1) Array(Cx2, Cmx2)
mjyval(2 * 1) Array(Cy2, Cmy2)

mcolor(2 * 1) mmomen2(i)

Next i

"creating member lines
For i = 1 To NM
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i) -XValues = mxVal (i)
-SeriesCollection(i).Values = myval(i)
.SeriesCollection(i).Name = "="""
End With
ActiveChart.SeriesCollection(i).-Select
With Selection

xINone

-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex = xINone
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-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColorIndex = 5
-Weight = xIThin
.LineStyle = xlIContinuous
End With

Next 1

LI =NM+1
LIl = NM + NM
am = 1
"creating moment lines
For i = L_I To L_11
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i).XValues
-SeriesCollection(i).Values
-SeriesCollection(i).-Name =
End With

moxVal (am)

moyVal (am)

ActiveChart.SeriesCollection(i).Select

With Selection
-MarkerBackgroundColorIndex
-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColoriIndex = 7
-Weight = xIThin
.LineStyle = xlIContinuous

End With

am = am + 1

Next i
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LI = LIl +1
LIV = L_Il + NM + NM
am = 1
"creating joint lines to axis
For i = L 111 To L_IV
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mjxVal (am)
-SeriesCollection(i).Values = mjyval(am)
-SeriesCollection(i).Name = "="""m
End With
ActiveChart.SeriesCollection(i).Select
With Selection
-MarkerBackgroundColorIndex

xINone

xINone

-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
IT mcolor(am) < O Then

-ColoriIndex = 3
Else
-ColorIndex = 5
End IT

-Weight = xIMedium
-LineStyle = xlIContinuous
End With
am = am + 1

Next 1

ActiveChart.ChartArea.Select

With ActiveChart
-Axes(xICategory, xIPrimary).HasTitle = True
-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _
"Max Moment, J." & At _joint & " =" & Format(Mmax, "'0.000')

End With
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End Sub

Sub PlotShear()

On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2

Dim Cmx1, Cmx2, Cmyl, Cmy2

ReDim mxVal(NM) As Variant

ReDim myVal(NM) As Variant

ReDim tagxVal(NM) As Variant
ReDim tagyVal(NM) As Variant
ReDim shxval(NM) As Variant
ReDim shyval(NM) As Variant
ReDim sjxVal(NM + NM) As Variant
ReDim sjyvVal(NM + NM) As Variant
ReDim mcolor(NM + NM) As Variant

Dim Smax As Double, At member As Integer, am As Integer, L_I As Integer, _

L_Il As Integer, L_ 111 As Integer, L_ 1V As Integer

ActiveSheet.ChartObjects(*"Chart 4').Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

Smax = Application.index(USMax(Pmm, Fm, NM), 1)
At _member = Application. index(USMax(Pmm, Fm, NM), 2)

For i = 1 To NM
With Member (i)

Cx1 = Joint(.J1l).x
Cyl = Joint(.Jl).y
Cx2 = Joint(.J2).x
Cy2 = Joint(.J2).y

"assign coordinates
Cmx1l = Cx1 - shearl(i)
Cmyl = Cyl
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Cmx2
Cmy2
End With
"member coordinates
mxVal (1)
myVal (1)

"shear coordinates
shxval (i) = Array(Cmx1, Cmx2)
shyval (i) = Array(Cmyl, Cmy2)

Cx2 + shear2(i)
Cy2

Array(Cx1l, Cx2)
Array(Cyl, Cy2)

"member-joint coordinates
sjxval(2 * i1 - 1) Array(Cx1l, Cmx1)
sjyval(2 * 1 - 1) Array(Cyl, Cmyl)
"mcolor: define color for positive/negative value
mcolor(2 * 1 - 1) = -shearl1(i)
sjxval(2 * 1) = Array(Cx2, Cmx2)
sjyval(2 * 1) Array(Cy2, Cmy2)
mcolor(2 * 1) shear2(i)

Next i

"creating member lines
For i = 1 To NM
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mxVal (i)
-SeriesCollection(i).-Values = myVal (i)
.SeriesCollection(i).Name = "="""""
End With
ActiveChart.SeriesCollection(i)-Select
With Selection

xINone

-MarkerBackgroundColorIndex

xINone

-MarkerForegroundColorIndex
-MarkerStyle = xINone
-Smooth = False

End With

With Selection.Border
-ColoriIndex = 5
-Weight = xIThin
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-LineStyle = xlIContinuous
End With

Next 1

LI =NV+1

LIl = NM + NM

am = 1

"creating shear lines

For i = L 1 To L_11

With ActiveChart

-SeriesCollection.NewSeries
.SeriesCollection(i).XValues = shxval (am)
-SeriesCollection(i).Values = shyval(am)
-SeriesCollection(i).Name = "=""m

End With

ActiveChart.SeriesCollection(i).Select

With Selection

-MarkerBackgroundColorIndex = xINone

-MarkerForegroundColorIndex = xINone
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColoriIndex = 7
-Weight = xIThin
-LineStyle = xlIContinuous
End With
am = am + 1

Next 1

LI = LIl +1
LIV = L_Il + NM + NM
am = 1
"creating joint lines to axis
For i = L 111 To L_IV
With ActiveChart
-SeriesCollection.NewSeries
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-SeriesCollection(i)-XValues = sjxVal(am)
.SeriesCollection(i).Values = sjyval(am)
-SeriesCollection(i).Name = "=""m
End With
ActiveChart.SeriesCollection(i).-Select
With Selection

-MarkerBackgroundColorIndex = xINone

-MarkerForegroundColorilndex = xINone
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
IT mcolor(am) < O Then
-ColoriIndex = 3
Else
-ColoriIndex = 5
End IFf
-Weight = xIMedium
-LineStyle = xlIContinuous
End With
am = am + 1

Next 1

ActiveChart.ChartArea.Select

With ActiveChart
-Axes(xICategory, xIPrimary).HasTitle = True
-Axes(xICategory, xIPrimary).AxisTitle.Characters.Text = _
"Max Shear, M." & At _member & " = ' & Format(Smax, ""0.000")

End With

End Sub

Sub PlotLoad()
On Error Resume Next

Dim Cx1, Cx2, Cyl, Cy2
Dim Cmx1l, Cmx2, Cmyl, Cmy2
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ReDim mxVal(NM) As Variant
ReDim myVal(NM) As Variant
ReDim IxvVal(NM) As Variant
ReDim Iyval(NM) As Variant

ReDim IjxvVal(NM + NM) As Variant
ReDim Ijyval(NM + NM) As Variant

Dim am As Integer, L_1 As Integer, L_I1 As Integer

ActiveSheet.ChartObjects(*"Chart 5').Activate

ActiveChart.ChartArea.Select

Selection.ClearContents

For i = 1 To NM
With Member (i)

Cx1 = Joint(.J1l).x

Cyl
Cx2
Cy2

Joint(.Jl).y
Joint(.J2).x
Joint(.J2).y

"assign coordinates
Cmx1l = Cx1 + Psum(2 * .J1)

Cmyl = Cyl

Cmx2 = Cx2 + Psum(2 * .J2)

Cmy2 = Cy2
End With
"member coordinates
mxVal (i) =
myVal (i) =
"load coordinates

Array(Cx1l, Cx2)
Array(Cyl, Cy2)

Ixval (i) = Array(Cmx1l, Cmx2)
Iyval (i) = Array(Cmyl, Cmy2)
"member-joint coordinates

Ijxval(2 *

Ijyval(2 *

Ijxval(2 *

ljyval(2 *
Next i

i - 1) = Array(Cx1, Cmx1l)
i - 1) = Array(Cyl, Cmyl)
i) = Array(Cx2, Cmx2)
i) = Array(Cy2, Cmy2)
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"creating member lines
For i = 1 To NM
With ActiveChart
-SeriesCollection._NewSeries
.SeriesCollection(i).XValues = mxVvVal (i)
.SeriesCollection(i).Values = myval(i)
-SeriesCollection(i).Name = "="rm
End With
ActiveChart.SeriesCollection(i).Select
With Selection

-MarkerBackgroundColorIndex = xINone

-MarkerForegroundColorilndex = xINone
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColorIndex = 5
-Weight = xI1Thin
-LineStyle = xlIContinuous
End With

Next 1

LI =NM+ NM + NM
am = 1
"creating joint lines to axis
For 1 = NM + 1 To L_I
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i).-XvValues = Ijxval(am)
-SeriesCollection(i).Values = Ijyval(am)
.SeriesCollection(i).Name = "="""
End With
ActiveChart.SeriesCollection(i).-Select
With Selection

-MarkerBackgroundColorIndex

-MarkerForegroundColorIndex

An Introduction to Excel for Civil Engineers 370




-MarkerStyle = xIDiamond
-Smooth = False
-MarkerSize = 6
-Shadow = False

End With

With Selection.Border
.Colorindex = 1
-Weight = xIMedium
-LineStyle = xlIContinuous

End With

am = am + 1

Next 1
End Sub

"user function to determine maximum value of joint translation
Function UXMax(Xs, NP) As Variant

Dim Abs FXMax As Double
Dim FXMax As Double

Abs FXMax = 0
n=2=0
For 1 = 2 To NP Step 2
IT Abs(Xs(i)) > Abs_FXMax Then
Abs FXMax = Abs(Xs(i))
FXMax = Xs(i)
n=1a1/72
"UXMax keeps origin value(+ or - value)
UXMax = Array(FXMax, n)
End IFf

Next 1

End Function
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"user function to determine maximum value of member moment

Function UMMax(Pmm, Fm, NM) As Variant

Dim Abs FMMax As Double
Dim FMMax As Double

Abs FMMax = 0
n=2=0
For i = 1 To NM
IT Abs(mmomenl(i)) > Abs_FMMax Then
Abs_FMMax = Abs(mmomenl(i))
FMMax = mmomenl(i)
n = Member(i).J1l
UMMax = Array(FMMax, n)
End If
IT Abs(mmomen2(i)) > Abs_FMMax Then
Abs_FMMax = Abs(mmomen2(i))
FMMax = -mmomen2(i)
n = Member(i).J2
UMMax = Array(FMMax, n)
End IFf

Next 1
End Function

"user function to determine maximum shear force
Function USMax(Pmm, Fm, NM) As Variant

Dim Abs FSMax As Double
Dim FSMax As Double

Abs FSMax = 0
n=2=0
For i = 1 To NM
IT Abs(shearl(i)) > Abs FSMax Then
Abs_FSMax = Abs(shearl(i))
FSMax = -shearl(i)
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n=1i
USMax = Array(FSMax, n)

End IT

IT Abs(shear2(i)) > Abs_FSMax Then
Abs_FSMax = Abs(shear2(i))

FSMax = shear2(i)

n=-1m

USMax = Array(FSMax, n)
End IT

Next i

End Function

"user function to determine maximum soil pressure
Function USPMax(Pmm, Fm, NM) As Variant

Dim Sp As Double
Dim Abs FSPMax As Double
Dim FSPMax As Double

Abs FSPMax = 0
n=2=0
For i = 1 To NJ
Sp = Joint(i).Ks * Xs(2 * 1)
IT Abs(Sp) > Abs_FSPMax Then
Abs_FSPMax = Abs(Sp)

FSPMax = Sp
n =1
USPMax = Array(FSPMax, n)
End If
Next i

End Function
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Command Button (XLAT)

Private Sub CommandButtonl Click()
ChartWindow = True

Call XLAT
End Sub

Private Sub CommandButton2 Click()
ChartWindow = False

Call XLAT
End Sub

Modulel (FDC)

Option Explicit
Sub FDCQ)

"FDC v.1.0 Program for One Dimensional Consolidation Analysis, 2004
"by: Gunthar Pangaribuan - Refer to the book:

"An Introduction to: Excel for Civil Engineers

On Error GoTo Check

Dim h As Double, t As Double, cv As Double, Tv As Double, m As Integer, n As
Long

Dim FDCCase As Integer, i As Integer, j As Integer
Dim AIP As Double, ATP As Double

im = Cells(4, 2) "no. of layer

m= 10 * im

= Cells(3, 2) “height of layer

Cells(b, 5) "time

cv = Cells(5, 2) "coef. of consolidation
FDCCase = Cells(3, 5) "Case of calculation

~ =
I
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ReDim dZ(0 To im) As Double, IP(0 To im) As Double, TP(0O To im) As Double

ReDim rsdZ(0 To m) As Double, rsIP(0 To m) As Double, rsTP(0O To m) As Double
Const Beta =1/ 6

For i = 0 To im
dz¢i) =i *h / im
IP(i) Cells(9 + i, 2)

Next i

"re-input dZ and IP to obtain a smooth isochrone curve
n=1
rsdz(0) = dz(0)
rsiP(0) = 1P(0)
For i = 0 To im - 1
For j =1 To 10

rsiP(j) = j * (IP(i + 1) - IP(i)) 7/ 10
rsdz(§j) = j * (dz(i + 1) - dz(i)) /7 10
rsiP(n) = rsIPQ) + IP(i)
rsdz(n) = rsdz(g) + dz(i)
n=n+1
Next j

Next i

Dim LastRow
LastRow = ActiveSheet.UsedRange.Rows.Count
Range(Cells(9, 1), Cells(LastRow, 4)).ClearContents
IT FDCCase = 1 Then
"open layered

Tv=cv*t/ (h/2) ™2

n=15*m~"2*Tv

ReDim u(0 Tom + 1, 0 To n + 1) As Double
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u(O, i + 1) =0 *"Ffirst row = 0
u(m, i + 1) =0 "last row = 0
Next 1

For i =1 Tom-1
u(i, 0) = rsIP(i) "> first row to < last row

Next i

"Finite difference approximation:
For J = 0 To n
For i =1 Tom-1

u(if, j + 1) = u(i, j) + Beta * (u(i -1, j) +u@ +1, j) - 2 *
u(i, 3))
Next i

Next j
Elself FDCCase = 2 Then
"half closed layered
Tv=cv*t/ hn2

n=6*m"2=*Tv

ReDim u(0 Tom + 1, 0 To n + 1) As Double

1
o

u(o, 0)

For 1 =0 Ton
u(O, i + 1) =0 "First row = 0
Next i

For 1 =1 Tom
u(i, 0) = rslIP(i)

Next 1
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"Finite difference approximation:
For j =0 Ton
For i =1 Tom-1
u(i, J +1) =u(, j) +Beta * (u@G -1, j) +u@ + 1, j) -2 =
uCi, 3))
Next i
"on impermeabel boundary (at m points):
i=m: u(@i, j+1) =udi, j) +Beta * @ *u@ -1, j) - 2 * u(i,
)
Next j

Else

GoTo Check

End If

"Result: after t pressure

For 1 =1 Tom
rsTP(i) = u(i, n + 1)

Next i

"Result

For i = 0 To im

Cells(9 + i, 1)_NumberFormat = "0.00"
Cells(9 + i, 1) = dz(i)

Cells(9 + i, 2).NumberFormat = "0.00"
Cells(9 + i, 2) = IP(i)

Cells(9 + i, 3)_-NumberFormat = "0.00"

Cells(9 + i, 3) = rsTP(10 * i)

Next 1

"Determine area under Isochrone
"using trapezoidal approximation
"in H/m unit

AIP
ATP =0

For i OTom-1
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AIP = AIP + (rsIP(i) + rsIP(i + 1)) / 2 "area of initial pressure
ATP = ATP + (rsTP(1) + rsTP(i + 1)) / 2 "area of after t pressure
Next i

"Print degree of consolidation, U
Cells(9, 4).NumberFormat = ""0%"
Cells(9, 4) =1 - ATP / AIP

"Produce FDC Chart

Dim Cx1, Cx2, Cyl, Cy2

ReDim mxValbf(0 To im) As Variant, myValbf(0O To im) As Variant

ReDim mxValaF(0O To m + m) As Variant, myValaf(0 To m + m) As Variant

Dim am As Integer

ActiveSheet.ChartObjects(*"Chart 1').Activate
ActiveChart.ChartArea.Select

Selection.ClearContents

"creating series lines: initial pressure
am = 1
For i = 0 To im - 1
mxValbf(am) = Array(1P(i), IP(i + 1))
myValbf(am) = Array(dz(i), dz(i + 1))
With ActiveChart
-SeriesCollection._NewSeries
-SeriesCollection(am) .XValues = mxValbf(am)
.SeriesCollection(am).Values = myValbf(am)
-SeriesCollection(am) .Name = "=""""""
End With
ActiveChart.SeriesCollection(am).Select
With Selection
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-.ColoriIndex = 5
-Weight = xIThin
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-LineStyle = xlIContinuous
End With
am = am + 1

Next 1

"creating series lines: after t pressure
For 1 = im + 1 To j
mxValaf(i) = Array(rsTP(am), rsTP(am + 1))
myValaf(i) = Array(rsdz(am), rsdzZ(am + 1))
With ActiveChart
-SeriesCollection.NewSeries
-SeriesCollection(i)-XValues = mxVvValaf(i)
-SeriesCollection(i).Values = myValaf(i)
.SeriesCollection(i).Name = "="""""
End With
ActiveChart.SeriesCollection(i)-Select
With Selection
-MarkerStyle = xINone
-Smooth = False
End With
With Selection.Border
-ColoriIndex = 7
-Weight = xIMedium
-LineStyle = xlIContinuous
End With
am = am + 1

Next 1

ActiveSheet.Range("'Al1") .Select
Exit Sub

Check: MsgBox ™"Please check the input data ...", vbOKOnly + vbExclamation,
"FDC Error!"

End Sub

An Introduction to Excel for Civil Engineers 379




Command Button (FDC)

Private Sub CommandButtonl Click()
Call FDC
End Sub
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